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Manual Overview

Warnings, Cautions, and Notes

Warnings

Warnings are extremely important recommendations, violating which may result in either 
injury to yourself or others, or damage to your analyzer and/or data. Warnings will always be 
identified as Warnings in the text, and will always be visually presented as follows:
WARNING  This is a Warning.

Example Warning:
WARNING  Tampering with the 5,500 ppm (Lead high) lead-in-soil standard may cause 
exposure to lead dust. Keep all standards out of reach of children.

Cautions

Cautions are important recommendations. Cautions will always be identified as Cautions in 
the text, and will always be visually presented as follows:
CAUTION  This is a Caution.

Example Caution:
CAUTION  Never tamper with Test Standards. They should not be used unless they are 
completely intact

Notes

Notes are informational asides which may help you with your analyses. Notes will always be 
identified as Notes in the text, and will always be visually presented as follows:
Note  This is a Note.

Example Note:
Note  For defensible Quality Control, keep a record of the time and precision of every 
calibration

Figures

Figures are illustrations used to show what something looks like. Figures will always be 
labelled and identified as Figures directly below the Figure itself, and will always be visually 
presented as follows:
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Figure 1. This is a Figure

Physical Buttons

Physical Buttons are actual buttons on the analyzer which must be pushed to activate their 
function. Physical Buttons will always be identified as Buttons in the text, and will always be 
visually presented as follows:

This is a Physical Button.

Example Physical Buttons:

On/Off/Escape Button, Clear/Enter Button, Interlock Button, and Trigger Button.

Other Hardware

Other Hardware refers to any physical part of the analyzer which performs a necessary 
function. Other Hardware will always be visually presented as follows:

This is an example of Other Hardware.

Example Other Hardware:

Battery, Touch Screen Display, Measurement Window, and USB Cable



 2 Using Your Analyzer
Safely and Effectively Using Your Analyzer

Thermo Scientific Niton XL3 Analyzer User’s Guide 3

Using Your Analyzer

This section discusses the basics of using your analyzer, no matter the specific type of analysis 
you wish to perform. First we go over analyzer safety, particularly radiation safety. Using an 
X-ray based analyzer safely is very important, and not difficult, provided you read, 
understand, and follow these guidelines. Secondly, we outline the startup procedure we 
recommend for daily use to ensure that your analyzer is performing properly and at its most 
efficient level. 

Safely and Effectively Using Your Analyzer
CAUTION  Niton analyzers are not intrinsically safe analyzers. All pertinent Hot Work 
procedures should be followed in areas of concern.

Radiation and General Safety
WARNING  Always treat radiation with respect. Do not hold your analyzer near the 
measurement window during testing. Never point your analyzer at yourself or anyone else 
when the shutter is open. 

Radiation and General Safety

This section covers topics related to radiation safety and general safety when using a Thermo 
Scientific Niton XL3 analyzer. At a minimum all operators of the analyzer should be familiar 
with the instructions provided in this chapter in order to handle the analyzer in a safe manner. 
In addition to reading the information presented on the following pages, Thermo Fisher 
Scientific recommends that instrument users participate in a radiation safety and operational 
training class.

Radiation Protection Basics

The Niton Model XL3t analyzer contains an x-ray tube which emits radiation only when the 
user turns the x-ray tube on. When the x-ray tube is on and the shutter is open, as during a 
measurement, the analyzer emits a directed radiation beam - see Figures 1 and 2. Reasonable 
effort should be made to maintain exposures to radiation as far below dose limits as is 
practical. This is known as the ALARA (As Low as Reasonably Achievable) principle. For any 
given source of radiation, three factors will help minimize your radiation exposure: Time, 
Distance, and Shielding.

The Niton Model XL3p analyzer contains a radioactive sealed source. Radiation from this 
source is fully contained within the device when not in use and allowed to escape through the 
measurement window only while the user is analyzing a sample. Radiation emission is 
controlled by a shutter. The analyzer emits a directed radiation beam (See Figure 1 and Figure 
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2) when the shutter is open during a measurement. Reasonable effort should be made to 
maintain exposures to radiation as far below dose limits as is practical. This is known as the 
ALARA (As Low as Reasonably Achievable) principle. For any given source of radiation, three 
factors will help minimize your radiation exposure: Time, Distance, and Shielding.

Time

The longer you are exposed to a source of radiation the longer the radiation is able to interact 
in your body and the greater the dose you receive. Dose increases in direct proportion to 
length of exposure.

Distance

The closer you are to a source of radiation, the more radiation strikes you. Based on geometry 
alone, dose increases and decreases with an inverse-squared relation to your distance from the 
source of radiation (additional dose rate reduction comes from air attenuation). For example, 
the radiation dose one foot from a source is nine times greater than the dose three feet from 
the source. Remember to keep your hands and all body parts away from the front end of the 
analyzer when the shutter is open to minimize your exposure.

Shielding

Shielding is any material that is placed between you and the radiation source. The more 
material between you and the source, or the denser the material, the less you will be exposed 
to that radiation. Supplied or optional test stands are an additional source of shielding for 
analysis. A backscatter shield accessory is also available and may be appropriate in some 
applications.

Exposure to Radiation

Human dose to radiation is typically measured in rem, or in one-thousandths of a rem, called 
millirem (mrem), 1 rem = 1000 mrem. Another unit of dose is the Sievert (Sv), 1 Sv = 100 
rem. The allowable limit for occupational exposure in the U.S (and many other countries) is 
5,000 mrem/year (50 mSv/year) for deep (penetrating) dose and 50,000 mrem/year (500 
mSv/year) for shallow (i.e., skin) dose or dose to extremities. Deep, shallow, and extremity 
exposure from a properly used Niton XL3t analyzer should be less than 200 mrem per year, 
(2.0 mSv per year) even if the analyzer is used as much as 2,000 hours per year, with the 
shutter open continuously. The only anticipated exceptions to the 200 mrem maximum 
annual dose are: 1) routine and frequent analysis of plastic samples without use of a test stand, 
backscatter shield, or similar additional protective measures, or 2) improper use where a part 
of the body is in the primary beam path.
Note  NEVER OPERATE THE DEVICE WITH A PART OF YOUR BODY IN THE 
PRIMARY BEAM PATH OR WITH THE PRIMARY BEAM PATH DIRECTED AT 
ANYONE ELSE.

Potential_Exposure_Limit_Times
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Also, consider the use of protective accessories such as a shielded test stand or backscatter 
shield (or equivalent) when performing routine and/or frequent analysis of any of the 
following:

• plastic (or similarly low density) samples,

• thin samples (such as foils, circuit boards, and wires)

• samples that are smaller than the analysis window.

Shown in Table 1are the typical background radiation doses received by the average member 
of the public. The radiation dose limits for radiation workers in the US are also shown in 
Table 2.

Table 1. Typical Radiation Doses Received (Source: NCRP 1987)

Category
Dose in 

mrem
Dose in mSv

Average total dose in US (annual) 360 3.6

Average worker exposure (annual) 210 2.1

Average exposure for an underground 

miner
400 4.0

Exposure for airline crew (1,000 hours 

at 35,000 ft)
500 5.0

Additional from living in Denver at 

5300’ (annual)
25 .25

Additional from 4 pCi/l radon in home 1,000 10.0

Typical Chest X-Ray 6 0.06

Typical Head or Neck X-Ray 20 0.2

Typical pelvis/hip x-ray 65 0.65

Typical lumbar spine x-ray 30 0.3

Typical Upper G.I. x-ray 245 2.45

Typical Barium enema x-ray 405 4.05

Typical CAT scan 110 1.10
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Monitoring your radiation exposure

Individuals can be monitored for the radiation dose they receive by use of radiation dosimetry 
devices (dosimeters). Monitoring dose using a dosimeter can be a way of identifying improper 
use and at the same time demonstrating proper use. In some locations, dosimetry is required 
by regulations and in others it is optional. It is normally required when the user could 
reasonably be expected to receive in excess of 10% of the annual dose limit. Thermo Fisher 
Scientific recommends that you determine and obey the local regulatory requirements 
concerning radiation monitoring of occupational workers.

Two common types of dosimeters are whole-body badges and ring badges. Whole body 
badges are often attached to the user’s torso (e.g., clipped to the collar, shirt pocket, or waist as 
appropriate). A ring badge is worn on the finger as a measure of maximum extremity dose. 
When worn, the specific location of the dosimeter should be that part of the body that is 
expected to receive the highest dose. This location will depend on how the analyzer is used 
and so it may not be the same for all users. Dosimetry services are offered by many companies. 
Two companies offering dosimetry services in the USA and much of the world are:

Table 2. Annual Occupational Dose Limits for Radiation Workers 

(Source: Code of Federal Regulations Title 10, Part 20)

Category
Dose in 

mrem
Dose in mSv

Whole Body 5000 50

Pregnant Worker (during gestation 

period)
500 5

Eye Dose Equivalent 15,000 150

Shallow dose equivalent to the skin or 

any extremity or organ
50,000 500

Maximum allowable dose for the 

general public (annual)
100 1.0

For a Minor 500 5.0
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Note  Wearing a dosimeter badge does not protect you against radiation exposure. A 
dosimeter badge only measures your exposure (at the dosimeter location).

Pregnancy and Radiation Exposure

International guidance documents (e.g., ICRP Publication 60 and NCRP Publication 116*) 
recommend that the radiation dose to the embryo/fetus of a pregnant woman should not 
exceed a total of 500 mrem (10% of normal radiation worker limit) during the gestation 
period. While this dose limit exceeds the dose limit to a trained operator, pregnant workers 
may want to take special precautions to reduce their exposure to radiation. For more 
information see the U.S. NRC Regulatory Guide 8.13 "Instruction Concerning Prenatal 
Radiation Exposure" which can be found on the resource CD.

* The International Commission on Radiological Protection, ICRP, is an independent 
Registered Charity, established to advance for the public benefit the science of radiological 
protection, in particular by providing recommendations and guidance on all aspects of 
protection against ionizing radiation.

* The National Council on Radiation Protection and Measurements (NCRP) was chartered 
by the U.S. Congress in 1964 as the National Council on Radiation Protection and 
Measurements.

How to Use the Niton XL3t Analyzer Safely

The Niton XL3t analyzer is designed to be safe to operate provided that it is used in 
accordance with manufacturer's instructions. Under conditions of normal use, monitored 
operators seldom receive a measurable dose and have not been known to receive in excess of 
10% of the annual occupational dose limits (a criteria that would require monitoring under 
regulation in the U.S.). In addition to proper use of the XL3t, it is recommended that you 
follow these precautions to ensure your safety and the safety of those around you.

Know where the beam is

The primary beam is a directed beam out of the front of the analyzer that can have high dose 
rates. The secondary beam, or scattered beam, has much lower dose rates.

Table 3. Dosimeters

Company Global Dosimetry Solutions Landauer, Inc.

Address 2652 McGaw Avenue 2 Science Road

City and State Irvine, CA 92614 Glenwood, IL 60425-9979

Website www.dosimetry.com www.landauerinc.com

Phone Number (800) 251-3331 (800) 323-8830

Safety_and_Compliance_Web_Hub.htm
Tips_and_Troubleshooting.htm#Registration and Licensing FAQ
Tips_and_Troubleshooting.htm#Registration and Licensing FAQ
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Figure 2. Primary Beam
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Figure 3. Secondary (Scattered) Beam
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The Shutter-Open Indicator Lights

When the lights are flashing, the primary beam is on, and radiation is being emitted from the 
front of the analyzer.

Figure 4. The X-ray Beam Indicator Lights

Handle and Use with Respect

Avoid holding the front of the analyzer when the x-ray tube is energized and the shutter is 
open. Never point the instrument at yourself or anyone else when the shutter is open and the 
x-ray tube is energized. Never look into the path of the primary beam.

Follow a Radiation Protection Program

Your organization should establish, document, and follow a Radiation Protection Program. 
An example of such a program can be found on the resource CD (provided with the 
instrument).

Take Proper Care of your Niton XL3

Keeping your analyzer maintained in good condition will help minimize the risk of accidental 
exposure. Mechanical malfunction of the shutter can be avoided by maintaining the 
measurement window, as described in the User Guide. This prevents foreign objects from 
entering your analyzer
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Avoid Over-Exposures

Direct contact with the window could result in overexposures in the times indicated inTable 4 
below.

Extremity is defined by the NRC as the hand, elbow, arm below the elbow, foot, knee, or 

leg below the knee. Whole Body is defined by the NRC as the head, trunk (including 

male gonads), arms above the elbow, or legs above the knee.

*Based on maximum deep dose rate and US exposure limit.

Safe Handling of Samples

As mentioned many times in this chapter, never place any part of your body in the path of the 
x-ray beam. There is always a safe way to handle samples whether they are small, irregularly 
shaped, or of low density. Never look into the path of the primary beam.

Small Samples

A small sample would be any sample that is smaller than the measurement window. Small 
samples present a unique risk because they don’t block the entire beam path. The difficulty 
with placing small samples down on a work surface to analyze them is that you may get 
readings from the work surface that interfere with analytical results. A test stand is an effective 
way of analyzing small samples accurately and safely. Never hold samples during analysis or 
look into the path of the primary beam.

Table 4. Potential Exposure Limit Times

Location of Dose Limit Time to Reach Limit

Deep Dose / 

Whole Body
5 rem (50 mSv) 2.1 minutes

Shallow Dose / 

Extremities
50 rem (500 mSv) 0.95 minutes

Member of 

Public (i.e. 

untrained 

operator)

0.1 rem (1 mSv) 2.5 seconds*
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Irregularly Shaped Samples

Irregularly shaped samples may not allow the proximity button to be depressed, or they may 
not entirely cover the primary beam and cause additional scattering. A back scatter shield is a 
safe way of reducing your radiation exposure while effectively analyzing an irregularly shaped 
sample.

Low Density Materials (such as plastics).

X-rays are attenuated more through denser materials and less through low density materials 
such as plastic. This causes higher dose rates in the scattered radiation. If you are frequently 
handling low density samples, you should consider the use of test stands, backscatter shields, 
or the equivalent.
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Niton XL3t Radiation Profile

Radiation Meter Information

Model: Bicron MicroRem

SN: 2057

Cal Due: 10/10/2009

Background Radiation Level

<0.01 mr/hr

* GM = General Metals, EM = Electronics Metals, DA = Dental Alloy, PM = Precious 

Metals, M = Mining, S = Soil,  E = Exploration, IP = Industrial Paint, T = Thin Sample, 

P = Plastic 

Scatter Measurements off various substrates - Dose Rates in mRem/hr

Table 1-4 - Niton XL3t Radiation Profile - Scatter Measurements - mRem/hr

kV uA Range Substrate
Max @ 

5cm

Max @ 

30 cm

Max @ 

Trigger

50 40

EM, GM, S, T, IP, PM, DA, M, E, P (Main 

Filter)

S, T, M, E (High Filter)

Plastic 40 3.5 2

50 40

EM, GM, S, T, IP, PM, DA, M, E, P (Main 

Filter)

S, T, M, E (High Filter)

Soil 8 0.4 0.07

20 100 S, P, T, M, E (Low Filter) Aluminum 0.015 0.01 0.01

20 100 S, P, T, M, E (Low Filter) Stainless 0.015 0.01 0.01

20 100 S, P, T, M, E (Low Filter) Plastic 0.13 0.015 0.015

20 100 S, P, T, M, E (Low Filter) Soil 0.015 0.015 0.015

15 100 IP, EM (Low Filter) Aluminum 0.015 0.015 0.015

15 100 IP, EM (Low Filter) Stainless 0.015 0.015 0.015
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Notes:

Scatter measurements were taken at a radius of 5 or 30 cm around the nose of the analyzer 

with the highest scatter dose rate being recorded.

Scatter Measurements off various substrates - Dose Rates in µSv/hr

* GM = General Metals, EM = Electronics Metals, DA = Dental Alloy, PM = Precious 

Metals, M = Mining, S = Soil, E = Exploration, IP = Industrial Paint, T = Thin Sample, 

P = Plastic

Table 1-5 - Niton XL3t Radiation Profile - Scatter Measurements - µSv/hr

kV uA Range Substrate
Max @ 

5cm

Max @ 

30 cm

Max @ 

Trigger

50 40

EM, GM, S, T, IP, PM, DA, M, E (P (Main 

Filter)

S, T, M, E (High Filter)

Plastic 400 35 20

50 40

EM, GM, S, T, IP, PM, DA, M, E (P (Main 

Filter)

S, T, M, E (High Filter)

Soil 80 4 0.7

20 100 S, P, T, M, E (Low Filter) Aluminum 0.15 0.1 0.1

20 100 S, P, T, M, E (Low Filter) Stainless 0.15 0.1 0.1

20 100 S, P, T, M, E (Low Filter) Plastic 1.3 0.15 0.15

20 100 S, P, T, M, E (Low Filter) Soil 0.15 0.15 0.15

15 100 IP, EM (Low Filter) Aluminum 0.15 0.15 0.15

15 100 IP, EM (Low Filter) Stainless 0.15 0.15 0.15
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In Beam Measurements - Dose Rates in Rem/hr

* GM = General Metals, EM = Electronics Metals, DA = Dental Alloy, PM = Precious 

Metals, M = Mining, S = Soil, 

E = Exploration, IP = Industrial Paint, T = Thin Sample, P = Plastic

Reported results are based on measurement results that have been reduced to 2 significant 

digits by rounding up.  For example, a measurement result of 1441 would be reported 

as 1500.

Notes:

In beam dose rates were measured using thermoluminescent dosimeters (TLDs) or Opti-

cally Stimulated Luminescent Dosimeters (OSL). 

In Beam Measurements - Dose Rates in mSv/hr 

* GM = General Metals, EM = Electronics Metals, DA = Dental Alloy, PM = Precious 

Metals, M = Mining, S = Soil, 

E = Exploration, IP = Industrial Paint, T = Thin Sample, P = Plastic 

Reported results are based on measurement results that have been reduced to 2 significant 

digits by rounding up.  For example, a measurement result of 1441 would be reported 

as 1500.

Table 1-6 Niton XL3t Radiation Profile - In Beam Measurements - Rem/hr

kV uA Range
Contact 

Deep

Contact 

Shallow

5cm 

Deep

30 cm 

Shallow

50 40

EM, GM, S, T, IP, PM, DA, M, E, P (Main 

Filter)

S, T, M, E (High Filter)

110 410 8.4 1.3

20 100 S, P, T, M, E (Low Filter) 150 3200 0.52 0.05

15 100 IP, EM (Low Filter) 14.0 1100 0.43 0.042

Table 1-7 Niton XL3t Radiation Profile - In Beam Measurements - mSv/hr

kV uA Range
Contact 

Deep

Contact 

Shallow

5cm 

Deep

30cm 

Shallow

50 40

EM, GM, S, T, IP, PM, DA, M, E, P (Main 

Filter)

S, T, M, E (High Filter)

1100 4,100 84.0 13

20 100 S, P, T, M, E (Low Filter) 1500 32000 5.2 0.50

15 100 IP, EM (Low Filter) 140 11000 4.3 0.42
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Niton XL3t GOLDD Plus Radiation Profile

Notes:

*SAMPLE TYPES (MODES)

GM=General Metals, M=Mining, EM=Electronics Metals, S=Soils, PM=Precious Metals, 

IP=Industrial Paint (Action lead Paint & Quantify lead Paint), MC=Metal Coatings, 

PP=Painted Products, P=Plastics, TG=Test All Geo (soil and mining), TA=Test All 

(consumer products), T=Thin

Reported results are based on measurement results that have been reduced to 2 significant 

digits by rounding up.  For example, a measurement result of 1441 would be reported 

as 1500.

Notes:

*SAMPLE TYPES (MODES)

GM=General Metals, M=Mining, EM=Electronics Metals, S=Soils, PM=Precious Metals, 

IP=Industrial Paint (Action lead Paint & Quantify lead Paint), MC=Metal Coatings, 

PP=Painted Products, P=Plastics, TG=Test All Geo (soil and mining), TA=Test All 

(consumer products), T=Thin

Reported results are based on measurement results that have been reduced to 2 significant 

digits by rounding up.  For example, a measurement result of 1441 would be reported 

as 1500.

Table 1-8 - Niton XL3t GOLDD Plus Radiation Profile - In Beam Measurements - mSv/hr

kV uA Range
Contact 

Deep

Contact 

Shallow

5cm 

Deep

30cm 

Deep

50 40
EM, MC, P, TA, PP (Main) M, S, T 

(High)
440 1300 74 5.3

50 40 GM, PM, M, S, IP (Main) 1500 3800 360 22

20 100 EM, P, TA, M, S, T (Low) 690 19000 190 9.2

15 133.3 GM (Low) 240 13000 50 2.3

8 200 GM, P, M (Light) 0.30 17000 0.10 <0.003

Table 1-9 - Niton XL3t GOLDD Plus Radiation Profile - In Beam Measurements - Rem/hr

kV uA Range
Contact 

Deep

Contact 

Shallow

5cm 

Deep

30cm 

Deep

50 40
EM, MC, P, TA, PP (Main) M, S, T 

(High)
44 130 7.4 0.53

50 40 GM, PM, M, S, IP (Main) 150 380 36 2.2

20 100 EM, P, TA, M, S, T (Low) 69 1900 19 0.92

15 133.3 GM (Low) 24 1300 5.0 0.23

8 200 GM, P, M (Light) 0.030 1700 0.010 <0.0003
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Table 1-10 - Niton XL3t GOLDD Plus Radiation Profile - Scatter Measurements - mRem/hr

kV uA Range Substrate Max @ 5cm
Max @ 30 

cm

Max @ 

Trigger

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Steel 0.14 <0.01 <0.01

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Aluminum 2 <0.01 <0.01

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Soil 2 0.04 <0.01

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Plastic 10 0.45 6

50 40
GM, PM, M, S, IP 

(Main)
Steel 0.3 <0.01 <0.01

50 40
GM, PM, M, S, IP 

(Main)
Aluminum 4 0.01 0.01

50 40
GM, PM, M, S, IP 

(Main)
Soil 4 0.09 <0.01

20 100
EM, P, TA, M, S, T 

(Low)
Soil <0.01 <0.01 <0.01

20 100
EM, P, TA, M, S, T 

(Low)
Plastic 0.07 <0.01 <0.01

15 133.3 GM (Low) Steel <0.01 <0.01 <0.01



2 Using Your Analyzer
Niton XL3t GOLDD Plus Radiation Profile

18 Niton XL3 Analyzer User’s Guide Thermo Scientific

Notes:

*SAMPLE TYPES (MODES)

GM=General Metals, M=Mining, EM=Electronics Metals, S=Soils, PM=Precious Metals, 

IP=Industrial Paint (Action lead Paint & Quantify lead Paint), MC=Metal Coatings, 

PP=Painted Products, P=Plastics, TG=Test All Geo (soil and mining), TA=Test All 

(consumer products), T=Thin

15 133.3 GM (Low) Aluminum <0.01 <0.01 <0.01

8 200 GM, P, M (Light)

<0.01 (no 

detectable 

scatter 

radiation) at 

any location 

for steel, 

aluminum, 

soil, or plastic 

sample types

Table 1-10 - Niton XL3t GOLDD Plus Radiation Profile - Scatter Measurements - mRem/hr

Table 1-11 - Niton XL3t GOLDD Plus Radiation Profile - Scatter Measurements - µSv/hr

kV uA Range Substrate Max @ 5cm
Max @ 30 

cm

Max @ 

Trigger

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Steel 1.4 <0.1 <0.1

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Aluminum 20 <0.1 <0.1

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Soil 20 0.4 <0.1

50 40

EM, MC, P, TA, PP 

(Main) M, S, T 

(High)

Plastic 100 4.5 60

50 40
GM, PM, M, S, IP 

(Main)
Steel 3 <0.1 <0.1

50 40
GM, PM, M, S, IP 

(Main)
Aluminum 40 0.1 0.1
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Note  *SAMPLE TYPES (MODES)
GM=General Metals, M=Mining, EM=Electronics Metals, S=Soils, PM=Precious Metals, 

IP=Industrial Paint (Action lead Paint & Quantify lead Paint), MC=Metal Coatings, 

PP=Painted Products, P=Plastics, TG=Test All Geo (soil and mining), TA=Test All 

(consumer products), T=Thin

50 40
GM, PM, M, S, IP 

(Main)
Soil 40 0.9 <0.1

20 100
EM, P, TA, M, S, T 

(Low)
Soil <0.1 <0.1 <0.1

20 100
EM, P, TA, M, S, T 

(Low)
Plastic 0.7 <0.1 <0.1

15 133.3 GM (Low) Steel <0.1 <0.1 <0.1

15 133.3 GM (Low) Aluminum <0.1 <0.1 <0.1

8 200 GM, P, M (Light)

<0.1 (no 

detectable 

scatter 

radiation) at 

any location 

for steel, 

aluminum, 

soil, or plastic 

sample types

Table 1-11 - Niton XL3t GOLDD Plus Radiation Profile - Scatter Measurements - µSv/hr
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Niton XL3p Radiation Profile

Table 1-12 - Niton XL3p Radiation Profile - In Beam Measurements

Distance From Window Dose Rate (mSv/hr) Dose Rate (mrem/hr)

5 cm 0.45 45

30 cm 0.03 3.0

100 cm 0.003 0.3

Table 1-13 - Niton XL3p Radiation Profile - Scatter Measurements - mSv/hr

Location
Plastic 

Substrate

Wood 

Substrate

Soil 

Substrate

Aluminum 

Substrate

Steel 

Substrate

Max Scatter @ 5cm from 

Snout (A’)
0.06 0.03 0.018 0.01 0.0042

Max Scatter @ Trigger (B) 0.0038 0.002 0.0015 0.0048 0.0003

Table 1-14 - Niton XL3p Radiation Profile - Scatter Measurements - mRem/hr

Location
Plastic 

Substrate

Wood 

Substrate

Soil 

Substrate

Aluminum 

Substrate

Steel 

Substrate

Max Scatter @ 5cm from 

Snout (A’)
6.0 3.0 1.8 1.0 0.42

Max Scatter @ Trigger (B) 0.38 0.2 0.15 0.48 0.03
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Figure 5. Primary and Secondary Dose Locations (Not to Scale)
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Primary Radiation

Niton XL3t and XL3t GOLDD

Primary radiation is radiation that is produced by the analyzer and emitted out through the 
measurement window. Individuals should never place any part of their body in the primary 
beam path when the x-ray tube is on. There should always be a sample in contact with the 
measurement window when the x-ray tube is on. The sample will absorb most of the 
primary-beam radiation unless it is smaller than the instrument's measurement window or of 
low density and/or thickness. Caution should be taken when analyzing samples that are small, 
thin, and/or low in density as they may allow much more of the primary beam to escape. 
In-beam primary radiation dose rates are listed in Table 1-6, 1-7, 1-8, 1-9, and their location 
identified relative to the analyzer in Figure 4 as Dose Point C.

Niton XL3p

Primary radiation is radiation that is produced by the analyzer and emitted out through the 
measurement window. Individuals should never place any part of their body in the primary 
beam path when the shutter is open. There should always be a sample in contact with the 
measurement window when the shutter is open. The sample will absorb most of the 
primary-beam radiation unless it is smaller than the instrument's measurement window or of 
low density and/or thickness. Caution should be taken when analyzing samples that are small, 
thin, and/or low in density as they may allow much more of the primary beam to escape. 
In-beam primary radiation dose rates are listed in Table 1-6, 1-7, 1-8, 1-9, and their location 
identified relative to the analyzer inFigure 4 as Dose Point C.

Secondary Radiation

Under conditions of normal and proper use, individuals can be exposed to secondary (or 
"scattered") radiation. Secondary radiation is low-level radiation that emanates from the 
sample being analyzed as a result of primary beam radiation scattering in the sample or 
primary beam radiation inducing fluorescent x-rays in the sample. Dose points A, A’ and B in 
Figure 4 are examples of where you can encounter secondary radiation. The magnitude of this 
secondary radiation is sample dependent. Higher density samples such as steel will emit the 
lowest levels as they absorb most primary and secondary radiations. Lower density samples 
such as aluminum, wood, and especially plastic, will produce higher levels of secondary 
radiation. 

Niton XL3t and XL3t GOLDD

Secondary radiation dose rates are listed in Tables 1-4, 1-5, 1-10, and 1-11, for a few common 
sample types over a wide range of densities.
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Niton XL3p

Secondary radiation dose rates are listed in Tables 1-13 and 1-14 for a few common sample 
types over a wide range of densities.

Holding Samples

The operator is reminded that one should never hold samples during analysis, doing so will 
result in higher than necessary exposure to secondary radiation and could expose the operator 
directly to the much higher primary-beam dose rates.

Deep and Shallow Dose

You will find in the tables that shallow dose rates are listed for some dose points. All dose rates 
listed in the In-Beam Primary Radiation Tables are deep dose unless they are specifically 
identified as shallow dose. Deep dose is dose from penetrating radiation that is delivered to 
both skin and underlying tissues and organs and is the type most commonly referred to when 
describing external radiation hazards. Occupational deep dose is limited to a maximum of 5 
rem (50 mSv) per year in the United States and most countries internationally. Deep dose is 
measured at 1.0 cm below the skin surface.

Shallow dose is often referred to as "skin dose" because it is a result of low penetrating 
radiation that only interacts with the skin. Shallow dose is limited to a maximum of 50 rem 
(500 mSv) per year in the United States and most countries internationally. Shallow dose is 
listed for primary in-beam dose points only because the low penetrating radiation that causes 
shallow dose is nearly all absorbed by a sample and does not produce any significant secondary 
radiation. Shallow dose is measured at a point 0.007 cm below the surface.

Proper and Improper Operation

Storage and Transportation

Storage

Regulations in nearly all locations will require that you store your analyzer locked in a secured 
area to prevent access, use, and/or removal by unauthorized individuals. Storage requirements 
will vary by location, particularly with regard to storage at temporary job sites or away from 
your primary storage location such as hotels and motels and in vehicles. You should contact 
your local Radiation Control Authority to identify the specific storage requirements in your 
jurisdiction.
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Transportation

Niton XL3t and XL3t GOLDD

There are no X-ray tube specific US Department of Transportation (DOT) or International 
Air Transport Association (IATA) radiation regulations regarding shipping the Niton XL3t 
analyzer. It is recommended that you ship the analyzert in its carrying case and an over-pack 
to protect the sensitive measuring equipment inside the analyzer. Do NOT ship the analyzer 
with the battery pack connected to the analyzer.

Niton XL3p

For Thermo Fisher Scientific, Niton Analyzers (Niton Analyzers), in the United States, the 
government agency that has primary authority and regulations which apply to transportation 
is the Department of Transportation (DOT) (Code of Federal Regulations 49 Parts 100 to 
185).

In addition, the EPA, OSHA, and the NRC also have regulations that touch on the 
transportation of hazardous substances.

The International Air Transport Association (IATA) has recommendations that every major 
air carrier has incorporated into their policies for the air transport of hazardous substances.

The enforcement of DOTregulations is carried out by the Department of Transportation, the 
Federal Aviation Administration, the Federal Highway Administration, the Federal Railroad 
Administration, the Coast Guard, and Customs and Border Protection. State agencies may 
also enforce state DOT regulations.

The major aspects of the regulations include:

• "training to recognize hazards and how to safely deal with hazardous substances,

• "classification and identification of packages to inform of hazards, 

• "protective packaging to safely transport hazardous materials,

• "hazard communication to inform personnel of hazards in a package,

and

• "incident reporting to inform regulators of incidents.

As part of shipping hazardous substances, you should be trained in:

• "a general awareness and a familiarity with the general provisions of the DOT and hazardous 
materials regulations,

• "training that is function specific and be applicable to the daily work performed,

• "the recognition and identification of hazardous substances,
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• "the specific requirements for functions performed,

• "security measures to keep a package secure.

• "safety issues as related to safe handling and hazard communication.

• "knowledge of emergency response information, self-protective procedures, and accident 
prevention procedures.

Employers are responsible for providing the proper training (every three years for DOT) to 
employees, testing employee knowledge, and record keeping.

The DOT Hazardous Material Regulations set the criteria for determining the hazard class 
and the proper shipping name for hazardous materials. The Hazard Classes as follows:

Class

1. Explosives

2. Gases

3. Flammable and Combustible Liquids

4. Flammable solids, combustible materials, and dangerous when wet materials

5. Oxidizers and organic peroxides

6. Toxic materials and infectious substances 

7. Radioactive Materials

8. Corrosive Materials

9. Miscellaneous dangerous goods

Niton analyzers with radioisotopes are Hazard Class 7. The Hazard Class of the material being 
transported tells you which Parts of the regulations are required.

A UN number is assigned to each type of hazardous material. It is the letters "UN" followed 
by a four digit numerical code, which allows emergency responders to identify the chemical 
being shipped. The UN number for Niton analyzers is "UN 2911".

There is also an official name designation for Niton Analyzers called the Proper Shipping 
Name. The proper Shipping Name for the Niton Analyzers is "Radioactive material, excepted 
package-instruments and articles".

A reportable quantity (RQ) is listed in DOT regulations for each hazardous material (e.g., 
each radioactive isotope). If you are shipping more than the reportable quantity in a package, 
that package must be marked clear and legibly with the letters "RQ". The Niton XL3p 
analyzer contains a 30 mCi (1.11 GBq) Am-241 source and is therefore considered a 
reportable quantity requiring the RQ marking when being transported. 
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Also, the quantity of Am-241 that is used in a Model XL3p Analyzer requires a special form 
certification for transport as an excepted package. This Special Form certificate must 
accompany the instrument during shipment. Thermo Fisher Scientific will provide the 
Special Form certificate for any analyzer with Am-241.”

The type of protective packaging used is dependent on the nature of the material to be 
packaged. All packaging must be designed to prevent a release of hazardous material during 
normal transportation or storage of the material. The classification of package used for Niton 
Analyzers is designated as an "Excepted Package". Always ship the analyzer in its original 
plastic case to ensure that the packaging used meets the regulatory requirements for an 
Excepted Package.

Shipments of radioactive materials must have proper Labeling and Marking.

Niton analyzers have a Marking requirement (i.e., UN number and RQ if applicable), but not 
a Labeling requirement (i.e., diamond shaped hazmat labels), and vehicles transporting these 
analyzers are not required to have "Placards".

When reading the DOT regulations, you will find the following information useful.

Thermo Fisher Scientific, Niton Analyzers are shipped:

• "Under the proper shipping name "Radioactive material, excepted package-instruments or 
articles" in accordance with 49 CFR 173.424, 

• "with the radiation level at 10 cm from the unpacked instrument surface less than 10 
mrem/hr (0.1 mSv/hr) “
Note  A Niton Analyzer in proper condition will be less than 0.5 mrem/hr (0.005 mSv/hr) at 
10 cm, 

• "with the radiation level at the package surface less than 0.5 mrem/hr (0.005 mSv/hr)” 
Note  A Niton Analyzer in proper condition will be less than 0.05 mrem/hr (0.0005 mSv/hr) 
at the surface of the case,

• "with all radioactive sources as "solid", "sealed sources"

• "Am-241 listed in A1 column of 173.435 (270 Ci) (Special Form capsule)

• "with the package design meeting the requirements of 173.410

• "package marked with "UN2911"

• "with the Am-241 source, the package is marked with "RQ"

• "meeting the 173.424 criteria for labeling and marking requirements

For any shipment: Include in the package a current copy of the instrument Leak Test.

Include a list of emergency numbers in the package.

For Am-241, include the Special Form Certificate in the package.



 2 Using Your Analyzer
Proper and Improper Operation

Thermo Scientific Niton XL3 Analyzer User’s Guide 27

Always ship in supplied plastic case, with the case secured against accidental opening. Always 
ship with the battery disconnected.

When shipping by air: Ship with the proper IATA marking (See IATA Dangerous Goods 
regulations Figure 10.7.8.A), UN 2911, and proper shipping name.

"RQ" marking and "dangerous goods declaration" are required.

When shipping by Ground: Ship under proper marking "UN2911"

"RQ" marking and shipping papers are required (Note: a dangerous goods declaration form 
can be used to meet the shipping paper requirement).

A "Dangerous Goods Declaration" can be obtained by the air carrier that you will be using. 
Instructions can also be obtained from the same source.

Carefully follow the directions given by the air carrier. Several typed copies will be required.

Shipping papers contain all of the same information as a Dangerous Goods Declaration, but 
do not have a specified format for that information.

At a minimum, a properly prepared shipping paper clearly identifies the hazardous substance 
by its proper shipping name, hazard class and division, UN identification number, packing 
group (if applicable), and total quantity. It also has consigner information, consignee 
information, and a shipper's declaration that the package is in compliance with the DOT 
regulations.

The elements of hazard warning information are communicated through shipping 
documents, packaging markings, and written emergency response information.

The DOT & FAA Hazardous Materials Regulations require the carrier to report all incidents 
involving hazardous materials. 

An "incident" involves the unintended release of hazardous materials (Am-241), suspected 
radioactive contamination, if the general public is evacuated for an hour or more, or the flight 
pattern or routine of an aircraft is altered.

For any "incident", contact the Company Radiation Safety Officer or Responsible Party and 
the state radiation control program. 

Any "incident" needs to reported to the:

Hazardous Materials Information Center

1-800-467-4922

Mon-Fri 9AM-5PM Eastern
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Leak Tests (Niton XL3p Only)

The Niton XL3p Series analyzer contains a radioactive source that must be periodically leak 
tested. The purpose of leak testing is to verify the integrity of the source encapsulation. A leak 
test sample is obtained by wiping exterior surfaces of the device with moderate pressure using 
a cotton swab, filter paper, or whichever wiping media is supplied by the analysis laboratory. 
Leak test samples are then typically analyzed at a laboratory, although some device users have 
the equipment and licensed authority to perform this analysis

Unless specified otherwise by your local authority or radioactive material license, the gauge 
must be leak tested at intervals not to exceed 6 months. In the US, leak test samples may be 
acquired by any end-user, however the analysis of the sample must be performed by an 
organization licensed to do so. If you are using a vendor to perform the laboratory analysis of 
the leak test sample, they will send you a leak test kit which comes with complete instructions 
for performing the test. These vendors will also typically send you a reminder when it is time 
to perform the next leak test on your instrument. Please follow the test kit instructions 
carefully, and promptly mail the test samples to the laboratory. They will send you a leak test 
certificate soon after. Keep one copy of the leak test certificate with the device at all times (i.e., 
in the case) and another copy safely on file.

Figure 6. Wipe Test Locations
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CAUTION  REMOVE THE BATTERY WHILE PERFORMING A WIPE TEST TO BE 
SURE THAT THE SHUTTERS ARE NOT OPEN DURING THIS PROCEDURE!

Lost or Stolen Instrument

THIS PAGE CONTAINS EMERGENCY CONTACT INFORMATION THAT 
SHOULD BE AVAILABLE TO THE OPERATOR AT ALL TIMES.

If the Niton XL3t analyzer is lost or stolen, notify your Radiation Safety Officer (RSO) or the 
equivalent responsible individual at your company or institution immediately. Your 
company's RSO, as well as other important emergency contacts, are listed below. Your 
company RSO may need to notify the x-ray tube regulatory authority and the local police. It 
is also recommended that a notification is made to Thermo Fisher Scientific.

Damaged Instrument

Minor Damage

If the instrument is intact but there is indication of an unsafe condition such as a cracked case, 
a shutter mechanism failure, or the lights remain flashing after a measurement is terminated, 
follow these steps:

1. Stop using the instrument

2. Remove the battery. The x-ray tube can not produce radiation when the battery is 
disconnected. The instrument is now safe to handle.

3. Place the instrument securely in the holster.

4. Place the instrument in the carrying case that came with the instrument.

5. Notify your Radiation Safety Officer (RSO) or the equivalent responsible individual at 
your company or institution immediately.

6. You or your RSO should call Thermo Fisher Scientific at one of their contact numbers 
listed below for additional instructions and guidance.

Major Damage

If the instrument is severely damaged:

1. Perform the same steps as described above for minor damage. There will be no radiation 
hazard as long as the battery is removed from the instrument.

2. Place all components in a plastic bag and contact Thermo Fisher Scientific.
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Emergency Response Information

Please Complete the Following Emergency Response Information and Keep with the Analyzer 
at All Times

NITON ANALYZER EMERGENCY CONTACT INFORMATION

The Company RSO is:______________________________________

RSO Telephone Number:____________________________________

Regulatory Agency Emergency Number:________________________

Local Fire Department:______________________________________

Local or State Police Department:_____________________________

Thermo Fisher Scientific's Niton Analyzer Contact Numbers

Main Number (USA): (800) 875-1578

Additional Radiation Emergency #'s: (978) 790-8269 or (617) 901-3125

Outside the USA - Local Niton Service Center:___________________

Europe

Niton Analyzers Europe

Munich, Germany

Phone: +49 89 3681 380

Fax: +49 89 3681 3830

Email: niton.eur@thermofisher.com

Asia

Niton Analyzers Asia

Hong Kong

Phone: +852 2869-6669

Fax: +852 2869-6665

Email: niton.asia@thermofisher.com

Registration and Licensing
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As a user of a Niton XL3 analyzer, you may be required to register or obtain a license with 
your local radiation control authority. In the US, if you intend to do work with your analyzer 
in states other than your own, you may be required to register there as well. See the Safety and 
Compliance Web Hub for much more information.

Regarding Safety Devices for the Open Beam Configuration:

In the US, you may be required to file for an exemption, "variance letter", with your state if 
there is a requirement for a safety device that would prevent entry of an extremity into the 
primary beam. If you need assistance with the exemption letter, you may contact the radiation 
safety group.

Registration and Licensing FAQ
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Startup Procedure

Unpacking and Preparing Your Niton XRF Analyzer
WARNING  The nose of the analyzer should not be touched during sample testing and 
calibration. If an ESD event occurs during measurement, the instrument may terminate the 
testing in progress and automatically reset to Log On screen. Any test data collected prior to 
reset will be lost and the testing may have to be repeated.

Figure 7. Populated Analyzer Case

• Inspect the shipping carton for signs of damage such as crushed or water damaged 
packaging. Immediately notify the shipping company and Thermo Fisher Scientific, in 
the United States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460, if there is any visible damage to the shipping container or any of its 
contents.

• Open the packing carton. If your analyzer is not packed in its carrying case, please call 
Thermo Fisher Scientific immediately, in the United States, toll free, at (800) 875-1578, 
or outside the United States, at +1-978-670-7460.

• Verify the contents of the shipping container against the enclosed packing list. If there are 
any discrepancies between the actual contents of the shipping container and the enclosed 
packing list, please notify Thermo Fisher Scientific immediately, in the United States, toll 
free, at (800) 875-1578, or outside the United States, at +1-978-670-7460.

• Open the carrying case and visually inspect the analyzer for damage before removing it 
from the case. Contact the freight carrier and Thermo Fisher Scientific if you find any 
damage to the case or its contents.
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• Save the shipping carton and all packing materials. Store them in a safe, dry area for reuse 
the next time that you ship the analyzer.

Figure 8. The Thermo Scientific Niton XL3 Analyzer Overview

Battery Installation and Charging

Installing or Replacing The Battery Pack

1. Slide back the catch on the bottom of your analyzer’s pistol grip and drop the battery out 
into your hand.

2. Place the old battery aside and slide the new battery up into the cavity in the bottom of 
the pistol grip. The battery is keyed, and will only insert fully one way.
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Figure 9. Rear and Side of Battery Pack Showing Key
CAUTION  Do not force the battery into the cavity!

3. Press in until the latch resets.

Recharging The Battery Pack

Fully recharging a battery pack takes approximately 2 hours.

1. Remove the battery pack from the analyzer.

2. Place the battery pack upside down into the charger. The battery pack is keyed, and will 
only fit into the charger fully one way. If your battery pack is resting on the back of the 
back of the charger rather than sliding all the way to the bottom, remove the battery pack, 
turn it around, and re-insert it into the charger.

CAUTION  Do not force the battery into the charger!

3. The red light is on when the charger is plugged in. This is the power indicator light.
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Figure 10. Power On

4. The yellow light indicates that the battery pack is currently being charged.

Figure 11. Charging

5. The green light indicates that the battery pack has finished charging and is ready for use.
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Figure 12. Charge Completed
Note  If there is a fully seated battery pack in the charger and only the red light is on, there is 
a fault with the battery pack or charger.
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Figure 13. Battery Pack in the Charger
CAUTION  Do not store battery packs or charger in direct sunlight.
CAUTION  Do not let the battery pack recharge for excessive periods of time.
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The Control Panel

The control panel is located on the analyzer’s top housing, directly below the Touch Screen. 
The control panel consists of a 4 Way Touch Pad, an Interlock Button, and two Control 
Buttons, one on each side. Using either the control panel or the touch screen you may 
navigate through all of the analyzer’s screens and menus. You can control the movement of the 
screen cursor by pressing the 4 Way Touch Pad in one of four directions to highlight each of 
the menu options. The Clear/Enter button to the right of the 4 Way Touch Pad is used to 
select highlighted menu options. The On/Off/Escape Button both controls the power to the 
analyzer and serves as an "escape" button. When the On/Off/Escape Button is pushed and 
immediately released, it functions as an "escape", and brings you back to the Main Menu 
from the current screen in the menu system.

Figure 14. The Control Panel

To turn your analyzer on, push and hold the On/Off/Escape Button until the Touch Screen 
comes on. To turn off your analyzer, push the On/Off/Escape Button and hold it down until 
the Touch Screen shuts off.
CAUTION  If for any reason your analyzer does not shut off normally, removing the battery 
will shut it down safely.

You also have the option of operating the analyzer, including navigating the menu system, by 
using the built in Touch Screen. To select a menu option, tap on the icon once. The touch 
screen icons have the same functionality as the 4 Way Touch Pad, the On/Off/Escape Button, 
and the Enter Button. This User's Guide will refer to the process of choosing a course of 
action by selecting an icon from a menu, either using the Touch Screen or using the control 
panel buttons, as “selecting.”

Selecting the Return Icon works everywhere throughout the User Interface to bring you back 
to the previous menu from the current menu in the menu system. Use the On/off/escape 
button to return to the Main Menu.
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The LCD Touch Screen

The LCD Touch Screen on your Niton XL3 Analyzer is designed to swing up and down to 
different angles for ease in viewing and interacting with your analyzer. The LCD Touch 
Screen is connected to your analyzer along the base of the screen, right above the Control 
panel. The screen is not designed to separate from the analyzer, but can be adjusted to any 
arbitrary angle between zero degrees - that is, flush with the analyzer - and 85 degrees, which 
is almost perpendicular. The LCD Touch Screen will stay at any given angle between these 
extremes until moved to a different angle. When in closed position, the screen is secured by a 
catch at the top center of the screen housing.

Figure 15. Niton XL3 Analyzer Showing LCD Screen Tilted.

To raise the LCD Touch Screen, disengage the catch at the top-center of the LCD Touch 
Screen housing and gently pull the screen towards you until it is at the best angle for your use. 
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To close the LCD Touch Screen, gently push away from you along the top edge of the screen 
housing. The screen will swing down until the catch solidly engages with an audible click.
Note  The LCD Touch Screen cannot be removed from your Niton XL3 analyzer. Removing 
or attempting to remove the LCD Touch Screen will damage your analyzer and void your 
warranty.
Note  Always close your LCD Touch Screen before storing or transporting your Niton XL3 
analyzer.

Startup Procedure

To turn on the analyzer, depress the On/off/escape button on the control panel until the 
Touch Screen comes on.

On startup, the screen will show by a Start Screen which will automatically count down from 
4 to 0 in increments of one second.

Figure 16. Logon Screen

When the startup is complete, the Start Screen will be replaced by the Logon Screen (see 
Figure 15). Tap anywhere on this screen to continue.

The Logon Screen will be replaced by a Warning Screen, see Figure 16, advising you that this 
analyzer produces radiation when the lights are flashing. You must acknowledge this warning 
by selecting the Yes button before logging on. Selecting the No button will return you to the 
Logon Screen.
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Figure 17. Warning Screen

After selecting the Yes button, the Virtual Numeric Keypad becomes available for you to log 
onto the analyzer.

Figure 18. Virtual Numeric Keypad
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Select your 4 digit security code, followed by the Enter button. The default password is 
1-2-3-4, followed by the Enter button. If you enter an incorrect number, you can use the 
Backspace button to backspace over it, or use the Clear button to clear the field. After you 
have completed the log on procedure, the word "USER" will appear on the bottom of the 
screen, then the Main Menu will appear. Note that security codes are editable. Please see 
Passwords and User Privileges for instructions on creating user-definable passwords.

Check the date/time. The time should be set correctly for accurate and verifiable record 
keeping (Setting the Date and Time).
Note  Your analyzer can be stored and operated safely in temperatures from minus 5º C (23º 
F) to 50º C (122º F). You will not be able to take a measurement if the analyzer overheats. If 
it is hot to the touch, you should allow it to cool before testing.

Performing a System Check

Figure 19. System Check Menu Path

Select the System Check Icon on the Main Menu to perform a system check. Thermo 
Scientific recommends that you perform a system check once every working day, as part of 
your normal startup procedure, after allowing a minute or so for the analyzer to warm up.
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Figure 20. System Check in Progress

While performing the system check, your screen will show a progress bar indicating the 
progress of the check. When it is done, the screen will show a 100% completion as in Figure 
20 below.

Figure 21. System Check Completed
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If you see any result other than "System OK", perform another system check. If the result is 
still not "System OK", please notify Thermo Scientific Service at 800-875-1578.
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Calibrating the Touch Screen

Figure 22. Touch Screen Calibration Menu Path
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Select the Calibrate Touch Screen icon to re-calibrate the analyzer's touch screen display. This 
procedure establishes the display boundaries for the touch screen interface.

1. Select the Touch Screen icon.

2. The display will show a message asking you to confirm whether or not you want to 
calibrate your Touch Screen. Select the Yes button.

3. The display will show the message: "Calibrate Touch Screen". There will be a small cross 
in the upper left-hand corner of the display.

4. Tap on this cross with the stylus, and the cross will disappear and reappear in the upper 
right-hand corner of the screen.

5. Tap on the cross again, and it will reappear in the lower right-hand corner of the screen.

6. Tap on the cross again and it will reappear in the lower left-hand corner of the screen.

7. Tap on the cross once more, and you will be presented with a Confirmation Screen.

8. Select the Yes Button to confirm that the parameters are good. Select the No Button to 
start the process again.

9. Once you have confirmed the parameters, the System Menu will be displayed. The screen 
is now calibrated.

Figure 23. The System Menu
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Calibrating the Touch Screen Without Using the Touch Screen

If the touch screen becomes misaligned, you may need to use the buttons below the screen to 
complete this process. There are 2 single buttons and a 4 way switch located to the rear of the 
display screen. The button at the left is the On/Off/Escape button. The button to the right is 
the Enter button and the center keypad is a 4 Way Touch Pad.

The 4 Way Touch Pad has 4 positions, Up, Down, Left and Right. The Interlock Button is 
not used in this procedure.

Figure 24. The Control Buttons for the Niton XL3 

1. Please, turn on your XRF analyzer using the On/Off button.
Note  From this point please DO NOT touch the touch screen.

2. Press the Enter button. You are now at the Radiation Warning screen.

3. Using the 4 way touch pad on the on the cover of the instrument, move the cursor around 
the screen by pressing the appropriate up, down, left, or right button. Please move the 
cursor such that the "Yes" option is highlighted in green.

4. Press the Enter button. You are now at the Enter Password Screen.

5. Move the cursor on the Virtual Numeric Keypad using the 4-way Touch Pad to the 
appropriate first number in your password. Press the Enter button on the right - it has the 
arrow/enter key symbol on it. The first number of your password should appear in the 
lower left of the screen.

6. Repeat step 5 until you have entered the entire password. Then move the cursor to the 
Enter Key on the Virtual Numeric Keypad and press the Enter button to enter it.
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7. You will now be at the Main Menu.

8. Again using the 4 Way Touch Pad, move the cursor to highlight the System icon, and 
press the Enter button to select it.

9. You will now be at the System Menu.

10. From the System Menu screen, move the cursor to highlight the Touch Screen icon and 
press the Enter button.

11. Now move the cursor to highlight the Yes Button and press the Enter button.

12. You are now at the Touch Screen Calibration screen.
Note  You must now use the touch screen for the balance of this procedure

13. In the upper left hand corner you will see a crosshair - like this: “+”. Using the stylus or a 
pen, tap the center of the “+”.

14. Repeat this for each “+” sign that appears, there should be one for each of the 4 corners.

15. Select the Yes Button to confirm that the parameters are good. Select the No Button to 
start the process again.

16. Once you have confirmed the parameters, the System Menu will be displayed. The screen 
is now calibrated.

Your touch screen should work properly after this and you may use normally it from this point 
forward. If it does not, please repeat the process.
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The Data Ports

Figure 25. The Data Ports

USB Port

The USB Port is a communications and control port, for uploading and downloading data, 
configuration files, and software to the analyzer.

Remote Trigger Port

The Remote Trigger Port controls the analyzer’s trigger function, for use with accessories and 
test stands.

Serial Port

The Serial Port is a communications and control port, for uploading and downloading data, 
configuration files, and software to the analyzer.

Power Port

The Power Port is used to run the analyzer under external power.
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Using the Navigation (NAV) Menu

The NAV Menu enables you to move between various menus and screens directly, without 
going through the intervening screens. Select a destination from the drop down menu and 
you will be brought directly to that menu or screen.

Figure 26. Accessing the NAV Menu

Using the Tools Menu

The Tools Menu enables you to perform common data-related tasks such as printing and 
averaging readings. Select a task from the menu to initiate that task. The options available can 
vary depending on the selected mode.
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Figure 27. The Tools Menu Path (Main)

The Tools Menu can be accessed in two ways, and the options are different depending on the 
way you access it. The main Tools Menu is accessed by selecting the Analyze Icon from the 
Main Menu, then selecting the Tools button from the slide down window on the Ready to 
Analyze screen.
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Figure 28. The Tools Menu Path (Alt)

The alternate Tools Menu can be accessed by selecting the Data Icon from the Main Menu, 
selecting the View Data Icon from the Data Menu, then selecting the drop down Tools Menu 
from the View Data screen. It can also be accessed from the Analysis Screen, after the reading 
is saved.

Toggling Buttons and Options

Most of the buttons and options on the Tools Menu are toggles. These buttons and options 
on the Tools Menu change to their opposites when selected. To stop averaging, for example, 
select Stop Avg Fwd or Stop Avg Back from the Tools Menu as appropriate.
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Tools Menu Options (Mode Dependent)

Averaging Results

You will find the two types of result averaging here: Avg Forward

Spectra: On/Spectra: Off

You will find how to use Live Spectra here: Spectrum:On/Spectrum:Off

Alloy Pass-Fail

You will find how to use Alloy Pass/Fail here: Set Pass/Faill

Editing and Switching Alloy Libraries

You will find how to use Alloy Libraries here: Switch Library (Main)

Enable/Disable Al

You will find how to use the Enable/Diable Al option here: Enable/Disable Al

Light Element Correction

You will find how to use Light Element Correction (LEC) here: Enable LEC/Disable LEC

Coatings Method

You will find how to use Coatings Method here: Coatings Method

Thickness Correction

You will find how to use Thickness Correction here: Thickness Correction

Enable Paint

You will find how to use Enable Paint here: Enable/Disable Paint

Action Level

You will find how to use Action Level here: Action Level

Print Data

You will find how to use Print Data here: Print Data
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Element Ranges

You will find how to use Element Ranges here: Adjusting the Element Range

Toggle He

You will find how to use Toggle He here: Enable/Disable Al

Toggle Spot

You will find how to use Small Spot here: Calibrating the Spot
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Setting the Date and Time

Figure 29. The Date and Time Menu Path

From the System Menu, select the Date & Time icon to set the date and time as needed for 
different time zones, daylight savings time, or any other reason. The date and time are factory 
preset prior to shipping. The clock is a 24 hour clock, so add 12 to PM hours - i.e. 1:13 PM 
would be 13:13.
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Figure 30. Setting the Date & Time

When the Date & Time icon is selected, the Date & Time Screen comes up on your analyzer’s 
LCD Screen. You may change the Month, Year, Date, Hour, and Minute on your analyzer.

Changing the Month

To change the month, select the downward pointing triangle button next to the month 
displayed. A drop down menu will appear, listing the months of the year in order of 
appearance.

Figure 31. Month Drop Down Menu
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Select the month you want from the drop down menu, using the vertical slider button to 
display hidden months. The display will change to show the month you selected.

Changing the Year

To change the year, select the downward pointing triangle button next to the year displayed. A 
drop down menu will appear, listing the years in order of appearance.

Figure 32. Changing the Year

Select the year you want from the drop down menu, using the vertical slider button to display 
hidden years. The display will change to show the year you selected.

Changing the Date

To change the date, select the date you want from the Date Selection Screen. The date you 
selected will be highlighted in red, while the old date will be shown in red numbers.
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Figure 33. Selecting the Date

Changing the Hour and Minute

To change the hour, select the hour numbers. The hour numbers will be highlighted in gray. 
Then select the Upwards Pointing Chevron Button to increment (increase) the hour, or the 
Downward Pointing Chevron Button to decrement (decrease) the hour.

Figure 34. Changing the Hour
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To change the minute, select the minute numbers. The minute numbers will be highlighted in 
gray. Then select the Upwards Pointing Chevron Button to increment (increase) the minute, 
or the Downward Pointing Chevron Button to decrement (decrease) the minute.

Figure 35. Changing the Minute

Saving Your Changes

To save your changes, select the "Save" screen Button. The display will return to the previous 
screen and the Date and Time will be saved.

Exiting Without Saving

To exit the screen without saving changes, select the "Cancel" Screen Button. The display will 
return to the previous screen and the Date and Time will not be saved.
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Data Entry

Figure 36. The Data Entry Menu Path

The Data Entry Menu can be accessed from the Ready to Test Screen, then selecting the Data 
Entry button from the slide down window on the Ready to Test screen. The Data Entry 
Menu is composed of several data fields with associated buttons. How many and exactly 
which fields are displayed depends on the Mode the analyzer is currently in.

Entering data into these fields enables you to keep track of details about the reading, for use in 
later analysis and enhancing the defensibility of the readings.
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Figure 37. The Data Entry Menu Buttons

The Data Entry Menu Buttons

The Data Entry Menu Buttons each enable you to enter data into the fields in different ways.

Field Name

The Field Name is the designation of the type of data to be entered into the field. Selecting 
the Field Name enables you to enter data into that field.

Virtual Keyboard Button

Selecting the Virtual Keyboard Button will bring up the Virtual Keyboard, which you can use 
to type data into the field.

Drop Down Menu Arrow

Selecting the Drop Down Menu Arrow enables you to select data from a list you have 
previously entered into the analyzer.
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Data Field

Your data will appear in the Data Field.

Back Button

Selecting the Back Button will return you to the Main Menu.

Show Button

Selecting the Show Button will bring the slide down window up into view for access to the 
Tools Button or Info Button.

The Results Screen

Your analyzer will display the Results Screen throughout the duration of each reading. The 
Results Screen is updated regularly throughout the reading. When the reading is complete, a 
final screen update will appear, and your analyzer will display the final results of the 
measurement which has just been completed.

Figure 38. The Results Screen

The Results Screen displays the following information:

The Reading Number shows a number sequentially assigned by your analyzer in order to 
uniquely identify each reading. The reading number automatically increments with each 
successive reading.
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The Nominal Seconds Test Duration line shows the number of nominal (source) seconds 
elapsing since the initiation of the reading. Nominal seconds are instrument time designed to 
compensate for the electronic dead-time that may occur when your analyzer is taking a 
measurement, and therefore tend to be a bit slower than real time. 

The Mode displays the test mode in use during the measurement.

The Match/No Match line indicates whether your analyzer has found a matching alloy in it's 
library for the sample you have measured, and displays the name(s) of any matching alloys 
and the Match Number (chi squared deviation).

The Element (left) column shows the elements that have been detected in the sample. 

The Concentration Level (central) column shows the concentration levels of the 
corresponding elements in percentages.

The Confidence (right) column displays the 2 sigma (95%) confidence interval for the 
corresponding elements.

If there are too many elements detected to fit onto a single screen, you can see the balance of 
the elements and their results (as in figure 3-16) by pressing the down arrow of the 4-way 
touch pad. To see previous results, use the left arrow of the 4-way touch pad. To go forward to 
later readings, use the right arrow of the 4-way touch pad.

Match Number

The Match Number is a rating of confidence in the identification of the alloy. The Match 
number ranges from 0.0 to 10.0, with 0.0 being a perfect match. Any number greater than 
4.0 gives a result of No Match by default, although you can change this match threshold. Any 
number less than 2.0 is considered a Good Match, and can usually be brought closer to 0.0 
with longer testing times. Numbers between 2.0 and 3.0 can be considered Probable Matches, 
and numbers between 3.0 and 4.0 as Possible Matches, often having one or more elements out 
of spec.
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How to Analyze

This section contains all the Standard Operating Procedures (SOPs) we have developed to 
serve as frameworks for you to build your own SOPs, tailored to your unique requirements. 
You can also use these SOPs as is if they suit your needs. We have also included the US EPA's 
Method 6200 for soil testing. Electronics Metals and Plastics analysis use the same SOP as 
that established for Consumer Goods analysis, so the links for those analysis types will redirect 
there. This section also covers data management on your analyzer. 
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Metal Sample Prep

Up until recently, sample preparation was not a big worry for XRF metals analysis, as the 
LOD of the analyzer was seldom low enough for any but the most heavy contamination to be 
intrusive; but recent developments such as He-purged analysis and the GOLDD technology 
have brought analysis to a level where even light surface contamination can skew an analysis.

You should always prepare your samples before analysis, especially when using GOLDD or 
He-purged analysis, as these analyzers will see even trace amounts of contaminants. Oils from 
fingerprints and other body contact, lint, oxidation materials, and abrasive materials used in 
cleaning can all skew readings if not removed. Sample preparation is simple and not time 
consuming, and usually well worth the effort. 

The following is a list of problems that need correction before testing:

• Oxidation or Rust may produce an increase or decrease in one or more element test values 
unless we remove the rust or oxidation and expose the raw metal.

• Paint may contain several elements which need to be tested at lower levels within metal 
alloys (Ti & Zn in white paint, Fe in red paint, Cr in green paint).

• Oil, grease or lubricates may contain high levels of the following elements: lithium, 
aluminum, barium, strontium, molybdenum or calcium.

• Plated surfaces may have high levels of the following elements: zinc, chromium, nickel, or 
copper.
CAUTION  Anything on the metal surface will become part of your test results!

Sample Analysis Preparation

You need to clear the surface of your samples of any paint, plating, or any oxidation such as 
rust or verdigris before analysis. In order to accomplish this, you need the following:

• Isopropyl alcohol - not rubbing alcohol, which contains oils.

• Lint-free paper.

• Diamond paper - P/N 179-1202- cut into 1 inch/2.5 cm squares. Never re-use this paper, as 
it may transfer contaminants to the surface of the sample from previous cleanings. Depending 
on the state of the sample, several squares may be needed per sample.

• A Sample Grinder for removing deeper surface contamination. Choice of grinding wheel 
media also may be important, depending on what you are testing for. Never re-use grinding 
media, as contaminants can be transferred from sample to sample on the media itself.
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For light contamination on hard metal reference standards, remove the oxidation by 
scrubbing the dry sample lightly with the diamond paper square, using the fingers to maintain 
pressure. If the diamond paper begins to load up with material, discard it and use a fresh 
square. When the oxidation is removed, wipe the sample with lint-free paper soaked with 
isopropyl alcohol to remove any oils or dust. Let the sample dry before attempting analysis.

For soft metal reference standards, wipe the sample with lint-free paper soaked with isopropyl 
alcohol, then remove the oxidation by scrubbing the wet sample lightly with the diamond 
paper square, using the fingers to maintain pressure. If the diamond paper begins to load up 
with material, discard it and use a fresh square. When the oxidation is removed, wipe the 
sample again with lint-free paper soaked with isopropyl alcohol to remove any oils or dust. Let 
the sample dry before attempting analysis.

Oils, lint and dust can be removed by wiping the sample with lint-free paper soaked with 
isopropyl alcohol. Let the sample dry before attempting analysis.

Surface Oxidation

With the exception of a limited number of metal types, most metal alloys form an oxide 
covering on the surface when exposed to oxygen or air. This oxide covering is visible in carbon 
and low alloy steel as a red colored substance called rust. Other metal alloys form oxidation 
which is not always visible, but that does not mean that it is not present. If the test results for 
low concentration elements are higher or lower than expected, remove the oxide coating by 
grinding and retest. Follow proper safety procedures when changing discs or grinding 
materials.

During a recent case study the effects of sample preparation became apparent. A customer 
asked for low detection limits of nickel, chromium and copper in carbon steel pipe. The 
reported chemistry of the purchased material is listed on the first line in the chart below. The 
test results of a hand held XL3t 900S GOLDD instrument appears in the second line of the 
chart. The results from a test on the unground surface appear in the bottom line of the chart. 
Note the values for nickel and copper in this carbon steel alloy in the chart below. The 
oxidation on the surface of this pipe was not visibly egregious. We need to always be wary of 
the presence of even low levels of oxidation and their possible effects on analytic accuracy.

Comparative test results with and without 

grinding

Sample % Mn % Ni % Cr % Mo % Cu

Reported Chemistry 0.650 0.090 0.070 0.030 0.040

Test Results with Ground Surface 0.67 0.089 0.070 0.033 0.039

Test Results with Unground Surface 0.61 0.178 0.081 0.033 0.514
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Painted Surfaces

Paint is a mixture of several items that are combined into a liquid which is applied to the 
surface of materials such as metal. Once applied this liquid dries with time and adheres to the 
surface of metal. Paint is used to protect or decorate the metal item. Paint can also be used to 
identify or mark the metal during the manufacturing process.

Components of paint are divided into classifications of pigments, binders, solvents, additives 
and fillers. The inorganic elements in pigments will contribute to increases in displayed values 
for those elements if paint on the metal surface is not removed prior to testing. Be especially 
careful of the presence of heavy elements, which can also act to shield x-rays from lighter 
elements in the metal sample.

The following is a list of some of the most common components of paint:

White Paint 

• Antimony (Sb)

• Lead (Pb)

• Titanium (Ti)

• Zinc (Zn)

• Cobalt (Co) 

Red Paint

• Iron (Fe)

• Lead (Pb)

• Green Paint

• Chromium (Cr)

An experiment was conducted to determine the effect and severity of surface problems on 
XRF results. Results from analyses of a 1541 alloy steel sample are shown below, before and 
after surface grinding. The sample had painted markings, of light to medium thickness, on 
the surface, as well as light rust. Note the change in titanium, zinc and cobalt levels after 
surface grinding.
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Oil, Grease & Cutting Oils

Oil and grease contain a number of elements combined into a viscous substance and applied 
to moving parts in order to reduce friction. Grease coatings can remain on component 
surfaces after it has been removed from service. Grease can also be applied to a metal's surface 
by accidental contact with other materials coated in heavy grease. Metals can also be coated in 
oil as a result of cutting and machining processes in manufacturing.

Grease and oil may contain the following elements:

• Aluminum (Al)

• Zinc (Zn)

• Molybdenum (Mo)

• Sodium (Na)

• Calcium (Ca)

An experiment was performed to show how grease on metal surfaces affects XRF results. A 
carbon steel sample was cleaned and ground as a control surface for the experiment. XRF tests 
were performed on the control surface, and again after light and heavier layers of automotive 
wheel bearing grease were applied to the surface of the steel sample. Results are shown below. 
Note the elevated levels of molybdenum, cobalt and zinc from the grease.

Prepped and unprepped 

painted metal analysis

Sample Mn Ni Cr Mo Ti Zn Co

Ground Surface 1.49 0.04 0.03 0.004 0.011 0.0001 0.03

Unground Surface 1.34 0.01 0.04 0.011 2.507 1.751 0.21

Clean and greased 

sample metal analysis

Sample Mn Ni Cr Mo Cu Co Zn

Clean Surface 1.18 0.001 0.041 0.004 0.001 0.001 0.019

Light Grease 1.07 0.001 0.001 0.067 0.033 0.322 0.416

Heavy Grease 0.96 0.001 0.001 0.500 0.062 1.760 3.430
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If a sample's surface contains lubricants or cutting oil, use a solvent and a clean towel or rag to 
remove them before analysis. You may then need to grind the surface to insure good results. 
Clean first, grind second, test last. 

Remember to follow safe techniques for handling and disposing of solvents and cleaning rags

Anodized, Plated and Galvanized Surfaces

Anodizing is the process of polarizing the metal surface into a passive state which protects it 
against corrosion. This process is most often applied to aluminum alloys.

Galvanized steel is one of the most common of the coated surfaces. In this process, steel is 
passed through a molten bath of a zinc alloy. Zinc reacts with the steel metal to form a 
bonding layer on the steel surface. The zinc layer does not separate from the steel and forms a 
protective layer that protects the steel from oxidation.

Galvanized layers are relatively thick compared to other plating elements and methods. When 
grinding to remove the zinc coating, you will find increased zinc values even when you can see 
the steel surface. Grind a little further and zinc values will disappear. Zinc clings to the surface 
of the sanding disc, so you will need to frequently change discs.

Electroplating is another common practice of applying a coating which not only protects the 
surface from oxidation, but also improves the base material's wear resistance, lubricity and 
improves the overall aesthetics of the product. The electroplated coating is generally thinner 
and more evenly applied than galvanizing. Electroplating has a wide range of elements and in 
some situations there may be two or more different coatings on the same part.

The following is a partial list of elements that are used to plate the surface of base metals: 

Ni, Cr, Cadmium (Cd), Tin (Sn), Zn, Al

Cordless Right Angle Drill

This style of drill is recommended for most surface preparation in the field because it gives the 
operator the greatest amount of control, and thus safety, when grinding samples. When 
moving a sanding disc on a conventional drill over a sample, forces tend to produce 
movement the operator may find difficult to control. Control and stability are important in 
grinding from effectiveness and safety perspectives. 

A cordless right angle drill similar to the one pictured below is recommended for light to 
medium surface removal. For materials with heavy oxidation such as carbon and low alloy 
steel, an angle grinder, explained in the next section, is recommended. A kit with the drill, 
batteries and charging units, can be purchased from ThermoFisher, or companies such as 
DeWalt, Hitachi, Makita, Milwaukee or Ryobi.
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Figure 39. Example of Right Angle Drill

A disc holder is needed with the drill to hold the sanding disc. (In the US, we recommend a 
3.0 inch disc holder. It has a 0.25 inch shank to insert into the chuck of the drill.) If sanding 
discs are ordered from a local supplier, attention should be paid to the method of attaching 
the sanding disc to the disc holder. There are three types of connections: metal snap-on, 
plastic twist and plastic snap-on.
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Figure 40. Sanding Disc

Before attaching the grinder and sanding disc as pictured below, first remove the battery to 
disable the grinder. Then insert the shaft of the disc holder into the drill and securely tighten 
the chuck. Next, attach the appropriate sanding disc. The method of attachment will vary 
depending upon the type of fastener on the sanding disc (snap-on or twist connectors). 
Reinstall the battery and prepare for use.
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Figure 41. Attaching the Sanding Disc 1

Figure 1-3. Attaching the Sanding Disc 2

Cordless Angle Grinder

A cordless angle grinder similar to the one pictured below will successfully remove medium to 
heavy oxidation or paint. This grinder (which uses a 4.5 inch sanding disc with a rubber 
backup pad) which can be purchased from ThermoFisher or industrial tool manufactures like 
DeWalt, Makita or Milwaukee.
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Figure 42. Cordless Angle Grinder Kit

A grinder kit typically contains the grinder, a battery, and charging unit. If the kit contains a 
grinding stone wheel, remove and dispose of it. Grinding stones are not to be used for XRF 
sample preparation. A rubber backup pad and a retaining nut are needed to use with sanding 
discs. (See picture below).
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Figure 43. Rubber Backing Pad and Nut

In the US, sanding discs are 4.5 inch diameter and can be purchased in various grit sizes of 36 
to 120. The surface abrasive can be one of the following materials: aluminum oxide, silicon 
carbide or zirconia alumina. The selection of sanding discs is covered in the next section.
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Figure 44. Assembling the Grinder

Remove the battery before assembling the grinder, backup pad and sanding disc. Start by 
installing the backup pad onto the drive shaft of the grinder, or, with some backup pads. You 
will need to screw it onto the threaded shaft. 

Next place the sanding disc over the drive shaft onto the backup pad. Hold the locking button 
on the reverse side of the grinder while tightening the retaining nut into the hole of the 
sanding disc.

Once the backup pad, sanding disc and locking nut are secured, reinstall the battery. The 
grinder is now ready for use.

Sanding Discs

It has been well tested and determined that samples can be easily contaminated by the abrasive 
material contained in and on a sanding disc. An example would be the increase in aluminum 
content of carbon steel after grinding the sample with a new aluminum oxide sanding disc. 
Aluminum from the aluminum oxide disc imbeds itself in the surface of the steel sample and 
an XRF would show an unusually high aluminum concentration. 
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Aluminum oxide is the most common abrasive surface used today. For most applications it 
will be safe to use aluminum oxide discs. But if test results for aluminum in any metal alloy are 
significantly higher than expected, switch to another type of abrasive disc. Also, when 
grinding aluminum, aluminum oxide discs tend to trap aluminum from the metal surface into 
the disc surface. Once this happens, the disc looses its efficiency and cross contaminates the 
next sample. 

Silicon Carbide 

Silicon carbide discs are a good alternative for aluminum oxide and the cost of a disc is only 
slightly higher than aluminum oxide. This adhesive type is best for grinding aluminum, 
copper and other soft metals.

Zirconia Alumina

Zirconia alumina discs are more expensive than aluminum oxide or silicon carbide but they 
last much longer and so may be the best investment. Few metal alloys have low additive levels 
of zirconium, so it is one of the safest abrasive types for general use.

One exception is the Aluminum alloy Al 7050 which is a near twin to alloy Al 7075 except for 
the ~0.1% Zr in 7050. Therefore, if 7075 is ground with Zr grinding paper it may be 
erroneously identified as Al 7050 due to the Zr transferred from the grinding disk to the 
surface of the Al 7075. s

Diamond Sanding Paper

Do not use diamond sanding paper for surface preparation in the field. Even after extensive 
and aggressive sanding with diamond paper, a metal surface will not be prepared properly. 
Diamond sanding paper is only recommended for removal of very light oxide coatings on flat 
surfaces such as analytical reference standards. 

• Nickel, cobalt, and steel alloys should be ground using 36, 40, 50 or 60 grit discs. The 
selection of a grit size of 100 or larger will produce an acceptable metal surface but will result 
in very short disc life. Even a slightly used 100 grit disc will stop cutting and will start to just 
smear a sample's surface. Although a 50 grit size will produce a rough surface, it will have a 
much longer useful life.

• Aluminum, copper alloys, and other softer metals should be ground using 60 or 80 grit 
discs. 

• Grinding stones are not recommended because they will absorb surface material and transfer 
them onto the next surface ground. 

Safety Rules

When using a grinder, follow these safety rules:
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• When changing sanding discs, always remove the grinder battery to prevent accidental 
activation of the grinder.

• Allow the grinder to stop spinning before placing it on a flat surface.

Replace any damaged or torn sanding discs immediately.

• Always wear impact eye protection to prevent eye damage from flying debris.

• Place small samples or standards in a clamping device when grinding to prevent accidental 
contact between the spinning disc and your hand.

• Use proper techniques and safety precautions when grinding beryllium, beryllium copper, 
lead, or titanium alloys.

• Always follow the safety instructions outlined by the grinder's manufacture as mentioned in 
the instruction manual.
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Metals Analysis

To analyze metal samples, from the main menu select sample type, and then click on the 
Metals icon. Once in the Metals Selection Screen you have between 1 and 4 metal modes to 
select (depending on how your instrument is calibrated).
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Figure 45. The Metals Analysis Menu Path (Main)

Select General Metals for most typical alloy analysis, such as iron (Fe), nickel (Ni), cobalt 
(Co), chromium (Cr), aluminum (Al), titanium (Ti), copper (Cu) and zinc (Zn) base metals. 
This is the ideal mode for any general metals analysis, such as PMI, incoming / outgoing 
inspections, QA / QC, and scrap metal sorting. This mode includes most common alloying 
constituents.

General Metals Analysis Standard Operating Procedure

PMI Analysis Standard Operating Procedure

FAC Analysis Standard Operating Procedure

Select Electronics Metals for analysis of metal samples typically found in electronic goods 
(such as printed circuit boards PCBs, wires and other manufactured components). This mode 
includes many common alloying constituents plus some elements used for bonding and 
soldering (such as Au and In).

Consumer Goods Analysisniton Standard Operating Procedure

Select Precious Metals for the analysis of precious alloys such as those found in jewelry, gold 
and silver coins, and archaeological and historical samples.

Select Metal Coatings for the determination of the thickness of 1 to 3 layers (coatings) on a 
metal substrate. For example, this mode may be used for the analysis of the thickness of a 
coated surface to ensure the material is plated consistently, or to determine that a conversion 
coating is of sufficient thickness. This mode does not determine the chemical composition of 
the sample. 

Coatings Analysis Standard Operating Procedure 

Element Ranges and Lists

From the Element Range Screen, select the Element List Button to display the Element List 
for the Range you want to use. This list shows the elements that the Range is best designed to 
detect. See Adjusting the Element Range for details.
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Figure 46. The Element Range Menu Path
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General Metals Analysis

Analyzing General Metal (Alloy) Samples Using the Thermo Scientific Niton XL3 800 Series X-Ray 
Fluorescence (XRF) Analyzer – Version 7.0 and Higher

Standard Operating Procedure

October 2009
Note  Each user should read the Thermo Scientific Niton XL3 User’s Guide carefully before 
initiating measurements with the system. Users are strongly urged to attend the Thermo 
Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses offered 
regularly, or the web-based trainings. For more information, visit www.thermo.com/niton.

PREPARATORY TASKS

1. Attach a charged battery to the analyzer and turn it on. Follow the screen instructions and 
“Log On” as the operator using either the default password or a custom one as designated by 
the user in an NDU file. See Passwords and User Privileges for details.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be displayed 
for verification. If the date is incorrect, correct it prior to proceeding. This can be done by 
“Closing” out of the Specs screen and selecting the Date & Time icon. Detailed information 
on this procedure is available in Setting the Date and Time.

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. (Consult Connecting the XRF Analyzer to Your PC for details, if 
necessary.)

5. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select System Check icon then the Yes button. (Figure 1.)

6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.

Advanced_Settings.htm#Password Files and User Privileges
Advanced_Settings.htm#Password Files and User Privileges
New_Topic1.htm#Setting the Date and Time
New_Topic1.htm#Setting the Date and Time
Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
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6.2. If the unit shows a failure error, then perform a second System Check by clicking 
Recheck. If the unit still does not show a “System OK,” please contact Thermo Scientific 
Niton Analyzers toll-free in the USA at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 47. System Check Menu Path

7. Verify and/or change Range time. 

Thermo Scientific Niton XL3 analyzers are equipped with excitation filters that optimize the 
analyzers’ sensitivity for various elements. The “Main Range” filter provides optimum 
sensitivity for the elements manganese (Mn) through bismuth (Bi). The “Low Range” filter is 
used to optimize the sensitivity for the elements from titanium (Ti) through chromium (Cr). 
Note that the main range filter can be used to analyze Ti, V and Cr, but the sensitivity is not 
as good as when using the low filter. The "Light Range" filter is available only with He-purged 
and GOLDD technology analyzers, and is typically used in light element analysis. The 
amount of time that the analyzer spends in each filter position is user definable. Please note 
that the analyzer will continue alternating excitation filters until the user selectable maximum 
analysis time is reached or the operator terminates the measurement. To verify or change the 
length of time each filter will be active, do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 2). 

In the drop-down menu, select the mode that is intended for use (i.e., General Metals, 
Electronics Metals).

7.2 Select the box next to Main Range and Low Range so that a check mark appears in each 
box.

7.3 Enter the desired length of time for each filter. For example, set values of 5 seconds for the 
Main Range and 5 seconds for the Low Range as shown in Figure 3.
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7.4 Select Save and return to the Main Menu by clicking Return.

Figure 48. Element Range Menu Path

Figure 49. Setting Element Ranges

8. Verify instrument measurement accuracy using the 1¼Cr ½Mo reference material (RM) 
supplied with the analyzer. 

8.1 Test the factory-supplied 1¼Cr-½Mo alloy standard (or other approved check sample) 
based on a 30s measurement using main range filter only. If the sample is correctly identified 
and all major elements read within calculated acceptance limits (within the low and high 
values of factory readings found on QC sheet, proceed to General Testing Protocol section
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8.2 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the detector calibration described in step 7, then repeat the reference sample 
analysis in step 8.1

8.3 If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

GENERAL TESTING PROTOCOL

1. Good surface preparation is essential for obtaining accurate test results. All non- 
representative material (e.g., paint, coating, scale) must be removed prior to testing. An 
approximately 2-inch-square section of surface should be cleaned down to fresh or 
“white”/“red”/”yellow” metal using an abrasive wheel. To prevent cross contamination, wheels 
that have been used on one type of alloy should not be used on a different alloy type. For 
example, a wheel used on stainless steel should not be used on carbon steel. The area to be 
sampled should be wiped clean or blown with air to remove any grinding dust before testing.

For the Thermo Scientific Niton XL3 Series, test times of 5 seconds on each filter (smart 
library will determine if low filter is needed) will generally give good identification of grade 
for most alloys. Total test time will be 5s for most samples but 10s if 2nd filter is needed. 

Test times of 10 seconds on each filter will generally provide accurate chemistry analysis for 
unknown samples. Since there are two Ranges (Main and Low), the total test time will be 20 
seconds if the sample is not identified as one of the grade library samples. 

The analyzer will often display a correct alloy identification and accurate chemistry result 
before the above specified time interval. If the accuracy meets the user’s requirements, it is not 
necessary to measure for the full time.

Longer measurements might be necessary if low concentrations of alloy elements must be 
determined. 

2. INSTRUMENT QC

Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once a shift. If 
correct, continue work. If incorrect, redo System Check and re-take the past 2 hours of 
results.

3. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact 
with or that do not fully cover the measurement aperture)

3.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two 
(e.g., from 10 to 20 seconds per filter for chemistry).

3.2. The best procedure to measure undersized samples is to use the Thermo Scientific Niton 
portable test stand (optional - see Parts and Accessories ), which is shielded to prevent 
radiation exposure to the operator.

Parts_and_Accessories.htm
Parts_and_Accessories.htm
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3.3 An undersized sample may alternately be measured while lying on another material. 
Results may be affected by the signal coming from the underlying material itself. Use only 
pure aluminum, pure plastic, or clean wood and employ the Disable Al feature. Use the Tools 
Menu, then select Disable Al, and check the underlying surface itself to be sure no metals are 
present. Be sure to use the Tools Menu and select Enable Al before testing aluminum alloys.



 5 Metals Analysis
PMI Analysis

Thermo Scientific Niton XL3 Analyzer User’s Guide 89

PMI Analysis

Field Procedures for PMI Using the Thermo Scientific Niton XL3 800 Series Alloy PMI Tool with Software 
Version 7.0 or Higher

Standard Operating Procedure

October 2009

1. DOCUMENT PURPOSE

1.1. This document is intended for use as a guide for performing Positive Material 
Identification (PMI) using the handheld Thermo Scientific Niton XL3 800 Series x-ray 
fluorescence (XRF) alloy analyzer in the field to ensure compliance with the refinery 
procedures for ensuring Positive Material Identification.

2. SAFETY

2.1. Any persons, including refinery personnel and their representatives, using approved alloy 
analyzers at the refinery will be given a safety orientation by the PMI coordinator (or his /her 
approved instructor) prior to using any PMI device.

2.2. The safety orientations will include the following as a minimum:

2.2.1. Radiation safety for x-ray fluorescence analyzers covering safe operation of the device 
and emergency procedures in case of malfunction or unit damage during field use.

2.2.2. Personnel will demonstrate and acknowledge satisfactory understanding of safe 
operation by passing and signing a written test for each analyzer to be used. This 
documentation is to be kept on file by the PMI coordinator or his/her designee.

2.3. PMI coordinator will periodically audit field use of instruments for compliance with 
safety procedures.

3. PERSONNEL AUTHORIZED TO CONDUCT PMI INSPECTIONS

3.1. Refinery inspection personnel who have completed safety-training requirements.

3.2. Refinery’s designated contractor representatives. These representatives are people who 
have demonstrated to the PMI coordinator or his/her designee that in addition to the safety 
requirements, they also have a firm understanding of the Niton® XL3 800 Series alloy analyzer 
operation, auto-calibration frequency requirements, and PMI job goals and objectives.

3.3. All authorized PMI personnel will be familiar with and have copies of the following 
documents available to them:

3.3.1. Thermo Scientific Niton XL3 800 Series User Guide
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3.3.2. API Recommended Practice 578 – Material Verification Program for New and Existing 
Alloy Piping Systems. 

3.3.3. PMI Field Procedures (e.g., this document)

3.3.4. Other documentation as specified 

4. PRE-INSPECTION Niton XL3 800 ANALYZER START UP AND CALIBRATION

4.1. Startup and Stabilization

4.1.1. Turn on, accept the radiation warning (if you are trained), and log into (enter 
password) the Niton XL3 800 Series analyzer. Allow 5 minutes for the analyzer to stabilize 
BEFORE proceeding. 

4.1.2. Calibrate the analyzer by pressing the “System Check” icon. This will start the detector 
auto calibrate process. When the Niton XL3 instrument completes the auto calibration, press 
the “Sample Type” icon, press the “Metals” icon and then the “General Metals” icon. Measure 
the check sample as directed in 4.2.1. If it reads correctly, testing may start (see 4.5). 

4.2. Verify the Calibration. 

4.2.1. Test the factory supplied 1¼Cr-½Mo alloy standard (or other approved check sample). 
If the sample is correctly identified and all major elements (Cr and Mo primarily) read within 
calculated acceptance limits (see factory QC readings), testing may start (see 4.5). 

4.2.2. If the check sample does not read correctly, then re-calibrate the analyzer by pressing 
the “System Check” icon. This will start the auto calibration. When the Niton XL3 
instrument completes the auto calibration, return to “Test” and re-measure the check sample 
as directed in 4.2.1. If it reads correctly, testing may start (see 4.5). If the check sample still 
does not read correctly contact your local Thermo Scientific Niton Service center.

4.3. The need for a hot surface adapter should be determined at this time. If surface 
temperatures of the components to be tested will exceed 315°C/600°F, the operator must 
install the HotfootTM hot surface adapter. If sample temperatures will exceed 315°C/600°F 
but are below 800°F, the user may operate the unit with ~6 mm (~1/4 inch) gap between the 
front measuring plate and the sample. When testing hot surfaces with the weld adapter in 
place, the operator should double the measuring time to maintain precision (compensates for 
the lower signal due to the gap created by the weld adapter and the 3 mm (reduced size) 
aperture. Accuracy compensation is handled automatically by the Niton XL3 software. 

4.4. If measurements will be taken on vibrating surfaces, hold the analyzer a few millimeters 
(~1/8 inch) away from the vibrating surface and double the measuring time to maintain 
precision. All concentration accuracy compensation (for the gap) is handled automatically by 
the Niton XL3 software (up to maximum of 6 mm). 



 5 Metals Analysis
PMI Analysis

Thermo Scientific Niton XL3 Analyzer User’s Guide 91

4.5. Check the analyzer for material-specific performance prior to any actual testing. 
Typically, this should be done using a Certified Reference Material (CRM) or Reference 
Material (RM) such as an ARMI CRM. The CRM(s) used in this procedure should represent 
each of the materials expected to be encountered during inspection. A kit of 15 PMI 
refinery-specific CRM alloys is available upon request. Contact Thermo Scientific Niton 
Analyzers or your representative for a quote.

5. FIELD TESTING REQUIREMENTS

5.1. Prior to beginning testing, the specific PMI testing and documentation requirements for 
the job should be discussed with the PMI coordinator or his designee. Data storage can be 
accomplished in real time at the exact test site by utilizing optional data download button 
storage devices and position indicators that affix directly to the measured piece or location. 
Contact Thermo Scientific Niton Analyzers or your representative for a quote.

5.2. Good surface preparation is essential for obtaining accurate test results. All non 
representative material (e.g., paint, coating, scale) must be removed prior to testing. This can 
be accomplished by using hand files, grinders, pneumatic rotary files, etc. to obtain a clean 
metal area on which to conduct the test. Test areas on welds may have to be ground flat. Note: 
The battery powered Makita 9500D cordless angle grinder with several extra batteries has 
been found to provide good service with rapid surface preparation.

5.3. Test time for the Niton XL3 Series will be a minimum of 5 seconds for grade 
identification and 10 seconds for chemical analysis. If used in the Spectral Fingerprints mode, 
testing time may be reduced to 3-5 seconds for identification. Although the analyzer may 
display a result before the specified time interval, the operator should continue to measure 
until the specified time has elapsed. Note sections above and below covering special cases that 
require longer measuring times.

5.4. One test point for each piping component (pipe, tee, ell, etc.) is required. Weld test 
requirements vary according to size. See Section 6.

5.5. Minimum documentation for field work will include:

5.5.1. An isometric drawing or sketch of the as-installed and tested piping or equipment. This 
drawing should include equipment ID and piping line number, or other documentation 
reference(s) as specified.

5.5.2. Alloy chemistry documentation for the primary elements required to provide PMI of 
the alloy grade for all units tested.

5.5.3. Documentation must be signed and dated by the personnel that performed the tests; 
the signed documentation is then given to the PMI coordinator or designee.

5.5.4. The PMI coordinator or designee may require additional documentation, which will be 
specified prior to testing. Electronic copies of the encrypted Niton Data Transfer (NDT©) 
files should be maintained in addition to paper copies.

6. WELDS – NEW AND EXISTING INSPECTION
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6.1. Prior to welding, consumables should be tested as indicated in 6.6 below. 

6.2. Number of test locations per weld:

6.2.1. ¾” to 1-½” butt welds – One test point.

6.2.2. ¾” to 2” socket welds – One test point.

6.2.3. 2” to 4” butt welds – Two test points.

6.2.4. 6” and larger weld – At least four test areas evenly distributed around the circumference 
of the weld should be inspected. If no discrepancy is found, the average of the primary 
identifier element chemistries for all areas tested on that weld can be used for documentation.

6.3. At the discretion of the inspector, as in the case of large diameter welds or at any other 
time deemed necessary to ensure correctness of the weld material, additional locations on the 
weld may be tested.

6.4. When testing welds, care must be taken to position the analyzer window to read only the 
weld, with no false reading from the adjacent piping component.

6.4.1. If weld is smaller than the measuring aperture (smaller than 10 mm), insert the weld 
adapter and activate the Weld Mode with the Weld Icon. If your analyzer did not come with 
the optional weld adapter, there will not be a Weld Mode. Contact Thermo Scientific Niton 
Analyzers or your representative for a quote.

6.4.2. The weld adapter should reduce the measurement aperture width to a size smaller than 
the width of the weld to be tested, or 

6.4.3. If the optional weld adapter is not an acquired accessory, it is possible to isolate the weld 
by masking adjacent metal with a non readable material, such as several layers of pure 
aluminum tape. Care should be taken that no readable elements are contained in the mask 
material and that the mask material is thick enough to prevent read through from the 
underlying material.

6.4.4. Double the measuring times when using the weld adapter (e.g., increase from 5 source 
seconds to 10 source seconds for ID, and from 10 to 20 seconds for chemistry), to 
compensate for the added gap and reduced surface area being tested. 

6.5. Testing of welding consumables shall be performed as follows:

6.5.1. Each and every box of weld rod to be used for the job will be prepared by first puddling 
a sample using at least two passes and grinding smooth for testing.

6.5.2. Documentation for the weld rod tested should include: 

6.5.2.1. Rod designation

6.5.2.2. Manufacturer’s name

6.5.2.3. Box lot number
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6.5.2.4. Element composition of samples

6.5.3. Rod box will be marked PMI CONFIRMED with:

6.5.3.1. Name of authorized person who performed the testing

6.5.3.2. Date tested

6.5.3.3. Other information as specified (e.g., vendor or contractor ID)

6.5.4. GTAW (TIG) wire can often be tested directly from the box either individually with a 
slot aperture or by using several pieces to cover more of the aperture window of the analyzer. If 
satisfactory results cannot be obtained, then puddling and grinding of the wire should be 
performed as specified in 6.5.1.

7. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact 
with or that do not fully cover the measurement aperture)

7.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two. 
(e.g., from 5 seconds to 10 seconds for ID and from 10 to 20 seconds for chemistry).

7.1.1. Undersized samples should be placed in the Thermo Scientific portable alloy test stand 
(optional), which is shielded to prevent radiation exposure to the operator. (NOTE: An 
undersized sample – one that does not cover the entire measuring aperture – measured while 
lying on another material such as, e.g., a stainless steel table top, will be affected by the signal 
coming from the table top itself.) Be sure to employ the Disable Al feature if measuring on an 
aluminum table or any plastic or wood table. Use “Tools,” then select “Disable Al.” Be sure to 
use Tools to “Enable Al” before testing aluminum alloys. 

7.2. Non-contact sample measurements include those measured with a gap of up to a 
maximum of ¼ inch (~6 mm) from the Niton XL3 measurement aperture opening. Such 
measurements require double the exposure time. (e.g., from 5 seconds to 10 seconds for ID 
and from 10 to 20 seconds for chemistry). 

7.3. Inside pipe measurements on pipes that are less than a few feet in diameter will result in 
non-contact measurements. Follow recommendations in 7.2 above.

8. INSTRUMENT QC

8.1. Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once for every 
2 hours of use time. If correct, continue work. If incorrect, recalibrate the Niton XL3 detector 
and re-take the past 2 hours of results.

9. STAMPS

9.1. All stamping is done with a specified proprietary stamp.
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9.2. All stamps purchased for special marking should be marked with a control number. A list 
indicating the number and location of these stamps is held by the PMI coordinator.

9.3. Typically, a stamp is assigned to each individual analyzer and stays in the respective 
analyzer’s field carry bag.

9.4. Report any loss of a stamp immediately to the PMI coordinator or designee.

10. WHEN TO USE AN APPROVED STAMP

10.1. Materials and components should be tested prior to fabrication. This will help find any 
discrepancies before final field inspection and prevent costly field cut outs.

10.2. Items checked prior to fabrication and before the final as-installed condition will only be 
marked with approved paint pen as “PMI CONFIRMED.”

10.3. Chemistry documentation may not be necessary for this phase of the PMI inspection.

10.4. The number of components and type tested should be documented for the job.

10.5. Discrepancies should be noted and handled as specified in the appropriate procedures 
document.

10.6. Shop made spool pieces may be stamped, providing that their final field location in the 
piping system can be tracked and documented. Final field installation must be confirmed by 
visual inspection for the stamp.

10.7. Use of any approval stamp should be in accordance with the appropriate company 
procedures document for PMI on existing equipment.

10.8. Use of an approval stamp does not negate the need for the written documentation.

11. RESOLUTION OF DISCREPANCIES

11.1. When analysis indicates a wrong material, component, or weld, then take the following 
steps:

11.2. Test several other areas on the same component. For welds, check adjacent components.

11.3. Check the analyzer calibration against the check sample or other known sample.

11.4. If performing pre-fabrication testing, components having reached this point must be 
rejected according to established procedures.

11.5. Discrepancies on field installed or in-place existing materials requires notifying the 
responsible inspector and completing the following items:

11.5.1. Complete chemistries should be taken for all elements present in the suspect material 
to help identify the material.
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11.5.2. Review the test data for the suspect component, and, if possible, confirm the results 
using a second analyzer.

11.5.3. If conclusive results cannot be obtained with field analyzers, the inspector may request 
a lab analysis on a small sample material removed from the component.
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FAC Analysis

Field Procedures for Measurement of FAC Predictor Elements Cr, Cu, Mo Using the Thermo Scientific 
Niton XL3 800 Series Alloy Analyzer with Software Version 7.0 or Higher

1. DOCUMENT PURPOSE

1.1. This document is intended for use as a guide for using the handheld Thermo Scientific 
Niton XL3 800 Series x-ray fluorescence (XRF) alloy analyzer as a tool in performing Flow 
Accelerated Corrosion (FAC) data modeling to ensure that proper measurement parameters 
are followed to reach indicative low-level concentrations of Cr, Cu, and Mo.

2. SAFETY

2.1. Any persons, including power plant personnel and their representatives, using approved 
alloy analyzers at the plant will be given a safety orientation by the FAC coordinator (or 
his/her approved instructor) prior to using any XRF inspection device.

2.2. The safety orientations will include the following as a minimum:

2.2.1. Radiation safety for x-ray fluorescence analyzers covering safe operation of the device as 
well as emergency procedures in case of malfunction or unit damage during field use.

2.2.2. Personnel will demonstrate and acknowledge satisfactory understanding of safe 
operation by passing and signing a written test for each analyzer to be used. This 
documentation is to be kept on file by the FAC coordinator or his/her designee.

2.3. FAC coordinator will periodically audit field use of instruments for compliance with 
safety procedures.

3. PERSONNEL AUTHORIZED TO CONDUCT MEASUREMENT OF FAC 
PREDICTOR ELEMENTS

3.1. Power plant inspection personnel who have completed safety-training requirements.

3.2. Power plant’s designated contractor representatives. These representatives are people who 
have demonstrated to the FAC coordinator or his/her designee that in addition to the safety 
requirements, they also have a firm understanding of the Niton® XL3 800 Series alloy analyzer 
operation, auto-calibration frequency requirements, and FAC program goals and objectives.

3.3. All authorized inspection personnel will be familiar with and have copies of the following 
documents available to them:

3.3.1. Thermo Scientific Niton XL3 800 Series User Guide

3.3.2 Thermo Scientific Niton NDT Data Transfer User’s Guide

3.3.3 Flow Accelerated Corrosion in Power Plants, EPRI Publication, 1996

3.3.4. Other documentation as specified
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4. PRE-INSPECTION Niton XL3 800 ANALYZER START UP AND CALIBRATION

4.1. Startup and Stabilization

4.1.1. Turn on, accept the radiation warning (if you are trained), and log into (enter 
password) the Niton XL3 800 Series analyzer (see Figures 1 & 2). 

Figure 50. Warning Screen 

Figure 51. Virtual Numeric Keypad for Log On
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4.1.2. Ensure that the filters are properly set up for the measurement: From “Main Menu” 
select “Advanced” -> ”Element Range” (see Figure 1-3). In the drop-down box select “General 
Metals”. Ensure that the boxes are checked for “Main Range” and “Low Range”. Ensure that 
the “Time” boxes show “10.0” in both the “Main Range” and “Low Range” boxes (see Figure 
1-4). If not, -> “Main Range Time” -> “C” to clear existing entry -> “1”, “0”, “E” to enter the 
desired time of 10 seconds. Repeat for the “Low Range Time” if so required (see Figure 1-5). 
Ensure that the “Filter Change on Time Only” is checked. Then press “Save”.

Figure 52. The Element Range Menu Path

Figure 53. Range Checkboxes, Range Time, and Time Only Checkbox
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Figure 54. Range Time Editor

4.1.3. Set up the screen display so that Cr, Cu, and Mo are always displayed, and are shown 
prominently at the top of the displayed element list: From “Main Menu” select “Advanced” -> 
“Element Sorting” (see Figure 1-6). In the drop down box select “Alloy Mode” (see Figure 7); 
in the element box scroll down and highlight Cr; in the “Display Options” box select “Always 
Display”; then using the blue arrow keys at the right of the screen use the up arrow to move 
Cr to the top of the element table; repeat this procedure for Cu and Mo respectively, first 
marking them as “Always”, then moving them up the element table to immediately below Cr. 
Press “Save” -> “Close” -> “Close” -> “Return” -> “Return” to reach the Main Menu. See 
Figure 1-8.

Figure 55. Sort Element Display Menu Path
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Figure 56. Sort Element Display

Figure 57. Sorting Options Screen

4.1.4. Calibrate the analyzer by pressing the “System Check” icon, (see Figure 9). This will 
start the detector auto-calibrate function. When the Niton XL3 instrument completes the 
auto-calibration, return to “Test” and measure the check sample as directed in 4.2.1. If it reads 
correctly, testing may start (see 5.0).
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Figure 58. System Check Menu Path

4.2. Verify the Calibration.

4.2.1. Test the factory supplied 1¼Cr-½Mo alloy standard (or other approved check sample). 
If the sample is correctly identified and all major elements (Cr and Mo primarily) read within 
calculated acceptance limits (within the low and high values of factory readings found on QC 
sheet), testing may start (see 5.1). 

4.2.2. If the check sample does not read correctly, then re-calibrate the analyzer by pressing 
the “System Check” icon (see Figure 9). This will start the auto-calibration. When the Niton 
XL3 instrument completes the auto-calibration, return to “Test” and re-measure the check 
sample as directed in 4.2.1. If it reads correctly, testing may start (see 5.0). If the check sample 
still does not read correctly, contact your local Thermo Scientific Niton service center.

4.3. If a weld of less than 10 mm is to be analyzed, it will be necessary to reduce the analysis 
area from the 10 mm normal aperture size to a size below that of the weld bead. See section 
6.4.1.

4.4. Check the analyzer for sensitivity performance for Cr, Cu, and Mo prior to any actual 
testing. Typically, this should be done using a Certified Reference Material (CRM) such as an 
ARMI CRM. The CRM(s) used in this procedure should represent each of the materials 
expected to be encountered during inspection.

5. FIELD TESTING REQUIREMENTS

5.1. Prior to beginning testing, the specific testing and documentation requirements for the 
job should be discussed with the FAC coordinator or his designee. Data storage can be 
accomplished in real time at the exact test site by utilizing optional data download button 
storage devices and position indicators (compact memory button – CMB) that affix directly 
to the measured piece or location. Contact Thermo Scientific Niton Analyzers or your local 
representative for a quote.
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5.2. Good surface preparation is essential for obtaining accurate test results. All 
non-representative material (e.g., paint, coating, scale) must be removed prior to testing. An 
approximately 2-inch-square section of surface should be cleaned down to fresh or “white” 
metal using an abrasive flapper wheel. The cleaning should not be performed using the same 
wheel that was used to prepare the component for ultrasonic testing (UT), but should be 
performed using a fresh wheel, designated for this operation only. Wheels that have been used 
on high chromium alloyed components (e.g., 300 series chromium-nickel stainless steels, or 
chromium steels) should not be used to clean carbon steel components. The area to be 
sampled should be wiped clean or blown with air to remove any grinding dust before testing.

5.3. Test time for the Niton XL3 Series will be a minimum of 10 seconds on each filter for 
accurate chemistry analysis. Since two filters (Main and Low) are required for the targeted low 
concentrations, the total test time shall be a minimum of 20 seconds. Although the analyzer 
may display a result before the specified time interval, the operator should continue to 
measure until the specified time has elapsed. Note sections above and below covering special 
cases that require longer measuring times.

5.4. One test point for each piping component (pipe, tee, ell, etc.) is required. Weld test 
requirements vary according to size. See Section 6.

5.5. Minimum documentation for field work will include:

5.5.1. An isometric drawing or sketch of the as-installed and tested piping or equipment. This 
drawing should include equipment ID and piping line number, or other documentation 
reference(s) as specified.

5.5.2 Documentation must be signed and dated by the personnel that performed the tests; the 
signed documentation is then given to the FAC coordinator or designee.

5.5.4. The FAC coordinator or designee may require additional documentation, which will be 
specified prior to testing. Electronic copies of the encrypted Niton Data Transfer (NDT©) 
files should be maintained in addition to paper copies.

6. WELDS – NEW AND EXISTING INSPECTION

6.1. Prior to welding, consumables should be tested as indicated in 6.5 below.

6.2. Number of test locations per weld:

6.2.1. ¾” to 1-½” butt welds – one test point.

6.2.2. ¾” to 2” socket welds – one test point.

6.2.3. 2” to 4” butt welds – two test points.

6.2.4. 6” and larger weld – At least four test areas that are evenly distributed around the 
circumference of the weld should be inspected. If no discrepancy is found, the average of the 
primary identifier element chemistries for all areas tested on that weld can be used for 
documentation.
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6.3. At the discretion of the inspector, as in the case of large diameter welds, or at any other 
time deemed necessary to ensure correctness of the weld material, additional locations on the 
weld may be tested.

6.4. When testing welds, care must be taken to position the analyzer window to read only the 
weld, with no false reading from the adjacent piping component.

6.4.1. If weld is smaller than the measuring aperture (smaller than 10 mm), insert the weld 
adapter and activate the Weld Mode with the Weld Icon. If your analyzer did not come with 
the optional weld adapter, there will not be a Weld Mode. Contact Thermo Scientific Niton 
Analyzers or your local representative for a quote.

6.4.2. The weld adapter should reduce the measurement aperture width to a size smaller than 
the width of the weld to be tested, or 

6.4.2. If the optional weld adapter is not an acquired accessory, it is possible to isolate the weld 
by masking adjacent metal with a non-readable material, such as several layers of pure 
aluminum tape. Care should be taken that no readable elements are contained in the mask 
material and that the mask material is thick enough to prevent read through from the 
underlying material.

6.4.4. Double the measuring times when using the weld adapter (e.g., increase from 10 to 20 
seconds per filter for chemistry) to compensate for the added gap and reduced surface area 
being tested.

6.5. Testing of welding consumables shall be performed as follows:

6.5. Testing of welding consumables shall be performed as follows:

6.5.1. Each and every box of weld rod to be used for the job will be prepared by first puddling 
a sample using at least two passes and then grinding smooth for testing.

6.5.2. Documentation for the weld rod tested should include:

6.5.2.1. Rod designation

6.5.2.2. Manufacturer’s name

6.5.2.3. Box lot number

6.5.2.4. Element composition of samples

6.5.3. Rod box will be marked FAC CONFIRMED with:

6.5.3.1. Name of authorized person who performed the testing

6.5.3.2. Date tested

6.5.3.3. Other information as specified (e.g., vendor or contractor ID)
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6.5.4. GTAW (TIG) wire can often be tested directly from the box either individually with a 
slot aperture or by using several pieces to cover more of the aperture window of the analyzer. If 
satisfactory results cannot be obtained, then puddling and grinding of the wire should be 
performed as specified in 6.6.1.

7. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact 
with or that do not fully cover the measurement aperture)

7.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two 
(e.g., from 10 to 20 seconds per filter for chemistry).

7.1.1. Undersized samples should be placed in a Thermo Scientific Niton approved alloy test 
stand (optional), which is shielded to prevent radiation exposure to the operator. (NOTE: An 
undersized sample – one that does not cover the entire measuring aperture – measured while 
lying on another material, such as a stainless steel table top, will be affected by the signal 
coming from the table top itself.) Be sure to employ the Disable Al feature if measuring on an 
aluminum table or any plastic or wood table. Use “Tools,” then select “Disable Al” Be sure to 
use Tools to “Enable Al” before testing aluminum alloys.

7.2. Inside pipe measurements on pipes that are less than a few feet in diameter will result in 
non-contact measurements. Follow recommendations in 7.2 above.

8. INSTRUMENT QC

8.1. Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once for every 
2 hours of use time. If correct, continue work. If incorrect, recalibrate the Niton XL3 detector 
and re-take the past 2 hours of results.

9. RESOLUTION OF DISCREPANCIES

9.1. When analysis indicates an undesirable or anomalous result, take the following steps:

9.2. Test several other areas on the same component. For welds, check adjacent components.

9.3. Check the analyzer calibration against the check sample or other known sample.

9.4. If performing pre-fabrication testing, components having reached this point must be 
rejected according to established procedures.

9.5. Discrepancies on field-installed or in-place existing materials require notification of the 
responsible inspector and completing the following items:

9.5.1. Review the test data for the suspect component, and, if possible, confirm the results 
using a second analyzer.
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Coatings Analysis

Coating Thickness Measurement Using the Thermo Scientific Niton XL3 800 Series X-Ray Fluorescence 
(XRF) Analyzer – Version 7.0 and Higher

Standard Operating Procedure

October 2009
Note  Each user should read the Thermo Scientific Niton XL3 User’s Guide carefully before 
initiating measurements with the system. Users are strongly urged to attend the Thermo 
Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses offered 
regularly, or the web-based trainings. For more information, visit www.thermo.com/niton.

Preparatory Tasks

1. Attach a charged battery to the analyzer and turn it on. Follow the screen instructions and 
Log On as the operator using either the default password or a custom one as designated by the 
user in an NDU file.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be displayed 
for verification. If the date is incorrect, correct it prior to proceeding. This can be done by 
returning to the System Menu and selecting the Date & Time icon. See Setting the Date and 
Time for detailed information on this procedure. 

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. See Connecting the XRF for more information.

5. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select the System Check icon, and select the Yes Button. (Figure 
1-1.)

6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.

http://www.thermo.com/niton
New_Topic1.htm#Setting the Date and Time
New_Topic1.htm#Setting the Date and Time
Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
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6.2. If the unit shows a failure error, then perform a second System Check by selecting the 
Recheck Button. If the unit still does not show a “System OK,” please contact Thermo 
Scientific Niton Analyzers toll-free at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 59. System Check Menu Path

7. Verify and/or change filter position time. 

Thermo Scientific Niton XL3 analyzers are equipped with 2 excitation filters that optimize 
the analyzers’ sensitivity for various elements. The “Main Range” filter provides optimum 
sensitivity for the elements manganese (Mn) through bismuth (Bi). The “Low Range” filter is 
used to optimize the sensitivity for the elements from titanium (Ti) through chromium (Cr). 
Note that the main range filter can be used to analyze Ti, V and Cr, but the sensitivity is not 
as good as when using the low filter. The amount of time that the analyzer spends in each 
filter position is user definable. Please note that the analyzer will continue alternating 
excitation filters until the user selectable maximum analysis time is reached or the operator 
terminates the measurement. To verify or change the length of time each filter will be active, 
do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 22)

In the drop-down menu, select the mode that is intended for use (i.e., General Metals, 
Electronics Metals).

7.2 Select the box next to Main Range and Low Range so that a check mark appears in each 
box.

7.3 Enter the desired length of time for each filter. For example, set values of 5 seconds for the 
Main Range and 5 seconds for the Low Range as shown in Figure 23. 

7.4 Select the Save Button and return to the Main Menu by selecting the Return icon.

mailto://niton@thermofisher.com
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Figure 60. Element Range Menu Path

Figure 61. Setting Element Ranges

8. Verify instrument measurement accuracy using the 1¼Cr ½Mo certified reference material 
(CRM) supplied with the analyzer. 

8.1 Test the factory-supplied 1¼Cr-½Mo alloy standard (or other approved check sample) 
based on a 20s measurement using main range filter only (see Figure 1-3). If the sample is 
correctly identified and all major elements read within calculated acceptance limits (within 3 
sigma of the average value of factory readings, proceed to General Testing Protocol section.

8.2 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the System Check described in step 7, then repeat the reference sample analysis 
in step 8.1.
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8.3 If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

Coatings Entries and Standardization

How to Access Metal Coatings Mode

To access Metal Coatings mode follow the sequence shown in Figure 24.

Figure 62. Metal Analysis Menu Path

If no coatings method entries have been loaded, screen A in Figure 25. will appear. Press the 
Add Button, which brings up a Virtual Keyboard, and enter a method name, which will bring 
you to screen B. Follow the steps in Creating a Metal Coatings Entry to create a new entry.

If method entries have been loaded, screen C will appear. Select desired method from drop 
down menu. If you need to add more methods, select the Edit Methods Button to open 
screen A.

Coatings_Analysis.htm#Creating a Metal Coatings Entry
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Figure 63. Screens A, B, and C

Creating a Metal Coatings Entry

Before coating thickness can be measured, a Coatings System Entry must be made defining 
the coatings system (see Figures 26-29). Note that the Coatings Method Menu can be 
accessed via the steps outlined in Figures 24 and 25 above or via the Tools Menu. See Using 
the Tools Menu for more information on the Tools Menu.

A B C

New_Topic1.htm#Using the Tools Menu
New_Topic1.htm#Using the Tools Menu
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Figure 64. Accessing the Tools Menu - Select Coatings Method Button
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Figure 65. Coating System Screen 

When creating a coating system, select the Add Button to activate the Virtual Keyboard and 
enter the name of a coating system (e.g. test). Once the name is created, select the coatings 
thickness units, substrate (type of metal to be coated) and layers (metal coatings) from the 
individual pull-down menus. See Figure 28.

Figure 66. Entering Units, Substrate, and Layer Information

Standardize Feature

The Standardize feature is a standardization routine that corrects for any bias in thickness 
measurement when compared to a known thickness sample or thickness standard. 
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To standardize, follow the sequence shown in Figure 29. From the Coating Entries screen 
select the Standardize Button. Enter known thickness of Zn layer, e.g. 20.0, and initiate a 
reading. Select the Yes Button to save the standardization.

Figure 67. Standardizing the Coating

Coatings Testing Protocol

Once a methods are created and standardized the analyzer is ready for routine analysis. All 
non-representative material (e.g. dust, oil) must be removed prior to testing. Test times of 10 s 
will generally provide accurate results

Figure 30. shows a typical measurement of Zn thickness over steel. 
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Figure 68. Example Coating Measurement

There is a maximum coating thickness that can be measured. This maximum value, know as 
“infinite thickness”, varies with coating element. If a coating above this value is measured it 
will give the message Saturated as shown in Figure 31.

Figure 69. Example Saturated Measurement

Typical infinite thickness values are given the fowllowing table.
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Coating Infinite Thickness

Element Substrate Microns

Au Cu 10

Cd Al 75

Cd Fe 75

Co Fe 50

Co Ti 50

Cr Fe 15

Cu Fe 20

Mo Fe 50

Mo Ti 50

Ni Fe 20

Pt Cu 15

Sn Fe 100

Ti Fe 50

Zn Fe 50

Zr Al 70
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General Metals Analysis

Analyzing General Metal (Alloy) Samples 

Using the Thermo Scientific Niton XL3 800 Series X-Ray Fluorescence (XRF) Analyzer – 
Version 7.0 and Higher

Standard Operating Procedure

October 2009

Note - Each user should read the Thermo Scientific Niton XL3 User’s Guide carefully before 
initiating measurements with the system. Users are strongly urged to attend the Thermo 
Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses offered 
regularly, or the web-based trainings. For more information, visit www.thermo.com/niton.

PREPARATORY TASKS

1. Attach a charged battery to the analyzer and turn it on. Follow the screen instructions and 
“Log On” as the operator using either the default password or a custom one as designated by 
the user in an NDU file. See Passwords and User Privileges for details.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be displayed 
for verification. If the date is incorrect, correct it prior to proceeding. This can be done by 
“Closing” out of the Specs screen and selecting the Date & Time icon. Detailed information 
on this procedure is available in Setting the Date and Time.

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. (Consult Connecting the XRF Analyzer to Your PC for details, if 
necessary.)

5. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select System Check icon then the Yes button. (Figure 1.)

6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.
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6.2. If the unit shows a failure error, then perform a second System Check by clicking 
Recheck. If the unit still does not show a “System OK,” please contact Thermo Scientific 
Niton Analyzers toll-free in the USA at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 70. System Check Menu Path

7. Verify and/or change Range time. 

Thermo Scientific Niton XL3 analyzers are equipped with excitation filters that optimize the 
analyzers’ sensitivity for various elements. The “Main Range” filter provides optimum 
sensitivity for the elements manganese (Mn) through bismuth (Bi). The “Low Range” filter is 
used to optimize the sensitivity for the elements from titanium (Ti) through chromium (Cr). 
Note that the main range filter can be used to analyze Ti, V and Cr, but the sensitivity is not 
as good as when using the low filter. The "Light Range" filter is available only with He-purged 
and GOLDD technology analyzers, and is typically used in light element analysis. The 
amount of time that the analyzer spends in each filter position is user definable. Please note 
that the analyzer will continue alternating excitation filters until the user selectable maximum 
analysis time is reached or the operator terminates the measurement. To verify or change the 
length of time each filter will be active, do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 2). 

In the drop-down menu, select the mode that is intended for use (i.e., General Metals, 
Electronics Metals).

7.2 Select the box next to Main Range and Low Range so that a check mark appears in each 
box.

7.3 Enter the desired length of time for each filter. For example, set values of 5 seconds for the 
Main Range and 5 seconds for the Low Range as shown in Figure 3.

7.4 Select Save and return to the Main Menu by clicking Return.
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Figure 71. Element Range Menu Path

Figure 72. Setting Element Ranges

8. Verify instrument measurement accuracy using the 1¼Cr ½Mo reference material (RM) 
supplied with the analyzer. 

8.1 Test the factory-supplied 1¼Cr-½Mo alloy standard (or other approved check sample) 
based on a 30s measurement using main range filter only. If the sample is correctly identified 
and all major elements read within calculated acceptance limits (within the low and high 
values of factory readings found on QC sheet, proceed to General Testing Protocol section

8.2 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the detector calibration described in step 7, then repeat the reference sample 
analysis in step 8.1
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8.3 If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

GENERAL TESTING PROTOCOL

1. Good surface preparation is essential for obtaining accurate test results. All non- 
representative material (e.g., paint, coating, scale) must be removed prior to testing. An 
approximately 2-inch-square section of surface should be cleaned down to fresh or 
“white”/“red”/”yellow” metal using an abrasive wheel. To prevent cross contamination, wheels 
that have been used on one type of alloy should not be used on a different alloy type. For 
example, a wheel used on stainless steel should not be used on carbon steel. The area to be 
sampled should be wiped clean or blown with air to remove any grinding dust before testing.

For the Thermo Scientific Niton XL3 Series, test times of 5 seconds on each filter (smart 
library will determine if low filter is needed) will generally give good identification of grade 
for most alloys. Total test time will be 5s for most samples but 10s if 2nd filter is needed. 

Test times of 10 seconds on each filter will generally provide accurate chemistry analysis for 
unknown samples. Since there are two Ranges (Main and Low), the total test time will be 20 
seconds if the sample is not identified as one of the grade library samples. 

The analyzer will often display a correct alloy identification and accurate chemistry result 
before the above specified time interval. If the accuracy meets the user’s requirements, it is not 
necessary to measure for the full time.

Longer measurements might be necessary if low concentrations of alloy elements must be 
determined. 

2. INSTRUMENT QC

Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once a shift. If 
correct, continue work. If incorrect, redo System Check and re-take the past 2 hours of 
results.

3. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact 
with or that do not fully cover the measurement aperture)

3.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two 
(e.g., from 10 to 20 seconds per filter for chemistry).

3.2. The best procedure to measure undersized samples is to use the Thermo Scientific Niton 
portable test stand (optional - see Parts and Accessories ), which is shielded to prevent 
radiation exposure to the operator.



 5 
General Metals Analysis

Thermo Scientific Niton XL3 Analyzer User’s Guide 119

3.3 An undersized sample may alternately be measured while lying on another material. 
Results may be affected by the signal coming from the underlying material itself. Use only 
pure aluminum, pure plastic, or clean wood and employ the Disable Al feature. Use the Tools 
Menu, then select Disable Al, and check the underlying surface itself to be sure no metals are 
present. Be sure to use the Tools Menu and select Enable Al before testing aluminum alloys.
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PMI Analysis

Field Procedures for PMI Using the Thermo Scientific Niton XL3 800 Series Alloy 
PMI Tool with Software Version 7.0 or Higher

Standard Operating Procedure October 2009

1. DOCUMENT PURPOSE

1.1. This document is intended for use as a guide for performing Positive Material 
Identification (PMI) using the handheld Thermo Scientific Niton XL3 800 Series x-ray 
fluorescence (XRF) alloy analyzer in the field to ensure compliance with the refinery 
procedures for ensuring Positive Material Identification.

2. SAFETY

2.1. Any persons, including refinery personnel and their representatives, using approved alloy 
analyzers at the refinery will be given a safety orientation by the PMI coordinator (or his /her 
approved instructor) prior to using any PMI device.

2.2. The safety orientations will include the following as a minimum:

2.2.1. Radiation safety for x-ray fluorescence analyzers covering safe operation of the device 
and emergency procedures in case of malfunction or unit damage during field use.

2.2.2. Personnel will demonstrate and acknowledge satisfactory understanding of safe 
operation by passing and signing a written test for each analyzer to be used. This 
documentation is to be kept on file by the PMI coordinator or his/her designee.

2.3. PMI coordinator will periodically audit field use of instruments for compliance with 
safety procedures.

3. PERSONNEL AUTHORIZED TO CONDUCT PMI INSPECTIONS

3.1. Refinery inspection personnel who have completed safety-training requirements.

3.2. Refinery’s designated contractor representatives. These representatives are people who 
have demonstrated to the PMI coordinator or his/her designee that in addition to the safety 
requirements, they also have a firm understanding of the Niton® XL3 800 Series alloy analyzer 
operation, auto-calibration frequency requirements, and PMI job goals and objectives.

3.3. All authorized PMI personnel will be familiar with and have copies of the following 
documents available to them:

3.3.1. Thermo Scientific Niton XL3 800 Series User Guide
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3.3.2. API Recommended Practice 578 – Material Verification Program for New and Existing 
Alloy Piping Systems. 

3.3.3. PMI Field Procedures (e.g., this document)

3.3.4. Other documentation as specified 

4. PRE-INSPECTION Niton XL3 800 ANALYZER START UP AND CALIBRATION

4.1. Startup and Stabilization

4.1.1. Turn on, accept the radiation warning (if you are trained), and log into (enter 
password) the Niton XL3 800 Series analyzer. Allow 5 minutes for the analyzer to stabilize 
BEFORE proceeding. 

4.1.2. Calibrate the analyzer by pressing the “System Check” icon. This will start the detector 
auto calibrate process. When the Niton XL3 instrument completes the auto calibration, press 
the “Sample Type” icon, press the “Metals” icon and then the “General Metals” icon. Measure 
the check sample as directed in 4.2.1. If it reads correctly, testing may start (see 4.5). 

4.2. Verify the Calibration. 

4.2.1. Test the factory supplied 1¼Cr-½Mo alloy standard (or other approved check sample). 
If the sample is correctly identified and all major elements (Cr and Mo primarily) read within 
calculated acceptance limits (see factory QC readings), testing may start (see 4.5). 

4.2.2. If the check sample does not read correctly, then re-calibrate the analyzer by pressing 
the “System Check” icon. This will start the auto calibration. When the Niton XL3 
instrument completes the auto calibration, return to “Test” and re-measure the check sample 
as directed in 4.2.1. If it reads correctly, testing may start (see 4.5). If the check sample still 
does not read correctly contact your local Thermo Scientific Niton Service center.

4.3. The need for a hot surface adapter should be determined at this time. If surface 
temperatures of the components to be tested will exceed 315°C/600°F, the operator must 
install the HotfootTM hot surface adapter. If sample temperatures will exceed 315°C/600°F 
but are below 800°F, the user may operate the unit with ~6 mm (~1/4 inch) gap between the 
front measuring plate and the sample. When testing hot surfaces with the weld adapter in 
place, the operator should double the measuring time to maintain precision (compensates for 
the lower signal due to the gap created by the weld adapter and the 3 mm (reduced size) 
aperture. Accuracy compensation is handled automatically by the Niton XL3 software. 

4.4. If measurements will be taken on vibrating surfaces, hold the analyzer a few millimeters 
(~1/8 inch) away from the vibrating surface and double the measuring time to maintain 
precision. All concentration accuracy compensation (for the gap) is handled automatically by 
the Niton XL3 software (up to maximum of 6 mm). 



 5 
PMI Analysis

Thermo Scientific Niton XL3 Analyzer User’s Guide 123

4.5. Check the analyzer for material-specific performance prior to any actual testing. 
Typically, this should be done using a Certified Reference Material (CRM) or Reference 
Material (RM) such as an ARMI CRM. The CRM(s) used in this procedure should represent 
each of the materials expected to be encountered during inspection. A kit of 15 PMI 
refinery-specific CRM alloys is available upon request. Contact Thermo Scientific Niton 
Analyzers or your representative for a quote.

5. FIELD TESTING REQUIREMENTS

5.1. Prior to beginning testing, the specific PMI testing and documentation requirements for 
the job should be discussed with the PMI coordinator or his designee. Data storage can be 
accomplished in real time at the exact test site by utilizing optional data download button 
storage devices and position indicators that affix directly to the measured piece or location. 
Contact Thermo Scientific Niton Analyzers or your representative for a quote.

5.2. Good surface preparation is essential for obtaining accurate test results. All non 
representative material (e.g., paint, coating, scale) must be removed prior to testing. This can 
be accomplished by using hand files, grinders, pneumatic rotary files, etc. to obtain a clean 
metal area on which to conduct the test. Test areas on welds may have to be ground flat. Note: 
The battery powered Makita 9500D cordless angle grinder with several extra batteries has 
been found to provide good service with rapid surface preparation.

5.3. Test time for the Niton XL3 Series will be a minimum of 5 seconds for grade 
identification and 10 seconds for chemical analysis. If used in the Spectral Fingerprints mode, 
testing time may be reduced to 3-5 seconds for identification. Although the analyzer may 
display a result before the specified time interval, the operator should continue to measure 
until the specified time has elapsed. Note sections above and below covering special cases that 
require longer measuring times.

5.4. One test point for each piping component (pipe, tee, ell, etc.) is required. Weld test 
requirements vary according to size. See Section 6.

5.5. Minimum documentation for field work will include:

5.5.1. An isometric drawing or sketch of the as-installed and tested piping or equipment. This 
drawing should include equipment ID and piping line number, or other documentation 
reference(s) as specified.

5.5.2. Alloy chemistry documentation for the primary elements required to provide PMI of 
the alloy grade for all units tested.

5.5.3. Documentation must be signed and dated by the personnel that performed the tests; 
the signed documentation is then given to the PMI coordinator or designee.

5.5.4. The PMI coordinator or designee may require additional documentation, which will be 
specified prior to testing. Electronic copies of the encrypted Niton Data Transfer (NDT©) 
files should be maintained in addition to paper copies.
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6. WELDS – NEW AND EXISTING INSPECTION

6.1. Prior to welding, consumables should be tested as indicated in 6.6 below. 

6.2. Number of test locations per weld:

6.2.1. ¾” to 1-½” butt welds – One test point.

6.2.2. ¾” to 2” socket welds – One test point.

6.2.3. 2” to 4” butt welds – Two test points.

6.2.4. 6” and larger weld – At least four test areas evenly distributed around the circumference 
of the weld should be inspected. If no discrepancy is found, the average of the primary 
identifier element chemistries for all areas tested on that weld can be used for documentation.

6.3. At the discretion of the inspector, as in the case of large diameter welds or at any other 
time deemed necessary to ensure correctness of the weld material, additional locations on the 
weld may be tested.

6.4. When testing welds, care must be taken to position the analyzer window to read only the 
weld, with no false reading from the adjacent piping component.

6.4.1. If weld is smaller than the measuring aperture (smaller than 10 mm), insert the weld 
adapter and activate the Weld Mode with the Weld Icon. If your analyzer did not come with 
the optional weld adapter, there will not be a Weld Mode. Contact Thermo Scientific Niton 
Analyzers or your representative for a quote.

6.4.2. The weld adapter should reduce the measurement aperture width to a size smaller than 
the width of the weld to be tested, or 

6.4.3. If the optional weld adapter is not an acquired accessory, it is possible to isolate the weld 
by masking adjacent metal with a non readable material, such as several layers of pure 
aluminum tape. Care should be taken that no readable elements are contained in the mask 
material and that the mask material is thick enough to prevent read through from the 
underlying material.

6.4.4. Double the measuring times when using the weld adapter (e.g., increase from 5 source 
seconds to 10 source seconds for ID, and from 10 to 20 seconds for chemistry), to 
compensate for the added gap and reduced surface area being tested. 

6.5. Testing of welding consumables shall be performed as follows:

6.5.1. Each and every box of weld rod to be used for the job will be prepared by first puddling 
a sample using at least two passes and grinding smooth for testing.

6.5.2. Documentation for the weld rod tested should include: 

6.5.2.1. Rod designation

6.5.2.2. Manufacturer’s name
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6.5.2.3. Box lot number

6.5.2.4. Element composition of samples

6.5.3. Rod box will be marked PMI CONFIRMED with:

6.5.3.1. Name of authorized person who performed the testing

6.5.3.2. Date tested

6.5.3.3. Other information as specified (e.g., vendor or contractor ID)

6.5.4. GTAW (TIG) wire can often be tested directly from the box either individually with a 
slot aperture or by using several pieces to cover more of the aperture window of the analyzer. If 
satisfactory results cannot be obtained, then puddling and grinding of the wire should be 
performed as specified in 6.5.1.

7. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact with or that do not fully 
cover the measurement aperture)

7.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two. 
(e.g., from 5 seconds to 10 seconds for ID and from 10 to 20 seconds for chemistry).

7.1.1. Undersized samples should be placed in the Thermo Scientific portable alloy test stand 
(optional), which is shielded to prevent radiation exposure to the operator. (NOTE: An 
undersized sample – one that does not cover the entire measuring aperture – measured while 
lying on another material such as, e.g., a stainless steel table top, will be affected by the signal 
coming from the table top itself.) Be sure to employ the Disable Al feature if measuring on an 
aluminum table or any plastic or wood table. Use “Tools,” then select “Disable Al.” Be sure to 
use Tools to “Enable Al” before testing aluminum alloys. 

7.2. Non-contact sample measurements include those measured with a gap of up to a 
maximum of ¼ inch (~6 mm) from the Niton XL3 measurement aperture opening. Such 
measurements require double the exposure time. (e.g., from 5 seconds to 10 seconds for ID 
and from 10 to 20 seconds for chemistry). 

7.3. Inside pipe measurements on pipes that are less than a few feet in diameter will result in 
non-contact measurements. Follow recommendations in 7.2 above.

8. INSTRUMENT QC

8.1. Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once for every 
2 hours of use time. If correct, continue work. If incorrect, recalibrate the Niton XL3 detector 
and re-take the past 2 hours of results.
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9. STAMPS

9.1. All stamping is done with a specified proprietary stamp.

9.2. All stamps purchased for special marking should be marked with a control number. A list 
indicating the number and location of these stamps is held by the PMI coordinator.

9.3. Typically, a stamp is assigned to each individual analyzer and stays in the respective 
analyzer’s field carry bag.

9.4. Report any loss of a stamp immediately to the PMI coordinator or designee.

10. WHEN TO USE AN APPROVED STAMP

10.1. Materials and components should be tested prior to fabrication. This will help find any 
discrepancies before final field inspection and prevent costly field cut outs.

10.2. Items checked prior to fabrication and before the final as-installed condition will only be 
marked with approved paint pen as “PMI CONFIRMED.”

10.3. Chemistry documentation may not be necessary for this phase of the PMI inspection.

10.4. The number of components and type tested should be documented for the job.

10.5. Discrepancies should be noted and handled as specified in the appropriate procedures 
document.

10.6. Shop made spool pieces may be stamped, providing that their final field location in the 
piping system can be tracked and documented. Final field installation must be confirmed by 
visual inspection for the stamp.

10.7. Use of any approval stamp should be in accordance with the appropriate company 
procedures document for PMI on existing equipment.

10.8. Use of an approval stamp does not negate the need for the written documentation.

11. RESOLUTION OF DISCREPANCIES

11.1. When analysis indicates a wrong material, component, or weld, then take the following 
steps:

11.2. Test several other areas on the same component. For welds, check adjacent components.

11.3. Check the analyzer calibration against the check sample or other known sample.

11.4. If performing pre-fabrication testing, components having reached this point must be 
rejected according to established procedures.

11.5. Discrepancies on field installed or in-place existing materials requires notifying the 
responsible inspector and completing the following items:
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11.5.1. Complete chemistries should be taken for all elements present in the suspect material 
to help identify the material.

11.5.2. Review the test data for the suspect component, and, if possible, confirm the results 
using a second analyzer.

11.5.3. If conclusive results cannot be obtained with field analyzers, the inspector may request 
a lab analysis on a small sample material removed from the component.
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FAC Analysis

Field Procedures for Measurement of FAC Predictor Elements Cr, Cu, Mo Using the 
Thermo Scientific Niton XL3 800 Series Alloy Analyzer with Software Version 7.0 or 
Higher

1. DOCUMENT PURPOSE

1.1. This document is intended for use as a guide for using the handheld Thermo Scientific 
Niton XL3 800 Series x-ray fluorescence (XRF) alloy analyzer as a tool in performing Flow 
Accelerated Corrosion (FAC) data modeling to ensure that proper measurement parameters 
are followed to reach indicative low-level concentrations of Cr, Cu, and Mo.

2. SAFETY

2.1. Any persons, including power plant personnel and their representatives, using approved 
alloy analyzers at the plant will be given a safety orientation by the FAC coordinator (or 
his/her approved instructor) prior to using any XRF inspection device.

2.2. The safety orientations will include the following as a minimum:

2.2.1. Radiation safety for x-ray fluorescence analyzers covering safe operation of the device as 
well as emergency procedures in case of malfunction or unit damage during field use.

2.2.2. Personnel will demonstrate and acknowledge satisfactory understanding of safe 
operation by passing and signing a written test for each analyzer to be used. This 
documentation is to be kept on file by the FAC coordinator or his/her designee.

2.3. FAC coordinator will periodically audit field use of instruments for compliance with 
safety procedures.

3. PERSONNEL AUTHORIZED TO CONDUCT MEASUREMENT OF FAC PREDICTOR 
ELEMENTS

3.1. Power plant inspection personnel who have completed safety-training requirements.

3.2. Power plant’s designated contractor representatives. These representatives are people who 
have demonstrated to the FAC coordinator or his/her designee that in addition to the safety 
requirements, they also have a firm understanding of the Niton® XL3 800 Series alloy analyzer 
operation, auto-calibration frequency requirements, and FAC program goals and objectives.

3.3. All authorized inspection personnel will be familiar with and have copies of the following 
documents available to them:

3.3.1. Thermo Scientific Niton XL3 800 Series User Guide
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3.3.2 Thermo Scientific Niton NDT Data Transfer User’s Guide

3.3.3 Flow Accelerated Corrosion in Power Plants, EPRI Publication, 1996

3.3.4. Other documentation as specified

4. PRE-INSPECTION Niton XL3 800 ANALYZER START UP AND CALIBRATION

4.1. Startup and Stabilization

4.1.1. Turn on, accept the radiation warning (if you are trained), and log into (enter 
password) the Niton XL3 800 Series analyzer (see Figures 1 & 2). 

Figure 73. Warning Screen 
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Figure 74. Virtual Numeric Keypad for Log On

4.1.2. Ensure that the filters are properly set up for the measurement: From “Main Menu” 
select “Advanced” -> ”Element Range” (see Figure 1-3). In the drop-down box select “General 
Metals”. Ensure that the boxes are checked for “Main Range” and “Low Range”. Ensure that 
the “Time” boxes show “10.0” in both the “Main Range” and “Low Range” boxes (see Figure 
1-4). If not, -> “Main Range Time” -> “C” to clear existing entry -> “1”, “0”, “E” to enter the 
desired time of 10 seconds. Repeat for the “Low Range Time” if so required (see Figure 1-5). 
Ensure that the “Filter Change on Time Only” is checked. Then press “Save”.

Figure 75. The Element Range Menu Path
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Figure 76. Range Checkboxes, Range Time, and Time Only Checkbox

Figure 77. Range Time Editor

4.1.3. Set up the screen display so that Cr, Cu, and Mo are always displayed, and are shown 
prominently at the top of the displayed element list: From “Main Menu” select “Advanced” -> 
“Element Sorting” (see Figure 1-6). In the drop down box select “Alloy Mode” (see Figure 7); 
in the element box scroll down and highlight Cr; in the “Display Options” box select “Always 
Display”; then using the blue arrow keys at the right of the screen use the up arrow to move 
Cr to the top of the element table; repeat this procedure for Cu and Mo respectively, first 
marking them as “Always”, then moving them up the element table to immediately below Cr. 
Press “Save” -> “Close” -> “Close” -> “Return” -> “Return” to reach the Main Menu. See 
Figure 1-8.
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Figure 78. Sort Element Display Menu Path

Figure 79. Sort Element Display
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Figure 80. Sorting Options Screen

4.1.4. Calibrate the analyzer by pressing the “System Check” icon, (see Figure 9). This will 
start the detector auto-calibrate function. When the Niton XL3 instrument completes the 
auto-calibration, return to “Test” and measure the check sample as directed in 4.2.1. If it reads 
correctly, testing may start (see 5.0).

Figure 81. System Check Menu Path

4.2. Verify the Calibration.
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4.2.1. Test the factory supplied 1¼Cr-½Mo alloy standard (or other approved check sample). 
If the sample is correctly identified and all major elements (Cr and Mo primarily) read within 
calculated acceptance limits (within the low and high values of factory readings found on QC 
sheet), testing may start (see 5.1). 

4.2.2. If the check sample does not read correctly, then re-calibrate the analyzer by pressing 
the “System Check” icon (see Figure 9). This will start the auto-calibration. When the Niton 
XL3 instrument completes the auto-calibration, return to “Test” and re-measure the check 
sample as directed in 4.2.1. If it reads correctly, testing may start (see 5.0). If the check sample 
still does not read correctly, contact your local Thermo Scientific Niton service center.

4.3. If a weld of less than 10 mm is to be analyzed, it will be necessary to reduce the analysis 
area from the 10 mm normal aperture size to a size below that of the weld bead. See section 
6.4.1.

4.4. Check the analyzer for sensitivity performance for Cr, Cu, and Mo prior to any actual 
testing. Typically, this should be done using a Certified Reference Material (CRM) such as an 
ARMI CRM. The CRM(s) used in this procedure should represent each of the materials 
expected to be encountered during inspection.

5. FIELD TESTING REQUIREMENTS

5.1. Prior to beginning testing, the specific testing and documentation requirements for the 
job should be discussed with the FAC coordinator or his designee. Data storage can be 
accomplished in real time at the exact test site by utilizing optional data download button 
storage devices and position indicators (compact memory button – CMB) that affix directly 
to the measured piece or location. Contact Thermo Scientific Niton Analyzers or your local 
representative for a quote.

5.2. Good surface preparation is essential for obtaining accurate test results. All 
non-representative material (e.g., paint, coating, scale) must be removed prior to testing. An 
approximately 2-inch-square section of surface should be cleaned down to fresh or “white” 
metal using an abrasive flapper wheel. The cleaning should not be performed using the same 
wheel that was used to prepare the component for ultrasonic testing (UT), but should be 
performed using a fresh wheel, designated for this operation only. Wheels that have been used 
on high chromium alloyed components (e.g., 300 series chromium-nickel stainless steels, or 
chromium steels) should not be used to clean carbon steel components. The area to be 
sampled should be wiped clean or blown with air to remove any grinding dust before testing.

5.3. Test time for the Niton XL3 Series will be a minimum of 10 seconds on each filter for 
accurate chemistry analysis. Since two filters (Main and Low) are required for the targeted low 
concentrations, the total test time shall be a minimum of 20 seconds. Although the analyzer 
may display a result before the specified time interval, the operator should continue to 
measure until the specified time has elapsed. Note sections above and below covering special 
cases that require longer measuring times.

5.4. One test point for each piping component (pipe, tee, ell, etc.) is required. Weld test 
requirements vary according to size. See Section 6.
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5.5. Minimum documentation for field work will include:

5.5.1. An isometric drawing or sketch of the as-installed and tested piping or equipment. This 
drawing should include equipment ID and piping line number, or other documentation 
reference(s) as specified.

5.5.2 Documentation must be signed and dated by the personnel that performed the tests; the 
signed documentation is then given to the FAC coordinator or designee.

5.5.4. The FAC coordinator or designee may require additional documentation, which will be 
specified prior to testing. Electronic copies of the encrypted Niton Data Transfer (NDT©) 
files should be maintained in addition to paper copies.

6. WELDS – NEW AND EXISTING INSPECTION

6.1. Prior to welding, consumables should be tested as indicated in 6.5 below.

6.2. Number of test locations per weld:

6.2.1. ¾” to 1-½” butt welds – one test point.

6.2.2. ¾” to 2” socket welds – one test point.

6.2.3. 2” to 4” butt welds – two test points.

6.2.4. 6” and larger weld – At least four test areas that are evenly distributed around the 
circumference of the weld should be inspected. If no discrepancy is found, the average of the 
primary identifier element chemistries for all areas tested on that weld can be used for 
documentation.

6.3. At the discretion of the inspector, as in the case of large diameter welds, or at any other 
time deemed necessary to ensure correctness of the weld material, additional locations on the 
weld may be tested.

6.4. When testing welds, care must be taken to position the analyzer window to read only the 
weld, with no false reading from the adjacent piping component.

6.4.1. If weld is smaller than the measuring aperture (smaller than 10 mm), insert the weld 
adapter and activate the Weld Mode with the Weld Icon. If your analyzer did not come with 
the optional weld adapter, there will not be a Weld Mode. Contact Thermo Scientific Niton 
Analyzers or your local representative for a quote.

6.4.2. The weld adapter should reduce the measurement aperture width to a size smaller than 
the width of the weld to be tested, or 

6.4.2. If the optional weld adapter is not an acquired accessory, it is possible to isolate the weld 
by masking adjacent metal with a non-readable material, such as several layers of pure 
aluminum tape. Care should be taken that no readable elements are contained in the mask 
material and that the mask material is thick enough to prevent read through from the 
underlying material.
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6.4.4. Double the measuring times when using the weld adapter (e.g., increase from 10 to 20 
seconds per filter for chemistry) to compensate for the added gap and reduced surface area 
being tested.

6.5. Testing of welding consumables shall be performed as follows:

6.5. Testing of welding consumables shall be performed as follows:

6.5.1. Each and every box of weld rod to be used for the job will be prepared by first puddling 
a sample using at least two passes and then grinding smooth for testing.

6.5.2. Documentation for the weld rod tested should include:

6.5.2.1. Rod designation

6.5.2.2. Manufacturer’s name

6.5.2.3. Box lot number

6.5.2.4. Element composition of samples

6.5.3. Rod box will be marked FAC CONFIRMED with:

6.5.3.1. Name of authorized person who performed the testing

6.5.3.2. Date tested

6.5.3.3. Other information as specified (e.g., vendor or contractor ID)

6.5.4. GTAW (TIG) wire can often be tested directly from the box either individually with a 
slot aperture or by using several pieces to cover more of the aperture window of the analyzer. If 
satisfactory results cannot be obtained, then puddling and grinding of the wire should be 
performed as specified in 6.6.1.

7. UNDERSIZED OR NON-CONTACT SAMPLES (samples that do not make contact with or that do not fully 
cover the measurement aperture)

7.1. For samples that do not fully cover the measurement aperture, increase the testing time 
by increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two 
(e.g., from 10 to 20 seconds per filter for chemistry).

7.1.1. Undersized samples should be placed in a Thermo Scientific Niton approved alloy test 
stand (optional), which is shielded to prevent radiation exposure to the operator. (NOTE: An 
undersized sample – one that does not cover the entire measuring aperture – measured while 
lying on another material, such as a stainless steel table top, will be affected by the signal 
coming from the table top itself.) Be sure to employ the Disable Al feature if measuring on an 
aluminum table or any plastic or wood table. Use “Tools,” then select “Disable Al” Be sure to 
use Tools to “Enable Al” before testing aluminum alloys.
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7.2. Inside pipe measurements on pipes that are less than a few feet in diameter will result in 
non-contact measurements. Follow recommendations in 7.2 above.

8. INSTRUMENT QC

8.1. Measure the supplied 1¼ Cr – ½ Mo calibration check sample AT LEAST once for every 
2 hours of use time. If correct, continue work. If incorrect, recalibrate the Niton XL3 detector 
and re-take the past 2 hours of results.

9. RESOLUTION OF DISCREPANCIES

9.1. When analysis indicates an undesirable or anomalous result, take the following steps:

9.2. Test several other areas on the same component. For welds, check adjacent components.

9.3. Check the analyzer calibration against the check sample or other known sample.

9.4. If performing pre-fabrication testing, components having reached this point must be 
rejected according to established procedures.

9.5. Discrepancies on field-installed or in-place existing materials require notification of the 
responsible inspector and completing the following items:

9.5.1. Review the test data for the suspect component, and, if possible, confirm the results 
using a second analyzer.
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Coatings Analysis

Coating Thickness Measurement Using the Thermo Scientific Niton XL3 800 Series 

X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and Higher

Standard Operating Procedure

October 2009
Note  Each user should read the Thermo Scientific Niton XL3 User’s Guide carefully before 
initiating measurements with the system. Users are strongly urged to attend the Thermo 
Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses offered 
regularly, or the web-based trainings. For more information, visit www.thermo.com/niton.

Preparatory Tasks

1. Attach a charged battery to the analyzer and turn it on. Follow the screen instructions and 
Log On as the operator using either the default password or a custom one as designated by the 
user in an NDU file.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be displayed 
for verification. If the date is incorrect, correct it prior to proceeding. This can be done by 
returning to the System Menu and selecting the Date & Time icon. See Setting the Date and 
Time for detailed information on this procedure. 

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. See Connecting the XRF Analyzer to Your PC for more 
information.

5. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select the System Check icon, and select the Yes Button. (Figure 1.)

6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.

http://www.thermo.com/niton
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6.2. If the unit shows a failure error, then perform a second System Check by selecting the 
Recheck Button. If the unit still does not show a “System OK,” please contact Thermo 
Scientific Niton Analyzers toll-free at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 82. System Check Menu Path

7. Verify and/or change filter position time. 

Thermo Scientific Niton XL3 analyzers are equipped with 2 excitation filters that optimize 
the analyzers’ sensitivity for various elements. The “Main Range” filter provides optimum 
sensitivity for the elements manganese (Mn) through bismuth (Bi). The “Low Range” filter is 
used to optimize the sensitivity for the elements from titanium (Ti) through chromium (Cr). 
Note that the main range filter can be used to analyze Ti, V and Cr, but the sensitivity is not 
as good as when using the low filter. The amount of time that the analyzer spends in each 
filter position is user definable. Please note that the analyzer will continue alternating 
excitation filters until the user selectable maximum analysis time is reached or the operator 
terminates the measurement. To verify or change the length of time each filter will be active, 
do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 1-2)

In the drop-down menu, select the mode that is intended for use (i.e., General Metals, 
Electronics Metals).

7.2 Select the box next to Main Range and Low Range so that a check mark appears in each 
box.

7.3 Enter the desired length of time for each filter. For example, set values of 5 seconds for the 
Main Range and 5 seconds for the Low Range as shown in Figure 1-3. 

7.4 Select the Save Button and return to the Main Menu by selecting the Return icon.

mailto://niton@thermofisher.com
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Figure 83. Element Range Menu Path

Figure 84. Setting Element Ranges

8. Verify instrument measurement accuracy using the 1¼Cr ½Mo certified reference material 
(CRM) supplied with the analyzer. 

8.1 Test the factory-supplied 1¼Cr-½Mo alloy standard (or other approved check sample) 
based on a 20s measurement using main range filter only (see Figure 3). If the sample is 
correctly identified and all major elements read within calculated acceptance limits (within 3 
sigma of the average value of factory readings, proceed to General Testing Protocol section.
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8.2 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the System Check described in step 7, then repeat the reference sample analysis 
in step 8.1.

8.3 If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

Coatings Entries and Standardization

How to Access Metal Coatings Mode

To access Metal Coatings mode follow the sequence shown in Figure 4.

Figure 85. Metal Analysis Menu Path

If no coatings method entries have been loaded, screen A in Figure 1-5. will appear. Press the 
Add Button, which brings up a Virtual Keyboard, and enter a method name, which will bring 
you to screen B. Follow the steps in Creating a Metal Coatings Entry to create a new entry.

If method entries have been loaded, screen C will appear. Select desired method from drop 
down menu. If you need to add more methods, select the Edit Methods Button to open 
screen A.
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Figure 86. Screens A, B, and C

Creating a Metal Coatings Entry

Before coating thickness can be measured, a Coatings System Entry must be made defining 
the coatings system (see Figures 7-11). Note that the Coatings Method Menu can be accessed 
via the steps outlined in Figures 1-4 and 1-5 above or via the Tools Menu. See Using the Tools 
Menu for more information on the Tools Menu.

A
B C
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Figure 87. Accessing the Tools Menu - Select Coatings Method Button

Figure 88. Coating System Screen 

When creating a coating system, select the Add Button to activate the Virtual Keyboard and 
enter the name of a coating system (e.g. test). Once the name is created, select the coatings 
thickness units, substrate (type of metal to be coated) and layers (metal coatings) from the 
individual pull-down menus. See Figure 7.
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Figure 89. Entering Units, Substrate, and Layer Information

Standardize Feature

The Standardize feature is a standardization routine that corrects for any bias in thickness 
measurement when compared to a known thickness sample or thickness standard. 

To standardize, follow the sequence shown in Figure 1-8. From the Coating Entries screen 
select the Standardize Button. Enter known thickness of Zn layer, e.g. 20.0, and initiate a 
reading. Select the Yes Button to save the standardization.

Figure 90. Standardizing the Coating

Coatings Testing Protocol

Once a methods are created and standardized the analyzer is ready for routine analysis. All 
non-representative material (e.g. dust, oil) must be removed prior to testing. Test times of 10 s 
will generally provide accurate results

Figure 9. shows a typical measurement of Zn thickness over steel. 
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Figure 91. Example Coating Measurement

There is a maximum coating thickness that can be measured. This maximum value, know as 
“infinite thickness”, varies with coating element. If a coating above this value is measured it 
will give the message Saturated as shown in Figure 1-10.

Figure 92. Example Saturated Measurement

Typical infinite thickness values are given in Table 1.
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Table 1: Coating Infinite Thickness

Element Substrate Microns

Au Cu 10

Cd Al 75

Cd Fe 75

Co Fe 50

Co Ti 50

Cr Fe 15

Cu Fe 20

Mo Fe 50

Mo Ti 50

Ni Fe 20

Pt Cu 15

Sn Fe 100

Ti Fe 50

Zn Fe 50

Zr Al 70
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Mining Analysis

Niton XL3 X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and 
Higher

Analyzing Grade and Process Control Mining Samples Using the Thermo Scientific Niton® XL3 Series 
X-Ray Fluorescence (XRF) Analyzer with Software Version 7.0 and Higher

Standard Operating Procedure
Note  Each user should read the Thermo Scientific Niton XL3 Series User’s Guide carefully 
before initiating measurements with the system. Users are strongly urged to attend the 
Thermo Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses 
offered regularly (US only), or contact their local representative for product and safety 
training. For more information, visit www.niton.com.

PREPARATORY TASKS

1. Insert a charged battery into the analyzer and turn it on. See Battery Installation and 
Charging for detailed instructions. Follow the screen instructions and “Log On” as the 
operator using either the default password or one designated by the user in an NDU file.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes. From the Main Menu, select 
the System icon then the Specs icon. The date will be displayed for verification. If the date is 
incorrect, correct it prior to proceeding. This can be done by “Closing” out of the Specs screen 
and selecting the Date & Time icon from the System Menu. See Setting the Date and Time 
for detailed instructions. Select the Return Button to go back to the Main Menu.

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. See Connecting the XRF Analyzer to Your PC for more 
information.

5. During analysis and System Check, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select the System Check icon, and select the Yes Button. (Figure 1.)

Mining_Analysis.htm#General Testing protocol
http://www.niton.com
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6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.

6.2. If the unit shows a failure error, then perform a second System Check by selecting the 
Recheck Button. If the unit still does not show a “System OK,” please contact Thermo 
Scientific Niton Analyzers toll-free at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 93. System Check Menu Path

7. Verify and/or change filter position time. 

Thermo Scientific Niton XL3 analyzers are equipped with excitation filters that optimize the 
analyzers’ sensitivity for various elements. The "High Range" filter is used to optimize barium 
(Ba) through silver (Ag). The “Main Range” filter provides optimum sensitivity for the 
elements manganese (Mn) through bismuth (Bi). The “Low Range” filter is used to optimize 
the sensitivity for the elements from titanium (Ti) through chromium (Cr). Note that the 
main range filter can be used to analyze Ti, V and Cr, but the sensitivity is not as good as 
when using the low filter. The "Light Range" filter is available only with He-purged and 
GOLDD technology analyzers, and is typically used in light element analysis. The amount of 
time that the analyzer spends in each filter position is user definable. Please note that the 
analyzer will continue alternating excitation filters until the user selectable maximum analysis 
time is reached or the operator terminates the measurement. To verify or change the length of 
time each filter will be active, do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 1-2)

In the drop-down menu, select the mode that is intended for use (i.e., General Metals, 
Electronics Metals).

7.2 Select the box next to Main Range, High Range, and Low Range so that a check mark 
appears in each box.

mailto://niton@thermofisher.com


 7 Mining Analysis
Niton XL3 X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and Higher

Thermo Scientific Niton XL3 Analyzer User’s Guide 151

7.3 Enter the desired length of time for each filter. For example, set values of 30 seconds for 
the Main Range, 30 seconds for the Low Range, and 30 seconds for the High Range as shown 
in Figure 1-3. 

7.4 Select the Save Button and return to the Main Menu by selecting the Return icon.

Figure 94. Element Range Menu Path
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Figure 95. Setting Element Ranges

8. Verify instrument measurement accuracy. Depending on the configuration of your 
instrument, you will have been supplied with a set of multi-element reference samples. These 
samples are use to verify that the instrument is performing properly. Use CCRMP TILL-4 
(180-601) to verify the instrument performance in Mining Mode and Soil Mode. The 
nominal element concentrations and acceptable ranges of results for each reference sample are 
shown below in Table 1-1

8.1 Mining

From the Main Menu, select the Sample Type icon, then the Soils & Minerals icon, then the 
Mining Cu/Zn icon (Figure 1-4) or Mining Ta/Hf icon (Figure 1-5) as appropriate. You can 
also use this procedure with TestAll Geo Mode. See GENERAL TESTING 
PROTOCOL below for more information.

Figure 96. Mining Cu/Zn Analysis Menu Path

-OR-
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Figure 97. Mining Ta/Hf Analysis Menu Path

8.1.1. Place the reference sample CCRMP TILL-4 (180-601) in the test stand for analysis, or 
set the reference sample on a clean surface. The unlabeled side should be presented to the 
spectrometer. Place the front end of the instrument against the sample with the window 
centered on the sample. 

8.1.2. Take a 90-second measurements on this reference sample (30 sec. with High Range, 30 
sec. with Main Range, and 30 sec. with Low Range). Prior to measurement, ensure that the 
analyzer has the maximum test time set to 90 seconds or greater. From the Main Menu select 
the Advanced icon, then the Start/Stop Setup icon. Edit the Max. Time dialog box to display 
the proper setting. Calibration factors must be set to factory values. See Start/Stop Setup for 
more information on the Start/Stop Menu, and Adjusting the Calibration for setting 
Calibration factors.

8.1.3. Compare the result with the acceptable ranges listed in Table 1-1; Fe and K for Mining 
mode and Cu ,Ti for Soil mode. The result should fall within these specified values.

* Depending on whether % or ppm is selected for reporting concentration.

8.1.4 If the analyzer reports values within the acceptable ranges of the reference values, it is 
ready for measurement of unknown samples. Proceed to GENERAL TESTING 
PROTOCOL section.

8.1.5 If the analyzer reports values outside the acceptance tolerance ranges specified in Table 
1-1, repeat the System Check described in step 5, then repeat the reference sample analysis in 
step 8.1

8.1.6 If the analyzer again fails to meet the acceptance tolerance ranges specified in Table 1-1, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

Table 1-1 Nominal Concentrations and Acceptable Ranges

Element - Mode Certified Value Minimum Acceptable* Maximum Acceptable*

% Fe - Mining 3.97 % 3.50 % or 35000 ppm 5.0 % or 50000 ppm

% K - Mining 2.68 % 2.3 % or 23000 ppm 3.5 % or 35000 ppm

ppm Cu - Soil 237 ppm 0.02% or 200 ppm 0.028% or 280 ppm 

ppm Ti - Soil 4840 ppm 0.41% or 4100 ppm 0.52% or 5200 ppm 

Parts_and_Accessories.htm#Soil Sample Cups
Parts_and_Accessories.htm#Mylar Film
Parts_and_Accessories.htm#Mylar Film
Parts_and_Accessories.htm#Polystuffing
Parts_and_Accessories.htm#Polystuffing
Parts_and_Accessories.htm#Test Stand
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Adjusting the Element Range
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GENERAL TESTING PROTOCOL

Mining Grade and Production Control samples require analytical capabilities for a range of 
elements and concentrations, as well as sample type. Samples may come out of production 
fully prepared as fine aggregates or powders, or in a less prepared state such as slurry. Similarly, 
they may come out of the mine pit as a whole rock hand sample or in an advanced state of 
preparation as blast chips. Furthermore, measurements may be required in situ on a mine 
wall. Consider the data quality requirements when determining the number of samples and 
the amount of preparation to undertake. When examining the data, consider the state of the 
samples in deciding the number of samples and readings to average.

The proper mode must be utilized obtain useful analytical results. For mining applications 
there are three choices: Mining (divided into Mining Cu/Zn and Mining Ta/Hf) and Soil. 
Mining Mode is used for measuring concentrations of all elements that are 0.5% (5000 ppm) 
or greater, or high concentration samples. Soil Mode is best for low concentration elements at 
0.5% (5000 ppm) or less. For samples containing high concentrations of elements other than 
those of primary interest, it is best to use Mining Mode for analysis. Mining Mode is a 
fundamental parameters (FP) calibration and will do the best job for all elements, even those 
at lower concentrations, as long as there are high concentrations of any elements present in the 
sample.

There are direct overlaps between the spectral peaks for copper (Cu) and tantalum (Ta) and 
zinc (Zn) and hafnium (Hf ). Handheld XRF technology cannot distinguish between these 
sets of elements. Cu and Zn are associated with each other as are Ta and Hf. Therefore, if the 
samples contain Cu or Zn, choose Mining Cu/Zn; if the samples contain Ta or Hf, choose 
Mining Ta/Hf mode.

Representative Sample

Homogeneity of samples is extremely important when considering whether or not to average 
readings. Non-homogenous samples contain different concentrations of elements at different 
points across the sample. Averaging a few or many measurements is often the best way to 
determine whole rock or area concentrations. This averaging gives the user a more complete 
information set over a specific area than would a single measurement. The other option with 
inhomogeneous samples is to fully prepare them, which then homogenizes the sample in the 
process.

To ensure robustness of the data, two criteria must be met when samples are presented to the 
analyzer. The first is that the sample must cover the analysis window. The window is located 
on the nose of the analyzer, and it is the point at which the x-ray beam is emitted from the 
analyzer and fluoresced x-rays are collected by the detector. It must be as close to the sample as 
possible for the entire measurement time, contact with the sample is required. The second 
condition is that the sample needs to be “infinitely thick.” Infinite thickness refers to having 
enough sample depth so that even if the depth of the sample were increased, no additional 
fluoresced x-rays would be produced and reach the detector.

Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
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Testing time affects detection limit and precision and is set by the user. For best results, each 
required filter should be activated for a minimum of 30 seconds. For analysis of mining 
samples, it is not unusual for measurement to take 60 seconds or more per filter. If 
concentrations of the elements of interest are high enough, and the range of acceptable values 
broad enough, shorter measurement times may be sufficient to achieve the desired results. For 
example, if it is necessary to determine whether a sample contains more or less than 1000 ppm 
of lead (Pb), 30 seconds on the Main Filter may be sufficient sampling time. In contrast, if the 
question is whether or not a sample contains 100 ppm of copper, suggested testing time is for 
a minimum of 60 seconds on the Main Filter. If the error is too great, increasing the testing 
time by a factor of four will decrease the error by 50%.

Sample Preparation

In situ samples are analyzed as is, on site, and with no sample preparation performed. Sample 
preparation can increase accuracy of data when compared to other analytical techniques. A 
fully prepared sample is one that is dried, crushed, ground, sieved, and loaded into a sample 
cup. Any intermediate step in the preparation process may be achieved and determined 
acceptable by the user.

Using He-purged and/or GOLDD analysis will both expand your element range (down to 
Mg) and give extremely low LODs, but can have other consequences. At these low Z elements 
and levels, contamination of the sample is a factor, and fingerprints, dust, oil, and other 
chance contaminants can give a false reading. Any samples, even in-situ, must be as clean as 
possible, given the nature of the sample and the circumstances of the reading. Condition of 
the sample should be noted if possible.

32mm Sample Cups first must be assembled if they are going to be used as part of the sample 
preparation process. They are assembled by placing a Mylar Film 2.5" dia. 6m thick on top of 
the sample cup collar. Then the sample cup cylinder is pressed into the collar so that the film 
is pulled tightly between the collar and cylinder, creating an enclosure. Next, the sample cup is 
turned over with the film down so that sample material can be placed and tamped into the 
cup. Place a Filter Paper 2.4cm dia. on top of the material, when the material reaches the line 
close to the top of the cup. Then place Polystuffing on top of the filter so that when the 
sample is inverted, the material is held firmly against the Mylar film. Last, place the sample 
cap on top of the batting and, if desired, affix a label to the cap.

There is a Portable Test Stand available for fixed bench or portable location (such as the 
tailgate of a truck) use.

Grade Control Samples

In-situ Measurements

In-situ Measurements – Measurements taken directly on the wall or floor of the mine are in 
situ. This is considered the most basic type of measurement because there is no sample 
preparation performed.

Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Parts_and_Accessories.htm#Soil Sample Cups
Parts_and_Accessories.htm#Soil Sample Cups
Parts_and_Accessories.htm#Soil Sample Cups
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Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
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1. Determine whether to average readings over a pre-determined area or to just take one spot 
measurement. See Avg Forward to set the averaging function for the analyzer.

2. Set the appropriate filters and reading times. See Adjusting the Element Range to set and 
save the filter settings.

3. If desired, set beeps to activate at the end of the predetermined measurement time. See 
Setting up Audio Cues for instructions to set beep times.

4. Grasp the analyzer by the handle, ensuring the wrist strap is properly placed on the wrist.

5. Position the analyzer on the desired analysis spot, ensuring that the nose of the analyzer is 
making contact with the rock face, and then initiate a reading. Continue the reading for the 
predetermined measurement time, and stop the reading when measurement is complete. 

6. Repeat to complete averaging over an area or move to different spot and repeat for a new 
measurement.

Hand Sample

If analysis of hand samples is required, they can be treated much like in-situ samples when 
performing analysis and interpreting the data.

1. Determine whether to average multiple readings or to take one measurement. See Avg 
Forward to set the averaging function for the analyzer.

2. Set the appropriate filters and reading times. See Adjusting the Element Range to set and 
save the filter settings.

3. If desired, set beeps to activate at the end of the predetermined measurement time. See 
Setting up Audio Cues for instructions to set beep times. 

4. Grasp the analyzer by the handle, ensuring the wrist strap is properly placed on the wrist.

5. Position the sample so that the analyzer may be safely operated, accounting for ALARA 
principals – as low as reasonably achievable. Place the nose of the analyzer on the desired 
analysis spot, ensuring that the nose of the analyzer is touching the sample, and then initiate a 
reading. Continue the reading for the predetermined measurement time, and stop the reading 
when measurement is complete. 

6. Repeat to complete averaging or choose a new sample and repeat.

Blast Hole Samples

Blast Hole Samples contain material sizes from fine-grained to chips and chunks. To ensure 
that infinite thickness is maintained and the sampling area will be covered, it is advisable to 
place these samples in a bag or sample container for analysis.

Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
Parts_and_Accessories.htm#Soil Sample Cups
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
Advanced_Settings.htm#Setting up Audio Cues
Parts_and_Accessories.htm#Soil Sample Cups
Parts_and_Accessories.htm#Soil Sample Cups
Parts_and_Accessories.htm#Filter Paper
Parts_and_Accessories.htm#Polystuffing
Parts_and_Accessories.htm#Polystuffing
Advanced_Settings.htm#Averaging Results
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1. Determine whether or not to average multiple readings or to take one measurement per bag 
or cup. See Avg Forward to set the averaging function for the analyzer.

2. Set the appropriate Ranges and reading times. See Adjusting the Element Range to set and 
save Range settings.

3. If desired, set beeps to activate at end of predetermined measurement time. See Setting up 
Audio Cues for instructions to set beep times.

4. Grasp the analyzer by the handle ensuring the wrist strap is properly placed onto the wrist.

5. Position the sample so that the analyzer may be safely operated accounting for ALARA 
principals. Place the nose of the analyzer on the spot where analysis is desired, ensuring the 
nose of the analyzer is touching the sample, and initiate a reading. Continue the reading for 
predetermined measurement time and stop the reading when measurement is complete.

6. Repeat to complete averaging, or choose a new sample and repeat.

Process Control Samples

Measurements taken after the initial crushing of mine material can be treated much like Blast 
Hole Samples in the Grade Control section because of their similarly inconsistently sized 
particles.

1. Determine whether to average multiple readings or to take one measurement per bag or 
cup. See Avg Forward to set the averaging function for the analyzer.

2. Set the appropriate Ranges and reading times. See Adjusting the Element Range to set and 
save Range settings.

3. If desired, set beeps to activate at end of predetermined measurement time. See Setting up 
Audio Cues for instructions to set beep times.

4. Grasp the analyzer by the handle ensuring the wrist strap is properly placed onto the wrist.

5. Position the sample so that the analyzer may be safely operated accounting for ALARA 
principals. Place the nose of the analyzer on the spot where analysis is desired, ensuring the 
nose of the analyzer is touching the sample, and initiate a reading. Continue the reading for 
predetermined measurement time and stop the reading when measurement is complete.

6. Repeat to complete averaging, or choose a new sample and repeat.

Powders and Fine Aggregates

Samples that may come out of a ball mill or similar device will be finer-grained and contain 
more consistent particle sizes than any of the previously discussed sample types. Therefore, it 
is appropriate to use a sample cup if desired for analysis.

Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Adjusting the Element Range
Advanced_Settings.htm#Setting up Audio Cues
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1. Determine whether to average multiple readings or to take one measurement per bag or 
cup. See Avg Forward to set the averaging function for the analyzer.

2. If using 32mm Sample Cups, ensure the cup is properly assembled. Load the sample by 
placing a few scoops of material into the sample cup and then tamping. Repeat until the 
material reaches the line just below the top of the cup. Place the Filter Paper 2.4cm dia., the 
Polystuffing, and the cap on top of the sample, in that order. Do not forget to properly 
identify each sample.

3. Set the appropriate Ranges and reading times. See Adjusting the Element Range to set and 
save Range settings.

4. If desired, set beeps to activate at end of predetermined measurement time. See Setting up 
Audio Cues for instructions to set beep times.

5. Grasp the analyzer by the handle ensuring the wrist strap is properly placed onto the wrist.

6. Position the sample so that the analyzer may be safely operated, accounting for ALARA 
principals – as low as reasonably achievable. Place the nose of the analyzer on the desired 
analysis spot, ensuring that the nose of the analyzer is touching the sample, and then initiate a 
reading. Continue the reading for the predetermined measurement time and stop the reading 
when measurement is complete.

7. Repeat to complete averaging, or choose a new sample and repeat.

Concentrates

“Cons” contain relatively high concentrations of the elements of interest and are typically 
measured using Mining Mode. Samples in this stage of production are generally sized so that a 
bag or cup is appropriate for analysis.

1. Determine whether or not to average multiple readings or to take one measurement per bag 
or cup. See Avg Forward to set the averaging function for the analyzer.

2. If using 32mm Sample Cups, ensure that the cup is properly assembled. Load the sample 
by placing a few scoops of material in the sample cup, and then tamping it down. Repeat until 
the material reached the line towards the top of the sample cup. Place the Filter Paper 2.4cm 
dia. the Polystuffing, and the cap on top of the sample, in that order. Do not forget to 
properly identify each sample.

3. Set the appropriate Ranges and reading times. See Adjusting the Element Range to set and 
save Range settings.

4. If desired, set beeps to activate at end of predetermined measurement time. See Setting up 
Audio Cues for instructions to set beep times.

5. Grasp the analyzer by the handle ensuring the wrist strap is properly placed onto the wrist.
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6. Position the sample so that the analyzer may be safely operated accounting for ALARA 
principals. Place the nose of the analyzer on the spot where analysis is desired, ensuring the 
nose of the analyzer is touching the sample, and initiate a reading. Continue the reading for 
predetermined measurement time and stop the reading when measurement is complete.

7. Repeat to complete averaging, or choose a new sample and repeat.

Slurry

The level of moisture in slurry samples is relatively high. Depending on the data quality 
needs, drying prior to analysis may be necessary. Like some of the previously discussed sample 
types, 32mm Sample Cups or bags may be used as long as care is taken to ensure that infinite 
thickness is maintained.

1. Determine whether or not drying samples is appropriate. If so, remove samples from the 
bath and place in the oven for 1 to 24 hours; then place in sample bag or cup, taking care to 
break up the sample if necessary.

2. If using 32mm Sample Cups, ensure that the cup is properly assembled. Load sample by 
placing a few scoops of material in the sample cup, and then tamping. Repeat until the 
material reaches the line towards the top of the sample cup. Place the Filter Paper 2.4cm dia., 
Polystuffing, and the cap on top of the sample, in that order. Do not forget to properly 
identify each sample

3. Determine whether to average multiple readings or to take one measurement per bag or 
cup. See Avg Forward to set the averaging function for the analyzer.

4. Set the appropriate Ranges and reading times. See Adjusting the Element Range to set and 
save Range settings.

5. If desired, set beeps to activate at end of predetermined measurement time. See Setting up 
Audio Cues for instructions to set beep times.

6. Grasp the analyzer by the handle ensuring the wrist strap is properly placed onto the wrist.

7. Position the sample so that the analyzer may be safely operated accounting for ALARA 
principals. Place the nose of the analyzer on the spot where analysis is desired, ensuring the 
nose of the analyzer is touching the sample, and initiate a reading. Continue the reading for 
predetermined measurement time and stop the reading when measurement is complete.

8. Repeat to complete averaging, or choose a new sample and repeat.
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Results Interpretation

Data from fully prepared samples will be comparable with laboratory results for most 
elements from most types of instrumentation within the error limits from both instruments. 
Samples that are less than fully prepared may show some discrepancies depending upon the 
homogeneity of the material in its in situ condition. If the user determines that one sample is 
not representative of an area, then two or more samples from that area may be quickly 
analyzed and averaged to aid in data interpretation. 

If results differ greatly from the user’s expectations, they can always be verified by inspecting 
the spectrum generated by the sample. Two peaks from each element that is present in the 
sample will always be present in the spectrum. X-ray energies for each element can be found 
either on the Thermo Scientific Niton X-ray Energy Reference chart or on the right hand side 
of the NDT software program. In Figure 1-4 below the Ka and Kb peaks of iron (Fe) are 
displayed between the 5.40 and 7.20 energies.

Figure 98. Sample spectrum with Fe Ka? and Kb? peaks at 6.40 and 7.06 respectively
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Soil Analysis

Niton XL3 X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and 
Higher

Analyzing Soil Samples Using the Thermo Scientific Niton® XL3 Series X-Ray Fluorescence (XRF) 
Analyzer with Software Version 7.0 and Higher

Standard Operating Procedure

Note - Each user should read the Thermo Scientific Niton XL3 Series User’s Guide carefully 
before initiating measurements with the system. Users are strongly urged to attend the 
Thermo Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses 
offered regularly (US only), or contact their local representative for product and safety 
training. For more information, visit www.niton.com.

PREPARATORY TASKS

1. Insert a charged battery into the analyzer and turn it on. See Battery Installation and 
Charging for detailed instructions. Follow the screen instructions and “Log On” as the 
operator using either the default password or one designated by the user in an NDU file.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes. From the Main Menu, select 
the System icon then the Specs icon. The date will be displayed for verification. If the date is 
incorrect, correct it prior to proceeding. This can be done by “Closing” out of the Specs screen 
and selecting the Date & Time icon from the System Menu. See Setting the Date and Time 
for detailed instructions. Select the Return Button to go back to the Main Menu.

4. (Optional) Connect the analyzer to a computer via the included serial cable, USB cable, or 
Bluetooth™ wireless module. See Connecting the XRF Analyzer to Your PC for more 
information.

5. During analysis and System Check, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

6. From the Main Menu, select the System Check icon, and select the Yes Button. (Figure 1.)

http://www.niton.com
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6.1. System Check calibrates the detector and verifies it is operating to specifications. After 
starting the process, no further user interaction is required during this operation. When the 
instrument is finished performing the check, the unit will show either “System OK” or one of 
the failure errors.

6.2. If the unit shows a failure error, then perform a second System Check by selecting the 
Recheck Button. If the unit still does not show a “System OK,” please contact Thermo 
Scientific Niton Analyzers toll-free at (800) 875-1578, +1 978 670-7460, 
niton@thermofisher.com, or contact your local Niton Analyzers representative for assistance.

Figure 99. System Check Menu Path

7. Verify and/or change filter position time. 

Thermo Scientific Niton XL3 analyzers are equipped with excitation filters that optimize the 
analyzers’ sensitivity for various elements in different matrices. In Soil Mode, up to three 
filters may be selected, depending on the elements required. The amount of time that the 
analyzer spends in each filter position is user definable. Please note that the analyzer will 
continue alternating excitation filters until the user selectable maximum analysis time is 
reached or the operator terminates the measurement. To verify or change the length of time 
each filter will be active, do the following:

7.1 From the Main Menu select the Advanced icon, then the Element Range icon (Figure 1-2)

In the drop-down menu, select Soils Mode.

7.2 Select the box next to High Range, Main Range, and Low Range so that a check mark 
appears in each box.

7.3 Enter the desired length of time for each filter. For example, set values of 60 seconds for 
the Main Range, 60 seconds for the Low Range, and 60 seconds for the High Range as shown 
in Figure 3. 

mailto://niton@thermofisher.com
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7.4 Select the Save Button and return to the Main Menu by selecting the Return icon.

Figure 100. Element Range Menu Path

Figure 101. Setting Element Ranges

8.1 Verify instrument measurement accuracy (QC check). From the Main Menu, select the 
Sample Type icon, then the Soils & Minerals icon, then the Soils icon. You can also use 
this procedure with TestAll Geo Mode. See GENERAL TESTING PROTOCOL below 
for more information.
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Figure 102. Soil Analysis Menu Path

8.1.1. Place TILL4 Reference Sample (P/N 180-601) (or any other reference sample supplied 
with your instrument) in the test stand for analysis, or set the reference sample on a clean 
surface. The unlabeled side should be presented to the spectrometer. Place the front end of the 
instrument against the sample with the Analysis Window centered on the sample.

8.1.2. Take one 180-second measurement on this reference sample (60 sec. on each Range). 
Ensure that the analyzer has the maximum test time set to 180 seconds or greater. From the 
Main Menu select the Advanced icon, then the Start/Stop Setup icon. Edit the Max. Time 
dialog box to display the proper setting. See Start/Stop Setup for more information on the 
Start/Stop Menu. 

8.1.3. Compare the results with the acceptable ranges as listed in the original accompanying 
Certificate of Calibration sheet, the results should fall within these specified values. 
Depending on the element calibrations provided with your Thermo Scientific Niton XRF 
analyzer, some of the reference sample elements may not be displayed. If your instrument is 
not displaying all elements, check the Element Display option to determine which elements 
are being displayed. To force elements not displayed to display, from the Main Menu, select 
the Advanced icon. Select the Element Sorting icon, then select Soil Mode from the menu. 
Select the element you wish to modify, select Always Display from the drop down list, then 
select the Save Button. Repeat this process for each element you want to change, then select 
the Close Button, select the Close Button again, then select the Return icon.

8.1.4 If the analyzer reports values within the acceptable ranges of the reference values, it is 
ready for measurement of unknown samples. Proceed to GENERAL TESTING 
PROTOCOL section.

8.1.5 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
accompanying Certificate of Calibration sheet, repeat the System Check described in step 5, 
then repeat the reference sample analysis in step 7.1
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8.1.6 If the analyzer again fails to meet the acceptable tolerance ranges specified in the 
accompanying Certificate of Calibration sheet, please contact Thermo Fisher Scientific or 
your local Thermo Fisher representative for assistance.

GENERAL TESTING PROTOCOL

Soil analysis may be performed as either In-Situ Analysis (i.e., in place) or Ex-Situ Analysis 
and (typically) prepared. The results obtained from the XRF instrument may be different on 
the same sample when comparing an unprepared with a fully prepared sample. This is 
generally caused by sample inhomogeneity, particle size effects and moisture content. The 
more time and effort you spend on preparing the sample properly will allow you to obtain 
close-to laboratory grade data, whereas in-situ analysis may only provide “screening” type 
data. The decision to prepare or leave a sample unprepared may be determined by your Data 
Quality Objectives (DQOs). 

Soil mode is a Compton normalized calibration which works over a fairly limited element 
concentration range. It is highly recommended that samples containing high concentrations 
of elements (such as ore samples) be analyzed using the Mining mode (see Mining Analysis). 

In-Situ Analysis

This is the most basic type of measurement as there is little to no sample preparation 
performed. It is typically used for providing screening data to help rapidly define an area of 
contamination for example. 

1. It is highly recommended that you read and follow the USEPA Method 6200 for soil 
analysis.

2. After performing a QC check (see above), place the In-Situ Test Guard over the front nose 
of the instrument. This test guard has 2 main purposes, firstly it helps to keep the front of the 
instrument clean by preventing soil particles from collecting on the window. Secondly it 
provides a solid base for the Proximity Button to engage properly, which can be difficult on 
very loose or powdery samples.

3. Set the appropriate range and analysis times. The analysis times should have been 
previously determined See Adjusting the Element Range to set and save the filter settings.

4. If desired, set beeps to activate at the end of the predetermined measurement time. See 
Setting up Audio Cues for instructions to set beep times.

5. Remove any large or non-representative debris from the soil surface before analysis. This 
debris includes rocks, pebbles, twigs, leaves, concrete, etc. If the surface is unlevel, it may be 
smoothed with a stainless steel trowel or other similar implement. If the soil is saturated with 
water, allow it to dry before starting the analysis.

6. Grasp the analyzer by the handle, ensuring the wrist strap is properly placed on the wrist.

EPA_Method_6200.htm
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7. Enter the sample name, GPS co-ordinates or any other pertinent information regarding the 
sample to maintain appropriate chain-of-custody. See Entering Soil Sample ID for details.

8. Position the analyzer on the desired analysis spot, ensuring that the nose of the analyzer is 
making contact with the soil, and then initiate a reading. 

Continue the reading for the predetermined measurement time, and stop the reading when 
measurement is complete.

9. Confirm that the readings are appropriate and then proceed to next sampling area. Repeat 
steps 6 and 7.

10. Per USEPA Method 6200, a minimum of 1 sample for every 20 analyses (i.e. 5%) should 
be taken and submitted for laboratory analysis. Make sure that as best you can the sample 
taken is the sample that you read, samples can vary immensely over very short distances (a few 
cm). 

11. After completing all the required analysis, rerun the QC standard to confirm stability of 
the instrument. 

12. Download all results (unknown sample readings, QC samples, and system check) and save 
as an appropriately named file. The ndt file created during the download is encrypted and 
provides data integrity. 

Ex-Situ Analysis

This is a more labor-intensive type of analysis as the sample undergoes full preparation. It is 
typically used to quickly provide on-site personnel with laboratory grade data without the 
wait for laboratory analysis, allowing more immediate and accurate decision making to occur. 

1. It is highly recommended that you read and follow the USEPA Method 6200 for soil 
analysis.

2. Samples are procured in the field and generally taken to a fixed location such as an office or 
even a vehicle for preparation and analysis. Sample collection is very important as samples 
collected incorrectly may bias the results. As for the in-situ analysis, non-representative debris 
should be removed (such as twigs, leaves, rocks etc.) before sample collection begins. The 
sample is collected from a 4” * 4” square that is 1” deep (10cm * 10cm * 2.5cm deep). This 
provides enough material to fill an 8oz or 250cm3 specimen jar. Label the jar immediately to 
maintain chain-of-custody requirements.

3. Collect all samples in a similar fashion, and return samples to sample preparation area.

4. Sample preparation must then be performed, samples are dried and homogenized, and then 
ground and sieved. 

5. Samples may be dried rapidly in either a convection or a toaster oven (if the work site has 
electricity), or spread out on a tray and air dried (this takes longer) if power is not available. It 
is generally not recommended to dry samples in a microwave oven.

EPA_Method_6200.htm
EPA_Method_6200.htm
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6. The dried sample should then be well mixed and then split using a technique such as 
coning and quartering that will ensure an even particle size distribution (so you do not bias 
the results). This procedure should be repeated until you have approximately 1oz (25g) of 
representative sample. This sample is then ground with a pestle and mortar until it passes a 
60-mesh (250?m) sieve. 

Note - The remaining unprepared sample should be returned to the container to allow 
duplicate XRF or laboratory analysis if required. It is possible to fully prepare the entire 
sample, but this can be a lengthy process and in-field work does not always allow the analyst 
the time to do this.

7. The ground sample should then be cupped. The 32mm Sample Cups should be assembled 
on a clean surface (to prevent cross-contamination). Place the outer ring on a clean surface. 
Lay a piece of Mylar Film 2.5" dia. 6m thick or Polypropylene Film 2.5" dia. 4m thick over 
the top of the outer ring making sure it is evenly situated over the ring. Take the inner ring 
and press gently but firmly into the inner ring until it is completely together. Check the film 
to ensure there are no rips or tears. Fill the cup with the prepared sample and tamp down to 
ensure there are no air gaps and that the sample is densely packed. When the cup is filled to 
approximately ¼” (6mm) from the top, add a piece of Filter Paper 2.4cm dia. and then a piece 
of Polystuffing over the filter (this will prevent the sample moving in the cup if it is inverted). 
Snap on the cap and label to maintain identification of sample.

8. Perform instrument QC check (see above).

9. The sample cups may then be analyzed. It is best to analyze these in Test Stands so that the 
cup is held firmly against the instrument window and the operator is shielded from any 
back-scattered radiation.

10. Enter the sample name, GPS co-ordinates or any other pertinent information regarding 
the sample to maintain appropriate chain-of-custody. See Entering Soil Sample ID for details.

11. Confirm that the readings are appropriate and then proceed to analyzing next cup.

12. Per USEPA Method 6200, a minimum of 1 sample for every 20 analyses (i.e. 5%) should 
be taken and submitted for laboratory analysis. Some of the remaining split can be used for 
this purpose. 

13. After completing all the required analysis, rerun the QC standard to confirm stability of 
the instrument. 

14. Download all results (unknown sample readings, QC samples, and system check) and save 
as an appropriately named file. The ndt file created during the download is encrypted and 
provides data integrity. 

EPA_Method_6200.htm
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Entering Soil Sample ID

1. From the Main Menu, select the Sample Type icon, then the Soils & Minerals icon, then 
the Soils icon which brings you into the Ready to Test screen.

Figure 103. Soil Analysis Menu Path

2. From the Ready to Test screen, select the Data Entry button, then select the Keyboard icon 
next to the word Sample. This takes you to the virtual keyboard with which you can enter the 
sample identification. When complete, select the Return Button to take you back to the 
Ready to Test screen.

Figure 104. Soil ID Data Entry

3. Additional sample identification information may be entered into other fields if required.



 9 Consumer Goods Analysisniton
Niton XL3 X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and Higher

Thermo Scientific Niton XL3 Analyzer User’s Guide 169

Consumer Goods Analysisniton

Niton XL3 X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and 
Higher

Screening Toys, Children’s Jewelry, and Consumer Products for Lead (Pb) and Other Heavy Metals Using 
the Thermo Scientific Niton XL3 700 Series X-Ray Fluorescence (XRF) Analyzer – Version 7.0 and Higher

Standard Operating Procedure
Note  Each user should read the Thermo Scientific Niton XL3 User’s Guide carefully before 
initiating measurements with the system. Users are strongly urged to attend the Thermo 
Scientific Niton XRF Analyzer Radiation Safety and Operations Training courses offered 
regularly, or the web-based trainings. For more information, visit www.thermo.com/niton.

For the purposes of this document the terms testing and screening are used interchangeably. 
The primary goal of screening is not to accurately analyze the chemical composition of all 
components or parts of the product, but to weed out and eliminate from the market products 
containing prohibited elements.

PREPARATORY TASKS

1. Insert a charged battery into the analyzer and turn it on. Follow the screen instructions and 
“Log On” as the operator using either the default password or a custom one as designated by 
the user in an NDU file.

2. Wait five (5) minutes before using the analyzer, allowing the instrument electronics to 
stabilize.

3. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be displayed 
for verification. If the date is incorrect, correct it prior to proceeding. This can be done by 
selecting the Close Button on the Specs screen, and selecting the Date & Time icon. See 
Setting the Date and Time for detailed information on this procedure.

4. If testing will be performed on small samples, mount the analyzer in its test stand. Any 
sample that does not completely cover the analyzer measuring window (aperture) is 
considered small. Also, samples that have a form of thin sheet, such as foil, paper, fabric, etc., 
should also be analyzed in a test stand.

5. (Optional) Connect the Thermo Scientific Niton 700 Series analyzer to a computer via the 
included serial cable, USB cable, or Bluetooth™ wireless module. See Connecting the XRF 
Analyzer to Your PC

Consumer_Goods_Analysis.htm#ANALYSIS OF UNKNOWN SAMPLES
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6. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer monitors, 
hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) feet (0.7 meters) 
distance between the analyzer and electronic devices.

7. From the Main Menu, select the System Check icon, then the Yes Button.

7.1. System Check standardizes the detector. After starting the process, no further user 
interaction is required during this operation. When the instrument is finished performing the 
check, the unit will show either “System OK” or one of the failure errors.

7.2. If the unit shows a failure error, then perform a second detector calibration. If the unit 
still does not show a “System OK,” please contact Thermo Scientific Niton Analyzers toll-free 
at (800) 875-1578, +1 978 670-7460, niton@thermofisher.com, or contact your local Niton 
Analyzers representative for assistance.

8. Verify and/or change Range time.

Thermo Scientific Niton analyzers are equipped with excitation filters that optimize the 
analyzers’ sensitivity for various elements. The “Main Range” provides optimum sensitivity 
for the elements iron (Fe) through barium (Ba) plus the elements mercury (Hg), lead (Pb), 
and bismuth (Bi). The “Low Range” is used to optimize the sensitivity for the elements from 
titanium (Ti) through chromium (Cr). The "Light Range" filter is available only with 
He-purged and GOLDD technology analyzers, and is typically used in light element analysis. 
The amount of time that the analyzer spends in each Range position is user definable. Please 
note that the analyzer will continue alternating excitation filters until the user selectable 
maximum analysis time is reached or the operator terminates the measurement. To verify or 
change the length of time each filter will be active, do the following:

Figure 105. The Range Menu Path (Main)

To verify or change the length of time each Range will be active, do the following:

Consumer_Goods_Analysis.htm#APPENDIX A
Consumer_Goods_Analysis.htm#APPENDIX A
Consumer_Goods_Analysis.htm#APPENDIX B
Consumer_Goods_Analysis.htm#APPENDIX B
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8.1. From the Main Menu select the Advanced icon, then the Element Range icon.

8.2. In the drop-down menu, select the mode that is intended for use (i.e., Plastics, 
Electronics Metals, or TestAll).

8.3. Select the box next to Main Range and Low Range so that a check mark appears in each 
box.

8.4. Enter the desired length of time for each filter. For example, set values of 50 seconds for 
the Main Range and 10 seconds for the Low Range as shown in Figure 1-2.

8.5. Select Save and return to the Main Menu by clicking Return.

Figure 106. Filter Configuration

9. Verify instrument measurement accuracy. Depending on the configuration of your 
instrument, you will have been supplied one or more multi-element reference samples. These 
samples are use to verify that the instrument is performing properly. There are two polymer 
reference samples; P/N 180-619 and P/N 180-554. You may have also been supplied with a 
modified SAC 305 solder sample, P/N 180-606. Either of the polymer samples can be used to 
verify the instrument performance in Plastics Mode, and the solder sample is used to verify 
Electronic Alloys Mode. The nominal element concentrations and acceptable ranges of results 
for each reference sample are given below in the following tables.

9.1 Plastics. From the Main Menu, select the Sample Type icon, then the Plastics icon.

9.1.1. Place the Multi-element Reference Sample (e.g., PN 180-619) in the test stand for 
analysis, or set the reference sample on a clean surface. The unlabeled side should be presented 
to the spectrometer. Place the front end of the instrument against the sample with the window 
centered on the sample. Due to the length of this check measurement, it is recommended that 
a test stand be used. It can be difficult to hold the analyzer steady on the reference sample for 
the required length of time.

Consumer_Goods_Analysis.htm#APPENDIX A
Consumer_Goods_Analysis.htm#APPENDIX A
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9.1.2. Take three 180-second measurements on this reference sample (120 sec. with Main 
Filter and 60 sec. with Low Filter). Ensure that the analyzer has the maximum test time set to 
180 seconds. From the Main Menu, select the Advanced icon, then the Start/Stop Setup icon. 
Edit the Max. Time dialog box to the proper setting. Average the results. See Averaging 
Results for information on how to average results forward. Select the number of readings to be 
average (in this case 3) and begin measuring.

9.1.3. Compare the averaged results with the acceptable ranges as listed in Tables 1, 2, or 3. 
The averaged results should fall within these specified values. Depending on the element 
calibrations provided with your Thermo Scientific Niton XRF analyzer, some of the reference 
sample elements may not be displayed. If your instrument is not displaying all elements, 
check the Element Display option. From the Main Menu, select the Advanced icon, then the 
Element Sorting icon. Select the mode that you wish to check or modify. Then, set the 
elements you wish to be displayed and not displayed according to the choices in the 
drop-down menu at the bottom of the screen (Always, Normal, and Never).

Table 5: Multi-element Polymer Reference Sample (Niton Part Number 180-619) in Nominal 

Concentrations and Acceptable Ranges (Main Range 120s, Low Range 60s)

Element
Nominal Concentration*

(mg/kg)**

Acceptable Range

(+/- % Rel)
Acceptable Range (mg/kg)

Ba 690 15% 585 - 795

Pb 150 10%135-165 135 - 165

Cr 100 15% 85 - 115

Hg 100 15% 85 - 115

Cd 290 16% 246 - 336

Sb 100 15% 86 - 116

Se 200 15% 173 - 235

As 50 25% 37-63

Table 6: Multi-element Polymer Reference Sample (Niton Part Number 180-554) in Nominal 

Concentrations and Acceptable Ranges (Main Range 100s)

Element
Nominal Concentration*

(mg/kg)**

Acceptable Range

(+/- % Rel)
Acceptable Range (mg/kg)

Br 500 25% 375 - 625

Pb 1000 10% 900-1000

Cr 1000 15% 850 - 1150

Advanced_Settings.htm#Averaging Results
Advanced_Settings.htm#Averaging Results
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* Please refer to the certificate accompanying the reference sample for actual elemental 

composition data.

** Please note that mg/kg is a unit of measure of concentration equal to ppm by mass, i.e., 

1000 ppm is equivalent to 1000 (mg/kg) = 0.1%.

9.1.4 If the analyzer reports values within the acceptable ranges of the reference values, it is 
ready for measurement of unknown samples. Proceed to ANALYSIS OF UNKNOWN 
SAMPLES section.

9.1.5 If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the detector calibration described in step 7, then repeat the reference sample 
analysis in step 9.1.

9.1.6 If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Niton Analyzers or your local representative for assistance.

ANALYSIS OF UNKNOWN SAMPLES

General Remarks

Toys and the majority of consumer products represent a wide variety of composition, shapes, 
and functionality. Plastic, wooden, and paper goods, as well as most apparel, should be tested 
using Plastic Mode, while those wholly made of alloys and metals, including isolated buttons 
and zippers, should be tested in Metals Mode. Products and components made of a 
combination of metallic and nonmetallic parts (materials) should be tested using Plastic 
Mode. Painted objects should be tested in the mode appropriate to the nature of their 
substrate, i.e., in Plastic or Metals Mode.

Hg 1000 15% 850 - 1150

Cd 150 25% 112 - 188

Table 6: Multi-element Polymer Reference Sample (Niton Part Number 180-554) in Nominal 

Concentrations and Acceptable Ranges (Main Range 100s)

Table 7: Multi-element Solder Reference Sample (Niton Part Number 180-606) in Nominal 

Concentrations and Acceptable Ranges (Main Range 30s)

Element
Nominal Concentration*

(wt %)
Acceptable Range (Wt %)

Sn Balance 93 - 98

Ag 3.05 2.50 - 3.30

Cu 0.55 0.40 - 0.80

Cd 0.34 0.27 - 0.41

Pb 0.12 0.10 - 0.18

Consumer_Goods_Analysis.htm#APPENDIX A
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Inside the Consumer Goods mode, the operator can select TestAll™ (patent pending), Metals 
& Minerals, or Plastics depending upon the operator’s knowledge of the material being tested. 
The TestAll calibration was developed to assist the operator when he or she is unsure of the 
correct calibration to use. This program will automatically determine the nature of the 
material being analyzed and will select the most appropriate calibration to apply to the 
analysis. If the operator can correctly identify the matrix of the test specimen, the best results 
may be obtained by selecting Metals & Minerals (alloys, ceramics, and minerals) or Plastics 
(PVC, polyethylene, or any polymer).

Consumer Goods mode also has a provision for an optional Painted Products calibration 
(calibration designator Ap). When enabled, Painted Products mode will determine if the 
element lead (Pb) is present in the painted coating or the substrate material. If the analyzer 
determines that Pb is present in the painted surface, the analyzer will report the Pb content in 
units of mass-per-unit-area, specifically µg/cm². Pb, if present, will cause the analyzer to PASS 
or FAIL the object undergoing testing based on the user-selectable Painted Products Action 
Level. The value of the action level can be set from 1 µg/cm² to 9 µg/cm². If the analyzer 
determines that Pb is present in the substrate of the material being tested, then the analyzer 
will report the Pb concentration in parts-per-million (ppm) and will be subject to the 
PASS/FAIL criteria designated by the user. If so desired, the Painted Products mode can be 
disabled within TestAll so that all data will be reported in ppm.

A more thorough discussion of the Consumer Goods mode, TestAll technology, and Painted 
Products is included inAPPENDIX A . A more thorough discussion of Errors of 
Measurement, Quality of Results, and Their Interpretation for Compliance Testing Using 
Niton XL3 Series XRF analyzers can be found in Appendix B. The following text applies to 
the use of an Niton XL3 700 for testing consumer goods in general and should be followed 
regardless of the software version installed on your instrument.

All parts of a product should be screened for restricted elements using the appropriate 
analytical mode of analyzer. The primary goal of screening is not to accurately analyze the 
chemical composition of all components or parts of the product, but to single out and 
eliminate from the market products containing prohibited elements. Therefore, it is only 
logical to start testing the product “as is,” without disassembly. This is particularly true of the 
products that are painted because many of the toxic elements – especially lead – are typically 
found in paint. Once the presence of a toxic element is confirmed during testing “as is,” the 
product can be sequestered, and further testing may not be necessary. If, however, the testing 
of the product “as is” produces no evidence of toxic elements, but it is suspected that such 
elements may be contained in inaccessible parts of the product for direct “as is” testing, one 
must consider disassembly of the product for compliance testing at the component level. If 
the product or its components are large enough, they may be tested directly by pressing the 
analyzer against their surfaces. Otherwise, measurements should be performed in a test stand.

Due to the large variety of consumer products, only general rules of testing, related mainly to 
proper sample selection and results interpretation, are outlined here. Detailed testing 
protocols should be developed for specific cases by the user.

Consumer_Goods_Analysis.htm#APPENDIX A
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GENERAL TESTING PROTOCOL

Large Objects

These are the objects that can easily cover the measuring window of the analyzer and are 
typically at least as large as the analyzer.

1. Select the areas or fragments of the sample that are to be tested.

2. Based on the type of material, select appropriate analytical mode:

Plastic Mode for all nonmetallic materials and combinations of nonmetallic and metallic

Metals Mode for all metallic materials

TestAll Mode for a mixture of both metallic and nonmetallic materials

3. Place the measuring window of the analyzer flush within the area identified on the toy or 
product for analysis and pull the trigger to start measurement.

4. Continue the measurement until the display says PASS or FAIL. These results can vary 
depending on the settings that are selected. For elaboration, refer to APPENDIX A.

5. Figures 1-3 and 1-4 show examples of this type measurement.

Figure 107. Screening a Larger Object

Advanced_Settings.htm#Thickness Correction
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Figure 108. One Possible Way of Screening a Toy

6. When testing larger surfaces, it is advisable to take several measurements at different 
locations. This is especially important if the surface tested is partially painted, plated, or 
otherwise appears different from location to location.

This will help in identifying the location of the analytes, whether in the substrate, paint, or 
both.

7. For interpretation of the results, consult Testing Time and Detailed Results Interpretation.

8. Continue measurements as planned.

Small Objects

These are objects that are typically smaller in size than analyzer, but still large enough to cover 
the measuring window of the analyzer.

1. Select the areas or fragments of the object that are to be tested.

2. Mount the analyzer in a test stand and connect the analyzer to a PC (via Serial Cable, USB 
Cable, or via Bluetooth). Start the NDTr Program on PC.

3. Place the object in a test stand in such a way that the area selected for testing covers the 
measuring aperture of the instrument as much as possible. If the toy cannot be manipulated 
into a position suitable for measurement, one may need to use some mounting assistance. 
Care must be taken to not allow any part of the support to be within the perimeter of the 
measuring window of the analyzer. Figures 4 through 13 show examples of how the object can 
be manipulated into proper testing position.

4. Based on the type of material, select appropriate analytical mode:

Plastic Mode for all nonmetallic materials and combinations of nonmetallic and metallic

Metals Mode for all metallic materials
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TestAll Mode for a mixture of both metallic and nonmetallic materials

5. Start the measurement, preferably via a PC using the NDTr software program.

6. Continue the measurement until the display says PASS or FAIL. These results can vary 
depending on the settings that are selected. For elaboration, refer to APPENDIX A.

7. If possible, take more than one measurement of the sample, preferably in a different 
location.

8. For interpretation of the results consultTesting Time and Detailed Results Interpretation.

9. Continue measurements as planned.

Figure 109. Positioning the Product

In Figure 1-5, the figure is positioned so that the paint on the palm of its hand is as close to 
the window as possible. A “helping hand” is used to assist positioning. Note: Clamps should 
be at least 1 inch from window.
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Figure 110. Analyzing theAarm

In Figure 1-6, the figure is balanced with its arm positioned for analysis. Not all samples will 
require “helping hand” or other devices.

Figure 111. Analyzing Figure Base

In Figure 1-7, we analyzed the unpainted bulk of plastics at the base of the figure.
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Figure 112. Analyzing the Back

In Figure 1-8, the figure is positioned to analyze its back.

Figure 113. Analyzing the Sword

In Figure 1-9, the sword of the figure is undergoing analysis. Note use of “helping hand” to 
position the sword.
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Figure 114. Ana;yzing the Arm Band

In Figure 1-10, again with the aid of the “helping hand,” the silver arm band on the right arm 
is screened.

Figure 115. Analyzing the Paint

In Figure 1-11, we are analyzing the brown paint on the figure’s clothing.
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Figure 116. Analyzing the hair

In Figure 1-12, propped on the “helping hand,” the yellow hair on the figure undergoes 
screening.

Very Small Objects

These are objects that are not large enough to cover the analyzer measuring window, typically 
less than 10 mm in any dimension, e.g., beads, small jewelry pieces, chains, etc.

1. Mount the analyzer in a test stand and connect it to PC (via Serial Port, USB port, or 
Bluetooth). Start NDTr software program on user’s PC.

2. Place the object in a test stand in such a way that it resides in the center of the measuring 
window of the analyzer. If available, it is possible to take more than one identical small item 
and pile a small quantity of them over the measuring window of the analyzer. However, one 
must be certain that these individual items are identical in composition.

3. Based on the type of material, select appropriate analytical mode:

Plastic Mode for all nonmetallic materials and combinations of nonmetallic and metallic

Metals Mode for all metallic materials

TestAll Mode for a mixture of both metallic and nonmetallic materials

4. Start the measurement, preferably using NDTr.

5. Continue the measurement until the display says PASS or FAIL. These results can vary 
depending on the settings that are selected. For elaboration, refer to APPENDIX A.

6. For interpretation of the results consult Testing Time and Detailed Results Interpretation.

Consumer_Goods_Analysis.htm#APPENDIX A
Consumer_Goods_Analysis.htm#APPENDIX A
Consumer_Goods_Analysis.htm#Testing Time and Detailed Results Interpretation
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7. Continue measurements as planned.

Thin Objects, Such as Plastic, Foils, or Films

1. Mount the analyzer in a test stand and connect it to PC (via Serial Port, USB port, or 
Bluetooth). Start NDTr program on user’s PC.

2. Place the film/foil object in a test stand in such a way that it covers the measuring window 
of the analyzer. If possible, take more than one layer of film and stack as many of them as are 
available over the measuring window of the analyzer.

It is recommended the thickness of the stack be at least 5 mm. However, either single layers or 
stacks can be analyzed as long as they are not less than 1 mm in thickness. Also, it should be 
noted for a meaningful representative result, all samples should have the exact same 
composition.

3. Based on the type of material, select appropriate analytical mode:

• Plastic Mode for all nonmetallic materials and combinations of nonmetallic and metallic

• Metals Mode for all metallic materials

• TestAll Mode for a mixture of both metallic and nonmetallic materials

4. If Plastic Mode has been selected or if the sample is a plastic being tested in TestAll Mode, 
set the thickness correction on the instrument to the actual thickness of the sheet or stack of 
film in mm. See Thickness Correction for details.

5. Start the measurement, preferably using NDTr.

6. Continue the measurement until the display says PASS or FAIL. These results can vary 
depending on the settings that are selected. For elaboration, refer to APPENDIX A.

7. For interpretation of the results consult Testing Time and Detailed Results Interpretation.

8. Continue measurements as planned.

Paint Chips

Some objects may have painted surfaces that will not be accessible for direct x-ray scan. In 
such circumstances, it is possible to scrape a small sample of paint and analyze it directly by 
placing it over the measurement window of the analyzer.

1. Mount the analyzer in a test stand and connect it to PC (via Serial Port, USB port, or 
Bluetooth). Start NDTr program on user’s PC.

2. Take a Mylar film (Part Number 187-462) and spread it on a clean, flat surface.

3. With a sharp razor blade or Exacto knife, scrape paint from the area to be tested and place 
it over the Mylar film. Use caution during this step so as not to disturb the substrate material.
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4. Take a Prolene window used for helium flush instruments (PN 187-1454) and cover the 
chip of paint. Now the paint chip is secured between two thin plastic films and ready for 
analysis (see Figure 1-13).

5. Select the Plastic Mode of analysis. Set thickness correction to OFF. SeeThickness 
Correction for details.

6. Place the paint sample over analyzer window and perform a measurement. Typically, a 
30-second analysis time is sufficient to ascertain the presence or absence of lead in the paint.

7. Continue the measurement until the display says PASS or FAIL.

8. For interpretation of the results consult Testing Time and Detailed Results Interpretation.

9. Continue measurements as planned.

Figure 117. Analyzing Paint Chips Secured Between Two Plastic Films

Apparel

Screening and analyzing apparel items – fabric, appliqués, buttons, zippers, footwear – for 
toxic elements using XRF can pose some challenges. While these challenges can be met, it is 
important to keep some key concepts in mind to successfully perform the screenings and 
interpret the results.
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By nature, fabrics, in particular, are a very low-density sample. This means that the XRF 
instrument effectively “sees” less sample-per-unit area than with a metallic specimen, for 
example. One way to compensate for the lower density is to increase the analysis time, thereby 
allowing the instrument to gather more data. Another option is to increase the apparent mass 
of the sample “seen” by the instrument by folding the fabric several times. Using the latter 
technique may mitigate having to significantly increase the analysis time, though increasing 
the time still could be necessary.

Another consideration when analyzing fabrics is that the incident x-ray beam will penetrate 
the material relatively unimpeded, meaning that x-rays generated from the 
sample-support-medium beneath the fabric can pass back up through the fabric sample to the 
analyzer. Simply pressing the analyzer on the garment while it is being supported on a 
tabletop is a common temptation. As expedient as this appears, it is possible to get erroneous 
results if there are elements in the table that are the same as those elements being tested for in 
the sample material. In addition, there may be elements present in the table that interfere with 
the detection of the elements of interest in the sample material. In all cases, the composition 
of the tabletop should be non-metallic.

Analyzing fabrics in one of the supplied test stands is always preferable, however, that may not 
always be practical because of the size of the sample undergoing screening or some other 
circumstance. If sample analysis on a tabletop is necessary, then the tabletop itself should be 
screened first with the analyzer to determine if it contains contaminate elements or if it 
contains significant concentrations of an element that could interfere with the target elements 
within the sample material. If the user determines, after screening, that tabletop does not pose 
an impediment to the analysis of the test specimens, then the fabric should be folded several 
times before subjecting it to analysis. Proper x-ray safety procedures should be followed, 
which includes avoiding having any body parts under the tabletop where the analysis is being 
performed.

The Niton XL3 can also be used to analyze garments on a hanger, though the user may find 
that it is impractical to support the weight of the instrument for the entire analysis time. 
Please note that when undertaking this type of analysis, it is imperative that the user give 
proper consideration to radiation safety procedures, ensuring that no one could possibly be 
exposed to the x-ray beam after it passes through the hanging garment.

Garment fasteners, such as buttons and zippers, should be centered as closely as possible over 
the analysis aperture of the instrument. If a signal is detected for any of the elements of 
concern, then the adjacent fabric should be tested to determine from where the signal is 
coming. Alternatively, the fastener of interest can be removed and screened separately.

Appliqués, such as decals or silk screens, can be screened directly. As in the above example, the 
adjacent fabric material should be screened separately if an element of concern is detected to 
determine whether the signal is coming from the appliqués or the fabric.

1. Mount the analyzer in a test stand, if used, and connect it to PC (via serial port, USB port, 
or Bluetooth™). Start NDTr software program on the user’s PC.
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2. Place the object in a test stand in such a way that it is centered in the measuring window of 
the analyzer. If enough material is available, fold it over on itself several times.

3. Based on the type of material, select appropriate analytical mode:

Plastic Mode for all nonmetallic materials and combinations of non-metallic and metallic

Metals Mode for all metallic materials

TestAll Mode for a mixture of both metallic and nonmetallic materials

4. Start the measurement, preferably using NDTr.

5. Continue the measurement until the display says PASS or FAIL. These results can vary 
depending on the settings that are selected. For elaboration, refer to APPENDIX A.

6. For interpretation of the results consult Testing Time and Detailed Results Interpretation.

7. Continue measurements as planned.

Detect vs. Non-Detect Screening (GO/NO-GO Screening)

All Thermo Scientific Niton XL3 700 Series instruments can be factory set with “Detection 
Element Display Option” activated in the Consumer Goods Settings Screen. When 
“Detection Settings” are activated in the Consumer Goods Settings, the user can set a 
requirement for a minimum measurement time. The minimum time must be achieved before 
the instrument will allow a sample to PASS on screening. If the minimum time is not 
achieved, and the sample has not yet reached a FAIL determination, then the Message will 
read INCONCLUSIVE.
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Figure 118. Consumer Goods Setting Screen
Note  The minimum time threshold applies only to the main filter. Match the Main Filter 
time to the minimum test time for optimized Pb testing. Also, if Cr, Ti, or V analysis is not 
desired, shut off the Low Filter.

For better sensitivity to Cr, set Main Range to less than the minimum test time, and activate 
Low range for the desired Cr test time. This mode yields best results for Cr.

Factory default settings are as follows:

• Main Range = 50 seconds

• Low Range = 10 seconds

• Detection Settings minimum test time = 30 seconds

The system toggles between the two Ranges until the minimum time on Main Range is 
achieved. Therefore, total test time is 30 seconds. Although the minimum test time is set to 
30s, the Low Range is still able to be activated by allowing the instrument to scan over 50s.

Making Determinations

The decisions for GO/NO-GO analysis will be made by checking whether or not a monitored 
element rises above the detection limit in a predefined measurement time.

Testing Time and Detailed Results Interpretation

Figure 119. 

In this case, the sample has been measured for the predetermined minimum amount of 
analysis time (30s).

• All elements are below the detection limit.

Advanced_Settings.htm#Consumer Product Settings
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• The element display changes each element to the color green.

• “Pass” is displayed meaning that the instrument either did not detect a monitored element 
or detected an element within the acceptable range in the pre-determined minimum analysis 
time.

This sample area passes the test.

Figure 120. 

In this case, the sample was measured for 6 seconds.

Pb determination:

• The instrument has already detected the presence of Pb.

• No more testing time is required for the determination of Pb presence.

• This sample area fails the test.

The other six elements of interest:

• More time is required to determine the presence of the other six elements being screened.

• If no other element is detected in time, then each of the other elements will turn to a green 
display color.

Pb remains red, the sample still fails
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Figure 121. 

Here, the sample was measured for 15 seconds.

Ba, Bal, and Zn determination:

• The color display is blue meaning that although the instrument did detect the presence of 
Ba, Bal, and Zn, they are not part of the Pass/Fail criteria and thus, their presence is 
considered neutral.

The other elements of interest:

• More time is required to determine the presence of the other elements being screened (Pb, 
Cd, Hg, As, Cr).

• If no other element is detected in time, then each of the other elements will turn to a green 
display color.

The “Inconclusive” will then change to “Pass”
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Figure 122. 

In the case of RoHS or Consumer Goods, as there are valued limits set for Pass/Fail and no 
minimum test time it is entirely possible to see the following screen. Here the sample was 
measured for 5s.

For lead(Pb)

• “nd“<33” means non-detect below 33ppm.

• Pb and its result appear in green because the instrument has determined that the sample has 
less than the lower set limit.

The other elements of interest:

• Hg, Cr, and Br have also been deemed to be a Pass denoted by the green color.

• The sample, itself, is inconclusive, though because Cd is showing nd below 89ppm which is 
above the lower Pass limit of 70ppm.

For the typical user, the system will be pre-programmed with fixed parameters. The user 
simply holds the trigger down through the INCONCLUSIVE period, until the display gives a 
result of PASS or FAIL.

The advanced user may choose to optimize testing times for a specific task. The test should 
never be run for less than 5 seconds. If two Ranges are activated, then measure for a minimum 
of 5 seconds on each filter. Normal test times are in the range of 20-120 seconds, depending 
on the desired detection limit. For example, it will take approximately 60 seconds on the 
Main Range to find 600 ppm Pb concentration in a 1 mil (25 micron) thick layer of paint.

See Thermo Scientific Niton Analyzer application notes for detailed studies into testing times 
for each monitored element.
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The results can always be verified by inspecting the spectrum generated by the sample. 
Whenever lead is detected, the spectrum will show two peaks of lead, approximately the same 
size, one at 10.5 keV and another at 12.6 keV. If lead is not detected, the spectrum will show 
no lead peaks. The spectra in Figure 22 below are examples of the two situations described.

Figure 123. Paint Spectrum

Spectrum of paint as measured directly on the same color on two separate areas of a doll. One 
part is painted with leaded paint (blue spectrum). The other part containing the same color 
paint, shown with red spectrum, does not show any lead. This can be caused by separate parts 
being painted on separate production lines, or may be due to rework of a cosmetic defect.

APPENDIX A

Consumer Goods Mode for Screening Consumer Products

Consumer Goods mode was recently developed to aid in the analysis of the wide range of 
samples for regulated toxic elements that may be present in consumer products. Toys and 
apparel have been the subject of much concern lately, so their testing will be the primary focus 
of this discussion. This is not to say that the Niton XL3 700 system cannot be used to screen 
for toxic elements in other diverse products such as artificial turf, furniture and apparel. 
Recent updates to the software have allowed for the ability to determine Cl (chlorine) and Br 
(bromine) for the analysis of consumer goods for halogen-free acceptance.
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The main features of Consumer Goods mode consists of calibrations for TestAll™ (patent 
pending), Metals & Minerals, Plastics and the optional Painted Products calibration.

The TestAll calibration was briefly described in the body of the attached SOP. As a review, this 
calibration performs a brief analysis of the sample being analyzed and then picks the most 
appropriate calibration to apply to this sample. The user benefits by not having to determine 
and then manually select the proper calibration to use. Upon starting the analysis sequence, 
the program will automatically select between the following matrix classifications: metal, 
painted metal, thin metal, plastic, PVC plastic, thin plastic, aluminum alloys, layered 
materials, and non-metal. The test results are evaluated for PASS/FAIL/INCONCLUSIVE 
based on the results for each element the user selects and compared against the decision 
criteria selected.

The decision criteria for PASS/FAIL/INCONCLUSIVE are set for each mode programmed 
into the Niton XL3 700. To view or change the criteria for the Plastic calibration, from the 
Main Menu select the Advanced icon, then the Element Thresholds icon, then the Plastic 
icon.

One of the following screens will appear:

Figure 124. Plastics Screens

The screen on the left shows the eight commonly regulated elements in toys that the analyzer 
is monitoring. These eight elements, or any other elements, can be monitored by toggling the 
value under the Pass/Fail column heading to be either ON or OFF. When the analyzer is in 
Toy mode, the elements are being monitored (i.e., ON) based solely on whether they are 
detected or not. If a monitored element is detected, that element will be noted as a failed 
condition regardless of its measured concentration. By scrolling down the elements list, you 
will see that all the other elements are labeled as OFF, which means that their presence in the 
sample is not being considered in the PASS/FAIL determination. The user may elect to not 
consider any element for PASS/FAIL by clicking on the Pass and Fail columns adjacent to the 
element and then editing the selection to be OFF.



9 Consumer Goods Analysisniton
APPENDIX A

192 Niton XL3 Analyzer User’s Guide Thermo Scientific

The screen in the middle shows the Restriction of Hazardous Substances (RoHS) elements. 
You will notice that there are fewer monitored elements than in Toy mode and that there are 
ranges of concentration for pass and fail. In the RoHS mode, the actual concentration of the 
monitored element is taken into account before declaring the sample as a 
PASS/FAIL/INCONCLUSIVE. The use of the instrument for the RoHS application is 
discussed in the SOP that is available to you. See Consumer Product Settings for changing 
testing criteria.

The screen image on the right shows the Pass/Fail limits set for Consumer Products. As in 
RoHS, there are concentration values, rather than just ON/OFF. In addition to the RoHS 
settings, there is also the option to set limits for halogens, which are a function of industries 
that are looking to push their products to be manufactured “Green.”

The analyzer will use one of the above three criteria for determining the PASS/FAIL state of a 
test sample based upon the selection made in the following section.

From the Main Menu select the Advanced icon, then the Consumer Goods icon.

The following screen will appear:

Figure 125. Consumer Goods Screens

The options are:

Minimum Test Time – This is the minimum time in seconds that must elapse before a sample 
will be labeled as PASS. If one of the monitored elements is detected prior to the minimum 
test time being reached, the sample will FAIL. The active analysis screen will indicate 
INCONCLUSIVE, up to the minimum test time, if a monitored element has not yet been 
detected. This setting is only active and valid in Detection Settings
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RoHS Settings – Selecting this option will make the analyzer consider the pass and fail criteria 
entered for each element as described above. There is no Minimum Test Time considered 
when the RoHS Settings are selected.

Detection Settings – This option will make the analyzer PASS or FAIL a sample based on a 
detect/not-detect basis for each of the selected monitored elements as described above. The 
minimum test time must be set to a desired value for the instrument to function up to the 
user’s standards.

Consumer Products – This option addresses the analysis of total halogens – chlorine plus 
bromine. To be considered halogen free there can be no more than 900 ppm Cl and 900 ppm 
Br. In aggregate, the sum of Cl and Br cannot exceed 1,500 ppm. On a Niton XL3 700, 
chlorine is detected on the low filter, yielding a detection limit of approximately 500 ppm or 
better in a polymer at a measurement time of 60s.

Painted Products Action Level – If so calibrated, the analyzer will refer to the entered value, 
which is in µg/cm², to determine if the test sample is a PASS or FAIL. Currently, only the 
element Pb is subjected to this test.

To select the TestAll mode, perform the following steps:
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Figure 126. TestAll Menu Path

The following screen shots are from an example of analyzing a painted metal sample that has a 
high level of Pb content in the dried paint film. The Live Spectrum option has been selected 
from the Tools drop-down menu. The Painted Products output option can be toggled off and 
on by using the Tools drop-down menu.
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Figure 127. TestAll Analysis

The Painted Products calibration and its indication of the lead content in µg/cm² was 
developed in anticipation of current legislation where the use of the mass-per-unit area 
indication will be allowed, in certain specific instances, in addition to the historical ppm lead 
level concentration stipulated by 16 CFR 1303 from the Consumer Products Safety 
Commission and ASTM F963. For XRF to accurately give readings in paint films on products 
directly in ppm, two more pieces of information are required to make the calculation – the 
paint density and thickness. These two variables are rarely known. Presenting the lead content 
in mass-per-unit area allows the instrument to be calibrated with known standards and does 
not rely on information about the sample being tested that is difficult or impossible to know. 
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Thus, this method allows the XRF instrument to be used to its full advantage, namely as a 
rapid and non-destructive test. XRF has already been widely used for determining the lead 
content in painted surfaces for years with the acceptance of OSHA and HUD for leaded paint 
remediation in buildings.

Appendix B

Errors of Measurement, Quality of Results, and Their Interpretation for Compliance 
Testing Using Thermo Scientific Niton XL3 Series X-ray Fluorescence (XRF) 
Analyzers

By Stanislaw Piorek, PhD, Principal Research Scientist

Author’s Note: For the purposes of this document, milligrams per kilogram (mg/kg) and parts 
per million (ppm) are used interchangeably, with mg/kg the preferred SI unit of measure.

MEASUREMENT ERROR

Any measurement result – regardless of the analytical method used – is always accompanied 
by error, which is defined as the difference between the measured value of the quantity (such 
as mass fraction or concentration) and its value accepted as true. Error is the consequence of 
variability inherent in any measurement process. Every time we repeat a measurement, we 
obtain a slightly different result.

Depending on the specific conditions of measurement and the measurement technique itself, 
the error may be large or small; however, it never is equal to zero. Therefore, any measurement 
result must always be reported with its associated error; the results reported without error are 
fundamentally meaningless despite the fact that the habit of reporting measurement without 
error is very common.

Error of measurement is expressed in the same units as the result, and it is called an absolute 
error. If we relate the value of an absolute error to the result of measurement itself, the 
outcome will be a unit-less number, a ratio, which we call relative error. When multiplied by 
100%, the relative error is called percent relative error. 

For example, we have analyzed lead-tin solder for its lead content, and obtained the result of 
80% lead by weight, with an absolute error of ± 2% by weight. Now, if we want to find the 
relative error of this measurement, we must take the ratio of an absolute error to the result, 
that is: divide ± 2% by 80%, which is equal to ± 0.025, and which - after multiplying by 
100% - may be expressed as ± 2.5% relative. In other words, we can either say that we 
measured the concentration of lead in solder and obtained the result of 80% by weight with 
an absolute error of ± 2% by weight, or that we obtained the result of 80% by weight with 
relative error of ± 2.5%. This example shows the importance of using the term relative, 
especially when measuring percent concentration(s) of elements in sample.
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Error of measurement has two fundamental, additive components: systematic error and 
random error. 

Systematic error is constant in nature and is usually caused by inadequacy of calibration or 
gross and persistent mistakes during the measurement process (such as use of the wrong 
calibration curve, significant change in measurement conditions, etc.). A large systematic 
error is relatively easy to detect. It will manifest itself by producing an obviously erroneous 
result. However, a small systematic error can be detected only by measurement of a known, 
well-characterized standard sample(s) or certified reference materials (CRM). Systematic 
errors can usually be corrected during the calibration procedure. Systematic error is also called 
a bias or inaccuracy of measurement.

Random error, often called imprecision of measurement, varies from measurement to 
measurement and expresses the variability of the measurement process when repeated under 
the same conditions and on the same object. Random error is due to randomly fluctuating 
factors that cannot be controlled or eliminated from the measurement process.

Thermo Scientific Niton® analyzers are calibrated at the factory to eliminate systematic errors 
or at least make them insignificant. Therefore, the errors associated with measured results are 
predominantly random in nature and mainly reflect the imprecision of the measurement 
process.

All analytical results obtained with any Niton XL3 Series analyzer are assumed to be bias free 
and are reported with error quoted at two standard deviations (colloquially known as “two 
sigma”), which approximately corresponds to a 95% confidence level. This rule follows the 
practice commonly accepted by analytical chemists. The 95% confidence level of 
measurement error means that if we measure concentration of lead at, for example, 3000 
mg/kg with two sigma error of ± 50 mg/kg, then, with a probability of 95%, we can expect 
that the true value of lead concentration will be within a range of 2950 to 3050 mg/kg. In 
other words, if we repeated the lead analysis 1000 times, 950 results (almost all) would fall 
within the range from 2950 to 3050 mg/kg and only 50 would not. Please note that error 
reported at one sigma corresponds roughly to a 68% confidence level. In practice, this means 
that almost half of the measured results would fall outside the ± one sigma band around the 
measured value. On the other hand, error reported at ± three sigma corresponds roughly to a 
99.7% (practically 100%) confidence level that the true value of lead concentration will be 
between 2925 and 3075 mg/kg.

It is specific to x-ray fluorescence (XRF) spectrometry that imprecision of measurement error 
can be calculated from just one measurement. [All other analytical methods require multiple 
measurements on a sample to determine the error.] It is also specific to XRF that the 
imprecision error can be reduced by extending measurement time. For each fourfold 
extension of measurement time, one can expect a twofold reduction of imprecision error.
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QUANTITATIVE VS. QUALITATIVE RESULTS AND MEASUREMENT TIME, LIMITS OF 
DETECTION

Quantitative or Qualitative Results

It is an accepted, practical rule to consider the measurement result as quantitative if the 
relative error of measurement (commonly two standard deviations, or sigmas) is not greater 
than 20% (or 1/5) of the reported result. If the relative error is greater than 20%, the result is 
considered qualitative or semi-quantitative at best, and should not be used as the basis of 
quantitative decisions (such as compliance with regulatory thresholds).

For example, if we measure Cd in polyvinyl chloride (PVC) for 120 seconds, and the result 
and error are 237 mg/kg and ±34 mg/kg respectively, this result may be considered 
quantitative, because two sigma, 34 mg/kg, is less than 20% of the result (here 47 mg/kg). On 
the other hand, if we measure for only 20 seconds, the error may be as high as ±78 mg/kg. In 
a case such as this, the relative error will be greater than 47 mg/kg, rendering the result 
semi-quantitative at best. This example illustrates how, by adjusting the measurement time, it 
is often possible to convert a qualitative result into a quantitative one.

The error of a single measurement is highly dependent on sample density and measurement 
time. As we have seen, a longer measurement time will yield a smaller reported error. To a first 
approximation, each fourfold extension of measurement time yields a twofold reduction of 
imprecision error. Therefore, when measuring an unknown sample, the user should observe 
the values of error reported by the instrument and continue analysis until the error reported is 
less than 1/5 of the result. Therefore, the answer to the commonly asked question of “How 
long do I need to measure a sample?” is “Measure at least as long as is needed to obtain 
quantitative result.”

Generally, it is a good practice to take several trial measurements before attempting a 
meaningful measurement of an unknown material. These trial measurements help estimate 
the measurement time needed for quantitative results.

For Restriction of Hazardous Substances (RoHS) screening, a 30-second minimum analysis is 
typically required to determine whether the RoHS elements, with limits at 1000 ppm, are 
compliant or non-compliant. If a 30-second reading yields non-compliant results for Pb, for 
example, then a longer reading time is not required because it would yield a more precise, but 
still non-complaint result. If a 30-second analysis yields compliant results for some, but not 
all, of the RoHS elements, then a longer analysis time may be required to obtain a compliant 
result. Note that this is typically the case for Cd because it is has a RoHS action level of 100 
ppm.
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Limit of Detection

The Limit of Detection parameter describes the ability of the analyzer or analytical method to 
positively affirm the absence or presence of analyte(s) in a sample. Limits of Detection 
(LODs) used in Niton XL3 Series analyzers are specified following the US Environmental 
Protection Agency (EPA) protocol of 99.7% confidence level. That is, the LOD for an 
individual analyte is numerically expressed as three standard deviations (or 1.5 times reported 
measurement error) measured on a sample with none or only a trace amount of the analyte 
present. An exception is metal alloys for which LODs are expressed at the more conservative 
level of four standard deviations. Since the individual LODs are based on measurement error, 
they also improve as a function of the square root of the testing time.

Due to the density of certain matrices, the detection limits of certain elements may be higher 
than the RoHS limits. One example would be Cd in a lead-free tin solder like a SAC305. 
Because of the high density of tin and the location of its x-ray energy in relation to Cd, the 
detection limit for Cd in this alloy can be as high as 500 ppm.

Obviously, the LODs are important only when measured analyte concentration is very low, or 
close to the LOD.
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Example of a Single Measurement

Figure 128. Table 1. Measurement of Cd in Polyethylene (PE). (Results reported in mg/kg)

Table 1 above illustrates the results of a single measurement of a polyethylene (PE) sample that 
contains 100 mg/kg of Cd. All Niton analyzers report results in real-time, updating them 
every data acquisition cycle, which lasts about one second. The first column in the table shows 
the number of seconds elapsed from the start of the measurement. The second, third, and 
fourth columns show the results as calculated by the analyzer’s internal software, while the 
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fifth column (all in bold face) shows the results as displayed on the instrument screen. Note 
that after the first and third cycle the calculated LOD was larger than the actual measured 
concentration of cadmium and, therefore, the instrument screen shows only the value of < 
LOD. Due to statistical fluctuations, the second cycle produced the result that was greater 
than the LOD, and the instrument reported measured value with its ±2 sigma error. However, 
the total period of the first three cycles, that is the first three seconds, are interpreted as 
yielding a result below detection limit. Only after the fourth cycle (second) is the error of 
measurement, and consequently the LOD, low enough for the result to be displayed as 
calculated. Over the consecutive cycles, up to the 29th second, the results can be considered 
only as qualitative because the reported error of two sigma is larger than 1/5 of the reported 
result. This period of qualitative results is marked with green color. Starting with the 30th 
cycle, the results are of quantitative quality (measurement at the 32nd cycle is borderline and 
is a perfect illustration of statistical fluctuations), and, as such, may be used for assessing 
compliance status. Please note that LOD is not assumed as constant, but is calculated anew 
after each data acquisition cycle.

In summary, this example shows that if we stopped the measurement after the third second, 
we would be able to say only whether Cd were present in the sample and whether its 
concentration were below 96 mg/kg. By continuing the measurement, we have seen that the 
measured Cd concentration stabilized around 100 mg/kg value; by waiting until the error 
dropped below 1/5 of the reported result, we have obtained quantitative concentration of Cd, 
which now could be compared with appropriate thresholds. 

INTERPRETATION OF THE RESULTS FOR COMPLIANCE

In our case, the objective of testing for compliance is to ensure that the concentrations of 
specified elements in the product (material) do not exceed the thresholds set by regulatory 
bodies. Below we see an excerpt from the Consumer Product Safety Improvement Act of 2008 
(CPSIA), which in paragraph 2A states that the total lead content by weight for any part of 
the product may not be more than 600 mg/kg.

Numerically, this condition is expressed as:

• measured lead concentration, [mg/kg] ≤ 600 [mg/kg]
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We will now discuss the meaning of this condition in terms of actual measured results and 
making compliance decisions.

First, we will analyze the decision-making process when the results are matched against a 
single value threshold. Figure 25 below illustrates several possible outcomes of lead 
measurement.

Figure 129. Results of measurement compared to a single value threshold.

Case 1 – In this case, the measured concentration of lead was equal to 350 mg/kg and the 
absolute error of this result at two sigma level (95% confidence) was ± 50 mg/kg. This is 
shown in Figure 1 with a green solid line at 350 mg/kg value and by a light green band 
stretching 50 mg/kg above and below the solid line. Based on the previous discussion, this 
result is definitely quantitative, meaning that we can say with 95% confidence that a true 
concentration of lead is within 300 to 400 mg/kg. As we can see, even the upper value of the 
range (400 mg/kg) is way below the regulatory threshold of 600 mg/kg lead, which is shown 
in Figure 1 with a thick red line. Therefore, we can make a statement that the object measured 
for lead is compliant with regulations; that is, its lead content is way below the regulatory 
level. The decision is PASS.

Case 2 – In this case, the measured concentration of lead is 520 mg/kg with an absolute error 
of two sigma equal to ± 60 mg/kg. Again, this result is quantitative, and it means that we can 
say with 95% confidence that the true concentration of lead is between 460 and 580 mg/kg. 
Therefore, since the upper limit of the error band is less than 600 mg/kg, we will consider the 
result as compliant. The decision is PASS.
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Case 3 – This case is identical to Case 2 except that the error band around the measured result 
this time is equal to three sigma (three standard deviations). Therefore, this time we can say 
with 99.7% confidence that the true concentration of lead is somewhere between 430 and 
610 mg/kg. Now the upper limit of the error band, 610 mg/kg, is greater than the threshold 
value of 600 mg/kg and we have to consider the object as noncompliant. The decision is 
FAIL. 

Case 4 – This case presents another variant of Cases 2 and 3. Here, we decided to double the 
measurement time, which resulted in the reduction of error by the square root of 2 or by 
about 1.41. Now, the three sigma error is only 65 mg/kg, as shown by the light green box 
around the value of 520 mg/kg. The consequence of doubling of measurement time is a more 
precise estimate of lead concentration, which now can be found with 99.7% confidence 
within the range from 455 to 585 mg/kg. Here we can say that the object tested contains lead 
below the regulatory level of 600 mg/kg and is compliant. The decision is PASS.

Case 5 – The lead is measured at 720 mg/kg with an absolute error of two sigma equal to 
±140 mg/kg. This is a quantitative result implying with 95% confidence that the true value of 
lead concentration is between 580 and 860 mg/kg. Note that the lower limit of the error 
band, 580 mg/kg lead, is now smaller than the threshold of 600 mg/kg, suggesting that 
perhaps the true concentration of lead is less than 600 mg/kg. While plausible, it is not very 
likely. In this case, it is more likely that the true concentration is greater than 600 mg/kg, and 
we decided that the tested object is not compliant. The decision is FAIL.

Case 6 – This is a follow-up to Case 5. Simply put, by extending the measurement time, we 
can make the result more precise before comparing it with 600 mg/kg threshold. As shown, 
now the measured result for lead is 724 mg/kg with a two sigma absolute error equal to ±100 
mg/kg. Now, both the upper and lower limits of the error band are above the 600 mg/kg 
threshold, and the result is definitely noncompliant with 95% confidence level. In other 
words, in comparison to Case 5 we have obtained more precise but still noncompliant result. 
The decision is FAIL.

Conclusions

1. Whenever the result of a measurement plus its absolute error at the accepted confidence 
level (of two or three sigma) is not greater than the regulatory threshold, the result may be 
considered as compliant.

2. If the result of a measurement is smaller than the regulatory threshold but the upper limit 
of its error band is greater than the regulatory threshold, then the result may be considered as 
noncompliant. Alternatively, one may perform more precise measurement with a narrower 
error band, which will either confirm the previous decision or determine that the product 
compliant.

3. If the measured result is greater than the regulatory threshold and the lower limit of its error 
(at the accepted confidence level of two or three sigma) band is also greater than the threshold, 
the result is considered noncompliant.
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4. When the measured concentration is greater than the regulatory threshold but the lower 
limit of its error band is below the threshold, then the result may be labeled as noncompliant. 
Alternatively, performing a more precise measurement resulting in a narrower error band will 
either confirm the previous decision or determine the product as compliant. 

By now it should be clear that to decide whether the measured concentration of an element in 
a sample does or does not exceed the regulatory concentration threshold, one must include 
the error of measurement in comparison. The decisions are then made with the confidence 
level adopted for the error of measurement. That is, if the error is reported at two sigma level, 
which corresponds to 95% confidence, the resulting compliance decisions are made with 95% 
confidence that they are correct. If the error is reported as three sigma, which corresponds to 
99.7% confidence, we then have 99.7% confidence that the compliance decisions are correct.

Note  For error reporting purposes, the user can select one, two, three, and even four standard 
deviations (sigmas) on their Niton XRF analyzers. However, for compliance determination 
(PASS/FAIL, as reported on the analyzer), the instrument software always uses three standard 
deviation (sigma) errors.

Next we will consider an example where the compliance threshold is specified as a range rather 
than as a single value. If the tested materials are homogeneous, uniform, and in all other 
aspects ideal samples for XRF analysis, the single value of a threshold may be adequate. 
However, the majority of testing is performed on finished products that rarely fulfill the 
conditions of perfect samples for XRF analysis. The results of tests on such non-ideal samples 
may affect the accuracy of results, which, in turn, may lead to wrong decisions. To prevent or 
at least minimize this occurrence, we can adopt more stringent criteria for rendering 
PASS/FAIL decisions. Instead of using the regulatory threshold for PASS, we could adopt a 
new, lower threshold for PASS. For example, instead of 600 mg/kg lead, we could use a value 
30% smaller or 420 mg/kg. Similarly, for the FAIL criterion, we might use a value which is 
30% higher than 600 mg/kg or 780 mg/kg. This would create a band of uncertainty that 
would make some of decisions INCONCLUSIVE, that is, neither PASS nor FAIL. This 
condition is illustrated in Figure 26. This “band-like” criterion has been suggested in the Test 
Method IEC 62321 for compliance testing under the EU RoHS Directive.
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Figure 130. Acceptance band and measured results. All error bands around measured 
values are at three sigma (99.7% confidence).

Case 1 – The result and its 3 sigma error band never exceed the lower threshold level of 420 
mg/kg. Therefore, the test result shows the tested object as compliant. Decision is PASS.

Case 2 – The result and its error band are above the lower threshold, but below the upper 
threshold. This makes the result INCONCLUSIVE. Since the measured value is well within a 
band, it is doubtful whether the more precise test would yield a conclusive result. Therefore, 
either we can make an arbitrary decision that the result implies noncompliance (FAIL), or we 
can analyze the object using another, much more accurate method to determine whether the 
lead concentration is below 600 mg/kg (and not below 420 mg/kg!).

Case 3 – Although the error band encroached over the lower acceptance threshold, it is 
warranted that we expect that a longer, more precise measurement might end with both the 
result and its error band falling below the lower acceptance threshold. As is, this measurement 
is INCONCLUSIVE.

Case 4 – This is identical to Case 2.

Case 5 – The conclusion is the same as Case 2.

Case 6 – The result and its error band are decisively above the upper acceptance threshold of 
780 mg/kg. Therefore, the result is conclusive and the decision is FAIL.
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As illustrated in the above example, we could simplify the interpretation of test results by 
adopting only the lower threshold value as a criterion and regard all cases except for Case 1 as 
noncompliant. Then, the situation would be the same as we saw in Figure 1, except the 
comparisons would be made against the new, lower value of 420 mg/kg rather than 600 
mg/kg. All conclusions based on Figure 1 would apply for here at the lower acceptance 
threshold.

Note that the values of lower and upper acceptance thresholds were selected arbitrarily and are 
not related to measurement error. 

Last, there is one more situation that deserves mention, which is when the acceptance 
threshold is close to the detection limit. In such instances, the result is conclusive and the 
decision would be PASS if the measured LOD is smaller than the threshold. In all other cases, 
the result would be FAIL.
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Spectral Fingerprint

Every instrument is supplied with the Spectral Fingerprint Mode which allows for the spectral 
comparison of any unknown sample with a known material. From the main menu select the 
Sample Type icon, then the Spectral Fingerprint icon. 

Figure 131. The Spectral Fingerprint Menu Path
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Select the Teach Fingerprint icon and then enter name or ID of the material into the Standard 
box. All Fingerprint names must be unique. Start analysis and run for a minimum of 60s to 
ensure the instrument collects a representative spectrum with good statistics. The screen will 
show elements and readings in cps/µA for a number of elements. After analysis the system will 
ask if you want to save the reading, answer yes. Analyze and save as many different types of 
material as you wish.

Figure 132. Teaching the Fingerprint 

After saving the fingerprints of the sample you want identified, it is possible to then run 
unknown samples and determine if there is a correlation between them and the stored 
fingerprint. Click on the Match FingerPrint icon, enter sample ID if required and start 
analysis. At the end of the analysis, the instrument will display the FingerPrint match name, 
and give an indication of how close the spectrum is to the original reference material. No 
chemical concentrations are given in this mode, simply an indication of how close a sample is 
to a reference material. 



 10 Spectral Fingerprint

Thermo Scientific Niton XL3 Analyzer User’s Guide 209

Figure 133. Matching the Fingerprint 
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Helium Purged Analysis

Attaching the Helium Supply to Your Analyzer

Make sure before you start that you are using a clean Prolyne Measurement Window intended 
for use with He-purged analysis, rather than the standard Polypropylene Measurement 
Window. Securely attach the regulator accompanying your analyzer to the helium tank. This 
custom regulator governs the helium flow to 70 cc/min flow rate. Confirm that the helium 
tank contains a sufficient supply for your testing purposes.

Figure 134. The Helium Tank Setup - Inset Showing Regulator Dial

1. Check the line for kinks, knots, or other obstructions before turning on helium flow.

2. Attach the ferrule, shown in Figure 2, to the Helium Input Port, shown in Figure 3.

Mining_Analysis.htm
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Figure 135. The Helium Ferrule

Figure 136. The Helium Input Port

3. Snap the Locking Clip into the Locking Groove, securing the ferrule to the instrument, as 
in Figure 4.
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Figure 137. Ferrule Attached and Locked

4. Turn on helium flow. Allow the helium to purge the instrument’s front end for a 
minimum of five minutes before starting analysis. Helium purging can be done at the 
same time as instrument warm-up.

He-Purged Analysis

Helium purge is required for optimum detection of light elements such as Mg, Al, Si and P. 
For analyses using helium, we recommend using the default Range setup, as shown below in 
Figures 5 and 6. As with other energy dispersive XRF analyzers, the longer the testing time, 
the better the statistical precision of the reading. See Adjusting the Element Range for more 
on setting Ranges.

Data_Management.htm#Managing Libraries
Advanced_Settings.htm#Alloy Libraries
Advanced_Settings.htm#Alloy Libraries


11 Helium Purged Analysis

214 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 138. The Default Range Setups for Metals and Mining

The user can see the precision improving with analysis time by watching the third column on 
the analysis display – the 2-sigma error. This value decreases as reading time increases. 
Knowledge of this relationship is important, especially for light element work.

See Metals Analysis and/or Mining Analysis for more information on sample analysis. See also 
Avg Forward, Spectrum:On/Spectrum:Off, Enable LEC/Disable LEC, and Set Pass/Fail for 
more information on specific aspects and methods of analysis.

Table 1 shows the approximate limits of detection of the light elements in various matrices. If 
testing time is shortened, the limits of detection (which are directly based on statistical 
precision) will increase.

Table 8. Approximate LODs for Light Elements in Fe and Al Matrices

Element
Fe Matrix 

(concentration %)

Al Matrix 

(concentration %)

Zn 0.015 0.010

Cu 0.030 0.030

Ni 0.050 0.010

Cr 0.015 0.015

V 0.010 0.010

Ti 0.010 0.010
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The above LODs were calculated with 60 sec per filter measurement times

Sample Requirements

1. Must be flat, sit directly on top of and cover the entire measurement window.

2. Surface must be clean and free of oxidation or other surface films.

See Metal Sample Prep for more information for metal sample preparation, and the Mining 
Analysis SOP for more information on preparing mining samples.

Alloy Grade Libraries

Using a library of alloy grade specifications, your alloy analyzer will attempt to identify an 
alloy sample being analyzed. It does this by comparing the chemistry analysis results against 
the minimum and maximum specifications in the library. The library is an .alb or .clb file, 
and is viewable, editable, and upload-able via the included NDT program. Your analyzer can 
store two alloy grade libraries in its memory, and automatically chooses one of the two for use 
while testing. See Managing Libraries for information on how to manage your Libraries.

Selecting the He Library

The 900 library will be auto loaded when the Light Range is selected. When the Light Range 
is de-selected, the standard 800 library will autoload. Selecting Switch Library (Main) from 
the Tools Menu will not work. It is disabled in favor of the autoloading. Alternately, you can 
select Toggle Helium from the Tools Menu. In non-GOLDD analyzers, this will select the 
Light Range and change to the 900 Library. Selecting it again will de-select the Light Range 
and change to the 800 Library.

Al 0.031 -

Si 0.075 0.150

Mg 1.300 0.650

Table 8. Approximate LODs for Light Elements in Fe and Al Matrices
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Figure 139. Selecting Toggle He from the Tools Menu and Alt Tools Menu

In GOLDD analyzers equipped with Helium Purge, selecting the Toggle Helium function 
from the Tools Menu will not deselect the Light Range. Instead it switches between Helium 
and Non-Helium applications - the Light Range remains enabled. You may also wish to use 
the analyzer without the Light Range activated. To do this, deselect the light range via the 
Tools Menu, as shown in Figure 1-7. To use the analyzer this way, be sure helium has been 
completely purged from the system.
Note  When switching between Helium and Non-Helium applications on a GOLDD 
analyzer, allow the helium to dissipate out of system for at least ten minutes before beginning 
non-helium analysis. To expedite this process, you may remove the Measurement Window 
bracket for three or four minutes instead.
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Figure 140. Menu Path for De-Selecting the Light Range

GOLDD and He-Purged Analysis Results

When using GOLDD technology analyzers and/or optional He-Purged analyzers, your results 
screen may look very different from the examples in this User’s guide, due to the general lack 
of elements below the LOD. Here are two analysis screens showing GOLDD analysis, for 
comparison.



11 Helium Purged Analysis

218 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 141. All Alloy Analysis of Al 6061, Showing Fast ID of Al Alloys (Light Range 
Disabled)

Figure 142. All Alloy Analysis of Al 6061, Showing Long Analysis of Composition (Light 
Range Enabled)
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Data Management 

Viewing Data

Figure 143. The View Data Menu Path

Use the Data Screen to view previously taken test result readings. When the View Data icon is 
selected, the Results screen of your most recent test is shown on the Touch Screen.

Figure 144. The View Data Screen
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Using the buttons on the control panel, you may view different readings or additional data for 
individual readings. Your analyzer will display the standard screen analysis. Pressing the Down 
Button on the 4-way touch pad will display a complete scrolling elemental chemistry listing. 
Each press of the Down Button scrolls the screen down to the next element. You can also use 
the scroll bar along the right side to scroll or page through the elements.

Scrolling Down Through the Complete Listing of Elements

Figure 145. Complete Listing of Elements

Pressing the Left Button on the 4-way touch pad of your analyzer will display the previous 
reading, or if the first reading is currently displayed, the last reading. Pressing the Right 
Button on the 4-way touch pad will display the next reading, or if the last reading is currently 
displayed, the first reading in memory. Your analyzer can store up to 10,000 readings. You can 
also look at the complete x-ray spectra for each reading stored in the analyzer's memory.

Sorting Elements 

You can sort element rows by various criteria in order to view your data in the manner you 
prefer. The Sort Buttons, which double as column headings, can be used to re-sort the data in 
different ways. The Data Screen always begins as a Standard Sort, as you have defined it. 
Selecting the appropriate Sort Button once toggles the sort order to High-to-Low. Selecting 
the Sort Button again toggles the sort order to Low-to-High. To return to the Standard Sort, 
select the Sort Button a third time.
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Figure 146. Standard, High-to-Low, and Low-to-High Composition Sorts

Element Sorts

Element sorts are performed alphabetically based on the element symbol.

Composition Sorts

Composition sorts are performed numerically based on the percentage of composition, i.e. 
from lowest to highest concentration, or by toggling again, from highest to lowest.

Error Sorts

Error sorts are performed based on the size of the error in the reading, i.e. from largest to 
smallest error, or by toggling again, from smallest to largest.
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Figure 147. Element, Composition, and Error Sorts

Spectrum Graph

For any reading result, simply use the NAV Menu to gain access to the reading’s spectrum 
graph. Selecting Spectra will show a graphed spectrum of this reading, called SpectraView. 
SpectraView can be a useful tool for rapid, qualitative analysis of a sample. See Viewing the 
Spectrum for details.

Figure 148. The SpectraView Screen



 12 Data Management
Viewing Data

Thermo Scientific Niton XL3 Analyzer User’s Guide 223

Viewing the Spectrum

SpectraView

SpectraView enables you to to visually inspect the fluorescent x-ray peaks obtained from any 
sample and qualitatively identify them using the on-board software. In SpectraView Mode, 
the spectrum is displayed using a linear energy scale along the x-axis, with the count rate 
autoscaled logarithmically on the y-axis so that the highest peak on the screen reaches the top 
of the scale.

How to Use SpectraView 

You can access the SpectraView screen after taking a measurement in any mode, or while 
viewing a previous measurement, by selecting Spectra from the NAV Menu. Once you are in 
SpectraView, you can use the up and down positions of the 4-way touch pad to scroll through 
the spectrum, or you can tap on the spectrum display with the stylus to place the cursor at the 
point you tapped. The vertical cursor line indicates the current position along the spectrum.

Viewing the Information in SpectraView Mode

Figure 149. The SpectraView Screen

By default, the following information is shown along with the spectrum:

• The Reading number (Bottom Left) in the form "Read:x", where x is the Reading 
number.

• The position of the cursor on the energy scale (Bottom Left, under the Reading 
number), in the form "E: x.xx KeV", where KeV is kilo electron volts.

• The count rate (Bottom Left, under the energy position), in the form “R:x.xx”.
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• Ka, Kb, La, Lb, and/or Lg peaks of the three elements closest to where your cursor is 
positioned on the energy scale (Bottom Right). This information is written with the 
element symbol first, followed by either Ka (K shell alpha peak), Kb (K shell beta 
peak), La (L shell alpha peak), La (L shell beta peak), or Lg (L shell gamma peak). An 
example would be "Al Ka 1.48." To determine if a given element is present, look at 
the count rate at that cursor position.

Note  SpectraView cannot be used to determine exact element percentages in a sample.

Fitting the Spectrum 

By using the touch screen, you can select parts of the displayed spectrum and zoom in. Touch 
and hold the stylus to the screen immediately before the area of the spectrum you wish to 
enhance, then - still holding the stylus to the screen - sweep it across the area of the spectrum 
you wish to see closer, lifting the stylus from the screen when you pass the end of the area of 
interest. The screen will display vertical lines to either side of the area of interest, delineating 
the boundaries of the area.

Figure 150. Delineating the Area of Interest

Select the FIT button in the upper right hand corner of the Spectrum to fit the area of interest 
to the display area.
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Figure 151. Area of Interest Fit to the Display

The view of the spectrum will change to show only the area of interest.

Multiple Ranges 

SpectraView can display any individual spectra, including those obtained from multiple 
Ranges (filters) if you are using more than one Range. Use the NAV Menu to select which 
spectrum to view.

The Spectra1 choice will display the spectrum produced by the first Range.

The Spectra2 choice will display the spectrum produced by the second Range.

SpectraView Navigation 

Use the left button on the 4-way touch pad to expand the spectrum, centered on the position 
of the cursor. 

Use the right button on the 4-way touch pad to contract the spectrum, centered on the 
position of the cursor.
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Viewing Fingerprints

Figure 152. The View Fingerprints Menu Path

Select the View Fingerprints icon to view data saved as reference sample Fingerprints in Teach 
Fingerprint Mode. When the View Fingerprints icon is selected, the Results Screen of your 
most recent Teach Fingerprint is shown on the Touch Screen display.

Figure 153. The View Fingerprints Screen
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Erasing Data

The Erase All Data Screen

Figure 154. The Erase All Data Menu Path

Select the Erase All Data icon to erase all data, including signatures and readings, from your 
analyzer. Selecting the Erase All Data icon will bring up a confirmation screen asking you “Are 
you sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all data 
from your analyzer. Selecting the No Button will return you to the Erase Menu.
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Figure 155. The Erase All Data Confirmation Screen
CAUTION  Never turn off the analyzer while data is being erased! 
WARNING  Do not attempt to take measurements while downloading readings! This will 
generate an error requiring a system reset, and may corrupt your stored readings, requiring all 
stored readings to be erased. 
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The Erase Readings Screen

Figure 156. The Erase Readings Menu Path

Select the Erase Readings icon to erase all accumulated test readings from your analyzer. 
Selecting the Erase Readings icon will bring up a confirmation screen asking you “Are you 
sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all test 
reading data from your analyzer. Selecting the No Button will return you to the Erase Menu.
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Figure 157. The Erase Readings Confirmation Screen

Note - We recommend that you download all your readings into an NDT file for recording 
purposes before erasing all data. 
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The Erase Fingerprints Screen

Figure 158. The Erase Fingerprints Menu Path

Select the Erase Fingerprints icon to erase all accumulated alloy fingerprints from your 
analyzer. Selecting the Erase Fingerprints icon will bring up a confirmation screen asking you 
“Are you sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all 
fingerprint data from your analyzer. Selecting the No Button will return you to the Erase 
Menu.
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Figure 159. The Erase Fingerprints Confirmation Screen

Managing Libraries

Figure 160. The Manage Libraries Menu Path

Select the Manage Libraries icon to access the Library Management Menu. The Library 
Management Menu allows you to view and modify data in the Primary Library as well as the 
currently loaded alternate libraries. Just select the library you wish to view or editfrom the list 
on screen.
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Figure 161. Viewing the Libraries

The entries in the Grade Library serve as a reference for chemistry based analysis. The library 
entries allow the analyzer to work properly “out of the box” without needing time-consuming 
pre-analysis.

Figure 162. The Library Editor
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Using the Library Editor 

The Library Editor enables you to edit any library to conform to your specifications.

Alloy Name Button 

Selecting the Alloy Name Button sorts the alloy list alphanumerically.

(Name in List) 

Selecting the actual name of the alloy - i.e. “Fe/CS” - will bring up the Element Specification 
Screen.

Add Button

Selecting the Add Button will add a new alloy to the Library. First the Alloy Name Editor will 
appear, enabling you to enter the name of the new alloy.

Figure 163. The Alloy Name Editor

The Alloy Name Editor is a standard Virtual Keyboard. Use it as you would any Virtual 
Keyboard. Hitting the return key enters the name into the alloy list. Select the name of the 
new alloy to bring up the Element Specification Screen and enter the specification of the alloy.

Del Button

Selecting the Del Button will delete the currently selected alloy. First a confirmation screen 
appears.
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Figure 164. Confirmation Screen

Selecting the Yes Button will delete the alloy from the list. Selecting the No Button will return 
you to the Alloy List.

Save Button

Selecting the Save button will save the current Library.

Close Button 

Selecting the Close button will close the current Library without saving it.

The Element Specification Screen

The Element Specification Screen allows you to edit the elemental content of any alloy.
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Figure 165. The Element Specification Screen

Library Name 

This is the name of the library you are editing. Make sure you are editing the correct library 
before proceeding further.

Alloy Name 

This is the name of the alloy you are editing. Make sure you are editing the correct alloy 
before proceeding further.

Element to be Edited 

This is the element you need to edit for this alloy.

Minimum Percentage 

This is the lowest amount of the element in question you want to be in the alloy. If the 
element in the analyzed sample is any lower, the sample will not be recognized as this alloy. 
Selecting the element minimum will open the Minimum Editor.
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Figure 166. The Minimum Editor

This is a standard Virtual Numerical Keypad. The C Button will clear the current display, The 
< Button will backspace one space, and the E Button will enter this number as the minimum. 
After selecting the E Button, you will be returned to the Element Specification Screen.

Maximum Percentage 

This is the highest amount of the element in question you want to be in the alloy. If the 
element in the analyzed sample is any higher, the sample will not be recognized as this alloy. 
Selecting the element maximum will open the Maximum Editor.

Figure 167. The Maximum Editor
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This is a standard Virtual Numerical Keypad. The C Button will clear the current display, The 
< Button will backspace one space, and the E Button will enter this number as the minimum. 
After selecting the E Button, you will be returned to the Element Specification Screen.

OK Button 

Selecting the OK button will save the edited library.

Cancel Button 

Selecting the Cancel button will exit the Element Specification Screen for this alloy, returning 
you to the Library Editor.
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Connectivity

This section discusses how to connect your computer and your analyzer, for data transfer and 
integration, translation to other formats, data storage and security, as well as controlling your 
analyzer remotely through your computer. Connection can be achieved via USB, serial, 
and/or Bluetooth wireless means. Your analyzer comes with software which facilitates these 
uses, and works together with your analyzer to increase your productivity and efficiency.

Using Your Analyzer With Your PC

Installing Niton Data Transfer Software

We recommend the following system configuration for Niton Data Transfer (NDT):

The installation program installs NDT and NDTr. You may install the files in any directory 
on your PC. 

To install Niton Data Transfer:

1. Close all the programs that you have open on your PC.

2. Insert the CD into the CD-ROM drive.

If the installation program starts automatically, follow the instructions on the screen. If the 
installation program does not start, go to the next step.

3. Double-click My Computer.

Table 9: System Configuration

Minimum 

Configuration

Recommended 

Configuration

Processor 133 MHz

Operating System Windows 98, Millen-

nium Edition, 2000, 

XP, Vista, Windows 7

Windows XP

Memory 64 MB 128 MB

Free Disk Space 10 MB

Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
Controlling_Your_Analyzer_From_Your_PC.htm
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Figure 168. My Computer Icon

4. Double-click the Compact Disc icon:

Figure 169. Compact Disc Icon

5. Double-click the Setup Application icon.
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Figure 170. Setup Application Icon

6. Follow the instructions on the screen.

Starting Niton Data Transfer Software

To start Niton Data Transfer:

1. Click the Start button.

2. Select Programs.

3. Select Thermo Niton.

4. Click NDT.

Using_Your_Analyzer_With_Your_PC.htm#Simultaneous_Save_As_CSV
Using_Your_Analyzer_With_Your_PC.htm#Exporting the Report Data
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Figure 171. Starting NDT Up

Connecting the XRF Analyzer to Your PC

There are three ways to connect the XRF Analyzer to your computer:

• The serial cable provided. See Using a Serial Cable to Connect the XRF Analyzer for more 
information.

• The serial cable provided, along with a Serial-to-USB adapter. See Using a Serial-to-USB 
Adapter to Connect Your XRF Analyzer for more information.

• The wireless USB Adapter provided. See Using the Wireless USB Adapter to Connect the 
XRF Analyzer for more information.

• The USB cable provided. See Using a USB Cable to Connect Your Analyzer for more 
information.

Using a Serial Cable to Connect the XRF Analyzer

To connect the XRF Analyzer to your PC using the serial cable:

1. Insert the DB9 connector on the serial cable into the COM port on your computer.

Using_Your_Analyzer_With_Your_PC.htm#Using a Serial Cable
Exporting the
Using_Your_Analyzer_With_Your_PC.htm#Exporting the
Using_Your_Analyzer_With_Your_PC.htm#Serial to USB Adapter
Using_Your_Analyzer_With_Your_PC.htm#Creating and Using Reports
Using_Your_Analyzer_With_Your_PC.htm#Serial to USB Adapter
Using_Your_Analyzer_With_Your_PC.htm#Bluetooth Wireless Setup
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Figure 172. The DB9 Serial Connector and COM Port
Note  The COM port has 2 rows of pins; 5 pins in one row, 4 pins in the other. Check that 
the holes in the DB9 connector align correctly with the pins in the COM port.

2. Tighten the screws of the DB9 connector with your fingers. You do not need to use a 
screwdriver.

3. Open the Port Cover on the XRF Analyzer.

4. Insert the micro stereo connector on the serial cable into the Serial port in the handle of 
the XRF Analyzer.
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Figure 173. Micro Stereo Connector

Using a Serial-to-USB Adapter to Connect Your XRF Analyzer

If your PC has a USB port available, but does not have a COM port available, you can also 
use the serial cable to connect using the USB port. You will need a Serial-to-USB Adapter. 
This type of adapter lets you connect the DB9 connector to one end, and plug the other end 
into a USB port.

Contact the manufacturer of your PC to get the correct adapter. The manufacturer of your 
PC will be able to provide an adapter that includes the driver software that is appropriate for 
your PC.

Using_Your_Analyzer_With_Your_PC.htm#Copying Report Data Into
Using_Your_Analyzer_With_Your_PC.htm#Exporting the
Using_Your_Analyzer_With_Your_PC.htm#Exporting the
Using_Your_Analyzer_With_Your_PC.htm#Creating and Using Reports
Using_Your_Analyzer_With_Your_PC.htm#Creating and Using Reports
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Using the Wireless USB Adapter to Connect the XRF Analyzer

Figure 174. The Bluetooth Setup Menu Path

The USB adapter provided by Niton uses Bluetooth wireless technology. See Setting up 
Bluetooth to set up Bluetooth. 

Select the Bluetooth icon from the System Screen to set up your analyzer for Bluetooth 
wireless connection.

New_Topic2.htm
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i Icon

Figure 175. BT Information Screen

Selecting the i Icon in the top right of the Bluetooth Setup Screen will open the Bluetooth 
Information Screen. The Bluetooth Information Screen will supply the current name as well 
as the MAC address of your analyzer

Search Button

Selecting the Search Button will initiate a search for currently available Bluetooth devices in 
the area.
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Figure 176. Bluetooth Searching

After the search, your analyzer will report which Bluetooth devices it has found in the main 
window of the screen.

You can connect your PC and analyzer two different ways, from the analyzer to the PC, and 
from the PC to the analyzer.

Connecting From Your Analyzer to Your PC

After searching, select the PC you would like to connect to from the main window of the 
screen.

Select the Connect Button. Your analyzer's screen will show connection progress.
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Figure 177. Connecting Via Bluetooth

Open the program you are attempting to connect to. Here we are connected to NDTr, 
running the analyzer remotely over COM 5

Figure 178. Connecting Via Bluetooth



 13 Connectivity
Connecting From Your Analyzer to Your PC

Thermo Scientific Niton XL3 Analyzer User’s Guide 249

Connect Button

Select a located Bluetooth device from the Search List, then select the Connect Button to 
connect to that device.

GPS Button

Select the GPS Button to download GPS data from a connected GPS Device.

Figure 179. Bluetooth GPS Data Screen

Reset Button

Selecting the Reset Button initiates a Bluetooth reset.
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Config Button

Figure 180. Bluetooth Config Screen

Selecting the Config Button will load the Config Screen. This screen enables you to se the 
name of the currently selected Bluetooth device, change the type of device, see that device's 
COD Number, and see that device's MAC Address.

Changing the Bluetooth Device Type

Select the Down Arrow button next to the Type field to change the type of device connected. 
Select the proper type from the drop down menu. Select the Save button to save this 
configuration. Select the Close Button to exit without saving.
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Figure 181. Changing Bluetooth Device Type

Disable/Enable Button

Selecting the Disable Button will disable Bluetooth neetworking and change the button to 
Enable. Selecting the Enable Button will restart Bluetooth networking and change the button 
back to Disable.

Close Button

Select the close button to exit from Bluetooth setup.

Using a USB Cable to Connect Your Analyzer

To connect the XL3 XRF Analyzer to your PC using the USB cable:

1. Insert the Standard USB connector on the USB cable into a USB port on your computer.
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Figure 182. Standard USB Connector

2. Open the Port Cover on the XRF Analyzer.

3. Turn on the analyzer and insert the mini USB connector on the USB cable into the USB 
port in the handle of the XRF Analyzer.

4. Upon initial installation, insert the NDT disk located behind the foam in your case. 
Follow the prompts and install the USB driver located on the disk.

Figure 183. Mini USB Connector

Using_Your_Analyzer_With_Your_PC.htm#Using the Customize
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Installing the Windows 7 USB Driver

1. Insert the NDT CD and close out any dialogue box that pops up. The driver is located on 
this disk. 
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2. Click on “Control Panel” and locate the “Device Manager”. If it is not available directly 
under “Control Panel”, look under “System and Security” then “System”. 
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3. Open “Device Manager” 

4. Plug in instrument using the USB cable provided 

5. Message will appear “Device Driver Software Not Successfully Installed” 

6. In “Device Manager”, “Unknown Device” will appear under “Other Devices” 

7. Right click on “Unknown Devices”; select “Update Driver Software” 
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8. Click on “Browse My Computer for Driver Software” 
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9. Click “Browse” button; select CD drive or the location of the driver if you are not 
installing from the NDT CD (recommended). 

10. Click “OK” 

11. Click “Next” 
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12. A Security Dialog Box will appear. Select “Install This Driver Software Anyway?”

13. Driver will install; close out. 

Downloading Data

Standard Download

To download data you have collected offline:

1. Make sure that the XRF Analyzer is connected to your computer. See Connecting the 
XRF Analyzer to Your PC for more information.

2. Turn on the XRF Analyzer. See the manual for the XRF Analyzer for more information.
Note  Wait at least 30 seconds after turning on the XRF Analyzer to begin downloading files. 
The System Start screens do not allow downloading.

3. Start Niton Data Transfer. See Starting Niton Data Transfer Software for more 
information.

4. Click the Download button. The Download dialog box will open.

Using_Your_Analyzer_With_Your_PC.htm#Connecting the XRF
Using_Your_Analyzer_With_Your_PC.htm#Removing a Column from
Using_Your_Analyzer_With_Your_PC.htm#Using the Customize
Using_Your_Analyzer_With_Your_PC.htm#Starting Niton Data Transfer Software
Using_Your_Analyzer_With_Your_PC.htm#Adding a Column to the
Storage/CustomizingReportColumns.htm#Using the Customize
Using_Your_Analyzer_With_Your_PC.htm#Using the Customize
Using_Your_Analyzer_With_Your_PC.htm#Using the Customize
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Figure 184. The Download Button

5. In the Download dialog box, Select the Test button to test the serial connection to the 
Analyzer.

Figure 185. The Test Button

6. You should get a pop-up window informing you that the connection tested successfully. If 
the test fails, there is a problem with your serial port setup.

Figure 186. Connection Success Window

7. In the Download dialog box, click the Connect button.
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Figure 187. The Connect Button

8. Click the Query Readings button. This will return a list of all current readings on your 
analyzer. The list appears in the large white box in the Download dialog box.

Figure 188. Current Reading List

9. Select the readings that you want to download. There are two ways to do this.
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a. Click the boxes next to each of the reading numbers to select or de-select individual 
readings. You can select a range of readings by pressing the shift key, then selecting 
the first and last reading in the range. All readings from the first reading selected to 
the last will then be selected.

Figure 189. Selecting Readings

b. Click the boxes on the left to select or de-select all the readings of a specific type. You 
can also use the Shift-Click method of selecting a range of readings as described 
above.

Figure 190. Using Check Boxes

10. The download generates a data file containing the selected readings. To save the file for 
later use:

c. Enter the path for the file in the Destination Folder field. You can use the ... button 
to browse.

Figure 191. The Browse Button

d. Enter a name for the file in the File Name field.

Using_Your_Analyzer_With_Your_PC.htm#Adding a Column with the
Using_Your_Analyzer_With_Your_PC.htm#Adding a Column with the1
Using_Your_Analyzer_With_Your_PC.htm#Adding a Column with the1
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CAUTION  Some characters are not allowed in the file name. Characters such as the "#" sign 
will cause an error. Niton recommends using only alphanumeric characters "-", "_" and the 
space character when naming a file.

e. Click the Download button.

Figure 192. The Download Button

When the progress bar shows that all the readings are downloaded, click the Done button.
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Figure 193. The Progress Bar

You should now see the readings you selected for download displayed, one reading per 
horizontal line. The data has been saved to the folder and filename you indicated prior to 
downloading. If an error message has appeared, see the following section. See Creating and 
Using Reports to continue otherwise.

You can also automatically save reports in .csv format for importing into Excel or other 
programs.Simultaneous Save as CSV File

Table 10: Error Messages while Downloading

Error Message Action

Couldn't open \\.\COM7 Error 

Code: 2

Select another COM port.

The port \\.\COM2 is in use Select another COM port.

Please Open the Port Click the Connect button.

Using_Your_Analyzer_With_Your_PC.htm#Simultaneous_Save_As_CSV
Using_Your_Analyzer_With_Your_PC.htm#Simultaneous_Save_As_CSV
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Note  When using the wireless USB adapter, if the serial port repeatedly disconnects, check 
that the battery is fully charged.

Live Download (Automatic Save)

If desired, your Niton XL3 analyzer has the capability to download and store each reading to 
the PC in real time to a file of your choice. To enable this feature, you must do the following:

Hardware Not Responding

or

Hardware Not Ready

Turn on the XRF Analyzer.

If you are using a serial cable, check that the cable is 

inserted snugly.

If you are using a serial cable, select the other COM 

port.

If you are using the wireless USB adapter, connect the 

serial port. See the "Installing and Using Bluetooth" 

manual for complete instructions on setting up the 

Bluetooth adapter to work with your analyzer.

Check that the spare battery is fully charged.

The Serial Port connection failed: 

RFCOMM connection failed

Check that the battery is fully charged.

WARNING: 38400 baud rate not 

supported.

This indicates a potential problem. Test the serial port. 

If there is a problem connecting, switch baud rate on 

both the analyzer and the NDT software to 115200.

Incorrect Data in reading # XXX.

Reading will be skipped.

Error code: 

BOUNDARY_ERROR1.

This indicates a version mismatch between your 

instrument code and the NDT code running on your 

computer. Use a version of NDT that matches the 

ver?sion number of the software on your analyzer.

Incorrect Data in reading # XXX.

Reading will be skipped.

Error code: 

BOUNDARY_ERROR2.

This indicates a version mismatch between your 

instrument code and the NDT code running on your 

computer. Use a version of NDT that matches the 

ver?sion number of the software on your analyzer.

Incorrect Data in reading # XXX.

Reading will be skipped.

Error code: 

BOUNDARY_ERROR3.

This indicates a version mismatch between your 

instrument code and the NDT code running on your 

computer. Use a version of NDT that matches the 

ver?sion number of the software on your analyzer.

WARNING: 115200 baud rate not 

supported.

This indicates a potential problem. Test the serial port. 

If there is a problem connecting, switch baud rate on 

both the analyzer and the NDT software to 38400.

SH4 Successfully Communicating 

Result: SUCCESS

This indicates a normal connection.

Table 10: Error Messages while Downloading
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• Your Niton analyzer must be turned on and connected to the PC. See Connecting the XRF 
Analyzer to Your PC.

• The NDTr program module must be running and connected to your analyzer. See 
Operating Your Analyzer Remotely.

• The Download icon in the NDTr toolbar must be selected.

Figure 194. Live Download Icon

The file created is in a format readable by the NDT program module, has an extension of 
.ndt, and looks identical to a file of manually downloaded readings - see Standard Download. 
It can also create a simultaneous .CSV file. Simultaneous Save as CSV File .

Please note the following:

1. When the instrument is unplugged, selecting the Download icon does nothing.

2. When you disconnect, then reconnect, your analyzer, Download appends future readings 
to same file.

3. Live Download does not overwrite any previous readings in the file. If you want to do 
this, you must first explicitly erase the file before initiating Live Download.

4. Live Download does not retroactively add any readings taken while your analyzer was 
disconnected.

Changing the Filename for Live Download

Once you have selected the Download icon, a dialog box appears as shown below:

Using_Your_Analyzer_With_Your_PC.htm#Hiding a Reading in the
Using_Your_Analyzer_With_Your_PC.htm#Restoring a Row to the
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Figure 195. File Dialog Box

You can change the destination file or folder by clicking in the appropriate text box and typing 
in the new file name, or by clicking on the browse button (...) to the right of the text box and 
selecting a different pre-existing filename. To implement these changes, click the OK button.

Your instrument serial number is associated with the file. If a different instrument is 
connected and Live Download is started, a message will appear saying that the connected 
instrument and file instrument do not match, and Live Download will not start. Saving the 
session as a new file will alleviate this issue

Simultaneous Save as CSV File

By clicking on the checkbox box labeled "Save the readings to CSV file as well" you can 
enable simultaneously saving the data as a standard CSV (Comma Separated Value) file for 
use with other programs.

Creating and Using Reports

Creating a New Report

Niton Data Transfer creates a new report whenever you download data. For more 
information. See Downloading Data for more information.

Opening an Existing Report

To open an existing report

1. Click the Open button to open the Open Existing Report dialog box.

Using_Your_Analyzer_With_Your_PC.htm#Restoring Multiple
Using_Your_Analyzer_With_Your_PC.htm#Reversing the Sort Order
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Figure 196. Open Existing Report Dialog Box

2. Click the name of the report to highlight it.

Figure 197. Selecting the Report

3. Click the Open button.
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4. The report is presented with one line per measurement. The report doesn't all fit onto 
one screen, but you can scroll right if the fields you are interested in are not visible. If they 
are still not visible read the following section on changing visible columns.

Configuring Reports for Printing.

Figure 198. Select Customize from the Menu

1. Select Customize from the Tools Menu.
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Figure 199. Select the Report Print Tab

2. Select the Report Print tab.

This brings up the Report Customization window.
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Figure 200. Customizing the Report

Like the Certificate Print option, the Report Print option adds company information, 
company logo, headers, and footers to a standard report printout. The data input into the 
various report fields is arbitrary - you can put anything you want to into any of the fields. For 
example, you can type test location into the company address field. The names given to the 
fields do not limit the data placed into the fields.

The Company Fields Font Size Selector controls the size of the font used in the Company 
Name, Address, and Location fields. The Headers & Footers Font Size Selector controls the 
size of the font used in the Header and Footer.

The report will print every optional field selected in the Print Options Checklist.
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Figure 201. Sample Report

Viewing the Report Properties

The report properties are:

• Analyzer Serial Number

• Report File Name

• File Version

• Report Download Date

• Total Readings in the Report

To view the report properties, click the Report Properties button, or select 
Properties from the View Menu.
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Figure 202. Select Properties from the Menu

Figure 203. The General Properties Tab

Using the Customize Report Dialog Box to Add and Remove Columns

To use the Customize Report dialog box to add and remove columns:

1. Click the View Menu.

2. Click Customize Report...
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Figure 204. View Menu

2. Click the boxes next to each of the column headings to add or remove each column from 
the report.

Figure 205. Select Columns for Report

3. When a checked box is selected, the check is removed and the box becomes empty.

Figure 206. Deselecting Boxes
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4. If you want, you can click the boxes in the Selection area to select or de-select a group of 
headings.

Figure 207. The Selection Area

5. If you want the changes to apply to all the reports, click the box next to Apply Global. If 
this box does not have a check mark, the changes only apply to the report that is currently 
open.

Figure 208. Applying Changes Globally

6. Click the OK Button.

The columns appear in the order in which they are listed in the Customize Report Dialog 
Box. If you change the position of the columns, and then use the Customize Report Dialog 
Box, the columns return to their original positions.
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Changing the Position of the Columns in the Report

To change the position of a column, click and drag the column heading. A shadow of the 
heading will appear, indicating where the heading will be placed.

Figure 209. Switching Columns

If you want to add or remove columns, but not change their position on the report, you can 
also use the Customize Report Dialog Box. See Using the Customize Report Dialog Box to 
Add and Remove Columns for instructions.

Changing the Columns in a Report

You can remove columns from the reports, add the columns back again, or change the 
position of columns within the reports.

To remove a column from a report, See "Removing a Column from the Report", and See 
"Using the Customize Report Dialog Box to Add and Remove Columns".

To add a column to a report, See "Adding a Column to the Report", and See "Using the 
Customize Report Dialog Box to Add and Remove Columns".

Removing a Column from the Report

Columns can be removed from a single report, or removed globally. Removing a column from 
a single report removes the column only from the report that is currently open. Removing a 
column globally removes the column from the report that is currently open, as well as from all 
reports that are opened later. If you have more than one report open, and you want to remove 
a column from all of the open reports, you must close them and re-open them.

Removing a column does not actually delete the data, it simply removes it from the display. 
You can later re-display the column with the data intact.

To remove a column from the report:

1. Right-click on the heading for the column that you want to remove.
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2. Click Hide, or Hide Global, on the Pop-Up Menu.

Figure 210. Hiding Columns
Note  For some columns, Hide Global is not available.

Adding a Column to the Report

After you remove a column from a report, there are three ways to add it to the report again.

1. Use the Hidden Columns dialog box to add a column to the same report from which you 
removed it. See "Adding a Column with the Hidden Columns Dialog Box" for more 
information.

2. Use the Options dialog box to add a column that you removed using Hide Global. See 
"Adding a Column with the Options Dialog Box" for more information. You can use 
either dialog box if you are adding a column that you removed using Hide Global, in the 
report from which you removed it.

3. Use the Customize Report Dialog Box to add or remove multiple columns at the same 
time. See "Adding a Column with the Options Dialog Box" for more information.

Adding a Column with the Hidden Columns Dialog Box

To add a column to the report using the Hidden Columns dialog box:

1. Open the report that you used to remove the column from the report.

2. Decide where you want the re-inserted column to appear.

3. Right-click on the heading for the column to the left of that.

4. Click Unhide on the pop-up menu to display the hidden columns



 13 Connectivity
Creating and Using Reports

Thermo Scientific Niton XL3 Analyzer User’s Guide 277

Figure 211. Displaying Hidden Columns

5. Click the column heading that you want re-insert.

Figure 212. Selecting Column to Display

6. Click the OK button.

The column is inserted to the right of the original column.
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Figure 213. Reinserting Columns

Adding a Column with the Options Dialog Box

To add a column to the report using the Options dialog box:

1. Select the Tools Menu.

Figure 214. The Tools Menu

2. Select Options.

3. Select the Report tab.
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Figure 215. The Report Tab

4. Click the column heading that you want to re-insert.

Figure 216. Unhide Button

5. Select the Unhide button.

6. Select the OK button.
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Hiding a Reading in the Report

Rows can be prevented from appearing in a report. Hiding a row removes the row only from 
the report that is currently open.
Note  Hiding a row does not actually delete the data, it simply removes it from the display. 
You can later re-display the column with the data intact.

To hide a row in the report:

1. Select the row you want to hide.

Figure 217. Selected Row

2. Right-click on the row and select Hide from the pop-up menu.

3. The row is hidden from the report view.

Figure 218. Hidden Row

4. You can hide multiple readings in this way.
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Restoring the Row to the Report

You can restore a hidden row to the report view.

1. Select the readings above and below the reading you want to restore.

2. Right-click on the highlighted readings.

3. Select Unhide from the pop-up menu, and the row is restored.

Figure 219. Restoring Rows

Restoring Multiple Readings to the Report

You can restore multiple hidden readings to the report view.

1. Right-click on a reading or empty row, and select Unhide from the pop-up menu.

2. The rows are restored.

Figure 220. Restored Readings

Rows (Readings) in a Report

You can prevent rows (readings) from appearing in the reports, add the rows back again, or 
change the position of columns within the reports.

• To hide a row from a report view, See "Hiding a Reading in the Report".

• To restore a hidden row to a report view, See "Restoring the Row to the Report".

• To restore multiple hidden rows to a report view, See "Restoring Multiple Readings to the 
Report".
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• To reverse the sort order of the rows in a report, See "Reversing the Sort Order in a Report".

Reversing the Sort Order in a Report

You can reverse the order of the rows (readings) in a report.

1. Click on any column heading - the labels in the first row of the report.

Figure 221. Column Heading

2. The rows change order from descending to ascending. The column heading you clicked 
displays a triangle indicating the direction of the sort.

Figure 222. Sort Direction Indicator

3. Click the column heading again.

4. The rows reverse order again, with the triangle reversing orientation to indicate the new 
sort order.

Figure 223. New Sort Order
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Note  To revert reading order to the original order click on the "reading number" or "index 
number" column heading.

Viewing the Spectra Graph

You can access the Spectra Graph by double-clicking on any field of the report containing 
non-editable reading information, such as the Reading Number, Index, Time, Type, etc. .

Figure 224. Accessing the Spectra Graph

Editable Fields

Double-clicking on an editable field in the report allows you to edit the contents of that cell. 
When the field is double-clicked, the field becomes highlighted and a text cursor appears in 
the cell. Editable fields contain note-type information which do not affect the reading in any 
way, such as SAMPLE, LOCATION, INSPECTOR, etc. Editable field names are always 
labelled in ALL CAPS.

Changing the Colors of the Spectra Graph

You can change the color of the pen, the text, the grid, the axis, or the background.

Changing the color of the pen changes this part of the graph:
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Figure 225. Changing Spectra Graph Pen Colors

Changing the color of the background changes this part of the graph:

Figure 226. Changing Spectra Graph Background Color
Note  Making the pen and background the same color makes the spectrum invisible.

Changing the color of the grid changes this part of the graph:
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Figure 227. Changing Spectra Graph Grid Colors

Changing the color of the text changes this part of the graph:

Figure 228. Changing Spectra Graph Text Colors

Changing the color of the axis changes this part of the graph:



13 Connectivity
Viewing the Spectra Graph

286 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 229. Changing Spectra Graph Axis Colors

To change the color of the spectra graph:

1. Click the Down Arrow button on the Pen Color button to display the Color Menu.

Figure 230. The Pen Color Button

2. Click the part of the graph that you want to change.

3. If you select Set Pen Color, the Spectrum Properties dialog box appears.
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Figure 231. Spectrum Properties Dialog Box
Note  This dialog box only appears if you select Set Pen Color. If you want to change the color 
of any other part of the spectra graph, skip to Step 6.

4. If you have selected more than one Reading, click the Reading Number that you want to 
set.

Figure 232. Selecting Readings

5. Select the Color button.

Note To select more than one Reading Number, hold down the shift key while selecting.

6. In the Color dialog box, click a color to select it.
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Figure 233. Selecting Colors

7. Click the OK button.

Defining Custom Colors

In addition to the forty-eight Basic Colors provided, you can also define additional colors. 
These are called "custom colors."

To define a custom color:

1. Select the Pen Color button to display the Color dialog box.

2. Select Define Custom Colors Button to display the custom color area.
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Figure 234. Custom Colors

3. Use the panel on the right to specify a color.

Click within the large color box to specify the hue and saturation. Hue is the color, or shade of 
color. Saturation is whether the color is pure or mixed with gray.

The values for hue range from 0 on the left side of the color box, to 239 on the right side.

The values for saturation range from 0 at the bottom of the color box, to 240 at the top.

Notice that as you click in different places in the color box, the values for hue and saturation 
change.

Figure 235. Selecting From the Color Box
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Use the slider to specify the luminosity. Luminosity is the measure of how much light is in the 
color.

The values for luminosity range from 0 at the bottom of the slider, which indicates black, to 
240 at the top, which indicates white.

Notice that as you move the slider up and down, the value for luminosity changes.

Notice as you move the slider up and down, the values for Red, Green, and Blue also change. 
These values represent a second method for specifying the same colors.

The color you have selected is shown in the smaller Color|Solid box.

Figure 236. Current Color
Note  If you know the values for the color that you want, you may type them directly in the 
boxes.

4. When you are satisfied with the color you have selected, click Add to Custom Colors 
button. The color appears on the left under custom colors. It can now be used in the 
spectra graph in the same manner as the Basic Colors.



 13 Connectivity
Viewing the Spectra Graph

Thermo Scientific Niton XL3 Analyzer User’s Guide 291

Figure 237. Closing the Dialog Box

5. Close the dialog box by doing one of the following:

To close the dialog box and replace the current color in the spectra graph, click the OK 
button.

To close the dialog box, but not replace the color, click the Cancel button.

Returning to the Default Colors

To return to the default pen colors, close the graph and re-open it.

To return to the default colors for the background, grid, text, axis and x-ray line:

1. From the Tools Menu, select Options.
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Figure 238. The Tools Menu

2. In the Options dialog box, click the Spectra tab.

Figure 239. Restoring the Default Colors from the Spectra tab

3. Click the Restore Default Colors button.

4. Click OK.
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Viewing Different Areas of the Spectra Graph

Niton Data Transfer lets you view different areas of the spectra graph. The available options 
are shown in the table.

Table 11. Spectra Graph Options

Option What the Option displays

Low Energy Spectra

The area of the spectra from 0-40 keV.

High Energy Spectra

The area of the spectra from 40-100 keV.

Full Spectra

The area of the spectra from 0-100 keV.

Custom Size

The area that you specify.

Max Y Limit is the maximum 

counts/sec?ond.

Max X Limit is the maximum keV.
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Magnifying the Spectra Graph

Niton Data Transfer lets you magnify a specific area of the spectra graph.

To magnify the spectra graph:

1. Display the spectra graph by double-clicking on the reading number.

Figure 240. Displaying a Spectra Graph

2. Highlight the area that you want to magnify. To do this, click and drag over the desired 
area. The Cursor Information dialog box appears showing the keV of the boundaries for 
the area of the spectra graph that is selected. It also shows the height of the highest peak 
within the selected area.

Auto Scale The area varies. It begins at 0 keV. It ends 

wherever the spectra flattens out so that all 

of the peaks are less than 10% of the height 

of the highest peak.

This option is the default.

Fit The area that you specify. See "Magnifying 

the Spectra Graph" for more information.

Table 11. Spectra Graph Options
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Figure 241. Selecting Spectra Graph Areas of Interest

3. Click the Fit button. The spectra graph expands to show only the previously selected area, 
and the Cursor Information dialog box is reset to zero.

Figure 242. Spectra Graph Fit to Area Selected

Hiding or Showing the Cursor Information Dialog Box

The Cursor Information dialog box displays the keV of the left and right boundaries for the 
area of the spectra graph that is selected. It also shows the height of the highest peak within 
the selected area. To show the Cursor Information dialog box, click anywhere in the spectra 
graph.

To hide the Cursor Information dialog box:

1. Click the View Menu.
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2. Click Cursor Information.

Figure 243. Selecting Cursor Information

The Cursor Information Box

Figure 244. The Cursor Information Box

Figure 245. Cursor Positioning on the Spectra Graph
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Left Boundary

This line lists the energy in keV of the Left boundary selected.

Right Boundary

This line lists the location of the Right boundary selected.

Highest Peak

This line lists the height of the peak selected in Counts/Second.

Nearest Ka Element peak

This line lists the element with the nearest Ka peak to the selected energy position, along with 
the energy of that peak in keV. If the selected energy position is an area - i.e. the Left and 
Right boundaries are different - this result will be zero.

Nearest Kb Element peak

This line lists the element with the nearest Kb peak to the selected energy position, along with 
the energy of that peak in keV. If the selected energy position is an area - i.e. the Left and 
Right boundaries are different - this result will be zero.

Nearest La Element peak

This line lists the element with the nearest La peak to the selected energy position, along with 
the energy of that peak in keV. If the selected energy position is an area - i.e. the Left and 
Right boundaries are different - this result will be zero.

Nearest Lb Element peak

This line lists the element with the nearest Lb peak to the selected energy position, along with 
the energy of that peak in keV. If the selected energy position is an area - i.e. the Left and 
Right boundaries are different - this result will be zero.

Figure 246. Cursor Information for Selected Area
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Hiding or Showing the Grid

Hiding the grid hides this part of the graph:

Figure 247. Hiding or Showing the grid

To hide the grid, click the Toggle Grid button.

To show the grid, click the Toggle Grid button again.

Viewing the X-ray Line List

To view the X-Ray Line List, Click on the View Menu, then Select the X-Ray Line List.

Figure 248. The X-ray Line List

The X-Ray Line List gives the energy in KeV of the peaks for various elements. This is a 
reference you may find handy. The list gives the Ka, Kb, and La energy peaks for the elements 
listed.

Below is the X-ray Line List:
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Figure 249. The X-ray Line List

You can select the element of your choice to highlight the characteristic energies for that 
element.
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Figure 250. Close View of the X-ray Line List

Peak Labels

If you load up the X-Ray Line List while viewing a spectrum, Peak Labelling is activated. 
When you click on a peak with Peak Labeling activated, that peak is labeled with the name of 
the nearest elemental energy line:

Figure 251. Peak Labelling
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In the example above, clicking on the peak at 32 shows that the nearest elemental energy line 
is the Ka line of Ba. Simultaneously, the other lines of Ba are also labeled - in this case the Kb 
line. The element Ba is also highlighted on the X-ray Line List:

Figure 252. Highlighted Element Peaks

This linking between the Line List and the Spectrum works in reverse as well. Click on an 
element in the line list, and the appropriate peaks in the spectrum will be labeled:

Figure 253. Selecting a Peak with the X-ray Line List

Select Options... from the Tools Menu, then select the Spectra Tag in the Options Screen.
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Figure 254. The Spectra tag

Then click the check box next to Persist Peak Labels.

Figure 255. Making Peak Labels Persistent

This makes all the previous Peak Labels stay on screen when you select another peak.
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Figure 256. Viewing Multiple Peak labels

You can also do this by right clicking on the spectrum and selecting Preserve Label(s)

Figure 257. Selecting Persistent Labels Through the Menu

You can also right click on the spectrum and select "Clear Label(s)" to remove all accumulated 
Peak Labels from the spectrum.
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Figure 258. Clearing Labels from the Spectrum

Overlaying Spectra

You can overlay the spectra from several different readings to highlight differences and 
similarities between and among the different spectra.

Open a reading file.

Select the readings you want by holding down the control key and clicking on the row 
containing the reading. This will select the readings you clicked on, but not anything in 
between.

Figure 259. Selecting Multiple Spectra for Overlay

OR
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Select the readings you want by holding down the shift key and click on the row containing 
the first reading you want, then clicking in the row containing the last reading you want. This 
will select the reading you clicked on and any readings in between.

Figure 260. Selecting a Range of Spectra for Overlay

Right click on any selected file and choose Spectra from the pop-up menu.

Figure 261. Selecting Spectra from the Menu

This will bring up the a window displaying the selected spectra overlain on the same graph.
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Figure 262. Overlain Spectra

Spectral Difference

To better detect subtle differences in spectra, you can subtract one spectrum from another. 
The difference will be displayed as its own spectrum.

Select the two samples you wish to compare, and display them as overlain spectra.

Figure 263. Two Overlain Spectra

From the Tools Menu, select Spectral Difference.
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Figure 264. Selecting Spectral Difference from the Menu

The difference between the two spectra is then presented as a spectrum of its own, giving the 
number of counts difference at each energy level

Figure 265. Difference Spectrum

When you are done with the Difference Spectrum, you can return to view the overlaid spectra 
by selecting Undo Spectral Difference from the Tools Menu.
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Figure 266. Undoing Spectral Difference

Paint Readings and Spectra

Paint readings are special in that they can be compared to a set quantity, known as the Action 

Level, for comparison. If a reading is below the Action Level, then one course of action is 
followed. If the reading is at or above the action level, then another course of action is 
followed. The NDT program allows you to see this difference visibly in the data.

Figure 267. Paint Readings

Above is a series of three paint readings. Each is a different color. The color of the row 
correlates to the result. In this case, the Null reading is black, the Positive reading is red, and 
the Negative reading is blue. These colors can be set to any combination of colors as your 
preference.
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Figure 268. Selecting Options from the Menu

To change your color preferences, select Options from the Tools Menu, then select the Report 
tab in the Options dialog box.

Figure 269. The Report Tab

You can select the color you want in the Color menu, or create a custom color.
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Figure 270. Selecting Your Preferred Colors

The new color will show up in the Report tab.

Figure 271. The Report Tab

The new colors will show up on the report.
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Figure 272. New Colors in the Report

Using the Menus Instead of the Toolbar

Most of the functions that can be performed using the buttons on the Toolbar can also be 
performed using the menus. This is illustrated in the table.

Table 12. Using the Menus Instead of the Toolbar

Button Menu
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Table 12. Using the Menus Instead of the Toolbar



 13 Connectivity
Using the Menus Instead of the Toolbar

Thermo Scientific Niton XL3 Analyzer User’s Guide 313

No Menu Equivalent

Table 12. Using the Menus Instead of the Toolbar
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Table 12. Using the Menus Instead of the Toolbar
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Table 12. Using the Menus Instead of the Toolbar
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Table 12. Using the Menus Instead of the Toolbar
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Renaming a Report

To give a report another name:

1. Select Save As from the File Menu.

Figure 273. Saving a Report Under Another File Name

2. Type a name in the File Name field of the Save As Dialog Box.

Table 12. Using the Menus Instead of the Toolbar
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Figure 274. Renaming the File

3. Click the Save Screen Button.

Saving Selected Readings from a Report

To save part of an NDT file, select the readings you wish to save by highlighting them with 
the Shift or Ctrl keys and the left mouse button. Select Save Selected Readings As from the 
File Menu.

Figure 275. Saving Selected Readings As

You will then be prompted to enter a new file name. Only the selected readings will be saved 
to the new NDT file.
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Figure 276. New File Name

Copying a Report Into Excel

Niton Data Transfer (NDT) enables you to copy report data and paste it into an Excel 
spreadsheet.

For information about exporting the report data as a CSV file to use in other programs, See 
"Exporting the Report Data".

For information about exporting the data from the spectra graphs, See "Exporting the Spectra 
Data".

To copy report data into Excel:

1. Open the report. For more information, See "Opening an Existing Report".

2. Select the readings that you want to copy to Excel.

To select a range of readings, hold down the shift key and click the first and last readings in 
the range.
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Figure 277. Selecting a Range of Readings

To select multiple readings that are not adjacent, hold down the control key and click each 
reading that you want to select.

Figure 278. Selecting Multiple Readings

3. Select Copy from the Edit Menu.

Figure 279. The Edit Menu

4. Open Excel. To do this:

a. Click the Start button.

b. Select Programs from the Start Menu.

c. Click Microsoft Excel.
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Figure 280. Loading Excel

5. Within Excel, select Paste from the Edit Menu.

Figure 281. Pasting Data Into Excel

6. Excel shows the data from the columns that are displayed in NDT, for the rows that you 
selected.

Figure 282. How NDT Data is Displayed in Excel
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Note  If the Time column does not display properly, click on the cell.

Exporting the Report Data

Niton Data Transfer lets you export the data from the reports to a file in Comma Separated 
Value (CSV) format. You can then import the data into another program to manipulate it.

You can also copy the report data directly into Excel. For more information See "Copying a 
Report Into Excel".

This section covers exporting report data. For information about exporting spectra data, See 
"Exporting the Spectra Data".

To export the report data:

1. Open the report. For more information, See "Opening an Existing Report".

2. Select Export Data from the Tools Menu.

Figure 283. Exporting Data

3. The Export Data Dialog Box will appear.
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Figure 284. The Export Data Dialog Box

4. In the Export Data dialog box, specify the reading numbers that you want to export.

If you want to export the report data for all the reading numbers, you do not need to make a 
change for the reading numbers. Leave the All box checked and move on to the next step.

If you want to export only some of the report data:

a. Uncheck the All box.

b. Enter the reading numbers. You may enter individual reading numbers, or ranges of 
reading numbers, separated by commas. Do not use spaces. For example: 1,3,5-12
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Figure 285. Exporting Data Ranges and Selected Readings
Note  Be sure that you specify the reading numbers, not the index numbers.

5. Specify the folder where you would like to place the report files. The folder that is 
currently selected appears in the Destination Folder field. To change the folder, click the 
"..." (Browse) button.

6. Enter a name for the export file in the Output File Name field.

Figure 286. Naming the Export File

7. Click the Start button.

8. When the progress bar shows 100%, click the Done button.
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Figure 287. Finishing the Process
Note  This export creates one text file that includes all of the specified readings as comma 
separated values. This file can be imported into any program that accepts data in CSV format.

Printing Certificates of Analysis

NDT can output certificates of analysis for any reading. To set up a default certificate for 
printing, select the Customize option from the Tools Menu.

Figure 288. Selecting Customize

This will bring up a pop-up window with options you can customize for your own use.
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Figure 289. The Certificate Print Tab
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Figure 290. Components of the Certificate Print Tab

The Logo Section

In the Logo Section of the certificate pop-up window, you can add your company logo to the 
printed document.

Logo File Field

You can type the location of your company logo directly into the Logo File Field if you know 
the location of the logo on your computer or local network

"..." Browse Screen Button

Selecting this button will bring up a standard browsing pop-up window, allowing you to find 
the logo graphics file if you are not sure of the logo graphics file?s location. This will 
automatically fill that location into the Logo File Field when you confirm the selection.



13 Connectivity
Printing Certificates of Analysis

328 Niton XL3 Analyzer User’s Guide Thermo Scientific

Clear Screen Button

Selecting this button will clear the Logo File Field and reset it to a null (blank) condition.

Logo Position Radio Screen Buttons

Selecting one of these three buttons allows you to position your company?s logo on the 
certificate document. Only one of these buttons may be selected at any given time. Selecting 
one button will clear the other buttons.

The Company Info Section

In the Company Info Section of the certificate pop-up window, you can add your company's 
name and location to the printed document. There are no restrictions on what you type into 
these fields - the names of the fields are just suggestions. If you want the Company Address 
field to contain your location - i.e. "Billerica, MA USA 01821" - and the Company Location 
field to contain your Telephone number - i.e. "Tel: 978-670-7460" - you are free to do so.

Company Name Field

You can type your company's name - i.e. "Thermo Fisher Scientific" - directly into this field.

Company Address Field

You can type your company's street address - i.e. "900 Middlesex Turnpike, Bldg #8" - 
directly into this field.

Company Location Field

You can type your company's city, state, province, or country - i.e. "Billerica, MA USA 
01821" directly into this field.

Company Info Radio Screen Buttons

Selecting one of these three buttons allows you to position your company's information on 
the certificate document. Only one of these buttons may be selected at any given time. 
Selecting one button will clear the other buttons.

The Heading Section

The Heading is the Certificate Name. You can use this field to enter the type of analysis 
certificate you are printing - i.e. "Certificate of Alloy Analysis", "Certificate of Testing", 
"Certificate of Analysis", or whatever else is customary for your company and the type of 
analysis done in the Reading.
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The Printing Options

The Printing Options allows you to select which Section you want to print along with the 
actual analysis. Selecting an option will place a check in the box if there is none there before 
your selection, and remove a check if there is one already there. All Sections which are checked 
will be included in the printout.

Printing the Certificate

Right-click on the Reading for which you want a certificate printed, and select the "Print 
Certificate" option from the pop-up menu.

Figure 291. Select print Certificate from the Menu

This will send the analysis and heading information directly to your regular printer.

The Certificate of Analysis

Here is a sample C of A printed by NDT:
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Figure 292. Example Certificate

Closing a Report

To close a report, select Close from the File Menu.

Figure 293. Closing a Report from the File Menu
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Deleting a Report

To delete a report:

1. Click the Open button.

2. Right-click the name of the report to highlight it.

Figure 294. Selecting a Report

3. A Pop-up window will appear.

Figure 295. The Pop-up Menu

4. Choose Delete from the pop-up menu.
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Figure 296. The File Deletion Pop-up Menu

5. Click the Yes button.

Printing from NDT

Niton Data Transfer lets you print both reports and spectra graphs. See See "Printing Reports 
and Spectra Graphs from Niton Data Transfer"<XREF> for more information.

You can also print spectra graphs by first exporting them to Microsoft Excel. This method 
gives you more formatting options. See "Printing Spectra Graphs from Excel" for more 
information.

Niton NDT uses a WYSIWYG (What You See Is What You Get) approach to report printing 
and creation. Displayed columns and readings will print, and hidden columns and readings 
will not. If you find your printout is missing data you are interested in, please see the section 
on "Viewing Data and Creating Reports".

Printing Reports and Spectra Graphs from Niton Data Transfer

Checking Paper Size and Orientation

Before printing a report, check that the paper size and orientation are correct. There are two 
ways to do this:

• Click the Print Preview Screen Button. This shows how the page will be printed.

• Use the Print Setup menu item. This displays the paper size and orientation and also lets you 
change them.

To use the Print Setup menu item to change the paper size and orientation:

1. Click the File Menu.

2. Click Print Setup to display the Print Setup Dialog Box.
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Figure 297. Select Print Setup

3. Select the correct paper size from the drop-down list.

4. Click the radio button for the correct orientation. The icon illustrates the orientation that 
is selected.

Figure 298. Print Setup Dialog Box

5. Click the OK Screen Button.

Printing from Niton Data Transfer
Note  Niton Data Transfer only prints the report or spectra graph that is currently displayed. 
You must open the report or spectra graph before you print it.
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To print the report or spectra graph:

1. Click the Print Screen Button to display the Print Dialog Box.

2. Check that the correct printer is displayed in the Name field. If it is not, use the 
drop-down list to select the printer. If you want to change the properties of the printer, 
refer to the documentation for your printer for more information.

3. Select the pages that you want to print by doing one of the following:

a. To print the entire report, click the All radio button.

b. To print only part of the report, enter the first and last page numbers for the part that 
you want to print.

4. Specify the number of copies that you want to print.

5. Click OK.

Printing Spectra Graphs from Excel

Printing a spectra graph from Excel requires:

1. Exporting the spectra data from Niton Data Transfer.

2. Importing the spectra data into Excel.

3. Creating the graph in Excel.

4. Printing the graph.

These steps are explained in detail below.
Note  Using this feature requires a separate copy of Microsoft Excel. Niton Data Transfer does 
not include a copy of Excel.

Exporting the Spectra Data

To export the spectra data from Niton Data Transfer:

1. Open the report. For more information, see "Opening an Existing Report".

2. Select Export Spectra from the Tools Menu.
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Figure 299. Select Export Spectra from the Menu

3. Specify the reading numbers that you want to export.

If you want to export the spectra data for all the reading numbers, you do not need to make a 
change for the reading numbers. Leave the All box checked and move on to the next step.

If you want to export only some of the spectra data:

1. Uncheck the All box.

2. Enter the reading numbers. You may enter individual reading numbers, or ranges of 
reading numbers, separated by commas. Do not use spaces. For example: 1,3,5-12

Figure 300. Specify Reading Numbers
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3. Specify the folder where you want place the spectra files. The folder that is currently 
selected appears in the Destination Folder field. To change the folder, click the "..." 
button.

Figure 301. Changing Folders with the Browse Button

4. Enter a name for the export file in the Output Filename field.

Figure 302. Naming the Export File
Note  The data for each reading is in a separate file. The file name for each reading is the file 
name that you specified, plus the Rdg # and reading number. For example: First_1_3, 
First_3_14, First_5_16.
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5. Click the Start button.

6. When the progress bar shows 100%, click the Done button.

Figure 303. Finish the Export Process

Importing the Spectra Data

To import the spectra data into Excel:

1. Open Excel. To do this:

2. Click the Start button.

a. Select Programs.

b. Click Microsoft Excel.
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Figure 304. Opening Excel

3. Select Open from the File Menu.

4. In the Open Dialog Box, select Text Files from the drop-down list.

Figure 305. Selecting File Type

5. Move to the directory that contains the spectra data files. Double click on a folder to 
move to a lower level. Click the Up One Level button
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Figure 306. Navigating to the Proper Folder

6. Double-click on the name of the file that you want to import into Excel.

Figure 307. Importing the Data

The data is now in Excel. You should see two columns of numbers, similar to this:
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Figure 308. The Data File Displayed in Excel

The first number is the Bin Number, which gives the number of the bin in that row. The 
second number is the number of Counts in the Bin. Bins separate the number of Counts at 
different energies. Since different elements fluoresce at different energies, the number of 
Counts in a Bin can tell you how much of each element is in a sample. The size of the Bin 
depends on the testing mode used on the sample.

Creating the Graph

To create the graph:

1. Select Chart from the Insert Menu.

Figure 309. Selecting Chart from the Menu

2. Select the Scatter Chart icon with data points connected by lines without markers.
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Figure 310. Selecting Scatter Chart

3. Click the Next Screen Button to move to Step 2.

Figure 311. Selecting Next
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4. Click the Next Screen Button to move to Step 3.

Figure 312. Selecting Next

5. Click the Next Button to move to Step 4.

6. Click the radio button for As new sheet.

Figure 313. Selecting "As New Sheet"

7. Click the Finish Button.

Printing the Graph
Note  For more information about how to format the graph before printing it, refer to the 
documentation for Microsoft Excel.

To print the graph:

1. Select Print from the File Menu.
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Figure 314. Selecting Print from the Menu

2. Check that the correct printer is displayed in the Name field. If it is not, use the drop-down 
list to select the printer. If you want to change the properties of the printer, refer to the 
documentation for your printer for more information.

Figure 315. Print Dialog Box

3. In the Print what section, click the radio button for Active sheet(s).
Note  Do not print the entire workbook. This prints the spectra data as two columns of 
numbers. It will require 60-70 pages to print all the data.

1. Specify the number of copies that you want to print.

2. Click the OK button.
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Creating a Report File from Multiple Source Files

You can copy readings from one report file and paste them into another file, or into a new file. 
Select the readings you want to copy, using the shift or control keys as appropriate. 

Figure 316. Selecting Multiple Readings

Right click on the selected files, and select Copy Readings (Binary) from the Pop-up Menu.
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Figure 317. Copying Readings

Open a destination report file to transfer the readings into.

Figure 318. New Destination File

Right-click on any of the readings, and select Paste Readings (Binary) from the Pop-up Menu. 
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Figure 319. Pasting Multiple Readings Into New Destination File

The new readings will be highlighted in color to distinguish them from the readings already in 
place.

Figure 320. Multiple Readings Pasted
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If you paste readings from yet another report file, they will be displayed in another color. Each 
group of readings copied in will have a different color.

Figure 321. Multiple Readings from Multiple Files Pasted

The color distinctions will disappear when you save the file.
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Figure 322. Saved Compound File

The original information is still there, though, and can be retrieved by right clicking on a 
reading and selecting Report Properties.
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Figure 323. Accessing the Report Properties

Each analyzer whose readings have been pasted into the Compound Report will have a 
separate tab in properties. The tab for the analyzer which was used to take the reading you 
highlighted will be displayed on top.
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Figure 324. Reading the Properties Window

You cannot upload a compound file into an analyzer. Compound files are for data correlation 
only.
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Controlling Your Analyzer From Your PC

The NDTr program allows you to completely control your Niton analyzer remotely, from 
your computer. It works over serial or USB connection over the supplied connector, or 
Bluetooth wireless communication. See Connecting the XRF Analyzer to Your PC for details 
on how to connect your Analyzer and PC.

The NDTr Toolbar 

The NDTr Toolbar is a string of icons along the top of the NDTr window. It looks like this:

Figure 325. The NDTr Toolbar

Start Measurement 

Clicking this icon will initiate a measurement in whatever mode the analyzer is in currently.

Stop Measurement 

Clicking this icon will halt any ongoing measurement on the analyzer.

Configure Connection Settings

Clicking this icon will allow you to change your configuration settings.

Connect 

Clicking this icon will attempt to establish a connection between your computer and your 
analyzer.
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Disconnect 

Clicking this icon will disconnect your computer from your analyzer.

Live Download

See Live Download from NDTr

Configure Connection Settings

Clicking on the Configure Connection Settings icon allows you to change the Com Port for 
connecting your computer to your analyzer. Once you click on the icon, a settings dialog box 
will appear.

Figure 326. Connection Settings Dialog Box

Selecting the Com Port

Selecting the down arrow in the "Connect Using" field will display the various Com Ports on 
the computer that the analyzer can connect through. 

Figure 327. Selecting the Com Port

Select the proper com port from the list, then select the OK Button.
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Operating Your Analyzer Remotely

NDTr version 7 and above will automatically select the proper virtual interface for you, 
whether you have a Thermo Scientific Niton XL2 or XL3. The virtual interface operates 
exactly as the analyzer would. Selecting the buttons, icons and menus with your mouse works 
exactly as if you were selecting them with your finger or stylus on the real analyzer.

Figure 328. Niton XL3 Virtual Interface 

Live Download from NDTr

Once you have connected to your analyzer using NDTr, click on the Download icon on the 
NDTr toolbar. When you click the Download icon, a Download dialog box will appear.
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Figure 329. File Dialog Box

Dest Folder 

This field shows the last used save folder, defaulting to the folder where NDT is installed.

... (Browse Folders) Button 

Selecting this button enables you to select a different folder for saving the file. This will 
change the Dest Folder Field.

Selected File 

This shows the filename the reading will be saved to unless you change it. 

... (Browse Files) Button 

Selecting this button enables you to select a different file name by browsing the file listing. 
The file extension “.ndt” will be appended to the name - i.e. File name “file” will be saved as 
“file.ndt” and the file will be in the NDT format.

Save the Reading to CSV File as Well Checkbox

Selecting this checkbox enables you to create a second autosave file with CSV format for 
importing into spreadsheets such as Excel. This file will have the same name as the NDT file 
above, but with the file extension “.csv” instead - i.e. “test.ndt” will be saved as “test.csv” as 
well. The checkbox is selected when there is a check in it, and deselected when it is empty.

Always Show this Dialog Box when the File button is Pressed Checkbox 

Selecting this checkbox will enable you to change the filename whenever you want. 
Deselecting this checkbox will save the file under the same name in the same folder every 
time. The checkbox is selected when there is a check in it, and deselected when it is empty.



 13 
Setting up Bluetooth

Thermo Scientific Niton XL3 Analyzer User’s Guide 355

Setting up Bluetooth

Step 1: Insert the Bluetooth USB Adapter CD

Figure 330. The Bluetooth Setup Screen

Step 2: Click the Next > Button
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Figure 331. The Bluetooth InstallShield Wizard Screen

Step 3. Accept the Agreement and press the Next Button
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Figure 332. The Bluetooth End User License Agreement

Step 4: Accept the selected folder and press the Next Button
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Figure 333. The Bluetooth Folder Selection Screen

Step 5: Press the Install Button to begin the Installation.
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Figure 334. The Bluetooth Software Installation Screen

Step 6: The screen will show a progress bar as the software is installed.
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Figure 335. The Progress Bar

Step 7: When the "Bluetooth device not detected" message appears, insert your Bluetooth 
device into any open USB port, and select the OK Button.

Figure 336. The Bluetooth Device Missing Message

Step 8: The Install wizard will finish copying the files to the system.
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Figure 337. The InstallShield Wizard Completed Screen

Step 9: Select the Finish Button to complete the installation.

Connecting the Bluetooth device to your XRF Analyzer.

Step 1: On the System tray, Right click on the Bluetooth icon and Select “Start Using 
Bluetooth”.

Figure 338. The Bluetooth Icon in the Setting Tray

Step 2: Select the Next Button with the following options selected.
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Figure 339. The Bluetooth Icon in the Setting Tray

Step 3: Select the Next Button with the default names selected by the system.



 13 
Connecting the Bluetooth device to your XRF Analyzer.

Thermo Scientific Niton XL3 Analyzer User’s Guide 363

Figure 340. The Device Name and Type

Step 4: Select the Next Button.
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Figure 341. Configuring the Bluetooth Services

Step 5: Select Bluetooth Serial Port if it is not selected, then Select the Next Button.
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Figure 342. Selecting the Bluetooth Serial Port

Step 6: IMPORTANT: TURN ON THE XRF INSTRUMENT, then select the Cancel 
Button. 
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Figure 343. Stopping the Configuration Wizard

Step 7: Right Click on the Bluetooth icon in your System tray, and select Explore My 
Bluetooth Places. 

Figure 344. Selecting My Bluetooth Places

Step 8: Select Add a Bluetooth Device
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Figure 345. Adding a Bluetooth Device

Step 9: The wizard will search for the instrument. When your analyzer’s icon appears, select 
the analyzer’s icon and select the Next Button.
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Figure 346. Searching for Your Analyzer

Step 10: Right-Click on the My Bluetooth Serial Port icon, and select Properties.
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Figure 347. Selecting Properties

Step 11: The Bluetooth Device will attempt to pair with your analyzr. When it askes for the 
passkey, type 0000.
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Figure 348. Pairing With Your Analyzer

Step 12: Select COM0, then the Next Button.
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Figure 349. Selecting COM0

Step 13: Select the OK Button.



13 
Connecting the Bluetooth device to your XRF Analyzer.

372 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 350. Establishing the Connection

Step 14: Select the Finish Button.
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Figure 351. Completing the Setup

Step 14: Your analyzer is now connected. Note the COM Port assigned, as you must use this 
COM port when using Bluetooth with your analyzer. Select the OK Button.

Figure 352. Note the Assigned COM Port
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Figure 353. The Serial Connection icon

Troubleshooting Your Connection

If the XRF instrument doesn’t connect with Bluetooth, load My Bluetooth Places, and check 
the following settings:

Step 1: Select View or Modify Configuration.
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Figure 354. My Bluetooth Places Screen

Step 2: Select Client Applications.



13 
Troubleshooting Your Connection

376 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 355. Client Applications

Step 3: Select Bluetooth Serial Port and then click the Properties Button.
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Figure 356. Selecting the Serial Port

Step 4: Uncheck Secure Connection option.
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Figure 357. Deselecting Secure Connections

Step 5: Make sure the Secure Connection is unchecked.
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Figure 358. The Properties Screen

Step 6: You should see “Not Required” in the Bluetooth Serial Port configuration. 
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Figure 359. Secure Connection Not Required

Now you are ready to use the Bluetooth adapter. See Using the Wireless USB Adapter to 
Connect the XRF Analyzer for using your analyzer with a Bluetooth Connection.
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Figure 360. The Serial Port Connected
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Interfacing Thermo Scientific Niton Analyzers and 
the Trimble/ArcPad GIS System

Setting Up Your Trimble Handheld

Trimble Setup

 Setup an incoming Bluetooth port on the handheld.

 Click on Start at the upper left corner of the screen.

Figure 361. The Trimble Main Screen

 Click on Settings in the pull down menu.
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Figure 362. Selecting Settings

 Click the connections tab at the bottom of the page.

Figure 363. Selecting the Connections Tab

 Select Bluetooth settings.
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Figure 364. Selecting the Bluetooth Settings

 Click the far-right tab labeled “COM Ports” in the lower right hand corner and edit the 
incoming port.

Figure 365. Selecting the COM Ports Tab
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You may need to try this with different COM ports to find one that works properly.

Figure 366. The COM Ports Tab

To change the port, click and hold “Incoming Port” then choose edit. 

Figure 367. Selecting the Bluetooth Settings

Choose a port and be sure to remember which port you select. Select Finish when done.
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Figure 368. Selecting the Bluetooth Settings

Click the middle tab labeled Mode and select the box to the left of “Turn on Bluetooth” and 
the box to the left of “Make this device visible to other devices”.

Figure 369. Turning Bluetooth Options On
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When the connection is ready, a window will pop up on the Trimble asking you if you want to 
connect with your analyzer. Select Yes.

Figure 370. Connecting With Your Analyzer

This may connect the Trimble to the Analyzer, but not the Analyzer to the Trimble. If so, 
attempt to connect again to the Trimble from the Analyzer.

Setting Up Your Analyzer

From the Main Menu, select the System icon. This will load the System Menu. From the 
System Menu, select the Printer icon. 
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Figure 371. The Printer Setup Menu Path

Enable the automatic printing of readings by selecting the Auto Print Readings checkbox. 
Finally, select the Close Button.

Figure 372. The Printer Setup Screen

Installing ArcPad GIS Software To Your PC

Place the software DVD that came with your Trimble into the disc drive of the computer and 
follow the on-screen prompts to install the syncing software onto your PC.
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Figure 373. The PocketPC Sync Installation Sequence
Note  You may not want to synchronize your email and personal folders with the Trimble 
device, especially if the Trimble is shared with others. The Trimble acts as a PDA, and syncing 
email and personal folders will share them with anyone having access to the device.

Open Microsoft ActiveSync and choose File from the tool bar and then Synchronize in the 
pull down menu.
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Figure 374. Connecting to the Trimble

Now install the ArcGIS software onto your PC. Place the DVD into your DVD drive.



14 Interfacing Thermo Scientific Niton Analyzers and the Trimble/ArcPad GIS System
Installing ArcPad GIS Software To Your PC

394 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 375. The ArcPad Splash Page

From the splash screen menu, select Install ArcPad 8.

Figure 376. The ArcPad Splash Page

Select Next.
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Figure 377. Beginning Setup

Browse to the Folder you want to use, and select Next.

Figure 378. The ArcPad Group

If you want, change the name of the group. Otherwise select Next.
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Figure 379. Ready to Install

Select the Next Button.

Figure 380. The ArcPad Splash Page

A progress bar will display as the components are installed.
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Figure 381. The ArcPad Splash Page

Select the Finish Button when the installation is done.

Select the ArcPad Deployment Manager from the ArcPad menu.

Figure 382. The Deployment Manager
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Select the checkboxes next to Install ArcPad for Windows Mobile and Install ArcPad Today 
Plug-in for Windows Mobile.

Figure 383. Progress Bar

A progress bar will display as the components are installed.

Figure 384. Deployment Complete

Select OK.

Deploying ArcPad to the Trimble and Setting Up GPS

Once the device is synchronized, Select Tools in the toolbar and choose Add/Remove 
Programs from the drop down menu.

Another window will open. Click boxes next to program to be added: ESRI ArcPad 8.0, ESRI 
ArcPad, etc. 
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Figure 385. Adding and Removing Deployed Programs

Select the OK Button and follow the remainder of the screen prompts on the PC and mobile 
device.

Figure 386. Progress Bar
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From the home menu on the Trimble click on Start.

Figure 387. ArcPad Start Button

A pull down menu will appear, choose the ArcPad program.
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Figure 388. Selecting ArcPad

When ArcPad opens, press the green OK Button in the lower left corner of the screen.

Figure 389. Select OK
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The main toolbar displays an icon that looks like a satellite. Click on the icon and then select 
GPS Preferences from the menu.

Figure 390. Select GPS Preferences

The default protocol – NMEA 0183 - and port 4 are the correct settings for a Juno. The Port 
is changed by clicking on the COM# displayed and choosing COM4:GPS from the pull 
down menu.

Note  Do not change port settings from COM 4 once initially established
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Figure 391. Setting up the GPS

Click the OK Button in the bottom left corner to return to the main page.

Setup the ArcPad Port for Receiving Data from the Analyzer

Click on the Tools icon which looks like a sheet of paper with the upper right corner folded 
over, then select Advanced Settings.
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Figure 392. The Tools Menu

Click the AUX tab at the bottom of the screen. If the AUX tab does not appear, click on the 
right arrow at the bottom of the screen until the AUX tab appears, then click it. Select a port 
which is not currently being used. The Aux port must be set to the Com port of the 
instrument selected. In Figure 393 below, Com 4 and Com 7 are in use..
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Figure 393. Selecting the AUX COM Port

Click the green OK Button at the bottom left corner of the screen.
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Installing the Analyzer Applet

Extract the files from the zipped folder attached in the e-mail. Open the My Computer folder 
on the PC by clicking the My Computer icon on the desktop. Select the Mobile Device 
System Folder and double-click to open.

Figure 394. The Mobile Device System Folder

Double-click My Windows Mobile-Based Devices to open the folder.

Figure 395. The My Windows Mobile-Based Device Folder

 Click Program Files twice to open folder.

Figure 396. The Programs Folder
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Click ArcPad folder twice to open.

Figure 397. The ArcPad Folder

Open folder containing the ANALYZER applet. Click the ANALYZER applet and drag to 
the Applets folder within the Program Files.

Figure 398. Copying the Applet

Drop the file in the Applets folder.

Figure 399. Dropping the Applet Into the Applets Folder
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Return to Microsoft ActiveSync and click on the Sync button on the toolbar to load the 
Applet file onto the mobile device.

Figure 400. Syncing the Mobile Device

Restart the mobile device.
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Using the Analyzer Applet

When ArcPad is started, the applet will automatically appear as an icon of an analyzer on the 
top toolbar. When you click that button you get a toolbar with four buttons. From left to 
right the buttons are 1) start collecting data, 2) view analysis, 3) save analysis to active layer, 
and 4) select active layer/create new layer.

Figure 401. The Applet Toolbar

To start using the software, first press the far right button to create a new layer or select a 
previously started layer. When you click that button you get a dialog box. The software uses 
ESRI shape files as its storage format, so if you add an existing layer, you will browse for 
existing shape files. If you create a new layer, there are a series of dialog boxes described below.

Figure 402. The Layer Dialog Box

Click the Create New button to add a new layer or click the Add Existing button to browse 
for a previously created layer. When you create a new layer, the dialog box in Figure 403 is 
shown. This allows you to choose from a set of various modes. There are checkboxes for the 
most commonly used elements in those modes. There is also the option of opening a textbox 
to enter additional elements in a space-separated list.
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Figure 403. The Create Layer Dialog Box

Elements are selected by checking the appropriate boxes or by entering them in a list in the 
text entry box. The units for the analyses are assumed to be PPM for soils and percent for all 
other modes.

Figure 404. Entering Other Elements

After clicking ok on the mode selection box a confirmation box will appear (Figure 405). This 
is an important step because it is not possible to add any elements later in ArcPad. It is 
possible to add elements later in ArcGIS on a PC.
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Figure 405. Mode and Element Verification

After selecting ok on the verification dialog, another window will open allowing you to choose 
the styles of symbols that display on the map as the data are collected (Figure 8). Choose the 
symbol, colors to correspond with the elements and the number of ranges that will be used for 
the different styles of points. Once you click ok, a dialog opens allowing you to choose the 
ranges and the size and color of the symbols for each range.

Figure 406. Selecting Symbol Size and Color

Following is the Dialog Box for choosing the ranges, size and color of symbols. The lowest 
value is fixed at 0 and the highest at 1,000,000. Choose the colors by clicking on the buttons 
labeled “…”. The default is a range from blue-green-yellow-orange-red. 
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Figure 407. Symbol Dialog Box

Following is the Dialog Box for choosing the ranges, size and color of symbols. The lowest 
value is fixed at 0 and the highest at 1,000,000. Choose the colors by clicking on the buttons 
labeled “…”. The default is a range from blue-green-yellow-orange-red. 

Once the layer is saved, the Layer Dialog Box is shown again with the newly created file. 
Select it and tap the OK button. Make sure your analyzer is set to Print Complete. From the 
Main Menu, select the System icon, then the Printer Icon to access the proper screen. You are 
now ready to collect data. Tap the far left button that looks like a running man. If you get an 
error immediately, it means the AUX port is not setup correctly in ArcPad. Make sure the 
AUX port is the port that the handheld is communicating with the instrument on. Also make 
sure that nothing else is communicating on that port.

Now take an analysis with the Analyzer. After the analysis is complete, when connected, you 
will receive coordinates and analysis data as shown in the following screenshots. In Figure 408, 
the screen with the X, Y, and Z Coordinates is shown. When you select the View Analysis 
Button, the Analysis window will appear, as shown in Figure 409.
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Figure 408. XYZ Coordinate Screen

Figure 409. Analysis Window
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Trimble-Niton Error Messages

"Unable to open the Niton XRF communication port. Check the ArcPad AUX configuration and try again."

This happens when the Trimble cannot communicate with the instrument. Usually means 
that the AUX port in ArcPad is set to a port different than the one the instrument is 
communicating on. It can also mean that the Bluetooth connection isn’t working properly.

"XRF capture receive not progressing. Disabling data capture. Check ArcPad AUX configuration and 
restart ArcPad. May be configured to receive from a GPS COM device rather than a Niton XRF analyzer." 

This error means that data was received by the Trimble but it is either an incomplete analysis 
or not a valid analysis. This differs from the next error because the maximum number of 
characters for an analysis is not reached in this case. This message will pop up after a delay of 
several seconds while the Trimble waits to see if more data is going to be received.

"XRF capture limit of 4096 characters exceeded. Disabling data capture. Check ArcPad AUX 
configuration and restart ArcPad. May be configured to receive from a GPS COM device rather than a 
Niton XRF analyzer." 

This is the typical error if the AUX port in ArcPad is set to the port that the Trimble uses for 
the GPS signal. It means too much data was received. This box should pop up almost 
instantly once data capture is started if the AUX port is set to the GPS port. It shouldn’t be 
possible for the instrument to send a valid analysis that is longer than this limit.

"Unrecognized XRF analysis received. Try transmitting the analysis again." 

This means data was received from the instrument but the applet couldn’t parse it. It means 
communication is actually working properly but either a mode that we don’t support was used 
(i.e. alloys) or some characters got dropped during transmission. If it is a problem with 
characters getting dropped, hitting print on the instrument again should do the trick. If it is 
the wrong mode, the user will have to change the mode.

"No XRF analysis available to view. Press the capture button to receive an analysis."

This error occurs if you press the button that looks like a piece of paper but you haven’t 
captured an analysis yet.

"No valid XRF analysis available to save."

This error happens if you click the save analysis button but have not yet captured an analysis.

"A new XRF analysis layer must contain at least one element for analysis." 

This error occurs if you do not select any elements at all when setting up the layer.
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"Unable to create layer file <filename>” 

This happens if you don’t have permission to read/write to the folder where you try to create a 
new layer. It could also occur if you try to replace an existing file that is already open.

"Unable to open layer file <filename>” 

This indicates that you selected an existing file to save analyses to and for some reason ArcPad 
can’t open it. Could be permissions or a corrupt file.

"<filename> does not appear to contain a layer configured for XRF analysis."

This occurs if you select an existing file to save analyses to and it isn’t formatted properly (i.e. 
it wasn’t created by the applet earlier).

"No active XRF analysis layer found. Press the XRF layers button to establish an active layer then try 
saving this analysis again."

This error occurs if you try to capture data before you setup a layer to store the data in.

"No element attributes were found to add to the shapefile for this analysis. The active layer is probably 
not configured correctly for this type of analysis."

This happens if your analysis has no elements that are in the file you selected to save analyses 
to.
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Parts

This section covers replacement parts and accessories for your analyzer, 
as well as the use of the reference samples included with your kit. The 
replacement parts and accessories section includes both a picture and the 
part number. The particular reference samples your kit includes depends 
upon the analysis modes your analyzer is configured to perform. You 
may not have all the reference samples referred to if your analyzer is not 
configured for all modes.

Parts and Accessories

Table 1. Table 1-1 - Parts and Accessories

Name
Part 
Number

Picture

Portable Test 

Stand

420-017

The Mobile Test 

Stand

430-032



15 Parts
Parts and Accessories

418 Niton XL3 Analyzer User’s Guide Thermo Scientific

The Field Mate 430-517

Holster 430-185

Battery Charger 420-011
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Power 

Cable/Supply 

for Charger 

- Power Cable 

 

  

420-007 

 

 

Power 

Cable/Supply 

for Charger 

- Power Supply

420-006

Battery 420-002
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Measurement 

Windows

187-1555

In-Situ Test 

Guard

187-1401

Mylar Window 

for In-Situ Test 

Guard

187-813
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Serial 

Download 

Cable

300-056

USB Download 

Cable

179-727

Welding Mask 420-008
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Measurement 

Window 

Bracket

187-1255

Printer 500-933

Analyzer Case 420-013
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GPS Systems GPS-01 

GPS-10

Bluetooth 

Module

500-714

32mm Sample 

Cups

187-466
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Mylar Film 2.5" 

dia. 6m thick

187-462

Polypropylene 

Film 

2.5" dia. 4m 

thick

187-461

Filter Paper 

2.4cm dia.

198-014
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Polystuffing 187-468

Plastic QC 

Reference 

Sample

180-554

Metal QC 

Reference 

Sample

195-019
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Soil/Mining QC 

Reference 

Sample Set

500-705

Lead Paint QC 

Reference 

Sample

500-934

Small Spot QC 

Calibration 

Sample

180-607
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Electronics 

Metals QC 

Reference 

Sample

180-606

Replacement 

Tank for 

He-purge

Replacement 

Standard 

Regulator for 

He-purge

350-001
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Refillable 

Helium Supply 

Kit

350-008

He-purge 

Replacement 

Fittings

430-302

Backscatter 

Shield

430-014
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Extend-a-Pole 420-018

Acid Brush for 

Soil or Mining

187-469

Whirl-Pak 

Mining Sample 

Bag

187-473
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Extend-a-Pole

The Extend-a-Pole accessory can be used to extend one's reach for analyzing samples, and/or 
to work more comfortably. The Extend-a-Pole features a remote trigger and a telescoping pole 
which locks securely at various lengths.

Figure 1. The Extend-a-Pole

Setting Up the Extend-a-Pole

When using the Extend-a-Pole on rough or dirty surfaces, such as with soil or mining 
samples, you should also use the In-Situ Test Guard. This accessory is part of the Soil Kit, and 
protects the nose, measurement window, and proximity button of your analyzer from wear, 
and facilitates use of the proximity button on soft or irregular surfaces.
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Figure 2. The In-Situ Test Guard

Figure 3. The In-Situ Test Guard in Place 

The In-Situ Test Guard clamps firmly over the nose of your analyzer with just a push, and 
comes off easily. The In-Situ Test Guard does not interfere with use of the Extend-a-Pole. 

Open the grip of the Extend-a-Pole. This pivots in place, allowing you to insert the handle of 
your analyzer.



 16 Extend-a-Pole
Setting Up the Extend-a-Pole

Thermo Scientific Niton XL3 Analyzer User’s Guide 433

Figure 4. The Extend-a-Pole Handle Grip - Two Views

Place the handle of your analyzer into the grip, seating the analyzer as far down into the grip 
as possible.
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Figure 5. The Extend-a-Pole Grip on the Analyzer 

Close the grip, hook on the latch, and press down the lever to lock the latch in place.
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Figure 6. Securing the Grip Latch 

Your analyzer will be firmly held by the grip, and the trigger can be actuated through the 
Remote Trigger on the Extend-a-Pole.



16 Extend-a-Pole
Setting Up the Extend-a-Pole

436 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 7. The Extend-a-Pole Grip on the Analyzer 

The Remote Trigger

To enable the Remote Trigger, you need to insert the Remote Trigger Jack of the 
Extend-a-Pole into the Remote Trigger Port of your analyzer. You can do this either before or 
after securing the handle in the grip. 

Figure 8. The Remote Trigger Jack in the Port 

The screen of your analyzer can be tilted to any viewing angle you find comfortable.
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Figure 9. Viewing the Touch Screen

You need to enable the Remote Trigger on the analyzer itself before using it. Go to the 
Start-Stop Settings and select the Remote Trigger checkbox.
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Figure 10. The Start/Stop Settings Menu Path

The Support Legs

The Support Legs can be swiveled out to make a stable, 3-point support for the 
Extend-a-Pole, enabling you to leave it standing without holding on.
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Figure 11. Using the Support Legs

Adjusting the Pole Length

The length of the Extend-a-Pole can easily be adjusted. 

Figure 12. Adjusting the Pole

Press in the Release Button to allow the Inner Pole to slide inside the Outer Pole. The Release 
Button is spring loaded, and will pop up into a hole in the Outer Pole to lock the poles 
together in this configuration. Continue adjusting the poles until you get the length you need.
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Test Stands

The Portable Test Stand

Figure 1. The Portable Test Stand

Setting Up the Portable Test Stand

1. To set up the Portable Test Stand, place the folded stand on your bench top with the 
scissored legs down. 
CAUTION  When setting up and taking down the Portable Test Stand, be aware of possible 
pinch points.

2. Lift up the top part of the Portable Test Stand. As you do so, the scissored legs will rise up 
and come together.

3. Hook the notch in the back, flat part of the top over the bar between the rear legs, as in 
Figure  2.
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Figure 2. Hooking Over the Bar

4. The Portable Test Stand is now ready for use.

Figure 3 shows a Portable Test Stand ready for use.

Figure 3. The Test Stand All Set Up
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Taking down the Portable Test Stand

1. First, unhook all cables from the instrument and/or test stand.

2. To take down the Portable Test Stand, unhook the back, flat part of the top section of the 
Test Stand. The hood locks shut with a sliding tab for transportation.
CAUTION  When setting up and taking down the Portable Test Stand, be aware of possible 
pinch points.

3. The air pistons between the scissors legs will let the top down slowly.

4. Support the top until the legs have fully collapsed. Figure 1-4 shows a Portable Test Stand 
fully collapsed.

Figure 4. The Portable Test Stand Collapsed

Connecting the Portable Test Stand to your Analyzer

Use the included Remote Trigger Cable to attach the Portable Test Stand to your Analyzer. By 
connecting the Test Stand, your analyzer knows whether the protective lid is open or closed, 
and thus whether it is safe to initiate a test, as in Figure 9. If unplugged, the instrument will 
not be able to initiate a reading.
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Figure 5. Plugging the Remote Trigger Cable Into the Portable Test Stand

Attaching the Remote Trigger Cable

Insert one end of the Cable into the Remote Trigger Port on your Portable Test Stand, and the 
other end to the Remote Trigger Port on your Analyzer, as in Figures 5 and 6 . Do not plug 
the cable into the Serial Ports.

Figure 6. Plugging the Remote Trigger Cable Into the Analyzer
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Powering the Test Stand via USB

Plug the USB cable into your computer’s open USB port as in Figure 7. Plug the other end 
into the Test Stand’s USB Port. The Test Stand can draw what power it needs from your 
computer.

Figure 7. Plugging the USB Cable into the Portable Test Stand

Powering the Test Stand Via Separate Power Cable

You may also use the power adaptor to power up the test stand. Plug the power adapter into 
the power port on your Portable Test Stand, and the other end into the wall outlet.
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Figure 8. Plugging the Power Cable into the Portable Test Stand

Figure 9. Test Stand Open and Closed Icons

How to Use the Portable Test Stand

When the Portable Test Stand is fully set up, insert the front of your analyzer into the cone 
under the floor of the top part of the stand, as in Figure 1-10. Push firmly until the analyzer 
seats with an audible click.

Open        Closed
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Figure 10. Portable Test Stand with Analyzer Attached

Your analyzer cannot be inserted fully in any orientation but the correct orientation, with the 
touch screen towards the front.

To remove your analyzer, simply squeeze the tabs on either side of the cone and pull the 
analyzer down, gently but firmly, until it separates from the cone.

When the hood is lifted, your analyzer will display a red icon at the top of the touch screen, as 
in Figure 11.

Figure 11. Portable Test Stand Open Icon
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When the hood is shut, your analyzer will display a green icon at the top of the touch screen, 
as in Figure 12.

Figure 12. Portable Test Stand Closed Icon

Your analyzer will not take a reading unless the hood is shut and the green icon is on.
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The Mobile Test Stand

How to Assemble the Mobile Test Stand

Attaching the legs to the main body

1. Orient the pop-up peg on the leg with the hole in the main body

2. Push the pop-up peg in with your thumb as shown in Figure 1-13.

Figure 13. Pushing in Peg

3. Slide the leg into the main body until the pop-up peg snaps into the matching hole as 
shown in Figure 14
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Figure 14. Attaching Leg

4. Repeat for each leg

5. Adjust the height of each leg by screwing or unscrewing the feet to allow a level platform

Fitting your Niton analyzer into the Mobile Test Stand

6. Set the test stand so that the hinge is away from you, and you have access to the test 
chamber when it is open.

7. Place your analyzer underneath the Mobile Test Stand so that the nose points up and the 
touch screen is facing you, as in Figure 15
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Figure 15. Inserting Analyzer into Portable Test Stand

8. Lift your analyzer firmly up into the recess until the clips snap solidly into place on both 
sides of the analyzer’s front end.

Configuring the Analyzer for the Test Stand

The test stand contains an RFID chip, which automatically configures your analyzer to 
properly work with the test stand. 
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Proximity Start Feature

A feature you can optionally use is to set the analyzer to Proximity Start. 

Figure 16. Menu Path to Set Proximity Start 

Press the trigger to initiate the reading, and disengage the Proximity Button by opening the 
cover to stop the reading. With this feature enabled, you do not need to hold the trigger down 
while the sample is being analyzed.
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Figure 17. Stopping the Analysis by Opening the Cover

You can always use standard operation, as well as remote operation via NDTr.

Measuring Small Parts and Components

To measure electronic parts and components, place the part to be measured directly on the 
measurement window of the analyzer, shut the hinged top firmly, and take a measurement. 
See Figure 16 for an example of placing electronic parts.

Figure 18. Measuring Electronic Parts
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To measure small alloy parts and samples, place the part to be measured directly on the 
measurement window of the analyzer, shut the hinged top firmly, and take a measurement. 

Measuring Bulk Samples in Sample Cups

To measure bulk materials in sample cups, place the Sample Cup Holder into the Mobile Test 
Stand so that it rests on the lip of the oval cutout. See Figure 17 to see how the Sample Cup 
Holder is oriented.

Figure 19. Inserting the Sample Cup Holder

Then place the sample cup to be analyzed into the sample cup holder, shut the hinged top 
firmly, and initiate a measurement. See Figure 18 for an example of placing sample cups into 
the Sample Cup Holder.
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Figure 20. Inserting Sample Cup

Measuring Bulk Samples in Bags

To measure bulk materials in plastic bags, make sure the material to be tested is at least 1.5 cm 
deep over the measurement window of the analyzer. The cover of the test stand must be shut 
completely before taking a reading, which limits the maximum size of the bagged sample to 
that of the capacity of the test stand cavity. 

Place the sample bag into the test stand, shut the hinged top firmly, and take the 
measurement.

When the hood is lifted, your analyzer will display a red icon at the top of the touch screen, as 
in Figure 19.
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Figure 21. Mobile Test Stand Open Icon

When the hood is shut, your analyzer will display a green icon at the top of the touch screen, 
as in Figure 20.

Figure 22. Mobile Test Stand Closed Icon 

Your analyzer cannot make an analysis unless the icon is green. To remove your analyzer from 
the Portable Test Stand, simply squeeze the tabs on either side of the cone and pull the 
analyzer down, gently but firmly, until it separates from the cone.
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The Field Mate Test Stand

The Field Mate is a small test stand which can be carried about easily in the field.

Figure 23. The Field Mate

The Field Mate has a pivoting top plate which covers a shielded cavity inside which the 
sample is placed. There are two insets which fit inside the cavity, optimized for the two most 
common sample types - bagged bulk samples and sample cups. 

There is a brace to support the analyzer on the underside of the base. Gently but firmly 
unsnap the brace by pushing down on the protruding black tab. The brace will pivot out and 
down 180 degrees. The brace helps compensate for the off-center weight of the analyzer when 
clipped into the pivoting top plate. 

To place your analyzer into the Field Mate, fit your analyzer's nose firmly up into the mating 
cone until the clips snap solidly into place on both sides of the analyzer’s front end. 
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Figure 24. The Field Mate with Top Plate Opened

The top plate is opened by pressing the large orange latch on the base. Inserts can be placed 
into the cavity, and samples can be placed into the inserts. The insert for bagged bulk samples 
(shown in Figure 23) has a spring loaded inner plate which pushes the sample up to contact 
the underside of the top plate for proper analysis. The insert for sample cups (shown in Figure 
1-24) holds the cup at the proper height for analysis with a soft foam support. Tilt the top 
plate back until it latches with an audible click for analysis. This can be done with or without 
your analyzer clipped into the cone. 
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Figure 25. The Field Mate Bagged Sample Insert

Figure 26. The Field Mate Sample Cup Insert

The top plate can also be completely removed by pressing the two small hinge tabs together 
towards the middle of the plate and lifting the plate from the base. This can be done with or 
without your analyzer mounted into the cone.
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Figure 27. The Top Plate Removed from the Base Unit

Removed from the base, the plate can be placed into the Test Guard, for soil screening in-situ.

Figure 28. The Test Guard

To insert the plate into the Test Guard, slide the front tab on the plate under the tab of the 
Test Guard.
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Figure 29. Inserting the Top Plate into the Test Guard

The interlocking tabs secure the front of the Test Guard to the plate.

Figure 30. The Front Tab

Squeezing the Hinge Tabs together, lower the back of the plate into the Test Guard. Release 
the tabs so the Hinge Tab Pins protrude through the holes on either side of the Test Guard. 
This secures the rear of the plate to the Test Guard.
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Figure 31. The Hinge Tab Pins

At this point, you can fit your analyzer into the cone. It may now be used for soil screening.
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Figure 32. The Top Plate Removed from the Base Unit

When the top plate is lifted, your analyzer will display a red icon at the top of the touch 
screen, as in Figure 26.

Figure 33. Field Mate Open Icon

When the plate is shut, your analyzer will display a green icon at the top of the touch screen, 
as in Figure 27.
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Figure 34. Field Mate Closed Icon

Your analyzer cannot make an analysis unless the icon is green.

To remove your analyzer from the Field Mate Test Stand, simply squeeze the tabs on either 
side of the cone and pull the analyzer up, gently but firmly, until it separates from the cone.
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Configuring the Analyzer for the Test Stand

The test stand contains an RFID chip, which automatically configures your analyzer to 
properly work with the test stand. 

Proximity Start Feature

A feature you can optionally use is to set the analyzer to Proximity Start. 

Figure 35. Menu Path to Set Proximity Start 
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Press the trigger to initiate the reading, and disengage the Proximity Button by pressing the 
Latch and opening the plate to stop the reading. With this feature enabled, you do not need 
to hold the trigger down while the sample is being analyzed.

Figure 36. Stopping the Analysis by Opening the Plate

You can always use standard operation, as well as remote operation via NDTr.
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Reference Samples

Metal Alloy Reference (Standard) Sample Care

Figure 1.    The Metals QC Reference Sample

Metal QC Reference Sample

One or more metal standard(s) are supplied with your instrument if 
there is an alloy calibration activated on it. This standard should be 
analyzed on a daily basis and the values obtained checked against the 
supplied certificate of analysis. For quality assurance purposes, you may 
also wish to keep a running chart of the values obtained and monitor it 
for consistency. 

If one (or more) of the elements begins to change in terms of reported 
concentration outside of the normal expected variability, the sample may 
have become contaminated. This contamination can occur for multiple 
reasons, for example, oils and salts may transfer from hand contact onto 
the surface, dust or lint from the surroundings may be deposited onto 
the sample, or oxidation of the surface may simply occur. If this 
happens, the sample will need to be cleaned to provide the XRF 
instrumentation with a clean surface for analysis.     

This may be achieved using clean, lint free paper, 2-propanol (isopropyl 
alcohol, IPA, (CH3)2CHOH)) and 360 grit diamond grinding paper 
(179-1203). Do not use rubbing alcohol as this may contain oils and 
other contaminants. Place the sample on a clean flat surface with the 
analytical side facing up. Moisten the surface with the alcohol and wipe 
away any surface debris or contamination. Take a square (approximately 
2.5cm or 1 inch) of the diamond paper, and with the rough side against 
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the sample gently polish the surface to remove oxidation. Dispose of the grinding paper and 
clean the surface with lint free paper moistened with alcohol until the paper shows no 
additional residue being removed from the surface. Allow the surface to dry before analyzing.  

Soil and Mining Reference (Standard) Sample Care

Figure 2.    The Soil/Mining QC Reference Sample Set

 Soil/Mining QC Reference Sample

 One or more cupped standards are supplied with your instrument if there is a soil or mining 
calibration activated on it. These standards should be analyzed on a daily basis and the values 
obtained checked against the supplied certificate of analysis. For quality assurance purposes, 
you may wish to keep a running chart of the values obtained and monitor them for 
consistency. 

If one (or more) of the elements begins to change in terms of reported concentration outside 
of the normal expected variability, the sample may have become damaged or contaminated. 
This may occur for a number of reasons, for example, oils and salts may transfer from hand 
contact onto the surface, dust or lint from the surroundings may be deposited onto the 
sample, or the thin film on the front of the cup may have pinholes or have been torn. If the 
cup film has torn or been damaged in any other way, it should be replaced immediately, this 
will prevent loss of the material and prevent contamination of the instrument and other 
samples. If you suspect that the film has been torn, also check the front window of the 
instrument and clean or replace that too if necessary.
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Plastic Reference (Standard) Sample Care

Figure 3.    The Plastic QC Reference Sample

Plastic QC Reference Sample

One or more plastic standards are supplied with your instrument if there is a plastic 
calibration activated on it. These standards should be analyzed on a daily basis and the values 
obtained checked against the supplied certificate of analysis. For quality assurance purposes, 
you may wish to keep a running chart of the values obtained and monitor them for 
consistency. 

If one (or more) of the elements begins to change in terms of reported concentration outside 
of the normal expected variability, the sample may have become contaminated. This 
contamination can occur for multiple reasons, for example, oils and salts may transfer from 
hand contact onto the surface, and dust or lint from the surroundings may be deposited onto 
the sample. If this happens, the sample will need to be cleaned to provide the XRF 
instrumentation with a clean surface for analysis.     

This may be achieved using clean, lint free paper and 2-propanol (isopropyl alcohol, IPA, 
(CH3)2CHOH)). Do not use rubbing alcohol as this may contain oils and other 
contaminants. Place the sample on a clean flat surface with the analytical side facing up. 
Moisten the surface with the alcohol and wipe away any surface debris or contamination. 
Moisten a lint free cloth with alcohol and rub harder to remove any imbedded materials. Dry 
the clean the surface with lint free paper moistened with alcohol until the paper shows no 
additional residue being removed from the surface. Allow the surface to dry before analyzing.  
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Electronics Metals Reference (Standard) Sample Care

Figure 4. The Electronics Metals QC Reference Sample

Electronics MetalsQC Reference Sample 

One or more Electronics Metals standard(s) are supplied with your instrument if there is an 
Electronics Metals calibration activated on it. This standard should be analyzed on a daily 
basis and the values obtained checked against the supplied certificate of analysis. For quality 
assurance purposes, you may also wish to keep a running chart of the values obtained and 
monitor it for consistency. 

If one (or more) of the elements begins to change in terms of reported concentration outside 
of the normal expected variability, the sample may have become contaminated. This 
contamination can occur for multiple reasons, for example, oils and salts may transfer from 
hand contact onto the surface, dust or lint from the surroundings may be deposited onto the 
sample, or oxidation of the surface may simply occur. If this happens, the sample will need to 
be cleaned to provide the XRF instrumentation with a clean surface for analysis. 

This may be achieved using clean, lint free paper, 2-propanol (isopropyl alcohol, IPA, 
(CH3)2CHOH)) and 360 grit diamond grinding paper (179-1203). Do not use rubbing 
alcohol as this may contain oils and other contaminants. Place the sample on a clean flat 
surface with the analytical side facing up. Moisten the surface with the alcohol and wipe away 
any surface debris or contamination. Take a square (approximately 2.5cm or 1 inch) of the 
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diamond paper, and with the rough side against the sample gently polish the surface to 
remove oxidation. Dispose of the grinding paper and clean the surface with lint free paper 
moistened with alcohol until the paper shows no additional residue being removed from the 
surface. Allow the surface to dry before analyzing. 

Lead Paint Reference (Standard) Sample Care

Figure 5. The Lead Paint QC Reference Sample

Lead Paint QC Metals Sample

One or more Lead Paint standard(s) are supplied with your instrument if there is a Lead Paint 
calibration activated on it. This standard should be analyzed on a daily basis and the values 
obtained checked against the supplied certificate of analysis. For quality assurance purposes, 
you may also wish to keep a running chart of the values obtained and monitor it for 
consistency. 

If one (or more) of the elements begins to change in terms of reported concentration outside 
of the normal expected variability, the sample may have become contaminated. This 
contamination can occur for multiple reasons, for example, oils and salts may transfer from 
hand contact onto the surface, dust or lint from the surroundings may be deposited onto the 
sample, or oxidation of the surface may simply occur. If this happens, the sample will need to 
be cleaned to provide the XRF instrumentation with a clean surface for analysis. 
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This may be achieved using clean, lint free paper and 2-propanol (isopropyl alcohol, IPA, 
(CH3)2CHOH)). Do not use rubbing alcohol as this may contain oils and other 
contaminants. Place the sample on a clean flat surface. Moisten the surface with the alcohol 
and wipe away any surface debris or contamination. Clean the surface with lint free paper 
moistened with alcohol until the paper shows no additional residue being removed from the 
surface. Repeat for the other side. Allow the surfaces to dry before analyzing.

Small Spot Reference (Standard) Sample Care

Figure 6. The Small Spot QC Reference Sample

Small Spot QC Calibration Sample

One or more Small Spot standard(s) are supplied with your instrument if there is a Small Spot 
Camera activated on it. This standard should be analyzed on a daily basis and the values 
obtained checked against the supplied certificate of analysis. For quality assurance purposes, 
you may also wish to keep a running chart of the values obtained and monitor it for 
consistency. 

If one (or more) of the elements begins to change in terms of reported concentration outside 
of the normal expected variability, the sample may have become contaminated. This 
contamination can occur for multiple reasons, for example, oils and salts may transfer from 
hand contact onto the surface, dust or lint from the surroundings may be deposited onto the 
sample, or oxidation of the surface may simply occur. If this happens, the sample will need to 
be cleaned to provide the XRF instrumentation with a clean surface for analysis. 
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This may be achieved using clean, lint free paper, 2-propanol (isopropyl alcohol, IPA, 
(CH3)2CHOH)). Do not use rubbing alcohol as this may contain oils and other 
contaminants. Place the sample on a clean flat surface with the analytical side facing up. 
Moisten the surface with the alcohol and wipe away any surface debris or contamination. 
Clean the surface with lint free paper moistened with alcohol until the paper shows no 
additional residue being removed from the surface. Allow the surface to dry before analyzing. 
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Learning More, Service, and Support

This section of the Resource guide is about getting the most out of your 
analyzer. We cover troubleshooting your analyzer by using the Specs 
screen. We also cover advanced topics like setting thresholds, using the 
Tools menu, correcting for light elements in the sample composition, 
setting up pass/fail analysis, changing safety and start/stop parameters, 
and many other special situations you may need. We have also included 
a number of documents for reference, so you can learn more about XRF 
analysis if you are so inclined. 
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Tips and Troubleshooting

The Specs Screen

Figure 1. The Specs Screen Menu Path
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Select the Specs icon from the System Menu to display the analyzer's specifications. These 
specifications include your analyzer's serial number, software and firmware versions, and 
other data. Press the Close Screen Button to return to the previous menu. Press the ">-" 
Screen Button to go to the Diagnostic Menu, and press the "<-" Screen Button to return 
to the Specifications Screen.

Figure 2. The Specifications Screen

On the Specs Screen, standard information on the state of your analyzer is shown for your 
reference. This information should be reported to Service if there is a problem.

Specs Information

The following is the information supplied on the Specs Screen:

Instrument Specific Serial Number

This is located in the left part of the blue band at the top of the screen.

Model Number

This is located in the right part of the blue band at the top of the screen.

Date And Time

This is the current Date and Time. This is particularly important for date stamping.

SW Version

This is the currently loaded software version, which should be reported to Service if there 
is any problem.
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FPGA

This is the currently loaded FPGA software version, which should be reported to Service 
if there is any problem. FPGA versions are always a four digit number. Any other number 
of digits may be a sign of a problem in the FPGA code.

Factory QC

This is the date that the machine was QCed at the factory.

Energy Cal

This line notes the last time a System Check was performed.

Battery

This line gives the proportional charge remaining to the battery.

System Check Reminder

Select the OFF Screen Button after "System Check Reminder" to set a reminder to 
calibrate your analyzer. Selecting the button will open the Cal. Reminder Editor. Select 
the number of days you want between reminders with the numeric keys. Of the other 
screen buttons, C = Clear All, E = Enter, and OFF shuts off the Reminder Function. 
Selecting the E button will enter the current value as the reminder interval and return to 
the Specs Screen.

Figure 3. Cal Reminder Editor Screen
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Diagnostics

Select the "->" Screen Button to load the Diagnostics Screen. The Diagnostics Screen 
shows Detector Temperature, Bias, Cooler Voltage, SubBias, Energy Scale, and 
Temperature in C and F scales.

The Diagnostics Screen can be of great utility in assuring proper operation of your 
analyzer.

Figure 4. The Diagnostics Screen

The proper ranges of operational values on the Diagnostics Screen follow.

Det Temp:

Detector Temperature should be within this range:

- 25 + or - 5 degrees

Bias:

Bias should be within this range:

175 + or - 10

VCool:

VCool will vary with the ambient temperature.
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SubBias:

SubBias should be within this range:

-11 + or - 3

Escale:

Escale should be within this range:

6.6 through 9.0

Preamp:

Preamp value should only be noted, and reported to Service if there is a problem.

Error Messages

The analyzer will auto-detect many perceived hardware problems and may display the 
following error messages:
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Figure 5. The Specs Screen Menu Path

Please re-run the System Check and if the problem persists, contact customer service. 

New_Topic1.htm#Performing a System Check
Contact_Us.htm
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Registration and Licensing FAQ

Niton XL3t and XL3t GOLDD

As a user of a Niton XL3t analyzer, you may be required to register or obtain a license 
with your local radiation control authority. In the US, if you intend to do work with your 
analyzer in states other than your own, you may be required to register there as well. 
Below is a list of commonly asked questions that come up when filling out registration 
forms.

FAQ 

Q: What is the max mA, max kVp, and max power?

A: Maximum mA is 0.1 mA

Maximum kVp is 50 kVp

Maximum power: 2 watts

Q: What is the accelerator voltage or MeV?

A: This should be filled out as not applicable N/A as it does not apply to Niton XL3t 
analyzers.

Q: What is the radioisotope?

A: There are no radioactive isotopes in Niton XL3t analyzers.

Q: What category is the Niton XL3t?

A: States differ greatly in their categories; the following is a list of common categories:

• X-Ray Fluorescence

• Analytical or Analytical XRF

• Open Beam or Open Beam Analytical

• Portable Gauge or Portable XRF

• Industrial Analytical or Non-Destructive Testing

When selecting the category make sure that you don't select medical or radiographic.
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Q: How many tubes are in the Niton XL3t?

A: One.

Q: What is the analyzer serial number?

A: The serial number is a 5 digit number located on the yellow sticker on the underside of 
your analyzer.

Q: What is the tube serial number?

A: The serial number of the tube can be found on the Calibration Certificate.

Q: What is the type of X-Ray Processing?

A: None. Niton XL3t analyzers do not use film.

Q: How often do I need to perform leak tests on the Niton XL3t?

A: Never. Leak tests are only required for analyzers with radioactive isotopes. Niton XL3t 
analyzers do not have radioactive isotopes.

Niton XL3p

Routine Maintenance Guidelines

Maintenance, Cleaning and Repairs 

To ensure the reliability, durability, and performance of your Niton Analyzer, keep it 
clean—especially the transparent measurement window covering the analysis window. 
Clean the measurement window gently with a cotton swab. Clean the body of the 
analyzer with a soft cloth. Never use detergents, or solvents on your analyzer, or immerse 
your analyzer in water. If the measurement window becomes frayed, ripped, or 
contaminated with metal particulates, replace it with a new window. measurement 
windows (Standard Window Niton P/N 187-1555 or Helium Purge Window Niton P/N 
187-1454) may be ordered from Thermo Fisher Scientific’s Service Department in the 
United States, toll free, at (800) 875-1578, or outside the United States, at 
+1-978-670-7460 or from your local Authorized Niton Analyzers Service Center.
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From time to time, your touch screen will need cleaning. Niton recommends that you use 
a lens cleaning solution with a soft cloth. Do not use water to clean your Niton Analyzer. 

WARNING  All Service, except exterior cleaning and measurement window replacement, 
must be performed by Thermo Scientific or an Authorized Niton Analyzers Service 
Center. Do not attempt to make repairs yourself. Opening the case of your Niton will 
void the analyzer Warranty in its entirety.

CAUTION  Always obtain a Return Authorization (RA) number from Thermo Fisher 
Scientific’s Service Department in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460 before returning your analyzer to the 
Niton Service Department or local Authorized Niton Analyzers Service Center.

Replacing the Measurement Window

1. Remove the two Phillips head screws.

Figure 6. View of Face Plate and measurement window

2. Remove the face plate and place it face down. 
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Figure 7. Face Plate Removed showing measurement window on Reverse

3. Remove the old measurement window. 

4. Clean the back surface of the face plate and install the new Window.

5. Turn the face plate over and replace it on the analyzer's front end, fitting the plate 
carefully over the Proximity Button

Figure 8. Fitting Face Plate over Proximity Button
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6. Reinstall the two screws, being careful not to over-tighten them.

Figure 9. Replacing the Screws.

Storing and Transporting Your Niton XL3 Analyzer

All Niton Analyzers are transported in waterproof, drop-resistant, fully padded carrying 
cases with padlocks. In most countries, Niton XRF analyzers may be transported by car or 
plane or shipped as an ordinary package. For most courier services, no special labels are 
required on the outside of the Niton analyzer case or on additional packaging.
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Figure 10. The Niton Carrying Case

All padlocks are shipped with a default combination of “0-0-0”. If you change this 
combination, please inform Thermo of the new combination if you return the unit for 
service.

To change the combination: 

1. Dial the default combination to open the lock, and pull out the shackle. 

2. Rotate the shackle 180 degrees and push it down as far as it can go. 

3. While holding the shackle down, rotate it 90 degrees back in either direction and 
release shackle. 

4. Change the dial settings to the desired combination, record the combination, and 
without disturbing the dials, rotate the shackle back 90 degrees to the position it had 
in step 2.

5. Pull shackle out and rotate it 180 degrees and secure it. Your lock now has its own 
secret combination.

CAUTION  Always transport the unit in its padded carrying case, and store the Niton 
Analyzer in its case whenever it is not being used.



18 Learning More, Service, and Support
Storing and Transporting Your Niton XL3 Analyzer

488 Niton XL3 Analyzer User’s Guide Thermo Scientific

CAUTION  In most cases, no notification is required if transporting within state 
boundaries. This may not be the case when entering federal properties.

CAUTION  Within the United States, always keep a copy of the US DOT compliance 
statement in your Niton analyzer case at all times. A copy is included with your analyzer.

CAUTION  Always follow all pertinent local and national regulations and guidelines, 
wherever your analyzer is transported or used.

CAUTION  Always obtain a Return Authorization (RA) number from Thermo Fisher 
Scientific’s Service Department in the United States, toll free, at (800) 875-1578, or 
outside the United States, at +1-978-670-7460 before returning your analyzer to the 
Service Department or to your local Authorized Niton Analyzers Service Center.

CAUTION  If you return your Niton analyzer without the carrying case, you will void your 
warranty in its entirety. You will be billed for a replacement case plus any repairs resulting 
from improper shipping.

CAUTION  CAUTION Always remove the battery pack when transporting or storing 
your analyzer.
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Advanced Settings

The Set Element Threshold Menu

Figure 1.    The Set Element Threshold Menu Path

Select the Set Element Threshold icon to configure pass and fail criteria 
for elemental analysis. Selecting the Set Element Threshold icon opens 
the Set Threshold Screen.

Figure 2.    Set Element Threshold Screen

Select the mode you wish to work with from the scrollable list. This will 
open up the Pass/Fail Settings Screen for that mode.
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Figure 3.    Pass/Fail Settings Screen

Selecting the Pass Value will open up the Pass Editor for the selected element.

Figure 4.    The Pass Editor

The Pass Editor is very similar to the Logon Screen. The C button clears the field, and the “<“ 
button clears the last numeral. Select the numerals you want, then press the E button to enter 
the number. The OFF button resets the value to “OFF”

Selecting the Fail Value will open up the Fail Editor for the selected element.
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Figure 5.    The Fail Editor

The Fail Editor works the same as the Pass Editor.

When you press the E button in either editor, you are returned to the Pass/Fail Settings 
Screen, with your new values in place.

Selecting the OFF button not only sets the value to “OFF” but also saves the new value.

Figure 6.    The Pass/Fail Setting Screen With New Parameters



18 
Advanced Settings

492 Niton XL3 Analyzer User’s Guide Thermo Scientific

Select the Reset Button to clear the current value and continue working.

Select the Save Button to save your current status as the new default. After saving, you will go 
back to the Element Display Menu.

Select the Close Button to exit without saving. When you select the Close Button after 
changing the display state of any element, a screen will open asking you if you want to save 
the changes you made. Selecting the Yes button will save these changes as the new default. 
Selecting the No button will return you to the Element Display Menu without saving the 
changes.

Figure 7.    Save Changes Screen

Plastic Thresholds

Under Plastics Mode, selecting the triangle next to the Analysis Options Field will open a pop 
up menu allowing you to choose between the three Analysis Option Modes. Select the mode 
you wish to edit.
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Figure 8.    The Analysis Options Popup Menu

Changing the settings for one mode will not affect the settings for other modes, and the 
configurations can be saved independently.

RoHS Option

When the RoHS Option is selected, clicking on the Pass and Fail values works as it does in 
any other Mode.

Detection Option

When the Detection Option is selected, Selecting the Pass/Fail field for that element acts as an 
On/Off Toggle, which will switch Pass/Fail mode between On and Off for the selected 
element. Selecting it again will reverse the toggle.

Consumer Products Option

When the Consumer Products Option is selected, clicking on the Pass and Fail values works 
as it does in any other Mode. In addition, the total of Cl+Br is also calculated and used for 
Pass/Fail Testing.
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Figure 9.    Pass/Fail Settings Under All Three Plastics Options
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Adjusting the Element Range

   

Figure 10.      The Range Menu Path (Main)

Multi-Range tests are used to either preferentially excite specific elements for increased 
sensitivity, or to cover a wider element range than one Range alone can provide. Most modes, 
when enabled, will use two Ranges in sequence to produce a combined analysis result. In 
typical alloy analysis applications, Main Range is used for the analysis of most elements, Low 
Range is utilized for the subsequent high sensitivity analysis of V, Ti, and Cr, and Light Range 
is available only with He-purged and 900 series GOLDD technology analyzers, and is 
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typically used in light element analysis. Multi-Range switching can be set to activate off time 
alone, or, when time switching is disabled, off settings in the General Metals grade library. In 
most modes, Low and Light Range add the capability to analyze light elements which cannot 
be efficiently excited by Mid Range.

Figure 11.    Selecting the Mode

Select the mode you wish to configure. You can set different configurations for different 
modes.

The Element Range Screen enables you to directly enable or disable any Range, or control the 
time that a Range alters the irradiation of the sample before auto-switching to another Range.
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Figure 12.    The Element Checkboxes

Select the checkbox next to the Range you want to use to determine exactly which of the 
Ranges contained in your Analyzer is used for sample testing. Selecting an empty checkbox 
will enable that range and place a check into the box as an indicator. Selecting a checked box 
will disable the Range and clear the box.

In typical alloy analysis applications, Main Range is used for the analysis of most elements. 
You cannot deselect the Main Range in alloy analysis

Low Range is utilized for the subsequent high sensitivity analysis of V, Ti, and Cr.
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Figure 13.    The Range Element Lists

Select the Element List Button to display the Element List for that Range. This list shows the 
elements that the Range is best designed to detect.
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Figure 14.    The Range Time Fields

Select the Range Time field for the intended range to change the switch time for that range. 
The Range Time Editor will appear. This enables you to set the number of seconds each 
enabled range is allotted before auto-switching will occur when needed during sample testing. 
Your analyzer will auto-switch from one range to another when the testing time for that range 
is greater than or equal to the time you have chosen, and the identified alloy is flagged as 
needing the switch in the Niton Alloy Library.
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Figure 15.    The Range Time Editor

Select the C button to clear the current time, then from the virtual numeric key pad, select 
each digit you want to input, then select the E button to enter.
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The LCD Brightness Screen

Figure 16.    The Adjust Backlight Menu Path

Select the Adjust Backlight icon to adjust the brightness of the analyzer screen.
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Figure 17. .    The Adjust Backlight Screen

Selecting the red [ - ] button will cause the slider to move some to the left and the screen to 
dim a bit. Selecting the green [ + ] button will cause the slider to move a bit to the right and 
the screen to brighten somewhat. Find the setting most harmonious with the ambient 
lighting. Selecting the Close button saves the backlight setting in the current state, and returns 
you to the Utility Menu.
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Rotate Screen

   

Figure 18.      Rotate Screen

Select the Rotate Screen icon to toggle the orientation of the screen between right side up and 
upside down.
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Setting Display Languages

     

Figure 19.      The Language Settings Menu Path

Selecting the Language Settings icon will load the Language Screen, allowing you to change 
the language from the default English to French, Spanish, Portuguese, or German.

Figure 20.      The Language Screen
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Select the down-pointing triangle button, and then select the language you want from the 
drop down menu. The menu system will now show on screen in the language you have 
selected.

 

  

  

Figure 21.      Select Language
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Figure 22.      The Radiation Warning Screen in Chinese
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Setting Up the Printer

  

Figure 23.      The Printer Setup Menu Path

The Printer Setup Screen allows you to adjust which sections of your reading data are sent to 
your optional portable printer. By default, your analyzer prints the detected list, reading 
number, reading length, reading mode and any applicable measurement data such as Alloy 
match grade names. You can select any combination of options on the Printer Setup Screen to 
change what is printed.

  

Figure 24.      The Printer Setup Screen
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Auto Print Readings

Selecting this option will enable automatic printing of readings when an analysis is performed.

Auto Print Averages

Selecting this option will enable automatic printing of averages when an averaging analysis is 
completed.

Print < LOD

Selecting this option will enable printing of readings which are lower than the Limit of 
Detection.

Print Complete

Selecting this option will enable printing of all the data fields in the reading.

Print Data Field

Selecting this option will enable printing of all entered data fields.

Print Date & Time

Selecting this option will enable printing of the Date and Time.
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Setting up Audio Cues

Figure 25.     The Beep Setup Menu Path

Selecting the Audio icon opens the Beep Times Setup Screen, enabling changes to the beep 
settings for various modes. The beeps sound as follows:
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Figure 26.     The Beep Setup Screen

Mode

This option allows you to change the beep settings for different modes independently. Select 
the Down Arrow Screen Button to access the list of modes.

Figure 27.     Drop-down Mode List
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First Beep

This option allows you to change the delay before the First Beep.

Second Beep

This option allows you to change the delay before the Second Beep.

Third Beep

This option allows you to change the delay before the Third Beep.

Beep on Grade Match

Selecting this option will enable a special beep when the reading chemistry matches an alloy 
grade.
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Tools Menu Options

The following options can be performed from the Tools Menu. Options which are only on 
the main Tools Menu are listed as (Main). Those which can be found only on the alternate 
Tools Menu are listed as (Alt).

Avg Forward

Enables you to average different readings together from this analysis forward. Select the Avg 
Forward button to initiate future sample averaging. Avg Forward will set up an automatic 
personal averaging protocol to be followed until your analyzer is shut down, or this feature is 
disabled. To begin, select the number of readings you want to average from the virtual 
numeric keypad. Your analyzer will calculate an average reading after that number of tests, and 
continue this pattern until stopped. For example, if you select 3 on the virtual keypad, the 
analyzer will automatically calculate, average, and store a reading for every three tests you take, 
storing the individual readings along the way.

The range number is selected using a virtual numeric keypad on your analyzer similar to the 
keypad used for login. Select the digits in the range number from the keypad, then select the E 
button to enter the number. The C button will clear all, and the “<“ button will clear the last 
digit entered. The average will automatically be displayed.
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Figure 28.      Example Averaging Screens

Avg Back (Alt)
Note  The alternate Tools Menu is only available when viewing readings, and the menu is only 
accessible through the touch screen interface or NDTr.
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Enables you to average different readings together from this analysis backward. Select the Avg 
Back option to initiate backwards sample averaging. Avg Back will take the number of 
readings you select and average their analytical results. The range is counted from the last 
reading backward by the number of readings selected. If your last reading was #15, selecting 3 
would average readings #13, 14, and 15. The average is calculated, displayed, and stored into 
memory as the next sequential reading number, in this case, #16.

The range number is selected using a virtual numeric keypad on your analyzer similar to the 
keypad used for login. Select the digits in the range number from the keypad, then select the E 
button to enter the number. The C button will clear all, and the “<“ button will clear the last 
digit entered. The average will automatically be displayed.

Figure 29.      The Virtual Numeric Keypad
Note  You cannot average readings taken in different modes. Doing this will generate an error.

Spectrum:On/Spectrum:Off

The Tools Menu contains a toggle option to display live spectra as sample analysis occurs.

Activating and Deactivating the Live Spectrum

From the Tools Menu, select the Spectra:On button to turn the Spectrum feed on. Once the 
spectrum is displayed, selecting Spectra:Off from the Tools Menu will stop the live spectrum 
display.
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Figure 30.      Example Analysis Screen Showing Live Spectrum

Enable LEC/Disable LEC

Select the Enable LEC button from the Tools Menu to enable Light Element Correction in 
sample analysis. Select the Disable LEC button - the toggle name - to disable Light Element 
Correction. Simple analysis cannot distinguish light elements such as Carbon from the 
background scatter, reporting only the identified elements and treating anything else as 
"balance". The Alloy Library, on the other hand, contains complete chemistry of the various 
alloys. When Light Element Correction is enabled, once an alloy is identified positively, your 
analyzer will report proper percentages of these light elements by reading them from the 
library and adjusting them to be proportional to the total "balance" of unidentified elements.
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Figure 31.     Autoswitch on Time Only Unchecked
Note  When using Light Element Correction (LEC) do not check Autoswitch On Time 
Only. 

Print (Alt)

Select the Print option from the Tools Menu to print the current analysis screen to any 
attached portable printer. If you do not have a portable printer attached to your analyzer, 
nothing will happen.

Set Pass/Fail

You can set up your analyzer to sort on a pass/fail basis. Pass/Fail uses the chemistry of a 
user-generated list of alloys in the library as a basis for comparison. If the sample analysis is 
entirely within the specifications for one of these alloys, a PASS result is given, otherwise a 
FAIL result is returned. To turn on Pass/Fail, select the Tools Menu and select Set Pass/Fail 
from the menu. The Pass/Fail Setup Screen will come up.
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Figure 32.      Set Pass/Fail Screen

On

Select the On radio button to turn Pass/Fail on.

Off

Select the Off radio button to turn Pass/Fail off.

Add/Remove (Toggle)

Select alloys from the Available list and then the Add Button to move the alloy to the Selected 
List. Select alloys from the Selected list and then the Remove Button to remove the alloys 
from the Selected List.

Save

Select the Save Button to save these criteria.

Close

Select the Close Button to exit without saving.

Pass Single

Select the Pass Single button to initiate Pass Single Mode. Use Pass Single Mode when you 
have only one possible desirable match. If the alloy being analyzed matches the alloy in the 
selected list, the alloy will Pass the analysis.
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Fail Single

Select the Fail Single button to initiate Fail Single Mode. Use Fail Single Mode when you have 
only one possible undesirable match. If the alloy being analyzed matched the alloy in the 
selected list, the alloy will Fail the analysis.

Setting the Reference Alloy for Pass Single or Fail Single

Before you use Pass Single or Fail Single mode, you need to set the Reference Alloy. Select the 
Data Entry Button from the slide down menu on the Ready to Test Screen, bringing up the 
Data Entry Screen.

Figure 33. .      The Data Entry Screen

Select the down triangle button next to the Sample Field. This will bring up the Sample Pick 
screen.
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Figure 34.      The Sample Pick Screen

Select the alloy you want as your Reference Alloy. In the example, we use 347 Stainless Steel.

Figure 35.      Example Pass Single Analysis



18 
Tools Menu Options

520 Niton XL3 Analyzer User’s Guide Thermo Scientific

Pass Multi

Select the Pass Multi button to initiate Pass Multi Mode. Use Pass Multi mode when you have 
more than one possible desirable matches. If the alloy being analyzed matches any one of the 
alloys in the Selected list, the alloy will Pass the analysis.

Fail Multi

Select the Fail Multi button to initiate Fail Multi Mode. Use Fail Multi mode when you have 
more than one possible undesirable matches. If the alloy being analyzed matches any one of 
the alloys in the Selected list, the alloy will Fail the analysis.

Using Either Pass or Fail Multi

There is no need to set a Reference Alloy in Pass or Fail Multi mode. You may use it as soon as 
you select your alloys to test against.

How Pass/Fail Mode Works

Pass/Fail Mode compares the chemistry to that of the alloy(s) selected, using the cutoff you 
selected. When the sample analysis reaches a match with the chemistry of any one of the alloys 
on the Selected list, a PASS or FAIL notice is generated as appropriate.

Switch Library (Main)

Selecting the Switch Library button from the Tools Menu will swap the currently loaded 
library with the other library on the analyzer. Selecting Switch Library again will switch them 
back.

Enable/Disable Al

Normally, the collective amount of unquantifiable light elements in alloy analysis - the 
"balance" - is assumed to be aluminum and labeled as such in the analysis. Selecting the 
Disable Al button from the Tools Menu will delete this "aluminum" from the analysis results, 
showing only the quantified elements. Selecting the Enable Al button, the default state, will 
label this "balance" as "aluminum".

Thickness Correction

Plastics, and polymers in general, unlike metals or soil, are very weak absorbers of X rays. This 
is because polymers are composed mainly of very light elements such as carbon and hydrogen. 
While just half a millimeter of steel will completely stop 23.1 keV energy X rays of cadmium, 
for example, it takes at least 10mm of plasticized PVC and as much as 100mm of 
polyethylene (PE) to do so. Fortunately, polymers that may contain cadmium (Cd), lead (Pb) 
and other restricted elements would also contain considerable quantity of elements such as 
antimony (Sb), bromine (Br), titanium (Ti), etc. Their presence results in much stronger 
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absorption of X rays which means that, instead of 100mm, it takes only about 15mm of 
compounded PE to achieve saturation thickness for these X rays. If the thickness of analyzed 
polymer sample is less than 5mm for PVC or less than about 9mm for a “typical” PE, the 
measured intensity of X rays will be a function of both analyte concentration and sample 
thickness. This is why measurements performed on thin samples (less than saturation 
thickness) need to be corrected for thickness.

How to apply Thickness Correction.

In order for the instrument to apply thickness correction to the measured concentration 
results, the user must be using the Thickness Correction screen and enter the thickness of the 
analyzed plastic object expressed in [mm] before the measurement is initiated. The thickness 
may be entered with precision to the second decimal place, although in practice only one 
decimal place is sufficient for effective correction.
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Figure 36.      How to Enable and Adjust Thickness Correction for Plastics Analysis
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When to use Thickness Correction

Thickness Correction should only be used during the analysis of plastic (polymer) objects. It 
has been experimentally verified that the correction algorithm will yield satisfactory results, 
for a 60 second minimum testing time, for samples as thin as 0.3mm. Nevertheless, the 
recommended range of use of the correction is from 1mm upwards. It is imperative that this 
correction is not used for thin films such as single foils and plastic membranes; analysis of thin 
films is performed using the Thin Sample Mode. (Contact Contact Thermo Scientific or your 
local Niton Analyzers representative for information on this testing mode.)

Whenever possible, one should analyze as thick a sample as available. For example, if the 
analyzed object is a piece of heatshrink tubing with wall thickness of 0.3mm, the best way to 
analyze it is to obtain several pieces of the tubing (four for example) and stack them like a flat 
sandwich, with the thickness correction set to 1.2mm. Doing so makes for faster and more 
precise analyses. While it would be possible to analyze just a single layer of the tubing with 
correction at 0.3 mm, by stacking several layers we reduce the relative error of measurement 
(by a factor approximately equal to the square root of the number of layers). Conversely, when 
analyzing thinner samples, we need to extend the measurement time fourfold (by the number 
of layers) in order to maintain the same relative error of measurement. We can see how 
quickly measurement time would escalate to impractical levels for thinner samples.

Examples: The most frequent instances in which thickness correction would be called for are 
analyses of plastic sheeting or plastic insulation on wires and/or cables and heat shrink tubing. 
Flat plastic sheeting or plastic enclosures pose no problems. We can either analyze an object 
“as is”, or stack several layers of it before analysis. Plastic insulation such as that on wiring or 
cables requires a little more sophisticated approach. First, the wire must be removed so that 
only insulation is analyzed. Then, the insulation should be flattened for analysis, and a 
thickness correction should be applied that is equal to double the wall thickness. Alternatively, 
if the insulation is stiff, it should be cut lengthwise into strands which are placed on the 
indtrument for analysis. The applied thickness correction should be equal to the wall 
thickness of the sleeve. Both operations are shown in Figure 37 and Figure 38.

Figure 37.      Wire Insulation Cut Into Strands
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Figure 38.      PVC Wire Insulation With Conductor Removed

A piece of large diameter heat shrink tubing presents an interesting case. It is tempting to 
analyze this object as is - see Figure 39. However, one needs to know that while lead or 
bromine or chromium X-rays from the upper wall of tubing will not contribute to the signal 
measured, X rays of such elements as cadmium, antimony, tin or barium in the upper wall will 
significantly contribute to overall signal. It is therefore imperative to either flatten the tubing 
for analysis or cut it in pieces and then analyze as shown in Figure 40.

Figure 39. .      Incorrect Way to Measure Heat Shrink Tubing

Figure 40. .      Correct Way to Measure Heat Shrink Tubing

WARNING  Thickness correction is only for use with plastic/polymer samples. 
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Enable/Disable Paint

Selecting the Enable Paint option from the Tools Menu will enable the Painted Products 
mode and toggle the option to Disable Paint. Selecting the Disable Paint option will disable 
Painted Products mode and toggle the option to Enable Paint. See “APPENDIX A - 
Consumer Goods Mode for Screening Consumer Products” on page 145 for details on how to 
use this mode.

Action Level

See “APPENDIX A - Consumer Goods Mode for Screening Consumer Products” on 
page 145 for details on how to use Action Levels.

Print Data

Selecting the Print Data option from the Tools Menu will print the currently displayed data to 
the optional attached printer. See Setting Up the Printer for details.

Coatings Method

Metals are sometimes coated with various materials. If you wish to analyze the coating, select 
the Coatings Method. See “Coatings Analysis” on page 81 for details.
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Passwords and User Privileges

1.     Install the latest version of Niton software (NDT) on your PC, if possible. You may 
obtain the latest version of NDT by contacting service at 800-875-1578.

2.     You can check the version number by opening NDT, selecting the Help menu, then 
selecting “About Niton Data Transfer”

Figure 41. .     Selecting Help

3.      Select the File menu

Figure 42.    Selecting File

4.     Select “New” then “New Password File”. Your screen should look like this:
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Figure 43.     Creating the Security Key

5.     Create a unique security key, then select the OK Button

Figure 44.     Security Key

6.     Your screen should look like this:
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Figure 45.     User Account Creation Screen

7.     Right click, then select “New User”

Figure 46.     User Creation Dialog Box
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8.     Enter a user name and password, then select the privileges assigned to this user. 
Selecting the Check All check box will result in enabling all features.

Figure 47. .      Creating a User

WARNING  it is recommended that only users at the highest level have access to the “Safety” 
feature. This should be unchecked for all other operators.
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Figure 48.     Unchecking Safety

9.    Select the Update Button

Figure 49.     User is Created

a. You are now ready to upload your password file to the analyzer.
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10.     Be sure the analyzer is switched on; connect the analyzer using USB or serial 
connection.

11.     Select the Upload icon.

Figure 50.     Selecting Upload

12.     Your screen should look like this:
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Figure 51.     Selecting Upload

13.     Select the Settings Button and choose the comm port that your analyzer is connect to.

14.     Select the Connect Button, then the Upload Button.

15.     Upon completion, you will receive a “File Upload Successfully Completed” message.

16.     Click the OK Button; save your password file at this time by selecting the File icon 
then “Save As.
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Figure 52.     Successful Installation Message

17.     Restart your analyzer; your password file should be successfully installed.
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NDF Files: User Data Structuring

Creating New User-Defined Fields

You can create your own data entry fields for your Niton analyzer customized to your own 
needs and usage. These fields are saved in a special format called an NDF (Niton Data File) 
file. To create a new NDF file, select the File menu, then select New, then select New NDF 
File.

Figure 53. Creating a New NDF File

This will create a new window in which you can create your own fields, and specify their 
structure and parameters. The new window will appear with a single box, called “Untitled.”
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Figure 54. NDF File Work Area

By right-clicking on this box, you can access a pop-up menu allowing you to set the mode of 
the new data fields. Select New Mode to access the menu.

Figure 55. Selecting New Mode

The Mode you select will be the Mode within which the new data entry fields will appear. If 
you have multiple Modes enabled on your analyzer, the new fields will only be available from 
the Mode you select. Only the default fields will be available from the other Mode or Modes.
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Figure 56. Selecting Mode

When you select the Mode for the new data fields, the Construction Window will change to 
look like this:

Figure 57. Working within a Mode

The “M” indicates the mode you have chosen - in this case Alloy Mode. Right click on the 
Mode name to access a pop-up menu.
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Figure 58. Mode Pop-Up Menu

Select New Field from the menu, and a blank new field will appear in the construction 
window.

Figure 59. Adding a New Field

Right clicking on the New Field box will bring up another pop-up menu. This menu gives 
you various options for using the field in your operations.

Selecting Required makes it mandatory that the new field be filled in prior to taking a 
measurement. This is very useful for necessary descriptors which vary from measurement to 
measurement, such as lot numbers, condi­tion descriptors, locations, etc. 
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Figure 60. Making Fields Required

Selecting the Incremental option sets up a field which increments the field descriptor by one 
for each measurement taken. This option is handy for measuring several items with identical 
descriptors, such as samples within a single lot, or several instances of the same part number, 
because it appends the incremental number to the descriptor.

For example: P/N 455A2-1, P/N 455A2-2, P/N 455A2-3.

Another Example: Impeller-1, Impeller-2, Impeller-3.

Figure 61. Making Fields Incremental
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Selecting Clear Every Reading will toggle between two states. By default, the field will fill with 
the data which was input during the last reading. By selecting Clear Every Reading, you tell 
the instrument to clear the data from the field for each new reading, insuring that the person 
taking the reading must input new data each time. This is very useful for times when the data 
descriptor is expected to vary widely between readings. 

Figure 62.  Clearing Data for New Readings

The state of each of these options can be seen in the Field Status Window at the bottom of the 
Construction Window. All options in effect for the field selected are checked.

Figure 63. Field Status Window - Default

This shows a field with no options in effect, the default configuration. This is a field that will 
present the previous reading’s data for this field - which may be changed by the user - without 
incrementing it, but does not require the user to input any data if there is none already there 
from a previous reading. 
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Figure 64. Field Status Window - Options Enabled

This shows a field with both Required and Clear Every Reading options in effect. This 
presents a field that is cleared for each reading, and must be filled in by the user before a 
reading is taken.

Selecting Edit from the pop-up menu allows you to edit the name of the field in the Editing 
Window to the right of the Construction Window.

Figure 65. Editing the Field Name

Selecting the box to the left of the field toggles the Required option on or off.
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Figure 66. Toggling the Required Option

Selecting Copy from the pop-up window allows you to copy the currently selected field.
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Figure 67. Copying the Current Field

Once you copy a field, the Paste option can be selected to paste the copied field into the 
Construction Window.

Figure 68. Pasting a Copied Field

Selecting the New Entry option from the pop-up menu allows you to define a choice for the 
user for this field. 
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Figure 69. Creating a New Entry

This is a New Entry in the Construction Window. 

Figure 70. New Entry in the Construction Window

The “E” is for “Entry.” You can edit the entry once it is created, the same way as you edit the 
field name. Right click on the entry name, and choose Edit from the pop-up menu.

Figure 71. Editing the New Entry

You can sort your entries by name, alphanumerically, by right clicking on the field and 
selecting “Sort” from the pop-up menu.
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Figure 72. Sorting Entries

To delete a field or entry, just right click on the item you wish to delete, and select Delete 
From the pop-up menu.

Figure 73. Deleting Fields and Entries

When you are finished creating your new NDF file, Upload it to your instrument using the 
Upload icon. 

Figure 74. Uploading the NDF File

Make sure the instrument is connected to your computer by testing the con­nection first. Use 
the Test button on the Upload Window.
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Figure 75. Testing the Upload Connection
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Pseudo-Elements

Pseudo-Elements are constructs you can create which will be treated like elements in analysis, 
showing up in analysis as if they were actual elements. An example of this is hardcoded into 
the system. You can have total Halogens show up as a line item in analysis - see Consumer 
Goods Analysis Appendix A for details - which sums the total detected Br and Cl in the 
sample. In setting up a Pseudo Element, you must name it with at least 3 characters and at 
most 6 characters - except you cannot use * (asterisk) and space. You can set up equations with 
the following operands:

Add

You can Add detected levels of elements or Pseudo Elements together or to a constant. For 
example: sum applicable elements for FAC Analysis - (FAC=Cr+Cu+Mo), or sum elements 
for Residual Element Application - (REA=Cr+Ni+Cu). 

Subtract 

You can Subtract detected levels of elements or Pseudo Elements from each other or a 
constant. For example: find the level of clinker material C2S in cement - (C2S = 
(2.87*SiO2)-(0.754*Ca3SiO5)) 

Multiply

You can Multiply detected levels of elements or Pseudo Elements by a constant. For example: 
Convert elemental data to oxide form - (CaO=Ca*1.4).

Divide

You can Divide detected levels of elements or Pseudo Elements by a constant. For example: 
Convert Au concentration to Karat% - (Karat=((Au/100)*24))

Parentheses

You can use parentheses to stack order of calculation, as in the Karat and C2S examples above.
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Figure 76. Pseudo Elements Menu Path

The Pseudo Elements Screen enables you to Create, Edit, and Delete Pseudo Elements in all 
Modes available on your analyzer. From the Pseudo Elements Screen, select the mode you 
wish to create the Pseudo Element for. 
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Figure 77. The Pseudo Element Mode Editor (Soils Mode)

To set up a new Pseudo Element, select the New Button. To Edit an existing Pseudo Element, 
select the Edit Button. To Delete an existing Pseudo Element, select the Delete Button. To 
Close the window and return to the previous screen, select the Close Button.

New

Figure 78. The Pseudo Element Equation Editor
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1. Select the Keyboard Button to bring up the Virtual Keyboard.

2. Type in the name you chose to call your Pseudo Element. 

Figure 79. Using the Virtual Keyboard

3. Select Enter.

4. Select the inverted triangle button to open the Drop-Down Menu.
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Figure 80. Selecting Elements from the Drop-Down List

5. Select the element you want to add to the equation. It will appear in the Current Element 
window.

6. Select the Add Button to add the Current Element to the equation.

Figure 81. Adding the Current Element to the Equation
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7. Using the Virtual Numeric Keypad integral to the editor, type in the other parts

of the equation.

Figure 82. Adding Operands and Constants

8. When the equation is complete, select the Close Button.

9. The Pseudo Element will show up in the Mode Editor Window.
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Figure 83. The Finished Pseudo Element in the Mode Editor Window

Edit

Select the Pseudo Element you want to edit from the Mode Editor window, then select the 
Edit Button.

Figure 84. Selecting a Pseudo Element for Editing
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This will open up the Pseudo Element Equation Editor with the selected Pseudo Element 
pre-loaded.

Delete

1. Select the Pseudo Element you want to delete from the Mode Editor window.

Figure 85. Selecting a Pseudo Element for Deletion

2. Select the Delete Button.

3. Select the Close Button to return to the previous screen.
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Figure 86. Pseudo Element Displayed in Reading
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TestAll Geo

TestAll Geo Mode allows you to test powder, mineral, and ore samples without first 
determining whether the samples would best be analyzed with Mining or Soil Mode. TestAll 
Geo Mode uses both the Compton Normalization calibration (Soil) and the Fundamental 
Parameters calibration (Mining) to determine whether the soil calibration is acceptable or 
whether the total metal content is too high for Compton mode. 

Figure 87. The TestAll Geo Menu Path
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If the sample can be analyzed via soil mode, then the analyzer will display results from both 
Soil and Mining Modes in one unified list. If both calibrations contain the same element, 
then the mode that has the lower detection limit will be displayed. Elements will be displayed 
in both ppm (mg/kg) and wt.% with 0.10% being the cutoff point.

Figure 88. The TestAll Geo Analysis Screen

Notice the ppm heading, but % is listed with results where appropriate.

Figure 89. The Same Sample As Analyzed in Mining, Soil, and TestAll Geo Modes

TestAll Geo Mode may be used with any Standard Operating Procedure appropriate for either 
Mining Analysis or Soil Analysis.
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Safety Settings

Access to the Safety Settings Screen is blocked unless the user logging in has explicitly been 
granted Safety access. The default login of 1234 does not have Safety access. See Passwords 
and User Privileges.

Figure 90. .    Safety Settings Menu Path
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The Safety Settings Screen enables you to change the Method of Operation for your 
analyzer. Each checkbox on the screen enables or disables the safety device named for purposes 
of the preconditions for operation. For example, checking the Proximity Button Required 
checkbox sets the engagement of the Proximity Sensor as a precondition for operation. 
Checking the Proximity Button Required checkbox and the Interlock Button Required 
checkbox sets the engagement of both the Proximity Button and the Interlock Button as 
preconditions for operation.

Safety settings always override start-stop settings. If your safety setting requires the use of the 
Proximity Button, you cannot set start-stop settings which ignore the Proximity Button. For 
example, the Easy Trigger start-stop setting must have the Backscatter safety setting enabled. 
While using Easy Trigger, you cannot disable Backscatter.

WARNING  The backscatter sensor is enabled by default and acts as a recommended safety 
feature for most applications. Some sample types, however, cannot be analyzed when this 
feature is enabled. Samples that present very little mass to the analysis window, such as certain 
thin films, thin layers of plastic, and very thin wires, may not be of sufficient mass to allow the 
analysis to continue while backscatter is enabled. One should disable the backscatter feature 
only when necessary to analyze such low mass samples, and re-enable the feature when 
finished with these sample types. These samples also provide very little absorption of the 
primary x-ray beam so it is typically most appropriate to analyze these samples in a test stand 
when possible.
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Start/Stop Setup

Figure 91.    The Start/Stop Settings Menu Path

The Start/Stop Setting Screen enables you to change the preconditions for operation at a 
lower level than the Safety level. See Safety Settings for more information. Start/Stop settings 
cannot contradict Safety settings. If your safety setting requires the use of the Proximity 
Button, you cannot set start-stop settings which ignore the Proximity Button. For example, 
the Easy Trigger start-stop setting must have the Backscatter safety setting enabled. While 
using Easy Trigger, you cannot disable Backscatter.
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The Start/Stop parameter options are Proximity Start, Remote Trigger, and Easy Trigger. 
There is also a field to set the maximum time for sample analysis before the analysis stops.

Proximity Start

Select the Proximity Start checkbox to use the Proximity Start parameters. Using Proximity 
Start, once the reading has been started, release of the Proximity Button will immediately stop 
the analysis. You cannot use Proximity Start with Easy Trigger.

Remote Trigger

Select the Remote Trigger checkbox to use the Remote Trigger parameters. Remote Tigger is 
used with the Extend-a-Pole accessory to control the analysis. With the Extend-a-Pole's input 
cable connected to the analyzer's Remote Trigger port, you can initiate and stop analysis 
remotely from the Extend-a-Pole's handle trigger. You can use Remote Trigger with either 
Proximity Start or with Easy Trigger.

Easy Trigger

Select the Easy Trigger checkbox to use the Easy Trigger parameters. Easy Trigger uses a single 
press and release of the trigger to initiate analysis, and a second press to stop analysis. Selecting 
Easy Trigger will immediately disable Proximity Start.

Max Time Field

  

Figure 92.    The Max Test Time Editor
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Select the Max Time field to change the maximum analysis time parameter. Selecting the Max 
Time Field brings up a Virtual Numeric Keypad. To input the maximum number of seconds 
before automatic shutoff, select the C button to clear the current time, then from the Virtual 
Numeric Keypad, select each digit you want to input, then select the E button to enter. Of the 
non-numeric screen buttons, C = Clear All, E = Enter, and ">" will backspace over the current 
value. Selecting the E button will enter the current value as the Max Time, and return to the 
Start/Stop Settings Screen.

Save Button

Selecting the Save Button will save your current settings.
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Updating System Software

You can use your computer to upload system software to your analyzer. Open the NDT 
application. Turn the device on and connect via USB or serial; wireless connection can be 
used, but is not recommended for this procedure. See Connecting the XRF for details on how 
to connect your analyzer and PC.

To upload CPU and FPGA code, please select the Utilities Menu then the Update Firmware 
option. Your computer will open a dialog box.

Figure 93.    The Update Firmware Window

Select the Settings Button, then select your com port from the list. When you are done, select 
the Connect Button and the Test Button. You should see this message:

  

Figure 94.   Successful Communications

Click on the OK Button when you see this dialog box.

Find the CPU code you wish to upload by selecting the Browse Button, then selecting the 
.nxg file you wish to upload. Select the Open Button when you are ready.
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Figure 95.    The Browse Window

Select the Upload Button; the progress bar will go to 100% and you will receive this message:
Note  Do not remove the battery or power supply from the instrument during this process.
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Figure 96.    The Progress Bar

Once the code has finished installing, the analyzer will give you an audio signal (beeping) that 
it is done and NDT will display this message: 

Figure 97. .   Firmware Successfully Updated Message

Restart the instrument when you see this message.
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Log on to the instrument. From the Main Menu, select the System icon, then the Specs icon. 
You should now see the updated version of code in either your “SW Ver” or “FPGA” line, 
depending on what you were uploading. Check the latest version of the mode specific 
calibration manuals for the minimum code requirements. The latest released code is always 
recommended when beginning a new calibration.

Figure 98.    The Specs Screen

Loading the .dll file (Calfile)

Each device has an instrument-specific .dll file, which is generated from the Calibration file 
associated with it. 
Note  Loading this .dll file will set all settings on your analyzer back to factory specifications, 
and you will lose all your custom settings. Do not load the .dll file unless told to do so by 
Service. To obtain your instrument specific .dll file, please contact Service.

NDT may be used to upload this .dll to the analyzer. Turn the device on and connect via USB 
or serial; wireless connection can be used, but is not recommended for this procedure. See 
Connecting the XRF for details on connecting your analyzer and PC.

To upload the .dll file, please select the Utilities Menu, then the Upload Calibration Dll 
option. Your should see this dialog box:
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Figure 99.   Loading the .dll File (Calfile)

Select the Settings Button, then select your com port from the list. When you are done, select 
the Connect Button and the Test Button.

Figure 100.    Browsing to Find the .dll File

Find the .dll file you wish to upload by clicking on the Browse Button and selecting the file. 
Select the Open Button when you are ready.
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Select the Upload Button; the progress bar will go to 100% and you will receive this message:

Figure 101.    The Progress Bar
Note  Do not remove the battery or power supply from the instrument during this process. 

Restart the instrument when you see this message.
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Adjusting the Calibration

  

Figure 102.    The Adjust Calibration Menu Path

The Adjust Calibration Screen enables you to change calibrations for Mining. Select the 
Mining from the list. Changing calibration factors for other modes must be enabled by 
download from your PC.

  

Figure 103.    Select Mode
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The Calfactors Screen will now appear.

Figure 104.    The Calfactors Screen

Select the radio button of the Calibration Factor Set you wish to edit, then select the 
appropriate Edit Button. The Calibration Edit Screen will open. You cannot edit the Factory 
Calibration. You may edit and store up to four alternate calibrations per Mode.
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Figure 105.    The Calibration Edit Screen

Select element you wish to edit in Element Column

Select intersection of Slope Column and Element Row to edit Slope.

Select intersection of Inter Column and Element Row to edit Intercept

Select Virtual Keyboard Icon to bring up the Virtual Keyboard and edit Set name in the Set 
Name Field.
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Figure 106.   Changing Set Names

Editing the Calibration Factors

Selecting the intersection of the Slope Column and the Element Row will bring up the Slope 
Edit Screen, a variation on the standard Virtual Numeric Keypad. To enter in a new value for 
this slope, select the C Button to clear the field, enter in the new value for the slope, and select 
the E Button to enter this value. The ">" Button operates as a backspace key.

Selecting the intersection of the Intercept Column and the Element Row will bring up the 
Intercept Edit Screen, a variation on the standard Virtual Numeric Keypad. To enter in a new 
value for this intercept, select the C Button to clear the field, enter in the new value for the 
intercept, and select the E Button to enter this value. The ">" Button operates as a backspace 
key.
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Figure 107.   Slope and Intercept Edit Screens

Calibration Factors

Although the FP software automatically corrects for most inter-element matrix effects, Niton 
XL3 analyzers cannot currently detect elements lighter than magnesium. As a result, the 
oxidation state of elements can bias measurements of other elements. In many cases, this bias 
is small, and uncorrected results provide sufficient accuracy, especially when data is for 
screening purposes only. For cases when more accurate results are required, We have provided 
slope/intercept calibration software with the analyzer to improve the quality of the data. The 
calibration software is element specific, and calibration factors can be entered for individual 
elements, independent of the other elements. A user may choose to correct a single element or 
a suite of elements.

The degree of severity of the bias should be evaluated before proceeding with routine 
measurement. A few test samples should be carefully measured by another technique, or by an 
outside lab. These samples should then be analyzed using the analyzer. If the agreement is 
good enough to provide the accuracy required for the application, the instrument can be 
operated as shipped. If it is determined that a bias correction is necessary, the procedure for 
establishing calibration factors should be followed. As site characteristics change, it is good 
practice to run a few check standards to ensure that the instrument results are still within an 
acceptable error range.
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Oxides versus elemental concentrations

Laboratories, certificates of analysis and other XRF instruments sometimes report data as 
oxides. The analyzer reports data only in elemental concentration. Therefore, oxide data must 
be converted to elemental concentration for comparison with Niton XL3 results. This may be 
achieved using the conversion factors below. The oxide is multiplied by this factor to convert 
to elemental concentration.

Oxides vs. Elemental Concentrations

Oxide Conversion Factor

MgO 0.6030

Al2O3 0.5292

SiO2 0.4674

SO3 0.4005

K2O 0.8301

CaO 0.7147

TiO2 0.5994

V2O5 0.5602

Cr2O3 0.6842

Mn3O4 0.7203

MnO 0.7745

Fe2O3 0.6994

FeO 0.7773

Co3O4 0.7342

NiO 0.7858

CuO  0.7989

ZnO 0.8034

PbO 0.9283

Fe2O3 0.6994

Bi2O3 0.8970
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This conversion factor is obtained by taking the atomic weight of the element multiplied by 
the number of its atoms in the oxide, and dividing by the molecular weight of the oxide.

Worked examples:

To convert SnO2 to Sn:

Sn = concentration of SnO2 * 0.7877

To convert Sn to SnO2:  

SnO2 = concentration of Sn * 1/0.7877

Measuring the Standard Samples
Use your analyzer to take readings of samples for which you already know the 

composition of the sample. It is important that the known composition of these 

samples be accurate. These samples provide the baseline to which your analyzer is 

adjusted. If the known composition is inaccurate, your analyzer will also be 

inaccurate.

For each sample, take a reading of at least 120 seconds. Make a note of the reading 

numbers for these samples.

For each sample, your analyzer reports the percentage by weight for the elements 

present in the sample. With the calibration factors set to the defaults, these 

percentages will differ from the known percentages, but are used to calculate the 

calibration factors.

Note  Readings from only three samples are required for each element, but increasing the 
number of readings also increases the accuracy of the results.

Calculating Calibration Factors

Using the data that you collected by measuring the standard samples, you now 

need to plot the percentage of each element as indicated by the standard samples, 

ZrO2 0.7403

MoO3 0.6665

WO3 0.7930

Ta2O5 0.8190

Nb2O5 0.6990

SnO2 0.7877
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against the percentage of each element as reported by your analyzer. Then use the 

linear regression function to calculate the slope and intercept for a straight line 

drawn through a graph of those data points. The slope and intercept for this line are 

the calibration factors for the element.

You may use any tools that you prefer to make this calculation. This document 

shows one possible method, using Excel. 

Note - your analyzer reports percentages of elements, and the calibration factors 

are based on percentages of elements. If your standard samples indicate 

percentages of oxides, see “Oxides versus elemental concentrations” on page 573 

to convert percentages of oxides to percentages of elements.

Calculating Calibration Factors Using Excel
To calculate calibration factors:

Open Excel. To do this:

a. Click the Start button.

b. Select Programs.

c. Click Microsoft Excel.

Figure 108. Starting Excel
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1. In the first column, enter all the percentages by weight for the element as reported by 
your analyzer.

Figure 109. Adding Data

2. In the second column, enter all the percentages by weight for the element as indicated by 
each standard.

3. Use the cursor to highlight all the numbers in both columns.
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Figure 110. Setting Up the Chart

4. Click Chart Wizard.

5. Select the Scatter Chart with data points that are not connected by lines.



18 
Calculating Calibration Factors Using Excel

578 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 111. Selecting the Scatter Chart

6. Click Finish.

7. Right-click on one of the data points.

8. Click Add Trendline on the pop-up menu.

Figure 112. Adding the Trendlines

a. On the Type tab, click Linear.
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Figure 113. Selecting Linear Trendline

b. On the Options tab, check the boxes for “Display equation on chart” and “Display 
R-squared value on chart.”
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Figure 114. Selecting Options

c. Click OK.

d. The equation shows the slope and intercept for the trend line. These are the 
calibration factors that you enter into your analyzer.
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Figure 115. Slope and Intercept Displayed

Note  If the intercept is negative in the equation, be sure that you enter the intercept as 
negative in your analyzer.

9. Repeat these steps to find the slope and intercept for every element that you are interested 
in.

Uploading Calibration Factors from your PC
For Precious Metals, Plastics, and Soil Modes, you need to upload the privilege to 

edit Calibration Factors from your PC before you can edit them. From NDT, create 

a New User, as described in Passwords and User Privileges. When selecting 

privileges, make sure that the checkbox next to Calibration Curves is checked, as 

in Figure 116 below. This user will have the ability to edit Calibration Factors for 

these modes.
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Figure 116. Uploading the Calibration Curves
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Display Units

Figure 117.    The Set Display Units Menu Path

Figure 118.    The Set Display Units Screen

Select the Set Display Units icon to choose between ppm (parts per million) and percentage 
(hundredths of whole) displays when taking readings, and to change the Sigma value you 
want for the reading.

Selecting the Set Display Units icon opens the Set Display Units Screen.
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Setting Display Units

In the Set Display Units Screen, you can select between Percent composition and Parts per 
Million as the units displayed in a measurement, and you can change this setting 
independently for Alloy, Mining, Plastic, Precious Metal, and Soil modes. You can also change 
the Sigma for each of these modes independently.

When you have changed the display units to the appropriate values, select the Save button to 
save these settings for use. Select the Close button to return to the previous screen without 
saving any changes.

Changing Precision (Sigma Value)

Sigma is the symbol used for Standard Deviation, a measure of how much a set of numbers 
deviates from the mean. For example, each of the three data sets {0, 0, 14, and 14}, {0, 6, 8, 
and 14} and {6, 6, 8, 8} has a mean of 7. Their standard deviations are 7, 5, and 1, 
respectively. The third set has a much smaller standard deviation than the other two because 
its values are all close to 7. In a loose sense, the standard deviation tells us how far from the 
mean the data points tend to be.

The number of standard deviations between the process mean and the nearest specification 
limit is given in sigmas. As process standard deviation goes up, or the mean of the process 
moves away from the center of the tolerance, the sigma number goes down, because fewer 
standard deviations will then fit between the mean and the nearest specification limit.

Confidence Intervals

Confidence intervals assume that the data are from an approximately normally distributed 
population - generally, sums of many independent, identically distributed random variables 
tend towards the normal distribution as a limit. Using this assumption, about 68 % of the 
values must be within 1 standard deviation of the mean, about 95 % of the values must be 
within two standard deviations, about 99.7 % must lie within 3 standard deviations, and 
about 99.99% of the values must lie within 4 standard deviations.

The greater the sigma value of the test, the more confident you can be that the sample is as it 
appears, but the more difficult and time consuming the testing must be to verify this. That's 
why it's important to use the most appropriate sigma value for the test. By adjusting the sigma 
value for each type of test, you can optimize the process for your needs.

Adjusting the Sigma Values

The sigma values are listed in the column headed s. The default value is 2 sigma. You can 
change this value by selecting the down arrow next to the value, which opens up a drop-down 
menu from which you can select the desired sigma value by clicking on it.
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Figure 119. .    Selecting the Sigma Value

When you have changed the sigma values to the appropriate number, select the Save button to 
save these settings for use. Select the Close button to return to the previous screen without 
saving any changes.
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Methods of Operation   
CAUTION  After being powered on, your Niton Analyzer will perform an internal 
re-calibration before an analysis is initiated. It is recommended that you let your analyzer 
warm up for ten minutes after start up, before testing is begun.

There are six different methods of operation for taking a sample measurement, and your 
analyzer will be configured to use one of those methods for alloy samples, depending on the 
regulatory requirements of your locality. These methods are:

• Trigger-Only method. With the Trigger-Only method, you only need to place the 
measurement window flush with the sample to be analyzed and pull the trigger for sample 
analysis to be initiated.

• Trigger-and-Proximity-Sensor method. With the Trigger-and-Proximity-Sensor method, 
you must place the measurement window against the sample to be analyzed to engage the 
proximity sensor on the front of the analyzer, then pull the trigger for sample analysis to 
be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With the 
Momentary-Trigger-Touch-and-Proximity-Sensor method, you must place the 
measurement window against the surface to be analyzed to engage the proximity sensor 
on the front of the analyzer, then pull the trigger. The trigger may be released and the 
reading will continue until you release the proximity button, or other criteria (such as 
Max Time) are reached.

• Trigger-and-Interlock method. With the Trigger-and-Interlock method, you need to 
place the measurement window close to the sample to be analyzed, press and keep 
pressing the interlock button at the rear of the analyzer with your free hand, then pull the 
trigger for sample analysis to be initiated.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the measurement 
window against the sample to be analyzed to engage the proximity sensor on the front of 
the analyzer, press and keep pressing the interlock button at the rear of the analyzer with 
your free hand, then pull the trigger for sample analysis to be initiated.

• Easy Trigger method. With the Easy trigger method, you need only place the 
measurement window against the sample area and pull the trigger once to initiate a 
sample analysis. Your analyzer will continuously sample the backscatter, using a complex 
internal algorithm, to determine if the measurement window is against a sample or 
pointing to the empty air. If it finds that there is no sample directly against the 
measurement window, the analyzer will stop directing radiation through the window as 
soon as this determination is made.

The analyzer is constantly checking the backscatter characteristics to determine if a sample is 
against the measurement window, whether or not the Easy Trigger method is being used, and 
will shut off any radiation directed through the window if it determines that there is no 
sample present.
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With any of these methods, analysis will stop if any one of the preconditions are violated. For 
example, with the Trigger-Interlock-and-Proximity-Sensor method, if the trigger or the 
Proximity Sensor or the Interlock is released, the reading will stop immediately, and the X-ray 
tube will shut down.

After your analyzer is calibrated, initiate a sample reading using the appropriate method. If 
you attempt to initiate a sample reading using a different method, the analyzer will inform 
you that one or more of the preconditions need to be met in order for sample analysis to 
begin.

Note  The LED lights will blink whenever the x-ray tube is on.

WARNING  The nose should not be touched during sample testing and calibration. If an ESD 
event occurs during measurement, the instrument may terminate the testing in progress and 
automatically reset to LogOn screen. Any test data collected prior to reset will be lost and the 
testing may have to be repeated.

 
WARNING  The preconditions for operation must be continued for the duration of the 
reading. If the preconditions are violated, the x-ray tube will turn off, the calibration shutter 
will close, and the measurement will end. The LED lights will stop blinking when the 
measurement is ended. The flashing of the LED lights is not synchronized to minimize 
power consumption.

To end the test, simply release the trigger mechanism, or any other applicable preconditions.
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Sorting the Element Display

Figure 120. .    The Element Sorting Menu Path

Select the Sort Element Display icon to configure sorting criteria used for analysis display. 
Selecting the Sort Element Display icon opens up the Sort Criteria Screen.

Figure 121.    The Sort Criteria Screen

Select the mode you wish to change, and the Sorting Options Screen will appear.
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Figure 122.    The Sorting Options Screen

On the left of the display are elements, each with its currently selected display option beside it 
to the right. The element list is ranked by importance, with the most important element on 
top, and each one lower down of less importance than the one above it.

By selecting an element and using the arrow buttons to the right of the list, you can change its 
ranking. Use the Top Arrow Button to move an element one rank closer to the top with each 
click. Use the Bottom Arrow Button to move an element one rank closer to the bottom with 
each click.



18 
Uploading Calibration Factors from your PC

590 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 123.   Changed Sort Order

Display Options

The Display Options Drop Down Menu, allows you to change the display status of any 
element to one of three states:

• Normal - The standard state. Element displays only when the elemental value is greater 
than the limit of detection.

• Always - Always display the results for this element. Use this state for elements critical to 
all of your analyses.

• Never - Never display the results for this element. Use this state for elements which are 
unimportant to your work. This makes your instrument display less complex.

Select the element you want to change, then select the menu option corresponding to your 
choice of display status. The currently selected element is displayed in white on black.
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Figure 124.   Changed Display Option

Select the Save Button to save your current status as the new default. After saving, you will go 
back to the Element Display Menu.

Close Button

Select the Close Button to exit without saving. When you select the Close Button after 
changing the display state of any element, a screen will open asking you if you want to save 
the changes you made. Selecting the Yes Button will save these changes as the new default. 
Selecting the No Button will return you to the Element Display Menu without saving the 
changes.
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Figure 125.   Save Changes Screen
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Consumer Product Settings

Figure 126.    Consumer Products Settings Menu Path

Select the Consumer Goods Settings icon to configure Consumer Goods analysis criteria. 
Selecting the Consumer Goods Settings icon opens up the Consumer Goods Settings Screen. 
See Consumer Goods Analysis APPENDIX A for details on Consumer Goods Analysis.

In the Consumer Goods Settings Screen, you can change the Minimum Test Time in 
Detection Mode, and the Painted Products Action Level for all Analysis Options. You 
cannont change the Minimum Test Time for RoHS and Consumer Products Mode. In RoHS 
Settings Mode or Consumer Products Mode, the Min Test Time field is greyed-out and not 
editable.
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Figure 127.   The Min Test Time Field Grayed Out

Editing the Min Test Time Field

To set the Minimum Test Time in Detection Mode, select the radio button next to Detection 
Settings. This will open the Min Test Time Field for editing.

Figure 128.   The Editable Min Test Time Field
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Click in the Min Test Time Field to bring up the Min Test Time Editor.

  

Figure 129.   Min Test Time Editor

Select the C Button to clear the editor’s field, then type in the numbers you want for a 
minimum test time, using the Virtual Numeric Keypad. Select the E Button to enter this 
value when you are done.

Editing the Painted Products Action Level

To change the Action Level for Painted Products, click in the Painted Products Action Level 
Field to open the Painted Products Action Level Editor.
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Figure 130.   Painted Products Action Level Editor

Select the C Button to clear the editor’s field, then type in the numbers you want for a 
minimum test time, using the Virtual Numeric Keypad. Select the E Button to enter this 
value when you are done.

Camera and Small Spot Video 

The Camera feature is only usable with properly configured analyzers, and the Small Spot 
feature is only available on Small Spot analyzers. 

If your analyzer is equipped with an internal video camera, you can turn that camera on and 
off, and turn the saving of images with the readings on and off through an interface. When 
the camera is on, the image will show in the Ready to Test screen, as in Figure 123. If the 
camera is off, saving of images will also be off. If the camera is on and the image saving 
function is also on, the images will automatically be saved with the reading. Saving images will 
curtail the maximum number of readings stored.

How to Use the Camera 

When a Camera equipped analyzer is in the Ready to Test screen, the video feed appears live 
on the analyzer’s touch screen. This is the image that can be saved with the sample analysis. 
When you take a measurement, if you choose to do so, the bitmap image will be saved on the 
analyzer along with the analysis results. The interface is accessible through the System menu, 
as in Figure 120. 
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Figure 131. The Camera Menu Path



18 
Camera and Small Spot Video

598 Niton XL3 Analyzer User’s Guide Thermo Scientific

Figure 132. Setting Up the Camera View and Image Saving

Selecting the empty checkbox next to Enable Camera will turn the internal camera on, 
displaying the camera view in the Ready to Test screen. Selecting the checkbox again turns the 
camera off. Enable Camera is enabled by default.

Selecting the empty checkbox next to Save Image will enable image saving with the analysis. 
Selecting the checkbox again will disable automatic saving of image data. Save Image is 
enabled by default.

Stored camera images from previous measurements can be viewed on the analyzer.

How to Use the Small Spot Technology

With a properly equipped Small Spot analyzer, you can restrict the analysis to a small spot 
within the camera view. You can toggle the Spot on and off from the Tools Menu as in Figure 
122.

A red circle will appear on the display. The circle marks the area analyzed. 
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Figure 133. Toggling the Small Spot from the TOOLS Menu

Using the Small Spot

The Small Spot can be used in several different modes.

Mining

• 3mm spot size allows analysis of veins and inclusions in mineral samples

• Initiate from Tools - Toggle Spot



 18 
Camera and Small Spot Video

Thermo Scientific Niton XL3 Analyzer User’s Guide 601

He Purged

• Helium purge allows analysis of light elements (Mg, V and Ti)

• Small spot enables analysis of light elements in welds and inclusions

• Helium and Small Spot modes can be used simultaneously for Metals and Mining modes

Calibrating the Spot

If your instrument has small spot capability, you may calibrate the spot to optimize 
performance. Please follow the following procedure to calibrate the spot.

Requirements: CPU code 7.0A or higher, Small Spot QC Calibration Sample part #180-607.

1. Connect the instrument to NDTr. It is strongly recommended that this procedure be 
done in a test stand whenever possible. See Operating Your Analyzer Remotely for details.

2. Log on (Default "1234")

3. Enter a mode that has small spot capability. It is recommended that the you use either 
Metals or Electronics Alloy if possible. Then exit out to the main menu.

4. Select the Small Spot Calibration icon from the Advanced Menu 

Parts_and_Accessories.htm#Small Spot QC Calibration Sample
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Figure 134. The Small Spot Menu Path

5. From the Calibrate Spot Screen, select the Yes Button. 
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Figure 135. Selecting the Yes Button

6. You will then receive a prompt asking if you want to reset the spot to the center position. 
It is recommended that you do this upon initial calibration. Saying "Yes" changes the 
position of the spot circle on the first calibration iteration to the calculated center. Saying 
"No" leaves this spot where it currently is for the first calibration iteration.

Figure 136. Centering the Spot



18 
Camera and Small Spot Video

604 Niton XL3 Analyzer User’s Guide Thermo Scientific

7. You will then see the small spot target on your instrument. Place the small spot calibration 
standard on the nose of analyzer so that the copper is in the center of the circle. If the copper 
is not properly centered for each of the five calibration shots, your calibration will not be 
valid. 

Figure 137. Centering the Spot

8. After centering the standard, take a reading for 30 seconds. After the reading time ends, you 
will notice that the spot has changed orientation. Please follow the previous step and re-center 
your standard. You will be asked to do this a total of five times.

9. You will then receive a prompt informing you of the detected X and Y position of the spot. 
If you made an error along the way, please select “No” and begin again. If you would like to 
accept the calibration, please select “Yes”.
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Figure 138. Spot Coordinates

10. Position the Small Spot Reference Sample over the calibrated spot and take a 
measurement. You should see >95% Cu in Metals or Electronics Alloy mode.

Note  The 180-607 standard is unique and should only be used for spot calibration. 

Figure 139. Positioning the Small Spot Reference Sample
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Figure 140. Small Spot Check Analysis
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Reference Documents

Glossary of Terms

(including acronyms, abbreviations and symbols)

Word/Phrase Definition

µA micro-amp - one millionth of an amp, 10-6A

µg microgram -one millionth of a gram, 10-6g

µg/ft2 micrograms per square foot

µm micrometer - one millionth of a meter, 10-6 M, also called a micron

% percent

A Ampere (often shortened to Amp), an SI base unit of electric 

current, equal to 6.242 x 1018 electrons / second

Accuracy the closeness of a measured value to the actual (true) value

ADC analog to digital converter

Ag silver (element 47) a precious metal known since antiquity

AIHA American Industrial Hygiene Association (US)

Al aluminum (US/Canada) or aluminium (ROW), (element 13), most 

abundant metal in the earth’s crust, first produced in 1825, it is so 

reactive it mostly occurs as the hydroxide in nature

ALARA As Low As Reasonably Achievable, a method to minimize 

radiation exposure based on the principles of time, distance and 

shielding 

See Radiation and General Safety

Alloy a partial or complete solid solution of two or more elements in a 

metallic matrix, e.g., steel (Fe + C), brass (Cu + Zn), bronze (Cu + 

Sn)

Alloy grade the name or designation of an alloy with a particular composition, 

e.g., C377, Forging brass (Cu 58.0-62.0, Fe 0-0.3, Pb 1.5-2.5, Zn 

35.2-40.5)

Alloy mode see metals
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Alpha particle a helium nucleus, 42He2+, a highly ionizing particle radiation

Am americium (element 95), a synthetic radioactive element first 

manufactured in 1944

241Am a specific radioisotope of americium, commonly pronounced as 

americium-241, used in some XRF instruments to provide the 

exciting radiation

Anodizing an electrolytic passivation process used to increase the thickness of 

the natural oxide layer on the surface of a metal

As arsenic (element 33), a metalloid known since antiquity, a poison

ASTM American Society for Testing and Materials

ASIC Application Specific Integrated Circuit (pronounced a-sick)- a 

custom designed chip

Au gold (element 79), a precious metal known since antiquity, 

chemical symbol from the Latin aurum

Audio settings user defined times for beep - See Setting up Audio Cues

Avg back average back (abbreviation) See  Averaging Results

Avg forward average forward (abbreviation) See Averaging Results

Ba barium (element 56), an alkaline earth and heavy metal, first 

identified 1774

Backscatter when x-rays interact with low density materials (e.g., polyethylene) 

they can be scattered back towards the instrument and the operator

Backscatter 

characteristics

the expected x-ray scatter from a particular sample type

Backscatter shield a device clipped onto the instrument manufactured from a dense 

material to absorb any backscattered radiation 

See Backscatter Shield

Bal balance of elements (abbreviation), displayed in mining mode to 

account for light elements that are not detected by the instrument, 

e.g., N, O, Na

Barcode pencil a device that reads a barcode and inputs the data electronically

Beep a single tone made by a computer or machine, the sound made by 

the instrument at specific times

Beta particles high energy electrons or positrons, �- and �+ -an ionizing radiation
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Bi bismuth (element 83), a metal known since ancient times, its’ 

liquid phase is denser than its’ solid phase

Binder a material not containing any elements of interest that is used to 

hold together a sample in the form of a briquette, e.g., wax, 

cellulose or boric acid

Bq Becquerel (abbreviation), an SI unit of activity, equal to 1 

disintegration per second

Br bromine (element 35), a halogen that is liquid at room temperature, 

used as a fire retardant

Brownfield abandoned or underused industrial or commercial facility available 

for re-use, they may require environmental decontamination before 

redevelopment

Bulk analysis the mode to select for analysis of bulk samples such as soil, mining 

and plastics

C Celsius, a temperature scale, °C, also called centigrade

C carbon (element 6), a common non-metal not detectable with the 

handheld XRF instrument

Ca calcium (element 20), an alkaline earth metal, fifth most abundant 

element in the earth’s crust

Calcination a heat treatment process often occurring in a kiln which induces 

thermal decomposition. Ores may be treated in this way to give 

more usable materials, such as the calcination of limestone 

(calcium carbonate) to produce lime (calcium oxide) in the 

manufacture of cement

Calibrate to undergo calibration

Calibration a  process whereby a signal is compared with a known quantity and 

a calculation is performed to generate values that are recognizable 

to the end user, e.g., ppm or %

Calibration factors a multiplication factor that adjusts a reading to improve accuracy - 

See Adjusting Analyzer Calibration

Cb columbium, see Nb (niobium)

Cd cadmium (element 48), transition metal discovered 1817, a poison

109Cd a specific radioisotope of cadmium, pronounced as cadmium-109, 

used in some XRF instruments to provide the exciting radiation
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Ce cerium (element 58), a lanthanoid metal, most abundant of the rare 

earth elements

CFR code of federal regulations (US)

Cl chlorine (element 17), a halogen that is a gas at room temperature, 

a common disinfectant

cm centimeter

Co cobalt (element 27), a transition metal discovered in 1735, known 

for its’ characteristic blue color (cobalt blue) in paints and 

pigments

Coating a thin covering over a substrate, usually to improve the surface 

properties such as corrosion resistance. Examples of coatings 

include anodized surfaces, electrochemical plating, chromate and 

phosphate coatings as well as paint and enamels

COD Class of Device

Columbium see Nb in glossary

COM port communications port (abbreviation)

Compton scatter the scattering of x-rays at lower energy than the incoming radiation

Concentration level the amount of an element present, shown in either % or ppm 

Confidence a value indicating an estimation of probable values for a reading

Coning and 

quartering

a process of reducing a sample size of a powder without creating a 

systematic bias - See Soil Analysis

Consumer goods  

Core sample a solid cylindrical rod of material representing changes in layers 

through depth. Both rock and soil cores may be analyzed. Rock 

cores can be hundreds of metres long and are used for exploration 

and mine mapping

Count rate the number of signals (counts) per a time interval, e.g. counts per 

second

cps counts per second

CPSC Consumer Product Safety Commission (US)

CPU central processing unit
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CRM certified reference material, a well-characterised material with a 

certificate which documents chemical concentrations with 

uncertainties generally obtained through multiple analyses. They 

may be used for calibration, QC or QA of an instrument

Crucible a heat resistant container for heating samples

Cs caesium (cesium US), element 55, discovered 1860, from the Latin 

caesius meaning blue-grey, first element discovered by spectrum 

analysis

CSV comma separated value

Cu copper (element 29), transition metal known since ancient times

Deep dose sometimes referred to as “deep dose equivalent”, the dose 

equivalent at a tissue depth of 1cm and applies to external whole 

body exposure (NRC) - See Radiation and General Safety

Dessicator a sealable container usually containing a desiccant where moisture 

sensitive materials may be kept to prevent or minimize hygroscopic 

behaviour

Diagnostics information displayed regarding the internal characteristics of the 

instrument

Display Units elemental concentration units displayed on instrument, either % or 

ppm

Dosimeter a device for monitoring radiation dose

DOT Department of Transportation (US)

DSP digital signal processor, a device that shapes and produces the 

spectrum in the XRF instrument

DQO data quality objective

Dy dysprosium (element 66), a lanthanoid metal and rare earth 

element, first identified 1886, from the Greek dysprositos meaning 

hard to get

Easy Trigger 

method

a way to run the instrument by placing it against the sample and 

pulling the trigger just once to activate the x-rays, the trigger does 

not need to be held down once measurement has started

EDXRF energy dispersive x-ray fluorescence

Element a pure chemical substance composed of only one type of atoms, 

e.g. iron (Fe), copper (Cu), gold (Au)
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Elemental relating to an element

Elemental limits of 

detection

See LOD

Element 

specification screen

a screen in the library editor which displays elements and valid 

ranges for named alloys

ELPAT Environmental lead proficiency analytical testing

ELV end of life vehicles directive (EU), adopted September 2000 to 

encourage vehicle recycling and to make it more environmentally 

friendly

EMR electromagnetic radiation, the generic name which covers all 

self-propagating waves in a vacuum or in matter. It is classified 

into types based on the energy of these waves, so from least 

energetic to most energetic we have: radio waves, microwaves, 

infra-red radiation, visible light, ultraviolet radiation, x-rays and 

gamma rays

Energy Cal energy calibration (abbreviation), a line displayed on the 

specification screen indicating the last date when an energy 

calibration (detector calibration) was performed on the instrument

EPA US Environmental Protection Agency

Er erbium (element 68) a lanthanoid metal and rare earth element, 

discovered 1843

ESD Electrostatic Discharge, a sudden and momentary electric current 

that flows between two objects at different electrical potential

Eu europium (element 63) a lanthanoid metal and most reactive of the 

rare earth elements, discovered 1890

eV electron volts

Ex-situ Latin phrase meaning off-site. Often a soil sample is removed from 

its’ original location, prepared (dried, ground, sieved and cupped) 

and then analyzed ex-situ

FAA Federal Aviation Administration, part of the USDOT, regulates 

civil aviation in the USA

FAC Flow-assisted corrosion, a process in which steel pipe is degraded 

due to flowing liquids or liquid-steam mixtures
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Factory QC A process of running certified reference materials to check the 

analytical integrity of the instrument at the place of manufacture 

before shipment. As shown on the instrument specifications screen, 

this defines the actual date of this process

Fe iron (element 26), transition metal known since ancient times

55Fe a specific radioisotope of iron, pronounced as iron-55, used in 

some XRF instruments to provide the exciting radiation

Ferrule a small metal object used for fastening

Filter a mechanism built into the instrument that allows the x-ray energy 

to be modified to preferentially enhance the analysis of certain 

elements in certain matrices - See Adjusting the Element Range

Filter a thin support mechanism for sample collection, such as a 37mm 

air filter

Flange an internal or external rib which acts as a guide

Flux a material which promotes glass formation

Fluxer a device for rapidly heating a crucible containing a sample and a 

flux material, melting and mixing the sample and flux

Fingerprint ID a method of comparing an unknown with a known sample

FP fundamental parameters (a calibration technique based on the 

physics of the instrument and sample)

FPGA Field Programmable Gate Array, a type of ASIC chip used in the 

instrument. As shown on the instrument specifications screen, this 

defines the version number

FPXRF field portable x-ray fluorescence

FWHM full width half maximum, a way of determining resolution by 

measuring the width of a peak at half its’ height

g gram, one thousandth of a kg, i.e. 10-4kg

Ga gallium (element 31), a metal discovered in 1875, it melts slightly 

above room temperature

Galvanization A process that is used to coat iron or steel with zinc, which acts as a 

protective coating to the underlying metal. May be done either as a 

hot dip (thick coating) or by electroplating (electro galvanization) 

which provides a thinner coating
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Gamma ray a form of electromagnetic radiation of high energy produced by 

sub-atomic particle interactions, i.e. produced within the nucleus of 

an atom

GB gigabyte

General metal a mode in which to read most common alloy materials

GOLDD Geometrically Optimized Large area Drift Detector (acronym)

Grade control the measurement and adjustment of mined materials to keep the 

elements of interest with a specific concentration range

Grade Library a listing of elements describing elemental ranges for specific alloy 

grades

Greenfield 

sampling

A preliminary mineral survey of a plot of land

Grinding mill a mechanical device for mixing and grinding samples into a more 

homogeneous material with a finer particle size

Gy gray, a unit of absorbed dose equal to 1 joule of deposited energy 

per kilogram of tissue 

See Radiation and General Safety

Halogen the generic name for a group of non-metal elements from Group 17 

(formerly VII, VIIA) of the periodic table, comprising F, Cl, Br, I 

and At

He purge helium purge (abbreviation)

Hg mercury (element 80), a heavy transition metal that in its’ pure 

form is a liquid at room temperature and pressure. Also known as 

quicksilver.

High Range the Range used in the instrument to preferentially fluoresce many 

of the heavy elements (Z = 47-56)

Horizontal slider an on-screen tool allowing a cursor or other device to be moved left 

to right

IATA International Air Transport Association, an international group of 

airlines formed to represent, lead and serve the airline industry. It 

publishes the IATA Dangerous Goods manual which covers the 

shipping of hazardous materials (including radioactive materials)

ICRP International Commission on Radiological Protection, an advisory 

board which provides recommendations and guidance on radiation 

protection
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IDL instrument detection limit, this is the best possible (i.e. lowest 

value) LOD that can be obtained, typically from pure matrices

In indium (element 49), a rare metal first isolated in 1864, greatly 

used in the electronics industry, especially LCDs

Infilling taking readings at a higher rate to more closely define the elemental 

composition of an area of interest, an exploration technique

In situ Latin phrase meaning in place. The XRF instrument may be used 

directly on a sample without moving or preparing it, for example 

taking a soil reading in situ.

Ir iridium (element 77), a transition metal discovered in 1803, a 

PGM, the second densest element and most corrosion resistant 

metal currently known

keV kilo electron volts

kg kilogram, an SI base unit of mass, approx equal to the mass of 1 

liter of water – currently being revised by the SI committee

LCD liquid crystal display

Library see Grade Library

Light Range the filter used in the instrument to preferentially fluoresce light 

elements where Z < 17

Live spectrum a real time spectrum of the sample currently undergoing analysis

LOD limit of detection - See Statistical Aspects of Spectrometry

LOQ limit of quantization - See Statistical Aspects of Spectrometry

Low Range the filter used in the instrument to preferentially fluoresce elements 

of Z = 19-24

MAC media access control, an address mechanism in the CPU

Main Range the filter used in the instrument to preferentially fluoresce the entire 

first row and some of the second row transition elements

Main menu the main screen on the instrument through which all functions are 

available

Match / no match 

line

a line displayed on the analysis screen displaying an alloy match if 

found

Match fingerprint an option on the instrument to compare spectral data from known 

sample to an unknown sample
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Max time maximum time (abbreviation), instrument may be programmed to 

run no longer than a certain time - See Start/Stop Setup

MDL method detection limit, the limit of detection for a particular 

method (this includes taking into account sample matrix and 

preparation as well as instrument and filters used, and integration 

time)

Metals the mode to select to allow analysis of metal samples such as 

alloys, precious metals and alloy coatings

mg/kg milligrams per kilogram (commonly called ppm)

Mining the process of removing material from the ground to extract the raw 

materials (ores or minerals) required, may be open pit or 

underground

Mn manganese (element 25), a transition metal known since ancient 

times but not isolated until 1774

Mo molybdenum (element 42), a transition metal discovered 1778

Mortar a smooth bowl used for grinding samples (with a pestle)

mREM millirem

MSv milli-Sievert

Muffle furnace a laboratory oven or kiln for heating and melting samples at a high 

temperature

Multi-filter an instrument containing 2 or more filters which can switch during 

the without any prompting by the user to preferentially fluoresce 

specific elements (to give optimum results)

Mylar a polyethylene terephthalate (PET) polyester material with high 

strength and chemical stability, used in the manufacture of thin film 

windows for soil cups (Part number 187-462, 6µ gauge, 2.5” 

diameter). Not suitable for light elements (Z<19)

N nitrogen (element 7), a gas not detectable with the handheld XRF 

instrument

Na sodium (element 11), an alkali metal discovered 1806, from the 

Latin Natrium, not detectable with the handheld XRF instrument

Nb niobium (element 41), transition metal discovered 1801. Also 

known as columbium.

NCRP National Council on Radiation Protection and Measurements (US)
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NDT non-destructive test

NDT Niton Data Transfer, a software package provided with the 

instrument to assist in the interface between the unit and a PC

NDTr Niton Data Transfer Remote control, a software package that 

allows the instrument to be run through a PC

Ni nickel (element 28), a transition metal first isolated in 1751, a 

ferromagnetic element

NIOSH National Institute for Occupational Safety and Health, the US 

federal agency responsible for monitoring and recommending 

preventative measures for work related injuries and illnesses

NIST National Institute of Standards and Technology, a non-regulatory 

agency within the  US Department of Commerce, previously called 

NBS (National Bureau of Standards), a supplier of certified 

reference materials

NRC Nuclear Regulatory Commission, a US government agency 

overseeing the licensing and material safety of radioactive 

materials

O oxygen (element 8), a common, highly reactive non-metal, the 

diatomic molecule O2 forms 20.9% of the earth’s atmosphere, not 

detectable with FP-XRF

Os osmium (element 76), a transition metal, also a PGM, discovered in 

1803, the densest natural element

Oxidation the process of gaining oxygen (or losing hydrogen) by an atom (or 

molecule) to form an oxide

Oxide a chemical compound containing at least 1 oxygen atom and an 

atom of another element, e.g. Al2O3, aluminum oxide commonly 

known as alumina and Fe2O3, iron (III) oxide commonly known as 

ferric oxide or rust

P phosphorus (element 15), a highly reactive non-metal, discovered 

1669, named from the Greek for light bearer

Pb lead (element 82), a heavy metal known since ancient times, a 

potent neurotoxin, chemical symbol from the Latin Plumbum (the 

same root word that we now get plumbing, lead was used to make 

pipes to carry water and waste

PC personal computer
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PCB polychlorinated biphenyls, a class of organic compounds with 1 to 

10 Cl atoms arranged on a double benzene ring with the generic 

formula C12H 10-xClx. A persistent organic pollutant

PCB printed circuit board, typically a flat sheet which provides 

mechanical support and electrical connections to multiple 

components

PCS performance characteristic sheet

Pd palladium (element 46), a transition metal, also a PGM, discovered 

in 1803, an expensive precious metal

PE polyethylene (US), polythene (UK), a common thermoplastic 

consisting of long chains of the ethane monomer - (C2H4)n-

Pearson correlation 

coefficient

see r

Periodic table an organized table displaying the chemical elements, generally 

credited to Mendeleev

Pestle a heavy rod with rounded end used for pounding and grinding 

samples in a mortar

PGM Platinum group metal, a group of 6 precious metals all having 

similar chemical and physical properties, namely Ru, Rh, Pd, Os, Ir 

and Pt

Pistol grip the part of the instrument to hold with your hand, the handle

Placer deposits an accumulation of valuable minerals formed by deposition of 

denser materials in a trap site, e.g. inside bend of a river where gold 

can accumulate. (Pronounced plasser)

Plated surface a metallic coating on a conductive surface providing a purpose, 

such as corrosion resistance, decorative value, increase hardness or 

solderability

Polypropylene a thermoplastic polymer with reasonable strength and chemical 

resistance, used in the manufacture of thin film windows for soil 

cups (Part number 187-461, 4µ gauge, 2.5” diameter). Allows 

higher transmission of low energy x-rays, but is not as strong as, 

Mylar film.

PMI Positive Material Identification
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ppb parts per billion, a unit of measure denoting relative proportions, 

and a dimensionless quantity as there are no associated units of 

measurement. It is not a SI term.

ppm parts per million, a unit of measure denoting relative proportions, 

and a dimensionless quantity as there are no associated units of 

measurement. It is not a SI term.

Preamp short version of preamplifier, an electronic amplifier used to 

prepare an electronic signal for further processing. In the XRF 

instrument, the preamp amplifies and differentiates the signal.

Precision a measure of how close multiple readings of the same sample are to 

one another, also known as repeatability

Primary radiation x-ray radiation that is emitted directly from the instrument - See 

Primary Radiation

Pt platinum (element 78), a transition and noble metal, also a 

PGM,  an expensive precious metal

PVC polyvinyl chloride, a common thermoplastic consisting of long 

chains of the vinyl chloride monomer -(CH2CHCl)n-

Q a quality factor, see RBE

QA quality assurance

QAPP quality assurance project plan

QC quality control

Quicksilver see Hg in glossary

r Pearson correlation coefficient, a measure of the correlation 

between two variables used in statistics, with a value between -1 

and 1 

See Statistical Aspects of Spectrometry

r2 coefficient of determination (pronounced r squared) which gives an 

indication of the goodness of fit 

See Statistical Aspects of Spectrometry

rad a unit of absorbed radiation equal to 0.01 joules of energy per kg of 

tissue. Now replaced with the SI unit gray, where 100 rad = 1 gray

Rb rubidium (element 37), an alkali metal discovered 1861, from the 

Latin rubidus meaning deep red, which is the color it imparts to a 

flame



19 
Reference Documents

620 Niton XL3 Analyzer User’s Guide Thermo Scientific

RBE relative biological dose, a quality factor often denoted by Q used to 

assess the tissue damage caused by various types of radiation. 

Alpha particles have a Q = 20, while beta particles, x-rays and 

gamma rays are all the same with Q = 1

RCRA Resource Conservation and Recovery Act, a federal law in the 

USA  which governs the disposal of waste (solid and hazardous)

REE rare earth element, a collection of 17 elements, Sc (21), Y (39) and 

the lanthanoids (57-71)

rem Röntgen equivalent in man, an older term for measuring a unit of 

radiation dose based on the absorbed radiation and the biological 

efficiency of said radiation. Generally now replaced with Sv

Rh rhodium (element 45), a transition metal, also a PGM, discovered 

in 1803, an expensive precious metal

RoHS restriction of hazardous substances, a European directive on the 

use of hazardous substances in electrical and electronic equipment 

2002/95/EC. It specifically restricts the use of Pb, Hg, Cd, Cr6+, 

PBB (polybrominated biphenyls) and PBDE (polybrominated 

diphenyl ether)

RMS root mean square (sometimes called the quadratic mean)

RPD relative percent difference - See Statistical Aspects of 

Spectrometry

RSD relative standard deviation - See Statistical Aspects of 

Spectrometry

RSO radiation safety officer

Ru ruthenium (element 44), a transition metal, also a PGM, discovered 

in 1827, an expensive precious metal

S sulphur (or sulfur) (element 16), a non-metal known since ancient 

times, sometimes called brimstone

Sample the material to be analyzed

Sample cup a device to contain a powdered (loose) or liquid sample for 

presentation to the instrument

SAP sampling and analysis plan

Sb antimony (element 51), a metalloid known since ancient times, a 

poison similar to arsenic
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sd standard deviation - See Statistical Aspects of Spectrometry

Se selenium (element 34), a non-metal discovered in 1817

Secondary 

radiation

radiation that is scattered by a sample in multiple directions, 

typically at lower energy that the exciting primary radiation 

See Secondary Radiation

Shallow dose sometimes referred to as “shallow dose equivalent”, applies to the 

external exposure of the skin or an extremity, means dose 

equivalent at a tissue depth of 0.007cm averaged over an area of 1 

cm2 (NRC) 

See Radiation and General Safety

Shutter a device attached to the tube housing assembly which can totally 

intercept the useful beam (NRC)

Si silicon (element 14), a metalloid first prepared in 1811, is the 

second most abundant element on earth

SI Le Systèm International d’Unités (French) or International System 

of Units, the internationally recognized metric system and the 

world’s most widely used system of measurement.

Sigma the standard deviation of a population in statistics, commonly 

written as � (lower case Greek alphabet)

Silica Common name for silicon (IV) oxide, SiO2

Slope a multiplication factor to adjust the slope (angle) of a calibration 

curve (line). Default is 1 (leaving the slope as it is), a number less 

than 1 reduces the reported value, a number larger than 1 increases 

the reported concentration

Sludge a mixture of solids suspended in a liquid

Small spot on instruments configured with small spot capability, the analysis 

area of the sample can be reduced to allow more accurate analysis 

of tiny parts

SOP standard operating procedure

SpectraView a way of viewing on the instrument screen the spectrum of a 

previously analysed sample

Spectrometer a generic name for an analytical device which separates and reads 

any measurable properties in the electromagnetic spectrum

Specs specifications (abbreviation)
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Sr strontium (element 38), an alkaline earth metal, discovered in 1798, 

15th most abundant element on earth

SRM standard reference material, a certified reference material (CRM)

Standards 

(samples)

materials containing known concentrations of specific elements 

used to check the performance of an instrument

Standardizing a way of calibrating an instrument, such as coating thickness

Stylus an input tool for a graphic (touch) screen

Substrate the base material of a sample

Sv sievert, the SI derived unit of dose equivalent, describing the 

biological effects of radiation. This replaced rem, where 1 Sv = 100 

rem

SW version Software version (abbreviation). As shown on the instrument 

specifications screen, this defines the version number

Ta tantalum (element 73), transition metal discovered 1802

Tb terbium (element 65), a lanthanide metal and REE, discovered in 

1843

Tc technetium (element 43), the lightest chemical element with no 

stable isotope, not naturally occurring on earth, a synthetic 

transition metal first reported manufactured in 1925, but discovery 

not confirmed until 1937

Te tellurium (element 52), a rare metalloid discovered in 1782

Tetraethyl lead an organometallic compound (CH3CH2)4Pb, the antiknock agent in 

leaded gasoline (petrol), now mostly banned for use in modern 

cars.

Threshold a user defined minimum and / or maximum concentration value to 

determine pass or fail for a sample

Ti titanium (element 22), a first row transition metal, discovered 1791

Trigger only 

method

a way to run the instrument whereby the x-rays are activated by 

pulling the trigger only - See Methods of Operation

Trigger and 

proximity sensor 

method

a way to run the instrument whereby the x-rays are activated only 

by pulling the trigger and engaging the proximity button 

simultaneously - See Methods of Operation
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Trigger and 

Interlock method

a way to run the instrument whereby the x-rays are activated only 

by pulling the trigger and pressing the rear interlock button 

simultaneously - See Methods of Operation

Trigger-Interlock 

and Proximity 

sensor method

a way to run the instrument whereby the x-rays are activated only 

by pulling the trigger, engaging the proximity button and pressing 

the rear interlock button simultaneously - See Methods of 

Operation

TSP total suspended particulate

U uranium (element 92), heaviest of the naturally occurring elements, 

discovered 1789

V vanadium (element 23), transition metal discovered 1801

V volt

Vertical Slider an on-screen tool allowing a cursor or other device to be moved up 

or down

Virtual keyboard a software and hardware interface that allows users to enter 

alpha-numeric characters without the use of a physical keyboard. 

The XRF unit has a virtual keyboard employing a touch screen 

with sensing areas representing each key.

Volatile substance a material that is easy to vaporize

W tungsten (element 74), transition metal discovered 1783, heaviest 

metal with a known biological role. Also known as wolfram

W watt, an SI unit of power, equal to 1 joule per second (energy 

conversion) , it may also be defined in terms of mechanical energy 

(object moves at one meter per second against a force of one 

Newton. 1W = 1J s-1 = 1 kg m2 s-3 = 1 N m s-1

WEEE waste electrical and electronic equipment, an EU directive 

2002/96/EC setting recycling and recovery rates for electrical 

goods to reduce toxic e-waste

x-ray a form of electromagnetic radiation, with energy in the range 

120eV to 120KeV (which is equal to a wavelength range of 10 to 

0.01nm), also known as Röntgen radiation

XRF X-ray fluorescence, an analytical chemistry technique

Z atomic number, e.g. Fe = 26 and Pb = 82, also sometimes called the 

proton number as it is equal to the number of protons in the nucleus 

of an atom
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Technical Specifications
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XRF Theory

Brief Theory of XRF

When x-rays interact with matter, they cause other x-rays to be emitted that are characteristic 
of the elements present in the material being irradiated.

The reason this characteristic radiation is produced is caused by the very nature of atoms 
themselves. An atom can be considered as the smallest building block that can still be regarded 
as an element. It consists of a nucleus (the center part of an atom) made from positively 
charged  protons and electrically neutral neutrons, and a surrounding electron cloud 
containing the same number of electrons as the nucleus contains protons, so an atom is a 
neutral particle. The number of protons in an atom defines the element itself and the number 
is referred to as the atomic number (sometimes also called the Z number). For example, a 
calcium atom has 20 protons and a lead atom has 82 protons. The electrons surrounding the 
nucleus are located in quantized orbitals of varying energy levels, referred to in XRF as 
“shells”. A very simplified way of visualizing this is the “sun and planets” concept, where the 
nucleus (sun) is surrounded by orbiting electrons (planets).  These “shells” are unique to each 
element and are identified by the letter series K, L, M, etc., where K is the closest to the 
nucleus, L is the second closest to the nucleus and so on. These letters may also be referred to 
as the principal quantum number n, where K is n=1, L is n=2 and M is n=3.

When x-rays enter an atom, there is a chance that they will interact with the electrons 
surrounding the nucleus and supply enough energy to cause the ejection (loss) of an inner 
electron. This process is called ionization as the atom becomes a positively charged ion, which 
is an unstable particle as it does not its’ full complement of electrons. This vacant inner shell is 
filled by an electron from one of the outer shells in a cascade process. As the electrons move 
from one shell to another, they release their excess energy in the form of the characteristic 
x-rays detected by the instrument.  

Figure 1-1 shows a diagrammatic representation of the hand-held XRF instrument. A 
miniature x-ray tube provides the source (primary radiation) which is used to excite the atoms 
in the sample. The characteristic fluorescent x-rays of the elements present in the sample enter 
the detector which registers the individual x-ray events and sends electronic impulses to the 

Zn zinc (element 30), transition metal known since ancient times

Zr zirconium (element 40), transition metal discovered 1789
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preamp. The preamp amplifies and differentiates the signal and sends it to the digital signal 
processor (DSP) which shapes and produces the spectrum. The CPU is used to store the 
algorithms to calculate the concentration of the elements present, and the final results are 
stored and displayed. 

Figure 1.    XRF Analysis Diagram 
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Statistical aspects of spectrometry

The mere mention of the word “statistics” can induce fear into the hearts of many people, 
however without a basic understanding of the science of statistics; the results from your 
instrument may be meaningless. Statistics is simply a mathematical way of collecting data, and 
then analyzing and interpreting it. This brief guide will take you through all the basics of 
statistics that will enable you to get the best from your instrument, with many worked 
examples and diagrams to explain the concepts.

Basic Terminology

In statistics, words have very particular meanings, which in the everyday world may seem to 
be very similar. However, describing an issue using the correct terminology may often result 
more rapidly in a solution to a problem. The following lists the most common terminology 
and describes the meaning of each one.

Accuracy can be defined as how close a reading is to the true value, and may be indicated using 
relative error, percent recovery, correlation coefficients or coefficient of determination.

Bell curve represents a normal or Gaussian distribution and describes that shape of the graph 
obtained, with a peak at the mean. These graphs vary in width indicating the size of sigma.

Bias may be random or systematic, and simply means that results are not as expected. A 
random error is caused by natural variations, and may be reduced by taking multiple readings 
and averaging. A systematic bias is generally when all readings are either higher or lower than 
expected, and average away from the expected (or true) value. This may be caused by a 
calibration issue, a matrix effect or incorrect assumption of the expected value.  

Coefficient of determination (r2) is the square of the correlation coefficient, with values 
between 0 and +1, and gives some indication of the goodness of fit. 

Correlation coefficient (r) is a determination of the strength of a relationship between 2 
variables, with a value of between -1 and +1 inclusive. +1 represents a perfect positive 
correlation between the variables, -1 represents a perfect negative correlation between 
variables, and zero (0) represents no correlation between variables.

Certified reference material (CRM) is a standard material that has been certified for certain 
elements  with a given range of uncertainty. Typically analysis has been performed by multiple 
methods and multiple laboratories.

Empirical rule or 3-sigma rule states that when considering a distribution that is normal 
(Gaussian or bell curve), 68% of the values are within 1 standard deviation, 95% are within 2 
standard deviations and 99.7% are within 3 standard deviations.

IDL and MDL are instrument detection limit and method detection limit respectively. IDL is 
the best possible limit of detection, calculated from a “clean” sample, i.e. one with no 
interferences.  A method detection limit is the limit of detection for a specific sample type 
(matrix) using particular instrument conditions. MDLs are typically worse than IDLs by a 
factor of 2 to 5 times.
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Limit of detection (LOD) is the smallest concentration of an element that can be detected 
with reasonable certainty. It is generally regarded as indicating whether an element is present 
or not, and does not imply that a value obtained is accurate. LOD is usually calculated using 3 
sigma.

Limit of Quantitation (LOQ) is the concentration at which a quantitative measurement can 
be made, i.e. there is a degree of certainty about the result. LOQ is usually calculated using 10 
sigma.

Mean or average is the average of a series of readings from the same sample. It is calculated by 
taking the sum of all the individual values and dividing by the total number of the analyses 
performed.

Percent recovery is a measure of how close a read value is to the expected (true) value of the 
sample. It is calculated by dividing the obtained value by the true value and multiplying by 
100. 100% would mean that the reading and the true value agree with one another. 85% 
would mean that the sample is reading 15% lower than expected, and 122% would mean that 
the sample is reading 22% higher than expected.

Precision can be defined as the repeatability of the results, in other words how close a series of 
analyses on the same sample are to one another. It may be measured in terms of sigma 
(standard deviation) or relative standard deviation.

Relative percent difference (RPD) is a numerical comparison of two experimental values. It is 
calculated by taking one value away from the other, dividing by the average of the 2 values and 
multiplying by 100.

Relative error is a measure of the difference between the read and the expected (true) value of 
a sample. 

Repeatability is a measure of the variation in results obtained by running the same sample by 
the same person on the same instrument under identical conditions, generally over a short 
time period.

Reproducibility is a measure of the variation in results obtained by different people running 
different instruments. Reproducibility is generally worse that repeatability in absolute terms.

Standard Deviation or sigma is a measure of the variability within a sample set. The smaller 
the value, the closer all the results are to one another. It is calculated by taking a data set and 
first calculating the mean. Then the mean is subtracted from each individual reading and the 
calculated value is squared (this gets rid of any negative numbers). Then these calculated 
values are averaged and the square root is calculated. This square root is sigma, or one 
standard deviation. It may also be calculated easily in spreadsheets such as Excel, in Excel use 
“=stdev(highlight cells of interest)”.



19 
Reference Documents

628 Niton XL3 Analyzer User’s Guide Thermo Scientific

Relative Standard Deviation (RSD) is another way of looking at standard deviation, by 
relating it to the read value. It is calculated by taking the calculated standard deviation and 
dividing by the average (mean) value and multiplying by 100. It relates directly to the 
precision of the readings. For example, a RSD of 1% or less tells us that the data set is very 
similar to each other, and that we are well above LOD. A RSD of 33% or higher tells us that 
we are at or below the LOD.  

True value is the actual or certified value of a sample.

Comparing accuracy and precision

This is often done visually using targets to demonstrate the differences between them. If we 
assume we have 5 arrows, and we are aiming at the red bull (center of target), then this 
diagram (Target 1) shows all 5 arrows in the center and so we have good accuracy and they are 
nicely grouped, so we also have good precision, this is generally what we aim for in terms of 
analysis, the correct value and all the readings are close to one another.

Figure 2. Target 1:

�
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Target 2 shows that the arrows are all very close to one another, so we have good precision, but 
we are not close to the center of the target, so we do not have good accuracy, in fact we have a 
bias. This may be caused by a number of different reasons. For example, we may have a poor 
calibration, we may have the wrong value for the “true” value (due to a typographical error for 
example), or we may have a matrix effect for which we have not accounted.

Figure 3. Target 2:

Figure 4. Target 3:
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Figure 5. Target 4:
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Target 3 shows good accuracy (if we average the numbers, we would end up in the middle), 
but poor precision. This is typical of when we are reading samples at or close to detection 
limit, if we average enough numbers we will get close to the correct value, but there is a large 
amount of scatter about that point.

Target 4 is neither accurate nor precise. This suggests we have a very big problem, there may 
be an issue with the instrument itself, or this could reflect bad (or no) sample preparation.

Example 1

An ore CRM is read 150 times. It contains 12.29% Ca, and gives us the readings in ppm as 
shown in Table 1.  The average for these 150 readings is 128226.6ppm (i.e. 12.82%) and the 
standard deviation is 2191.5 (or 0.22%).

If we split them into groups, we see that we get 1 at 12.2%, 2 at 12.3%, 7 at 12.4% etc., and 
we see the typical bell curve forming in Diagram 1.

Based on this data, we would expect the following:

68% of all readings should be within 1-sigma. This is the average ± 1 standard deviation, or in 
this example 12.82 ± 0.22, i.e., 12.60 – 13.04%, and we see that we have 99 readings in this 
range, or 66%, pretty close to what we expect
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95% of all readings should be between 12.82 ± 0.44, or 12.38 – 13.26, and we have 146 
readings or 97% in this range, again what we would expect.

The RSD is calculated as 0.22 / 12.82 *100 = 1.71%, which indicates that the readings are 
well above the LOD, and we can consider them quantitative.

The percent recovery is calculated as read/certified *100, or 12.82/12.29*100 = 104.3%, 
which is an excellent recovery. Anything between 95 and 105% is excellent (±5%), between 
90-110% (±10%) is good, and a ±20% recovery is reasonable.

This data set demonstrates the information shown in Target 1, as we have good accuracy and 
precision.

Example 2

The same ore CRM also contains 28000ppm Cu, and gives us readings as shown in Table 2. 
The average for these readings is 33328ppm, and the standard deviation is 756.

The RSD is 756/28000 *100 = 2.7%, indicating that the readings are well above LOD, and 
therefore should be considered quantitative. However the percent recovery 
(33328/28000*100) is 119%, i.e. we are reading on average 19% higher than the certified 
value.

This data set demonstrates the information shown in Target 2, we have good precision and 
poor accuracy.  Another way of considering this data is to plot the points and see where the 
certified value lies in relation to the readings, as can be seen in Chart 2.
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Table 1. Table 1

Figure 6. Diagram 1

Ca read Ca read Ca read Ca read Ca read Ca read Ca read Ca read

127701.7 126216.7 128323.6 126322.9 132187.6 126242.7 128259.1 128367.7

129661.0 128028.6 130710.2 123288.2 126605.9 130108.8 126356.0 129188.5

127413.7 126873.4 128468.8 124019.3 129879.8 130062.5 129645.6 129528.2

130101.6 127647.0 126533.3 127876.5 125222.5 128412.1 130426.1 130699.6

128207.4 129473.2 128761.3 125954.4 130795.1 127659.9 125046.3 128550.9

128943.4 122043.0 127487.5 130581.2 127958.8 131951.2 128050.4 132956.9

127874.1 129722.2 125640.7 126991.1 127327.5 128798.6 132187.3 131686.0

124963.7 128726.3 129718.2 128342.1 125764.9 128530.4 130459.2 126944.6

129684.8 131689.9 127698.4 127018.1 125477.3 127293.4 131384.8 125065.2

127799.3 130853.9 131691.9 124028.2 126517.7 127524.0 130158.7 128233.0

130256.1 127769.2 125481.0 127938.1 128243.2 128197.0 131457.4  

124723.1 128283.3 124260.0 129318.0 126778.4 126416.6 125649.6  

127022.5 129912.9 128582.6 127840.3 129127.9 125589.4 124797.8  

127302.0 130708.8 128027.9 129290.3 126987.1 128872.3 126570.1  

127383.1 125554.5 129167.6 130543.7 130735.8 131209.0 131537.4  

125546.1 126399.9 126199.1 129430.6 129365.6 126396.7 130975.4  

131038.3 123862.1 126380.1 126169.2 130026.1 131313.1 129401.4  

127713.0 125781.3 130631.4 127463.3 129005.6 129119.8 125967.9  

129868.9 127551.4 126474.0 130059.8 126297.1 129359.1 128008.1  

124477.3 127715.8 132939.1 127824.9 133425.3 127760.8 131910.9  
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Table 2. Table 2

Figure 7. Chart 2

Cu read Cu read Cu read Cu read Cu read Cu read Cu read Cu read

33387.86 31856.34 32740.38 33687.23 34756.38 32933.31 33186.25 33076.11

33991.01 33680.85 33909.94 32589.40 32915.60 33749.85 32749.94 33159.21

34071.70 32634.30 33736.93 32204.39 33486.02 33210.62 33290.37 34292.28

34529.59 34025.62 32234.62 34111.94 32534.00 32713.45 33638.88 35284.71

33059.04 34357.05 32877.01 33365.14 33969.77 32913.59 32216.05 34283.20

33304.52 31673.18 33051.36 34948.63 33779.44 34403.56 33726.88 34560.44

33078.60 32682.12 32236.69 33222.50 32907.96 33779.25 33647.55 33753.34

33622.60 33615.13 33178.60 33392.14 33244.81 33246.47 33979.57 32279.92

32732.53 34437.75 32542.88 32769.55 32628.07 32118.03 34131.02 32156.34

33569.09 34063.87 34320.18 32735.69 33010.81 32740.08 33100.64 33202.32

33786.19 33237.50 32381.56 33066.61 33500.42 33030.59 34481.41  

31785.92 33672.32 32223.76 33863.22 33797.62 33550.79 32950.11  

33008.73 32669.46 32312.26 33399.00 34557.60 32448.79 33639.86  

33540.20 33118.25 32885.37 34117.85 33278.59 33508.32 32520.64  

33517.70 32043.74 32879.28 33703.34 34576.89 33859.27 33865.25  

32044.99 33063.97 33025.60 34448.46 34003.35 32543.92 34466.34  

34145.80 31654.85 31680.70 32404.05 33741.77 34100.24 34072.38  

33352.85 33261.42 33919.88 32790.72 33778.54 33053.59 32344.51  

33495.84 33827.10 33278.86 33982.80 33205.91 34062.01 33328.92  

32390.06 32998.97 35415.67 33122.56 33755.98 32609.61 34113.34  
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Example 3

The same ore CRM also contains 24ppm Se, and gives us readings as shown in Table 3. The 
average for these readings is 33.8ppm, and the standard deviation is 6.7.

The RSD is 6.7/33.8 *100 = 19.8%, indicating that the readings are only just above LOD, 
and therefore should be considered semi-quantitative at best.

This data set demonstrates the information shown in Target 3, we have good accuracy and 
poor precision.  Another way of considering this data is to plot the points and see where the 
certified value lies in relation to the readings, as can be seen in Chart 3. As can be seen, the 
points are scattered about the certified value (although there is a small positive bias). This 
demonstrates that in order to obtain the most accurate reading, a large number of readings 
must be taken. Any one single reading may be quite different from the true value.

It should also be pointed out that the standard error (2 sigma) for these readings is 13, which 
agrees well with our calculated sd of 6.7 (x 2 = 13.4), and the error readings should always be 
viewed by the user in order to determine how close you are to the LOD, and therefore give an 
indication of how variable the results may be.
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Table 3. Table 3

Figure 8. Chart 3

Se read Se read Se read Se read Se read Se read Se read Se read

35.51 26.52 28.69 38.54 41.08 31.82 38.82 30.88

28.53 25.92 33.89 37.86 34.23 37.59 36.82 33.32

50.58 29.23 38.07 25.57 15.85 32.02 40.66 32.88

26.21 37.12 34.07 38.69 34.11 29.45 34.00 45.88

37.20 47.35 34.06 23.24 49.67 37.56 31.72 34.10

41.11 29.60 25.59 35.76 29.88 19.22 33.39 32.87

34.60 36.25 47.01 30.45 42.47 47.54 37.21 21.73

24.26 36.32 32.06 44.35 29.03 32.87 38.95 19.98

32.14 38.26 32.45 37.94 33.68 32.02 30.16 26.23

36.17 37.45 39.05 20.15 35.72 38.86 43.04 34.42

45.70 37.91 34.51 32.19 21.10 37.61 33.46  

29.00 26.69 30.22 33.30 26.87 44.73 37.43  

37.02 34.74 27.81 28.47 36.15 30.13 26.01  

41.64 34.51 26.98 26.37 38.73 21.60 33.24  

33.41 31.31 34.81 53.06 28.19 41.85 31.65  

28.38 24.93 26.76 30.78 39.89 31.64 35.95  

31.44 39.70 35.42 33.56 42.60 30.85 44.62  

32.72 38.98 16.06 34.68 25.27 26.45 38.46  

32.10 29.33 31.65 46.39 36.55 31.98 40.99  

30.57 32.02 33.28 29.59 40.29 41.24 36.97  
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Example 4

One question that is often asked is for how long to run a test, and the answer is for however 
long it takes to generate the results with enough certainty for an appropriate decision. The 
longer the integration time, the more precise the result.

Let’s consider an example of Pb in soil. A soil sample containing approximately 5000ppm of 
Pb was analyzed 10 times each at different integration times (10s, 20s, 30s, 60s, 120s and 
240s). The results are listed in Table 4. There are 2 main things to notice with this data, firstly 
the shorter the analysis time the greater the spread, so for the 10 second analysis time we go 
from 4876 – 5759ppm (883ppm spread) while for the 240s analysis time we go from 5271 – 
5398ppm (127ppm spread). The spread that is seen is also reflected in the 2 sigma error that 
is reported for each of the individual tests as seen in the table. Secondly the average obtained 
from each of the 10 readings is very similar in all cases.

These two points can be seen diagramatically in Chart 4. So if we need the results for a 
5000ppm Pb sample to have a 2 sigma error of less than 100ppm, we will need to read for 60s 
to achieve this criterion. But if I am more concerned with obtaining the best average value in 
the shortest possible time, then I would take 10 10s runs and average the value to obtain an 
average that will approximate a much longer run instead of taking a single 120s or 240s 
analysis.

Note that increasing the integration time only improves precision, it does not improve 
accuracy of the results.
Table 4. Table 4
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Figure 9. Chart 4

Duration Pb Pb Error Duration Pb Pb Error Duration Pb Pb Error

10.2 5445.9 270.3 30.3 5364.1 126.0 120.4 5346.4 58.7

10.0 4876.5 248.9 30.0 5183.6 123.9 120.0 5316.0 58.6

10.0 5605.3 278.2 30.0 5329.3 127.9 120.0 5331.6 58.9

10.2 5029.0 251.8 30.0 5321.6 126.1 120.3 5364.8 59.0

10.2 5314.3 265.0 30.2 5290.8 126.1 120.1 5256.5 58.0

10.2 5254.6 260.3 30.0 5147.2 123.7 120.4 5302.0 58.5

10.1 5758.9 286.9 30.3 5539.1 130.1 120.1 5266.8 58.2

10.0 5100.9 257.9 30.3 5288.5 125.5 120.1 5368.8 59.3

10.0 5458.5 276.5 30.4 5392.2 128.7 120.1 5292.5 58.2

10.0 5304.9 270.7 30.3 5323.8 126.0 120.0 5350.5 59.0

20.1 5423.6 163.8 60.1 5270.2 81.9 240.1 5315.1 41.5

20.3 5002.0 152.4 60.1 5422.3 83.8 240.3 5355.2 41.9

20.2 5468.9 164.6 60.2 5385.1 83.0 240.3 5306.3 41.5

20.3 5258.9 160.0 60.2 5198.0 80.7 240.3 5377.6 42.1

20.2 5244.8 158.0 60.2 5278.1 81.7 240.3 5343.1 41.7

20.2 5251.0 159.5 60.2 5457.3 83.8 240.3 5271.4 41.3

20.3 5237.7 159.6 60.2 5300.4 81.8 240.2 5360.3 41.8

20.3 5376.5 161.2 60.2 5531.8 84.7 240.3 5322.5 41.6

20.3 5293.9 159.4 60.2 5200.0 80.8 240.2 5395.9 42.1

20.2 5095.2 156.1 60.2 5311.9 82.5 240.3 5398.5 42.2
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Example 5

A question that is often asked is how to improve (i.e. reduce) the limit of detection. The LOD 
is related to error, and x-ray analysis depends on measuring the counts of photons hitting the 
detector. Therefore the most obvious way to improve the LOD is to get more counts. This is 
done mechanically by improving detectors (to “see” more), or by improving x-ray tubes (to 
give more excitation energy). But, most users merely increase the length of the integration 
time (longer time = more counts). Every time you double the analysis time, the LOD will 
improve by the √2 (or 1.414). If you triple the analysis time, the LOD will improve by √3 (or 
1.732), if you quadruple the analysis time the LOD will improve by √4 (or 2.0), and so on. 
However, there is a law of diminishing returns (in terms of time) and you can never get to 
zero!

Let’s consider a real example. A soil sample contains 10ppm Co, for how long do I have to 
integrate in order to be able to detect this concentration? Table 5 shows the results of reading 
this sample at a few different integration times. Firstly we can see that our rule of using the 
square root of the time increase agrees very well with the instrument calculated LODs, for 
example going from 60s to 120s we would expect the 175ppm LOD to improve by  √2 
(175/1.414=123.8) and the instrument gives us 124pm. Similarly if we go from 60s to 240s 
we would expect an improvement of √4 (175/2 = 87.5) and the instrument reads  88. 
Essentially we need a ten times improvement of LOD from that obtained at 240s, so we need 
to run for 100 times longer (10 is the square root of 100) than the 240s, i.e. for 24,000 
seconds  (400 minutes or 6.66 hours). Clearly this is impractical, so we can never reach 
10ppm Co.
Table 5. Table 5

This example demonstrates that  we should understand the practical limits of the instrument 
and not try to exceed them.

Example 6

Accuracy can also be ascertained by looking at the coefficient of determination (r2). This is 
done by running numerous standards or well-characterized samples and plotting the known 
or certified values (x-axis) against the read concentrations (y-axis). For example, a number of 
materials containing Cu at varying levels was analyzed using the mining mode. The results for 
these standards are tabulated in Table 6 and the plot obtained can be seen in Chart 6a.

Time Co Co err Co LOD

30s -62.7 176.8 265

60s -9.6 116.4 175

120s -35.2 82.6 124

240s -55.5 58.8 88
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The coefficient of determination (r2) is shown on the graph as being 0.9983. An r2 of 1 would 
be a perfect fit, and this at 0.9983 is excellent. This tells us that the points all plot well on a 
line (in this case a linear plot), and so the relationship between them is good. This indicates 
that the calibration is valid for all sample types. 

However the coefficient of determination is not the only thing we must observe on the chart, 
we must also consider the equation itself. The equation is y = 1.0038x + 289.61. This tells us 
we have a good agreement between the read and certfied values as we have y = 1.0038x. This 
first value should be very close to 1, if the value is much different then we have a bias. For 
example, Chart 6b shows a similar data series for nickel  with an excellent r2 of 0.9994 (i.e. all 
points plot well on the straight line), but the equation is y = 0.8647x + 25.428. As y = 
0.8647x, this indicates that the reading is only 86% of the certified value, i.e. we have a 
negative bias on this instrument.
Table 6. Table 6

Sample
Cu ppm 
certified

Cu ppm 
read

Cu err Sample
Cu ppm 
certified

Cu ppm 
read

Cu err

SiO2 0 1 32.2 NIST1645 109 226.93 66.92

BCS355 850 479.39 134.55 NIST1646 18 71.39 45.2

NIST113b 2953 2817.11 373.07 NIST1646a 10.01 34.7 37.28

CPB-1 2540 2854.62 416.69 NIST2780 215.5 253.7 58.42

MP-1 20900 21074.01 1055.52 NIST2781 627.4 1274.97 106.05

MRG-1 135 208.15 72.05 NCSDC28024 14 59.33 128.22

PTM1 302400 301525.4 19744.75 NCSDC73306 23 119.01 53.07

NCSDC190

05

65 102.18 62.96 NCSDC73308 22.6 74.47 39.39

NCSDC700

06

93.6 94.95 86.48 NCSDC73309 79 131.83 47.18

NCSDC700

10

140 80.53 68.3 NCSDC73323 144 164.01 55.97

NCSDC700

11

97.4 1 50.86 NCSDC77302 23.2 81.78 40.88

NCSDC735

09

28000 33023.99 1467.3 NCSDC77303 65.4 114.75 51.88

NCSDC735

10

960 1171.82 204.44 170-ES 228.7 380.35 63.79

NCSDC735

13

1380 1540.97 283.36 171-S 17.9 116.86 100.39

AGV1 60 110.98 47.95 172-PS 870.2 1185.28 120.44

CCU-1 247100 246932.9 15293.72 173-S 359.8 411.96 74.74

SU-1a 9670 10769.61 595.71 174-PS 3370.6 4722.92 323.92

RTS-1 595 782.03 116.85 175-S 1064 1629.33 161.2

RTS-2 670 790.29 164.23 176-CCD 1519 2148.84 159.18
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Figure 10. Chart 6a

RTS-3 2820 3200.3 247.08 177-S 4977.3 7250.36 314.08

RTS-4 280 371.04 175.6 179-S 978.1 1536.75 122.45

CZN-1 1440 1155.58 255.98 185-S 1517 2088.72 150.44

DTS-1 7.1 1 48.5 186-CCD 255 356.62 76.11

DWA1 4 38.98 39.09 189-S 1461.9 2361.88 159.84

PTC1 51600 52750.17 2930.05 191-ES 347.1 379.91 69.95

SO-1 61 150.45 51.93 192-ES 102.3 130.64 45.83

TILL-1 47 97.5 44.07 193-S 1173 1710.95 131.44

FER-2 45 39.16 69.73 195-S 1017.8 1514.52 129.88

G2 11 49.95 40.18 196-CCD 618 765.84 108.39

PACS-2 210 486.1 72.41 197-S 664 1166.79 121.17

SY-2 5 56.18 47.09 199S 154.7 183.69 54.76

TILL-2 150 278.58 57.69 200ES 91 158.06 45.68

CZN-3 6850 6590.49 565.4 201-S 673.5 1022.73 97.53

MA-3a 100 163.54 55.63 202-PS 919.3 1360.74 145.68

MESS-3 33.9 87.5 46.55 205-S 2522.2 4346.04 242.75

PI 3.12 14 92.78 130.56 207-S 1588 2303.46 167.76

IGS-21 7980 8556.18 531.84 209-S 2633.5 4505.38 243.95

NIST57a 40 92.47 52.11 212-PS 536.4 767.41 97.89

NIST330 8400 9194.91 380.03 T-215S 42.4 117.25 45.35

NIST331 910 1242.44 103.34 219-S 1543.5 2266.31 266.29

JSAC 0403 26.2 76.16 42.38 220-ES 36.6 77.38 38.98

BAM529-1 100 189.69 64.35 221-S 281.2 487.74 68.15

NIST691 320 290.04 223.49 222-PS 871.4 1162.97 116.15

NIST1633 128 257 63.85 225-S 44.5 101.86 43.57

NIST1633a 118 238.69 64.58 226-HD 315.6 608.84 72.56

228-ES 101.9 133.47 45.7 227-S 228.4 252.75 54.28

229-S 16.7 49.28 39.05     
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Figure 11. Chart 6b
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Note

Your instrument was supplied with various reference materials (depending on the calibrations 
you have on your instrument) so that you can confirm its’ analytical performance. It is 
recommended that you run these on a daily basis and keep a record of your results, that way 
you can easily confirm that your instrument is running at its optimal performance.

But if you are purchasing additional standards from other vendors beware, not all standards 
are created equally. Standards are manufactured for specific tasks, and may, or may not, be 
suitable for reading on your XRF.  Always read the certificate carefully before analysis. For 
example many soil standards are certified for multiple elements as can be seen in the partial 
Certificate shown below, which shows part of a certificate of analysis for a natural matrix 
CRM.

Figure 12. Certificate

�

However, when using XRF to analyze this sample, the Cr reads consistently high, 
approximately 1700ppm. There is clearly a positive bias, but what is causing it? The answer 
lies in the fine print on the certificate of analysis, excerpts of which state:
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“…The reference values were determined by USEPA SW846 (3rd edition) Methods 3050 and 

6010,… The sample is suitable for other 3000-series metal digestion method procedures and 
7000-series 9000-series spectroscopic methods.”

Method 3050B is an acid digestion of sediments, sludges and soils for AAS, ICP, GFAAS and 
ICPMS . This method is not a total digestion method, it will only dissolve elements that 
could become environmentally available. 

Any comparison of XRF values with a sample that has been analyzed after a partial digestion 
method is prone to have this type of bias, the XRF will typically always read higher.

The same is true when looking at extractable-type samples, for example, landfill samples run 
under TCLP (USA), or migration of certain elements in toys using EN 71 Part 3 (EU). 

It should be noted that extraction rates of elements vary considerably from sample to sample, 
so it is not practical to apply a “correction factor” to adjust the XRF results to agree with 
another analytical technique using partial digestion or extraction methods.
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Service

See “Contact Us” on page 1 to find your nearest Service facility.

Warranty

Warranty statement

Seller warrants that the Products will operate or perform substantially in 
conformance with Seller's published specifications and be free from 
defects in material and workmanship, when subjected to normal, proper 
and intended usage by properly trained personnel, for the period of time 
set forth in the product documentation, published specifications or 
package inserts.  If a period of time is not specified in Seller’s product 
documentation, published specifications or package inserts, the warranty 
period shall be one (1) year (unless otherwise agreed upon at time of 
purchase) from the date of shipment to Buyer in the country of 
purchase.  Any part replaced on an instrument, covered by the original 
factory warranty, will be warranted for the remainder of the instrument's 
factory warranty. Seller agrees during the Warranty Period,  to repair or 
replace, at Seller's option, defective Products so as to cause the same to 
operate in substantial conformance with said published specifications; 
provided that Buyer shall (a) promptly notify Seller in writing upon the 
discovery of any defect, which notice shall include the product model 
and serial number (if applicable) and details of the warranty claim; and 
(b) after Seller’s review, Seller will provide Buyer with service data and/or 
a Return Material Authorization (“RMA”), which may include 
biohazard or other Radiation safety decontamination procedures and 
other product-specific handling instructions, then, if applicable, Buyer 
may return the defective Products to Seller with all costs prepaid by 
Buyer. Replacement parts may be new or refurbished, at the election of 
Seller, the warranty of these parts expire with the instrument warranty. 
 All replaced parts shall become the property of Seller.  Shipment to 
Buyer of repaired or replacement Products shall be made in accordance 
with the Delivery provisions of the Seller’s Terms and Conditions of 
Sale.  Accessories and Consumables are expressly excluded from this 
warranty (see list A for details).  

Notwithstanding the foregoing, Products supplied by Seller that are 
obtained by Seller from an original manufacturer or third party supplier 
are not warranted by Seller, but Seller agrees to assign to Buyer any 
warranty rights in such Product that Seller may have from the original 
manufacturer or third party supplier, to the extent such assignment is 
allowed by such original manufacturer or third party supplier.  
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In no event shall Seller have any obligation to make repairs, replacements or corrections 
required, in whole or in part, as the result of (i) normal wear and tear, (ii) accident, disaster or 
event of force majeure, (iii) misuse, fault or negligence of or by Buyer, (iv) use of the Products 
in a manner for which they were not designed, (v) causes external to the Products such as, but 
not limited to, power failure or electrical power surges, (vi) improper storage and handling of 
the Products, (vii) use of the Products in combination with equipment or software not 
supplied by Seller, (viii) Moderately heavy or excessive impact against any object, including 
but not limited to floors, walls, furniture, sample or other objects. A shock sensor is fitted 
inside of the instrumentation; warranty is void if this shock sensor is activated, (ix) Excessive 
water, moisture or condensing humidity that breaches the instrument seals, (X) Excessive or 
extreme ambient or direct temperature or (vi) Heavy vibrations directly to the instrument for 
extended periods of time. If Seller determines that Products for which Buyer has requested 
warranty services are not covered by the warranty hereunder, Buyer shall pay or reimburse 
Seller for all costs of investigating and responding to such request at Seller's then prevailing 
time and materials rates.  If Seller provides repair services or replacement parts that are not 
covered by this warranty, Buyer shall pay Seller therefore at Seller's then prevailing time and 
materials rates. 

ANY INSTALLATION, MAINTENANCE, REPAIR, SERVICE, RELOCATION OR 
ALTERATION TO OR OF, OR OTHER TAMPERING WITH, THE PRODUCTS 
PERFORMED BY ANY PERSON OR ENTITY OTHER THAN SELLER WITHOUT 
SELLER'S PRIOR WRITTEN APPROVAL, OR ANY USE OF REPLACEMENT PARTS 
NOT SUPPLIED BY SELLER, SHALL IMMEDIATELY VOID AND CANCEL ALL 
WARRANTIES WITH RESPECT TO THE AFFECTED PRODUCTS.

 

THE OBLIGATIONS CREATED BY THIS WARRANTY STATEMENT TO REPAIR 
OR REPLACE A DEFECTIVE PRODUCT SHALL BE THE SOLE REMEDY OF 
BUYER IN THE EVENT OF A DEFECTIVE PRODUCT.  EXCEPT AS EXPRESSLY 
PROVIDED IN THIS  WARRANTY STATEMENT, SELLER DISCLAIMS ALL OTHER 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, ORAL OR WRITTEN, WITH 
RESPECT TO THE PRODUCTS AND INCLUDING WITHOUT LIMITATION ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE.  SELLER DOES NOT WARRANT THAT THE PRODUCTS 
ARE ERROR-FREE OR WILL ACCOMPLISH ANY PARTICULAR RESULT.

Accessories, Spares and Consumables - exclusions 

(List A)

Specific warranties of some common accessories:

• Battery Charger and batteries - 12 months

• Instrument accessories - 12 months

• Consumable - no warranty
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• Soil Grinder - no warranty

• Single-stage or two stage helium tank regulator - 12 months

• Test stands, extend-a-poles and docking stations – 12 months

• Parts or spares sold, installed or supplied outside of the product warranty period and not 
listed above – 12 months
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	3. Snap the Locking Clip into the Locking Groove, securing the ferrule to the instrument, as in Figure 4.

	Figure 137. Ferrule Attached and Locked
	4. Turn on helium flow. Allow the helium to purge the instrument’s front end for a minimum of five minutes before starting analysis. Helium purging can be done at the same time as instrument warm-up.
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	Connectivity
	Using Your Analyzer With Your PC
	Installing Niton Data Transfer Software
	Table 9: System Configuration
	1. Close all the programs that you have open on your PC.
	2. Insert the CD into the CD-ROM drive.
	3. Double-click My Computer.

	Figure 168. My Computer Icon
	4. Double-click the Compact Disc icon:

	Figure 169. Compact Disc Icon
	5. Double-click the Setup Application icon.

	Figure 170. Setup Application Icon
	6. Follow the instructions on the screen.



	Starting Niton Data Transfer Software
	To start Niton Data Transfer:
	1. Click the Start button.
	2. Select Programs.
	3. Select Thermo Niton.
	4. Click NDT.
	Figure 171. Starting NDT Up


	Connecting the XRF Analyzer to Your PC
	Using a Serial Cable to Connect the XRF Analyzer
	1. Insert the DB9 connector on the serial cable into the COM port on your computer.
	Figure 172. The DB9 Serial Connector and COM Port
	2. Tighten the screws of the DB9 connector with your fingers. You do not need to use a screwdriver.
	3. Open the Port Cover on the XRF Analyzer.
	4. Insert the micro stereo connector on the serial cable into the Serial port in the handle of the XRF Analyzer.

	Figure 173. Micro Stereo Connector

	Using a Serial-to-USB Adapter to Connect Your XRF Analyzer
	Using the Wireless USB Adapter to Connect the XRF Analyzer
	Figure 174. The Bluetooth Setup Menu Path

	i Icon
	Figure 175. BT Information Screen

	Search Button
	Figure 176. Bluetooth Searching


	Connecting From Your Analyzer to Your PC
	Figure 177. Connecting Via Bluetooth
	Figure 178. Connecting Via Bluetooth
	Connect Button
	GPS Button
	Figure 179. Bluetooth GPS Data Screen

	Reset Button
	Config Button
	Figure 180. Bluetooth Config Screen

	Changing the Bluetooth Device Type
	Figure 181. Changing Bluetooth Device Type
	Disable/Enable Button
	Close Button


	Using a USB Cable to Connect Your Analyzer
	To connect the XL3 XRF Analyzer to your PC using the USB cable:
	1. Insert the Standard USB connector on the USB cable into a USB port on your computer.
	Figure 182. Standard USB Connector
	2. Open the Port Cover on the XRF Analyzer.
	3. Turn on the analyzer and insert the mini USB connector on the USB cable into the USB port in the handle of the XRF Analyzer.
	4. Upon initial installation, insert the NDT disk located behind the foam in your case. Follow the prompts and install the USB driver located on the disk.

	Figure 183. Mini USB Connector

	Installing the Windows 7 USB Driver
	1. Insert the NDT CD and close out any dialogue box that pops up. The driver is located on this disk.
	2. Click on “Control Panel” and locate the “Device Manager”. If it is not available directly under “Control Panel”, look under “System and Security” then “System”.
	3. Open “Device Manager”
	4. Plug in instrument using the USB cable provided
	5. Message will appear “Device Driver Software Not Successfully Installed”
	6. In “Device Manager”, “Unknown Device” will appear under “Other Devices”
	7. Right click on “Unknown Devices”; select “Update Driver Software”
	8. Click on “Browse My Computer for Driver Software”
	9. Click “Browse” button; select CD drive or the location of the driver if you are not installing from the NDT CD (recommended).
	10. Click “OK”
	11. Click “Next”
	12. A Security Dialog Box will appear. Select “Install This Driver Software Anyway?”
	13. Driver will install; close out.


	Downloading Data
	Standard Download
	1. Make sure that the XRF Analyzer is connected to your computer. See Connecting the XRF Analyzer to Your PC for more information.
	2. Turn on the XRF Analyzer. See the manual for the XRF Analyzer for more information.
	3. Start Niton Data Transfer. See Starting Niton Data Transfer Software for more information.
	4. Click the Download button. The Download dialog box will open.
	Figure 184. The Download Button
	5. In the Download dialog box, Select the Test button to test the serial connection to the Analyzer.

	Figure 185. The Test Button
	6. You should get a pop-up window informing you that the connection tested successfully. If the test fails, there is a problem with your serial port setup.

	Figure 186. Connection Success Window
	7. In the Download dialog box, click the Connect button.

	Figure 187. The Connect Button
	8. Click the Query Readings button. This will return a list of all current readings on your analyzer. The list appears in the large white box in the Download dialog box.

	Figure 188. Current Reading List
	9. Select the readings that you want to download. There are two ways to do this.
	a. Click the boxes next to each of the reading numbers to select or de-select individual readings. You can select a range of readings by pressing the shift key, then selecting the first and last reading in the range. All readings from the first readi...

	Figure 189. Selecting Readings
	b. Click the boxes on the left to select or de-select all the readings of a specific type. You can also use the Shift-Click method of selecting a range of readings as described above.

	Figure 190. Using Check Boxes
	c. Enter the path for the file in the Destination Folder field. You can use the ... button to browse.

	Figure 191. The Browse Button
	d. Enter a name for the file in the File Name field.
	e. Click the Download button.

	Figure 192. The Download Button
	Figure 193. The Progress Bar
	Table 10: Error Messages while Downloading


	Live Download (Automatic Save)
	Figure 194. Live Download Icon
	Please note the following:
	1. When the instrument is unplugged, selecting the Download icon does nothing.
	2. When you disconnect, then reconnect, your analyzer, Download appends future readings to same file.
	3. Live Download does not overwrite any previous readings in the file. If you want to do this, you must first explicitly erase the file before initiating Live Download.
	4. Live Download does not retroactively add any readings taken while your analyzer was disconnected.


	Changing the Filename for Live Download
	Figure 195. File Dialog Box
	Simultaneous Save as CSV File


	Creating and Using Reports
	Creating a New Report
	Opening an Existing Report
	1. Click the Open button to open the Open Existing Report dialog box.
	Figure 196. Open Existing Report Dialog Box
	2. Click the name of the report to highlight it.

	Figure 197. Selecting the Report
	3. Click the Open button.
	4. The report is presented with one line per measurement. The report doesn't all fit onto one screen, but you can scroll right if the fields you are interested in are not visible. If they are still not visible read the following section on changing v...


	Configuring Reports for Printing.
	Figure 198. Select Customize from the Menu
	1. Select Customize from the Tools Menu.

	Figure 199. Select the Report Print Tab
	2. Select the Report Print tab.

	Figure 200. Customizing the Report
	Figure 201. Sample Report
	Figure 202. Select Properties from the Menu
	Figure 203. The General Properties Tab

	Using the Customize Report Dialog Box to Add and Remove Columns
	1. Click the View Menu.
	Figure 204. View Menu
	2. Click the boxes next to each of the column headings to add or remove each column from the report.

	Figure 205. Select Columns for Report
	3. When a checked box is selected, the check is removed and the box becomes empty.

	Figure 206. Deselecting Boxes
	4. If you want, you can click the boxes in the Selection area to select or de-select a group of headings.

	Figure 207. The Selection Area
	5. If you want the changes to apply to all the reports, click the box next to Apply Global. If this box does not have a check mark, the changes only apply to the report that is currently open.

	Figure 208. Applying Changes Globally
	6. Click the OK Button.


	Changing the Position of the Columns in the Report
	Figure 209. Switching Columns

	Changing the Columns in a Report
	Removing a Column from the Report
	1. Right-click on the heading for the column that you want to remove.
	2. Click Hide, or Hide Global, on the Pop-Up Menu.
	Figure 210. Hiding Columns

	Adding a Column to the Report
	1. Use the Hidden Columns dialog box to add a column to the same report from which you removed it. See "Adding a Column with the Hidden Columns Dialog Box" for more information.
	2. Use the Options dialog box to add a column that you removed using Hide Global. See "Adding a Column with the Options Dialog Box" for more information. You can use either dialog box if you are adding a column that you removed using Hide Global, in ...
	3. Use the Customize Report Dialog Box to add or remove multiple columns at the same time. See "Adding a Column with the Options Dialog Box" for more information.
	Adding a Column with the Hidden Columns Dialog Box
	1. Open the report that you used to remove the column from the report.
	2. Decide where you want the re-inserted column to appear.
	3. Right-click on the heading for the column to the left of that.
	4. Click Unhide on the pop-up menu to display the hidden columns
	Figure 211. Displaying Hidden Columns
	5. Click the column heading that you want re-insert.

	Figure 212. Selecting Column to Display
	6. Click the OK button.

	Figure 213. Reinserting Columns

	Adding a Column with the Options Dialog Box
	1. Select the Tools Menu.
	Figure 214. The Tools Menu
	2. Select Options.
	3. Select the Report tab.

	Figure 215. The Report Tab
	4. Click the column heading that you want to re-insert.

	Figure 216. Unhide Button
	5. Select the Unhide button.
	6. Select the OK button.



	Hiding a Reading in the Report
	1. Select the row you want to hide.
	Figure 217. Selected Row
	2. Right-click on the row and select Hide from the pop-up menu.
	3. The row is hidden from the report view.

	Figure 218. Hidden Row
	4. You can hide multiple readings in this way.


	Restoring the Row to the Report
	1. Select the readings above and below the reading you want to restore.
	2. Right-click on the highlighted readings.
	3. Select Unhide from the pop-up menu, and the row is restored.
	Figure 219. Restoring Rows

	Restoring Multiple Readings to the Report
	1. Right-click on a reading or empty row, and select Unhide from the pop-up menu.
	2. The rows are restored.
	Figure 220. Restored Readings

	Rows (Readings) in a Report
	Reversing the Sort Order in a Report
	1. Click on any column heading - the labels in the first row of the report.
	Figure 221. Column Heading
	2. The rows change order from descending to ascending. The column heading you clicked displays a triangle indicating the direction of the sort.

	Figure 222. Sort Direction Indicator
	3. Click the column heading again.
	4. The rows reverse order again, with the triangle reversing orientation to indicate the new sort order.

	Figure 223. New Sort Order


	Viewing the Spectra Graph
	Figure 224. Accessing the Spectra Graph
	Editable Fields
	Changing the Colors of the Spectra Graph
	Figure 225. Changing Spectra Graph Pen Colors
	Figure 226. Changing Spectra Graph Background Color
	Figure 227. Changing Spectra Graph Grid Colors
	Figure 228. Changing Spectra Graph Text Colors
	Figure 229. Changing Spectra Graph Axis Colors
	1. Click the Down Arrow button on the Pen Color button to display the Color Menu.

	Figure 230. The Pen Color Button
	2. Click the part of the graph that you want to change.
	3. If you select Set Pen Color, the Spectrum Properties dialog box appears.

	Figure 231. Spectrum Properties Dialog Box
	4. If you have selected more than one Reading, click the Reading Number that you want to set.

	Figure 232. Selecting Readings
	5. Select the Color button.
	6. In the Color dialog box, click a color to select it.

	Figure 233. Selecting Colors
	7. Click the OK button.


	Defining Custom Colors
	1. Select the Pen Color button to display the Color dialog box.
	2. Select Define Custom Colors Button to display the custom color area.
	Figure 234. Custom Colors
	3. Use the panel on the right to specify a color.

	Figure 235. Selecting From the Color Box
	Figure 236. Current Color
	4. When you are satisfied with the color you have selected, click Add to Custom Colors button. The color appears on the left under custom colors. It can now be used in the spectra graph in the same manner as the Basic Colors.

	Figure 237. Closing the Dialog Box
	5. Close the dialog box by doing one of the following:


	Returning to the Default Colors
	1. From the Tools Menu, select Options.
	Figure 238. The Tools Menu
	2. In the Options dialog box, click the Spectra tab.

	Figure 239. Restoring the Default Colors from the Spectra tab
	3. Click the Restore Default Colors button.
	4. Click OK.



	Viewing Different Areas of the Spectra Graph
	Table 11. Spectra Graph Options
	Magnifying the Spectra Graph
	To magnify the spectra graph:
	1. Display the spectra graph by double-clicking on the reading number.
	Figure 240. Displaying a Spectra Graph
	2. Highlight the area that you want to magnify. To do this, click and drag over the desired area. The Cursor Information dialog box appears showing the keV of the boundaries for the area of the spectra graph that is selected. It also shows the height...

	Figure 241. Selecting Spectra Graph Areas of Interest
	3. Click the Fit button. The spectra graph expands to show only the previously selected area, and the Cursor Information dialog box is reset to zero.

	Figure 242. Spectra Graph Fit to Area Selected


	Hiding or Showing the Cursor Information Dialog Box
	1. Click the View Menu.
	2. Click Cursor Information.
	Figure 243. Selecting Cursor Information

	The Cursor Information Box
	Figure 244. The Cursor Information Box
	Figure 245. Cursor Positioning on the Spectra Graph
	Left Boundary
	Right Boundary
	Highest Peak
	Nearest Ka Element peak
	Nearest Kb Element peak
	Nearest La Element peak
	Nearest Lb Element peak
	Figure 246. Cursor Information for Selected Area


	Hiding or Showing the Grid
	Figure 247. Hiding or Showing the grid


	Viewing the X-ray Line List
	Figure 248. The X-ray Line List
	Figure 249. The X-ray Line List
	Figure 250. Close View of the X-ray Line List
	Peak Labels
	Figure 251. Peak Labelling
	Figure 252. Highlighted Element Peaks
	Figure 253. Selecting a Peak with the X-ray Line List
	Figure 254. The Spectra tag
	Figure 255. Making Peak Labels Persistent
	Figure 256. Viewing Multiple Peak labels
	Figure 257. Selecting Persistent Labels Through the Menu
	Figure 258. Clearing Labels from the Spectrum

	Overlaying Spectra
	Open a reading file.
	Figure 259. Selecting Multiple Spectra for Overlay
	Figure 260. Selecting a Range of Spectra for Overlay
	Figure 261. Selecting Spectra from the Menu
	Figure 262. Overlain Spectra


	Spectral Difference
	Figure 263. Two Overlain Spectra
	Figure 264. Selecting Spectral Difference from the Menu
	Figure 265. Difference Spectrum
	Figure 266. Undoing Spectral Difference

	Paint Readings and Spectra
	Figure 267. Paint Readings
	Figure 268. Selecting Options from the Menu
	Figure 269. The Report Tab
	Figure 270. Selecting Your Preferred Colors
	Figure 271. The Report Tab
	Figure 272. New Colors in the Report


	Using the Menus Instead of the Toolbar
	Table 12. Using the Menus Instead of the Toolbar

	Renaming a Report
	1. Select Save As from the File Menu.
	Figure 273. Saving a Report Under Another File Name
	2. Type a name in the File Name field of the Save As Dialog Box.

	Figure 274. Renaming the File
	3. Click the Save Screen Button.


	Saving Selected Readings from a Report
	Figure 275. Saving Selected Readings As
	Figure 276. New File Name

	Copying a Report Into Excel
	1. Open the report. For more information, See "Opening an Existing Report".
	2. Select the readings that you want to copy to Excel.
	Figure 277. Selecting a Range of Readings
	Figure 278. Selecting Multiple Readings
	3. Select Copy from the Edit Menu.

	Figure 279. The Edit Menu
	4. Open Excel. To do this:
	a. Click the Start button.
	b. Select Programs from the Start Menu.
	c. Click Microsoft Excel.

	Figure 280. Loading Excel
	5. Within Excel, select Paste from the Edit Menu.

	Figure 281. Pasting Data Into Excel
	6. Excel shows the data from the columns that are displayed in NDT, for the rows that you selected.

	Figure 282. How NDT Data is Displayed in Excel
	Exporting the Report Data
	1. Open the report. For more information, See "Opening an Existing Report".
	2. Select Export Data from the Tools Menu.
	Figure 283. Exporting Data
	3. The Export Data Dialog Box will appear.

	Figure 284. The Export Data Dialog Box
	4. In the Export Data dialog box, specify the reading numbers that you want to export.
	a. Uncheck the All box.
	b. Enter the reading numbers. You may enter individual reading numbers, or ranges of reading numbers, separated by commas. Do not use spaces. For example: 1,3,5-12

	Figure 285. Exporting Data Ranges and Selected Readings
	5. Specify the folder where you would like to place the report files. The folder that is currently selected appears in the Destination Folder field. To change the folder, click the "..." (Browse) button.
	6. Enter a name for the export file in the Output File Name field.

	Figure 286. Naming the Export File
	7. Click the Start button.
	8. When the progress bar shows 100%, click the Done button.

	Figure 287. Finishing the Process


	Printing Certificates of Analysis
	Figure 288. Selecting Customize
	Figure 289. The Certificate Print Tab
	Figure 290. Components of the Certificate Print Tab
	The Logo Section
	Logo File Field
	"..." Browse Screen Button
	Clear Screen Button
	Logo Position Radio Screen Buttons

	The Company Info Section
	Company Name Field
	Company Address Field
	Company Location Field
	Company Info Radio Screen Buttons

	The Heading Section
	The Printing Options
	Printing the Certificate
	Figure 291. Select print Certificate from the Menu

	The Certificate of Analysis
	Figure 292. Example Certificate


	Closing a Report
	Figure 293. Closing a Report from the File Menu

	Deleting a Report
	1. Click the Open button.
	2. Right-click the name of the report to highlight it.
	Figure 294. Selecting a Report
	3. A Pop-up window will appear.

	Figure 295. The Pop-up Menu
	4. Choose Delete from the pop-up menu.

	Figure 296. The File Deletion Pop-up Menu
	5. Click the Yes button.


	Printing from NDT
	Printing Reports and Spectra Graphs from Niton Data Transfer
	Checking Paper Size and Orientation
	1. Click the File Menu.
	2. Click Print Setup to display the Print Setup Dialog Box.
	Figure 297. Select Print Setup
	3. Select the correct paper size from the drop-down list.
	4. Click the radio button for the correct orientation. The icon illustrates the orientation that is selected.

	Figure 298. Print Setup Dialog Box


	Printing from Niton Data Transfer
	To print the report or spectra graph:
	1. Click the Print Screen Button to display the Print Dialog Box.
	2. Check that the correct printer is displayed in the Name field. If it is not, use the drop-down list to select the printer. If you want to change the properties of the printer, refer to the documentation for your printer for more information.
	3. Select the pages that you want to print by doing one of the following:
	a. To print the entire report, click the All radio button.
	b. To print only part of the report, enter the first and last page numbers for the part that you want to print.
	4. Specify the number of copies that you want to print.
	5. Click OK.


	Printing Spectra Graphs from Excel
	1. Exporting the spectra data from Niton Data Transfer.
	2. Importing the spectra data into Excel.
	3. Creating the graph in Excel.
	4. Printing the graph.

	Exporting the Spectra Data
	1. Open the report. For more information, see "Opening an Existing Report".
	2. Select Export Spectra from the Tools Menu.
	Figure 299. Select Export Spectra from the Menu
	3. Specify the reading numbers that you want to export.
	1. Uncheck the All box.
	2. Enter the reading numbers. You may enter individual reading numbers, or ranges of reading numbers, separated by commas. Do not use spaces. For example: 1,3,5-12

	Figure 300. Specify Reading Numbers
	3. Specify the folder where you want place the spectra files. The folder that is currently selected appears in the Destination Folder field. To change the folder, click the "..." button.

	Figure 301. Changing Folders with the Browse Button
	4. Enter a name for the export file in the Output Filename field.

	Figure 302. Naming the Export File
	5. Click the Start button.
	6. When the progress bar shows 100%, click the Done button.

	Figure 303. Finish the Export Process

	Importing the Spectra Data
	1. Open Excel. To do this:
	2. Click the Start button.
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